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End User Licence Agreement

This end-user licence agreement describes the rights and warranty granted to its customers by
QuantumSoft (“the Publisher”). By using the pro Fit Software package you the customer are agreeing to
be bound by the terms of this agreement, which includes the software licence, software limited warranty,
and hardware limited warranty.

1. Licence: The Publisher grants the customer and the customer accepts a perpetual, non-exclusive, and
non-transferable licence to use the proFit software ('software’) so long as the customer complies
with the terms of this Agreement.

2. Copies: The Publisher grants the customer the right to make copies of the software for back-up
purposes only. The customer agrees to reproduce and incorporate the author's copyright notice on
any copies. It is expressly understood that such copies will not be used for any purpose except to
substitute for the initial copy in the event that it is unusable.

3. Use: In addition, the licence granted herein includes the right to move the software from one
computer to another provided that 1-user versions of the software are used on only one computer at
atime and that two people will not use the program at the same time on different computers.

4, Security: The customer agrees to secure and protect the pro Fit software package, the
documentation, and copies thereof from copying (except as permitted above) or from modification
and shall ensure that its employees or consultants do not copy or modify the product.

5. Owner ship: The Publisher represents that it has the right to grant the licences herein granted.

6. Limited Warranty: Whilst all reasonable efforts have been made to test the software and user
manual prior to first publication, the authors and Publisher welcome corrections being brought to
their attention.

The liability of the Publisher in respect of any defect, error, or omission in the disk, user manual, or
software (‘defective material’) and in respect of any breach of warranty or condition is limited to the
purchase price paid by the customer. The Publisher shall have no liability whatsoever arising out of any
defect, error, or omission or breach of warranty or condition unless the customer shall have returned the
defective material to the Publisher within 90 days of the date of purchase. In that event the Publisher shall,
as requested by the customer, either replace the defective material without charge or refund the purchase
price paid by the customer in respect of the defective material.

The Publisher (or the authors or copyright-holders) shall have no further or other liability including
without limitation in respect of damage to other property or in respect of any economic or consequential
loss of whatever nature arising out of or in connection with the product or any part thereof or itsuse or
application.

Should you have any questions concerning this licence or this limited warranty or if you want to contact
QuantumSoft for any reason, please write to:

QuantumSoft

Postfach 6613

8023 Zurich

Switzerland

e-mail: profit@quansoft.com
www.  http://www.quansoft.com
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Introduction

proFit is an interactive tool for the investigation, analysis and representation of functions and data. It is
designed for usersin science, research, engineering and education. The key features of proFit are:

Customized functions and algorithms: Very powerful and simple Pascal-like syntax for defining
mathematical functions, data transformation algorithms, drawings, and general macros. Support of
complex numbers, vectors, and up to 4x4 matrices as general data types to be used in any
mathematical expressions.

Interactive parameter modeling and curve fitting: Intuitive interface for modeling and fitting data.
Various fitting algorithms. Optional restriction of parameter ranges. Support for y- as well as x-
errors. Statistical error analysis for fitted parameters. Hand-fitting by dragging the function curve to
vary aparameter.

Professional plotting. Accurate and flexible graphical representations of mathematical functions and
numerical data. Multiple coordinate axes. Linear, logarithmic, 1/x, and normal probability scalings.
Reverse scaling. Coloring of areas between curves and any axis. Editing of any part of a plot with
standard drawing tools. Scatter plots, skyline plots and histograms.

Drawing editor. Support for standard drawing objects, Bézier curves, two different kinds of polygon
smoothing, texts with sub- and superscripts, data point symbols, and any imported picture. Dash
patterns are applicable to most drawing objects. Arrows are available for smoothed and unsmoothed
polygons and simple lines. The drawing editor supports colors, views at different magnifications, and
extended precision positioning of graphical objects. The floating point coordinates of drawing objects
can be edited graphically and numericaly.

Customizable graphical elements. Dash-patterns, line thicknesses, arrows, error bars, and data point
symbols can be customized. New arrows and data point symbols can be designed with a graphical
editor and added to the standard drawing menus.

Extensive graphical output possibilities. Support for PostScript™, PICT format, high resolution
bitmaps. Export of drawings with Copy& Paste, Drag& Drop, Publish& Subscribe, and as EPS, GIF
or JPEG files.

Soreadsheet data management: Spreadsheets for editing and transforming data. Predefined and user
defined algorithms. Single precision as well as double precision data columns and text columns are
supported.

Scriptability and Recordability. Automatically record your actions as a Pascal program or Apple
Script for replaying them later.

Function and data preview: Real-time automatic display of the current function and data. Interactive
graphical editing tools for function parameters and data points.

Externally compiled code: Import functions, algorithms, and other programs written in your favorite
programming language or in Apple Script.

On-line evaluation of mathematical expressions: Wherever pro Fit expects numerical input (such as
in spreadsheets or dialog boxes) any mathematical expression can by entered

10
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» Drawing froma program: proFit programs can directly draw in proFit’s drawing windows to create
drawings with high precision coordinates. These drawings are available for copying and pasting into
other applications and for high resolution printing. Specific drawing objects as buttons, check boxes,
and pop-up menus are supported to be used as interfaces for user-defined programs.

* Macro programming: Write complete macros to perform common tasks such as opening and
closing document windows, fitting, importing and exporting files, etc.

» Debugging enviroment: A powerful debugger providestools for developing and debugging complex
programs and functions.

« Extensive on-line help: Balloons and Apple Guide™ provide answers and explanations. A dedicated
on-line help is available for function and program definition.

» Powerful plug-ins: Various external modules further increase pro Fit's power, e.g. for contour
plotting and 3D plotting of functions and data sets (3D plotting requires a Power Macintosh with
OpenGL).

* And much more...: Such as Drag& Drop, Publish& Subscribe, Numerics algorithms, customizable
datafile import, etc.

What you need to run proFit:

proFit is supported on Mac OS® version 8.5 or later. proFit requires at least 2 MByte of free memory —
if virtual memory isoff, it requires at least 4 MByte. However, for normal activities, at least 5 MBytes are
recommended.

pro Fit 5.5 isaPower PC only application. There are no pro Fit 5.5 versions for older machines based on
Motorola's 680x0 family of processors. For users interested in running a version of pro Fit on those
machines, pro Fit 5.1 is still available. pro Fit 5.5 allows to save most of its documentsin pro Fit 5.1
format.

A note on updates

Development of pro Fit continues. To check for updates to your current version, visit QuantumSoft’s
webpage at http://www.quansoft.comny.

Y ou can aso use pro Fit’s built-in mechanism for checking for updates. Choose “About pro Fit” from
the Apple menu and click the button “Check for Update”. pro Fit will contact our web servers
electronically and tell you about any updates that you may want to download.

How to read this manual

This manual givesafull description of proFit 5.5. If you do not want to read it, you will still be ableto
find your way through proFit: proFit was designed to be used without a manual and most of its features
are self explanatory. Extensive on-line help is provided. However, you will need to read the manual to
efficiently work with some of proFit’s most advanced features.

Those of you who are aready familiar with proFit 5.1 arereferred to the last section of this chapter,
"Changes between versions 5.1 and 5.5". Then you may go directly to the chapters giving in-depth
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information on the new features.

Those who prefer a beginner's introduction should continue with "Getting started”, which gives an
overview on the most common features of proFit.

A description of the basic concepts of proFit is given in the next section.

Basic concepts

pro Fit works with data, drawings, functions and programs (or, through Apple Events, with other
applications or Applescripts).

Functions Programs
DN DN
y:=a[1]*sin(x) NewWindow(

fori:=1to 10
datali,1]:=i;

AppleScripts Data
A A
X y
tell applicatio 1.00 0.23
open file da 1.10 0.38
run programn 1.20 0.13
close windog

Plots Drawings
N N
OO
-4 Al
NG,

Y ou can enter data into spreadsheet windows. Data can be transformed by built-in transformation
algorithms, (e.g. sort, transposg, filter, Fourier transform, or mathematical operations) or by user-defined
ones. Data can be text or numbers.

Y ou can define your own data transforms by writing programs, which can access directly the data in the
spreadsheet window. pro Fit translates these programs into computer code, which can be executed
directly by the central processing unit of your computer. Y ou can automate many operations using such
programs or Apple Events and Apple Script.

Functions can be used for plotting, analysis and fitting. There are a number of built-in functions (such
aslog, cos, exp, etc.). You can define your own functions using the same simple, yet powerful definition
language used to define other programs and macros.
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Functions and programs can also be defined using an external compiler (external modules).

Y ou can plot your functions and data setsin a drawing window. proFit offers most standard features of
adrawing program, and the appearance of al graphical elementsis customizable. proFit generates high
resolution printer information for direct printing or for exporting data via the clipboard, Drag& Drop, or

Publish& Subscribe.

Changes between versions 5.1 and 5.5

proFit 5.5 brings various new features. Thisisalist of the most important ones:

Plotting, Drawing

Date & Time

Preview Window

Functions

Graphs now support horizontal and vertical historgram and skyline plots.
Graph labels can be rotated, and displayed as dates or times.

A new preference setting alows to set which data points are ignored when
plotting data without auto-range for the coordinate axes.

Log axes can now have 0, 1, 4 or 8 minor ticks.

Lines, Polygons, and Rectangles can be rotated by any angle, not just
multiples of 90 degrees. The "Coords" window displays the current angle,
which can be edited to change the orientation of a shape.

New Save and Open possibilities for JPEG and PICT files, as well as
saving of (uncompressed) GIF files. Anti-aliasing is supported when
saving drawings as GIF or JPEG.

Drawing objects can be controlled from programs. New objects such as
buttons and popup menus that can be used as user-interfaces for user-
defined programs.

pro Fit 5.5 supports date and time data, i.e. absoulte calendar dates and
relative time. You can store such data in data windows and use it for
labelling graphs, and for calculations.

The preview window has been redesigned. It is now resizeable, and many
more options, like the color of the function curve, its thickness, or the size
of data points, are user-selectable.

Functions can now have up to 128 parameters. The parameter window has
been re-designed. The function Spline has more options that can be set by
clicking the “ Spline Settings’ button in the parameter window. Thereisa
new possibility to define the spline curve by using function parameters to
set the coordinates of the points on which it isbased. Thisallows, e.g., to fit
a Spline function to some set of noisy points, in order to get a smooth
guide-to-the-eyes curve. When doing this, be careful not to choose too
many points for the Spline-definition

Introduction 13



Data processing

Preferences

User Interface

Programming

Column-calculations can be stored and made permanent. They will be
executed automatically whenever data is changed in a data window. The
instruction for calculating a "cal culation-column™ can be changed via the
column format dialog box.

A “binning” command allows you to categorize your data.

Improved sorting mechanism. Text columns can be used for sorting.

The index column in data windows can be set to the default x or y column.
New data column types and formatting options for date & time, and relative
time data.

pro Fit now looks for/creates a “pro Fit Preferences’ folder inside the
system's preferences folder. In this folder it looks for afile "pro Fit 5.5
preferences’ and creates one if no such file is found. If the "pro Fit
Preferences’ folder contains a folder named “pro Fit modules’, the
modulesin thisfolder are linked to pro Fit during start-up.

There are many new preferences to influence various pro Fit functions.

"Open" and "Save" dialog boxes now use the new "navigation manager”
routines.

Command click on the title-bar of windows to see where a document is.
Click and drag on the icon to move the document the window belongsto..
Live feedback when resizing columns and info field in data windows.
Proportional scrollbars.

Text and data files now store the current selection.

All windows and tool palettes use the current system appearance.

The status window appearing during fitting is now resizeable when it
containsalist of parameters.

All Dialog boxes and Alert boxes are movable.

The "Check for update" button in the "About pro Fit" dialog box can be
used to find out if anewer version of pro Fitisavailable.

A powerful debugging environment allows you to step through your
programs and functions, to view variables, set breakpoints, etc.

New data types. Now you can use any 2x2, 3x3, or 4x4 complex matrix,
and any complex vector of length between 2 and 4 in any mathematical
expression where it makes sense.

A wealth of new calls have been added to pro Fit' s definition language. See
Appendix A of this manual.

Y ou can create complex user interfaces for your programs using pro Fit's
drawing tools, and attach programs to such a drawing window.

There are new possibilities to store and retrieve text files, directory paths,
and setting the creators of exported files.

14
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2 Installation

The installation procedure

Installation of pro Fit is very easy. Just double-click the self-unstuffing archive to copy all required files
onto your hard disk.

Before installing pro Fit, read the “read me” file if any such file came with the package.
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3 Getting started

A first session

This chapter describes atypical proFit session. It shows how to enter new data, plot it, and how to fit a
mathematical function toit.

Our data

The world's human population is growing rapidly. Table 3.1 shows the number of inhabitants of this
planet for the period after 1940

Table 3.1  The world’'s population since 1940

year population in millions
1940 2200
1950 2500
1960 3000
1969 3600
1975 4000
1981 4400
1987 5000
1990 5300

Let us plot and analyze these figures.

Starting pro Fit
First install pro Fit on your computer, as described in the Chapter “Installation”. Then

* Double-click pro Fit.

pro Fit comes up with the following windows: The results window is used to output results of various
calculations. The parameters window lists the parameters used by the current function and allows
you to edit their values. The preview window shows a*“rea-time’ preview of the current function and
data set.

(Close these windows if you do not want them. When you need them again, choose their name from
the Windows menu.)

Entering the data

First, you must enter the numbers given in Table 3.1 into a datawindow. To do this, you have to open a
new data window.

1. Choose “New Data” from the File menu
An empty data window appears.

Getting started 17



O [ untitled Data 1=—"=—=H1H
F. |4$r i 1 =10 2 1 z E
Index Calurmn 1 Column 2 Column 3

= 1

= 2

= 3

= 4

= 5

= B

= K

= 8 |

= 9 [ |

200, 10 [ [« ]~

Data are arranged in horizontal rows and vertical columns. The topmost cell of each column shows the
name of the column (by default ‘ Column 1, *Column 2', etc.). The cells below contain the data of each
column.

2. Click into the first empty cell of column 1 and enter the first year, 1940.

We fill the first column with the years and the second column with the population. The first year is
1940.

3. Click into the first cell of column 2 and enter the population in millions, 2200.

4. Repeat steps 2 and 3 to enter the other years and population figures in the
following rows.

Enter the values given in Table 3.1. Note that you can use the arrow keys, the tab and the return or
enter key to move from one cell to another.

5. Enter the column titles, ‘year’ and ‘population in millions’.

Click into the titles *Column 1’ or *Column 2" and enter the new names. Move the mouse to the
vertica separation lineto the right of the second column title, click, and drag the separation line alittle
bit to the right, so that you see the complete title. Y our window should now look like this:

O [ population data == E1H
I3 1 =10 2 b L E
Indes LE AL population in rillions C

= 1 1940.00000 2200.00000

= 2 1950.00000 2500.00000

= & 125000000 S000.00000

= 4 19&3.00000 SE00.00000

= = 1975.00000 S000.00000

= =) 1921 .00000 <400.00000

= L 198700000 S000.00000 "
% B 1930.00000 S5300.00000 =
=] O

100, 10 o | 1l v
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6. Save the data by choosing “Save As...” from the File menu.

Y ou are prompted to enter a name for your file.

Plotting the data
Now that we have entered the data, we can display it graphically.

1. Choose “Plot Data...” from the Draw menu

A dialog box appears.

Plot Data

_ H-aHis _ Y_aHis

| X1 + ][ lin + | A Aute range [ ¥1 +][ lin + | A Aute range

__Graph
[] Hew window

_ Data | populationdat.. [ $]|

X column | year B
¥ columns [ ] Plot into current graph
year Style [ Current | |

population in millions
_ Plot type | 4 Scatter Plot | % |

Point [E ] Connected

| e )

2] [ cancel |

Here you can enter the ranges of the plot, the columns to be plotted, and more. In this introductory
session we can use the settings asthey are.

2. Click OK.
A drawing window appears, showing a graph of the data.

[] Selected rows only
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A " populaton data .
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I:::l l"lulull " ] ] ] '
= 5000 - -
A+ &
T .
= 4000 - - -
Fill | = .
wEl & -
Fen | = 3000} . .
R -
Lazh 2000 * ! ! . I
— 1940 1960 1980
Ao
= - yem -
Eoarm E
:
HE o eeeKIng

You can edit adrawing easily. For example, you can change most parts of the graph just by double-
clicking.

3. Double-click the vertical axis to change its range.

(Double-click the vertical axisitself, not the numbers to the left of it!) A dialog box called “ Graph
Settings’ appears, presenting the settings of the left y-axis:

20 Getting started



g Vi = at H=|1938
= |
General — @ General () Labels () Prefix () Lines
—_ Firstizﬁﬁﬁ ii_ﬂsi 5508 [iin %]
H-axes
- | r Oraw Ticks [ custom
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Y ou can change avariety of parameters here. Often you will use the edit fields First and L ast to set
the range of the axis. Another important field isthe ‘Distance’ field that defines the distance between
major tick marks.

4. Enter O for First and 6000 for Last, then click OK.
The vertical axis of the graph now starts at 0 and ends at 6000.

Double-click other parts of the graph or its legend to change other attributes. Try double-clicking the
horizontal axis, the center of the plot, or the dot in the legend. Y ou can aso double-click any text in the
drawing to changeit. Or you can choose any of the drawing tools to add lines, polygons, text, etc.

A function to fit our data

The growth of a population can often be described by an exponentia function of the type
[t —x,0
t) = x ex ' 3.1
p(t) = p(x,) pETE (3.1

where p(t ) isthe population at timet, p(Xp) the population at an arbitrary start time xg, and tg its growth
constant.

Let ustry to investigate the validity of thisformulafor the world' s population. We want to find the set of
parameters for which equation (3.1) fits our data best.
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1. Choose Exp from the Func menu

This brings the parameters window of the Exponential function to the front. It gives a description of
the built-in exponentia function and its parameters:

| ' [ o oo N T . |-i-1-i
| parameiers  w] YW = &4 " eHpLTLE-HUISTU) + GOnst |I_£‘|

exponential function

A =||1.0000000 =0 = 0.0000000 0= 1.0000000 const = 0.0000000

& [multiplicative factor) Limits from [none [ £a [rone | [¥f Use for fitting

The window is divided into three regions. The top region displays the function parameters, and lets you
edit their value. The bottom right region displays information on the selected parameter, the bottom |eft
region gives a short description of the function.

The function looks like this:
Ox —x, 0
= Axex + const, 3.2
y pETE (3.2

which is essentially identical to equation (3.1). The parameters window also displays the default values
for the parameters A, Xp, to and const. Starting from these parameters, proFit can find a better set of
parameters for describing our data. But first you must define which parameters you want to fit, i. e. which
parameters you want to vary in order to approximate the data with the Exponential function.

As mentioned above, the starting time Xg is arbitrary. Let us set it to 1940.

2. Click the number beside ‘x0’ in the parameters window and enter 1940.
This defines the parameter’ s value.

Since Xg is arbitrary, we do not want to fit it:

3. Uncheck “Use for fitting”.
(The check box “Use for fitting” can be found in the lower right area of the window.)

The parameter name changes from bold face to plain text. This indicates that this parameter is
constant and will not befitted.

(Shortcut: You can also toggle the option “Use for fitting” by simply clicking on a parameter’s
name.)

4. Click the parameter name ‘const’

We don’'t want to fit this parameter, either. The parameter name is not bold anymore and the option
“Use for fitting” is unchecked now.

Beforefitting, it isagood ideato assign starting values to the parameters that are going to be fitted, in our
case A andtp. Thisincreases the speed of the fit and the probability of finding the best set of parameters.

Reasonable starting values for our problem can be estimated easily:
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A isthe population in the year 1940, so we can set it to 2200 millions. o (note the minus, it comes from
the different definitions of Egs. (3.1) and (3.2)) is the time within which the population increases by a
factor e=2.71.... Looking at the plot of the data in the drawing window, we can easily guess it to be
between 50 and 200 years. Let us set tg to —100:

5. Enter the starting values 2200 for A and —100 for tg
Y our parameter window should now look like the one below

O=———————— — mmp=——————— H
s

| parameters 1r| v = 8 ® expl-Cx-x01/40) + const N4
exponential function

A= Z20O0.0000 =0= 1940 0000 0 =0-100.0000 const = 00000000

0 I:time—n:n::ngtant:l Limits fram !nnnp !‘h‘. !nnne | E

.......................... so for fitting
i e for Tiiing

|
U

Intermission: Previewing the data and the function

Above we have seen how to produce a graphical representation of the datain a drawing window and how
to edit it. Y ou can have aquick look at the graphical appearance of the data (without actively plotting it)
by using the Preview window. This same window also shows you a graphical representation of the
current function.

Select Preview from the Window menu. Y ou should see the following window:

=S8 —————"FPPrevien=amam—_LU0H
|:| Floating EData EFunctinn [ Crata... ” Eedraw]
|55|:u:|.|:| | ! 't
| |
. o
[ Auto - . {:}
[ Leg . =g
[1s000 | E‘
[ tuto [ Leg 7

To the left of the window there are some controls that et you determine what the window must show, and
iIf it must be afloating window or anormal window. To the right are some tools that can be used to edit
and analyze the function and the data.

The window shows the current data set and the current function. If you change any function parameter
the curve will change to reflect the new value (try it!). The window aways shows a plot corresponding to
the current set of function parameters and data points.

Asyou see, our first guess for the function parameters was not altogether bad, but the function doesn’t
grow as fast as the actual data. The parameter set corresponding to the actual data set can be found by
fitting.
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Fitting
1. Choose Fit... from the Calc menu
Y ou can choose the data columns you want to fit:

Fitting Setup

Algorithm | Levenberg-Marquardt % |

—Data Use last choice —
Window [ population.data examp... = ] ] Selected rows only
X column | year 4| ¥column| population [Mio] 4 |
X errors [ Zero $|—— Yerrors[ Unknown @& |———
Column Column
Distribution Distribution

Error analysis:

[+ Print full description

[[] Print active parameters only 2| | cancel I |UKI

The data column settings are already ok. This box gives you also the possibility of specifying errors for
the data points. For the moment, we don’t need to do this.

2. Click OK to start fitting
Fitting isvery fast. When it is completed, the fitted parameters are printed in the results window
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[0 ==———— Results

12|
i » | m

Fit Algorithm: Levenberg-Harguardt

Function : Exp
4 = A * expi-Cx—x02/102 + const
exponential function

Datao D population.data example
®»  column: year
ax owalue @ 0.0
ax distr.: Goussian

g column: population [Mial

ay walue : not specified
ay distr.: Gaussian

|terations: 12

Chi squared = 1.69528=+4

Farameters: Standard dewviations:
A = 2113.2935 AR = 30,2618

=00 = 1940, 0000

t0 = =54 .8120 At0 = 1.0812

const = 0. 0000

-
e

Thefit yields—54.8 yearsfor tg and 2113 millionsfor A.
The Preview window automatically shows the function with the new, fitted parameters:

|| ==—————"— Previewn =/ H 3

Floating Crata Func:tion Fit params [rata... Fedraw
O [A pats [ | I Il J
|55IIIIII.III | h.
E.ﬁ.ut-:- {l
[ Lag =g
1
-n-
[15000 | 2
B aute  [Leg 7

The function now approximates the data points quite well.
We can plot function (3.2) using the fitted parameters:
3. Choose Plot Function... from the Draw menu
A dialog box appears, displaying options for plotting the function:

Getting started 25



Plot Function 'Exp’

H-axis Y-axis
|:l:| =I|"“ #I |"I"l #Illin :I Dﬁutu range
from | 1930 I to (1990 from |D to (6000
Graph

- @ From X min to X max [] Mew window

=y Plot int t h
“_ (JFrom[1930 |to[1990 [« Plot into current grap
— Style [Current % |

Step: |auto

Line [— 4 || 4| 4|

(2] |cancel | || oK I

[+] Use fitted parameters

We don’'t need to change any of these options.
4. Click OK to draw the curve

The curveisdrawn in the graph. Y ou can now rearrange the itemsin the drawing window to obtain a
representation of data and theory like this one:

The world's population since 1940

6000

= i
< 4000 -
c i
Q

IS

é 2000 m  population [Mio]

8_ - — theory .

1 | 1 | 1

0
1940 1960 1980 2000
year

Defining your own functions

In the previous session you have fitted the built-in exponential function to your data. Fine. But what do

you do if your model is described by some mathematical equation that does not appear among the built-
in functions in the Func menu?
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Define your own function!
proFit can work with virtually all functions you can think of. Let uslook at an example:
Imagine you want to analyze afunction of the form
y = asin(x) xIn(x) +b (3.3)
with the parameters a and b. To define this function:
* Choose New Function from the File menu.
This opens a new, empty function window.

[0 == untitled Function 1 =""o=—O H

[ ][] | (To Menu]) [ Debug | Hetp (2) Const () (2]
e

Browse |4 |||||I LB

e Enter the definition of your function in the new window.
Just enter:
a[1] *sin(x)*I n(x) + a[ 2]
on thefirst line.

e Click the "To Menu" button in the function window, or choose “Compile & Add To
Menu” from the Customize menu.

Thistrandates your function into computer code.

pro Fit looks at what you wrote and sees that you used the variable x and the standard function
parameters g 1], g 2]. It therefore assumes that you want to define a new function and interprets your
text accordingly.

The new function is added to the Func menu, and the parameter window shows its default parameters.

Y our simple expression is replaced by a complete, syntactically correct function definition:

function User_Function;
begi n

y = a[l1l] *sin(x)*In(x) + a[2];
end;

Thefirst line defines the name of the function asit appears in the Func menu (User _Funct i on isthe
default proposed by proFit. You can change it to something like LogSi ne). Then, enclosed between
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begi n and end, there follows the definition of the function. In the third line the function is cal culated
(from the variable x and the parametersa[ 1] anda[ 2] ), anditisassigned (“: =") to the variabley.

Note:  Anaternative way to define the same functioniis:

function | ogSi ne(anpl, offset:real);
begi n

y = anmpl *sin(x)*I n(x) + offset;
end;

In this definition, the parameters of the function are defined in the function header. The names used in the
header are then used in the function body. This is the syntax used for standard PASCAL functions.
pro Fit uses the parameter names defined in the function header for displaying the parameters in the
parameters window.

After adding the function to proFit, you can change its parameters in the parameters window. Y ou can
plot the function, useit for fitting, calculations, etc.

To plot it, you should first set its parameters to reasonable values, e.g. 1 and 0.5: Enter these valuesin the
Parameter window and choose “Plot Function...” from the Draw menu. In the dialog box that comes up,
select the plotting range (e.g. the x-axis from 0 to 5). If you already have an open drawing window, you
should check the option “Open New Window”, otherwise your curve will be drawn into the existing

graph.

Our sample function is not defined for x<=0. If you were to calculate it for a negative x-value, an error
would occur. How—ever, the function converges to y=g[2] for x=0. You may want to expand the
definition range of the function by defining y(x) = a[2] for al x < 0. This can be done easily with the
following modification.

function | ogSi ne;

begi n

if x <=0

then y := a[2]

elsey = a[l]*sin(x)*In(x) + a[2];
end;

(After having modified a definition in the function window, click the "To Menu" button or choose
“Compile & Addto Menu” from the Customize menu to add it to proFit in its new form.)

Y our function could even become much more complicated than this. You can define functions that
contain more than one statement, as well as variables and procedures. Y ou can use most elements of the
PASCAL programming language for defining functions.

Aswe aready noted above, it is also possible to implement the same function in such away that it uses
arbitrary namesfor the parameters instead of the predefined array element a[1], a[2]:
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function | ogSi ne(anplitude, offset: real);

begi n

if x <=0

then y : = of fset

el se y := anplitude*sin(x)*ln(x)+offset;
end;

The pro Fit package comes with more examples of function definitions. Look them up.

Writing programs

Besides defining functions for fitting and plotting, you can also define any data-generation and
-transformation algorithms using the same syntax.

Let us have aquick look at a small program that fills the first column of a data window with the powers
of two: 2, 4, 8, 16, etc. To define this program, again open anew function window (choose New Function
from the File menu) and enter:

for i := 1 to nrRows do
data[i,1] := 2 ** i;
Set Col ummNarne( 1, "' Powers');

Then click the To Menu button. This time proFit recognizes that you are defining a program, not a
function. It adds the program to the Prog menu and replaces your text with the syntactically correct
version:

program User _Program
var i:integer;
begi n
for i := 1 to nrRows do
data[i, 1] := 2 ** j;
Set Col ummNane(1, "' Powers');
end;

Note that this program starts with the keyword pr ogr am and not f unct i on. Therest of it followsthe
same syntax as a function definition, with the exception that no “ parameters’ are used.

To run the program, open a new data window and choose “User_Program” from the Prog menu. The
first column of the datawindow will be filled with the desired val ues.

In this chapter, you have seen some of the most important features of proFit. For in-depth information
consult the following chapters of this manual.
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4 Working with data

Data editing

The data window

The data window is organized in horizontal rows and vertical columns. It can hold up to 16 millions
columns with up to 16 millionsrows if enough memory is available.

home field O [ population data =" EI =
F. |:l$? [1If 1 ® = T E
resize field {hﬁ:{ LE AL population in rmillions
—E 1| 1240.00000 2200.00000
= 2|  1950.00000 2500.00000
= 3|  19e0.00000 Z000.00000
drag field ~ 4| 195700000 2600.00000
= s|  1975.00000 4000.00000
= 6| 1921 00000 4400.00000
= 7| 1987.00000 5000.00000) [ —
= 8|  1990.00000 5300.00000 1
= 0
100, 10 = | (4] ]~

info hook

To change the size of adata window (i.e. the number of rows and columns), click theresizefield in the

top left corner of the window.

To bring thefirst cell of the first column into view, click the homefield (to the right of the resize field).
To insert or delete empty rows or columns, click one of the drag fields and drag the mouse.
To change the width of acolumn, click and drag the separation line between column titles.

Dragging down the info hook opens an empty area at the top of the data window. In this area you can

enter general information or comments about your data:
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When editing numbers in a data window, the arrow keys () move the selection mark to
neighboring data cells.

If you hold down the option key while pressing or , the insertion mark moves horizontally within
onecdll.

The tab key moves the selection one column to the right. The carriage return or enter key moves the
selection to the cell below.

Selecting data

You can select asingle cell by clickingit.

» Tosdect arectangular region of datacells, drag the mouse from the top left to the bottom right cell,
or click thetop left cell and then click the bottom right cell while holding down the shift key.

* Tosdlect all cellsin arow/column, click the row/column number field. To select several rows or
columns, click and drag over the row or column numbers you wish to select.

e To select al cellsin a column starting from a certain row, hold down the option key while
clicking the topmost cell of the desired selection ,or click the column number field and then drag the
mouse down to the first row to be selected.

* Tosdect dl cels, choose Select All from the Edit menu.

Y ou can create a discontinuous selection:
» To extend or modify a current selection to a discontinuous selection of rows, click (and drag) into the
rows to be selected or desel ected while holding down the command key.
» Note that a discontinuous selection can also be created by selecting data in the Preview window.
See also Chapter 6, “Preview Window”.

Data types

By default, each column of a data window contains numerical data, i.e. real-valued numbers. The
precision and range of these numbers can be:

o 10739 to 10°% with approximately 12 significant digits (double precision)

« 1028 to 103 with approximately 6 significant digits (single precision)

See Appendix B for details on numeric representations.
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By default, a new data window opens with either single or double precision columns. The default type
can be selected by choosing the command “ Preferences’ from the File menu. In the dialog box that
comes up, click the “General” icon. See Chapter 13 for details.

A column can a'so contain text, up to 255 arbitrary charactersin each cell. To switch between text and
number formats, first select the column or columns you want to change and then choose Column
Format from the Calc menu. Alternatively, you can also double-click the column number of a column
you want to change.

After either of these actions, the Column format dialog box appears:

Column Format

Column 1 Width |default
Data Format
[ Number s |
Range:  _1e3@... 1230 Format: Decimals |auto

@ -1e300 ... 1e3080 ] Scientific
Example: > 125341235 «

Calculation
dutomatic transformation OFF Remoue [ New... I

El | Cancel I |I]I{|

The popup at the top left contains the entries “Text”, “Number”, “Date & Time” and “Rel. Time”.
Choose Text if you want the selected columns to contain text, choose Number s for numerical data. In
the latter case you can specify their Range (single or double precision) and define the format for
displaying numbers: select the number of digitsto be displaced after the decimal point (decimals) from
the Decimals pop-up menu. If you check Scientific, all numbers will be shown in exponential
representation (i.e. 1.34e+3 for 1340).

You can aso enter the column width in pixels in the corresponding edit field. A second way for
changing the width of a columnisto click on the boundary line between column titles (the mouse cursor
will changeto ) and drag it to the desired position.

If you choose “Date & Time” as the column format, you can display a date and atime in a column:
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Nata Cnemiat
LFLILLN § I INIUL
[Date & Time + |
Date | Short - i Time [ Shoiv Time
| B - T I —
L] *nNogLLr dECONUS
Example: = 10.2.19938 5:44 Uhr <

Note: Use the “Date & Time” panel of the “Preferences...” command in the “File” menu to choose
the display format for date and time values.

About dates:;

The Mac OS stores dates as the number of seconds since January 1, 1904. For the technically minded,
the date is stored as an integer number, 8 byte long.

pro Fit users the same convention as the Mac OS to store dates, but uses "double" floating point values
instead of integers. With this number representation, pro Fit can store and recognize dates with second
precisions until up to 1015 (this corresponds more or less to a 6 byte long integer) seconds after January
1, 1904. .pro Fit can store dates with second-precision up to 31 million yearsin the future, and it can
store dates with day-of-the-week precision up to 3.1 billion years (3 x 1012) in the future.

However, the date-time conversion routines currently available in Mac OS 9 only support dates up to
29'940 AD for date-to-string conversions, date-calculations, etc. Up to this limit, pro Fit can store dates
with a precision of milliseconds, while it can store dates in the present with a precision of approximately a
microsecond.

If you choose “Rel. Time” as the column format, you can display atime difference.
Data Format

[Rel. Time ¢]
Show: [JCentury [4Day Decimals |auto
[+ Year [+ Hour
] Month [+ Minute
] Week [+ Second
Example: = 109y 349 21h 1m 53.11453 <

Note: Use the “Date & Time” panel of the “Preferences...” command in the “File” menu to define
how many daysfit in ayear or amonth.

pro Fit stores relative times as double precision floating point numbers, interpreted as a number of
seconds. Thisleadsto arange of -2147483647 to 2147483647 centuries, which corresponds to floating
point numbers between -6.77680e+18 and 6.77680e+18
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Permanent transformations

pro Fit data windows allow you to attach a permanent transformation to each individual column.

Whenever the data fields that are used in a permanent transformation as input data, the calculation is
restarted and the results are updated. If possible, the recalculation is done only for the rows that have
been changed. If you are defining permanent cal culations using formulas that contain calls like 'datd[,]’,
pro Fit always recalculates all datain the corresponding column, because the input rows are not clearly
defined anymore.

Permanent calculations are created either from the Data Transform dialog (discussed below) or viathe
Column Format dialog (discussed above). The modification of existing permanent calculationsis done
viathe Column Format dialog.

Note that recursive usage of column datais not allowed. E.g. if column 2 is automatically (permanently)
calculated from the contents of columnl, then it is forbidden to define a permanent calculation for column
1 that depends on column 2. If you are defining permanent cal culations using formulas that contain calls
like 'data[,]’, pro Fit cannot anymore be shure that there is no recursion. Avoid the definition of such
recursive calculations because they can lead to unpredicatable results!

Entering data

Y ou can type datain the data window, copy and paste it , or drag it and drop it everywhere you want.

Instead of entering a number directly, you can enter a mathematical expression, e.g. “exp(1)” or
“6+sin(1v4)”, or any predefined function or variable. See Chapter 9, “Defining functions and
programs’ for more information about all the predefined keywords and functions you can use in
mathematical expressions.

Y ou can also import data from text files. See the Appendix C, “File Formats® for detailed information.
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Data transformation

proFit offers various methods for transforming data:
Numerical transformations, data reduction, sorting, trans-
posing, and Fourier transforms. In addition, you can
write programs that edit, manage, or create datain any
conceivable way (for more information on writing such
programs see Chapter 9, “Defining functions and pro-
grams”).

All the commands for transforming data are found in the
Calc menu and they work on the data window which is
infront of all other windows.

Algebraic transfor mations

To make ssimple numerical transformations on your data,
choose Data Transform from the Calc menu.

The transformations you can carry out with this
command are of the form y = func(x). You can define
where the x-value comes from and where y has to be
stored. Y ou can also choose what function you want to
use (note that some of these “functions’ do not need an
x-vaue).

Fit...
Monte Carlo Fit...
Optimize...

Params -->>»

Calculate Polynomix)...
Tabulate Polynomix)...

Analyze Polynom(x)

Data Transform...
Data Reduction...
Sort...

Transpose
Statistics...
Binning...

Fourier Transform

Column Format...

3 F
M

B
e K
ET

Y

Data Transformations

In / Qut: @ H:[-Eulumnl S
[] Selected rows only

i) Selected cells (Y cell = H cell)

¥ [ < Column 3

@ Simple arithmetics : ¥ := H[ + - II

) Column arithmetics: ¥ := H[ + - [- Column 1 =
) Differential/Integral : ¥ := [dfdu = [- Column 1 -
() Uarious functions : Y= [Pulgnum[H] + |

) Formula : ¥i=|"-cl*

[]Make it permanent

| Apply I 12 |Eance|| |l]|=2|

The transformation is either by columns or on the current selection: Check Selected Rows only to only
include selected rows in the calculation. Choose Selected cells to work on the current selection. In
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calculations on the current selection, each cell (x) in the selection isreplaced by its transformed value (y).
In transformations by column, the cells of the x-column are transformed and stored in the cells of the y-
column. Y ou can select the x- and y-columns from the pop-up menus. (In these menus empty columns
are marked with *¢’, columns already containing datawith ‘ ®’, and text columnswith ‘1").

Check Make it permanent if you want the destination column to be updated automatically whenever
one of itsinput columns changes.

Five different groups of transformations are available:

Simple arithmetics: All these transformations are of the type y = x op val, where op is one of the
operators +, -, * (multiplication), / (divison), ~ (power), div (integer division), mod (modulus).
Column arithmetics: These transformations are of the type y = x op col. Again, op can be any of
the operators mentioned above.
Differential / Integral: These transformations return the discrete derivative or integral.
The derivative is calculated as the discrete derivative of acolumn d that is selected from the menu to
the right of the ‘d/dx’ popup field, in respect to the x-column. The result is stored in the y-column
according to the formula

= disg — G

|

Xiv1 =X |

Theintegral is calculated as the discrete integral of acolumn d over the x-column. d is again selected
from the menu to the right of the ‘[ dx’ popup field. The result is stored in the y-column according to
the formula

12
Yi :E;(diﬂ +0i ) (X4 = %)

Sometimes you may want to integrate over asingle column d, or you may want to differentiate over a
single column d, according to one of the following equations:

-1
szzdi or y; =diyy —d.
\=1

Y ou can do this by creating a column containing the numbers 1, 2, 3, ... (use the fill(n) command
described under *Various functions' below) and using this column as your x-column.

Various functions: Here you can select various simple transformation functions, such as sin(x),
exp(x), In(x), etc. Among them, you can also find the currently selected function of the Func menu, as
well asthe specia functionsfill(0), fill(1) and fill(n), which let you fill acolumn with the valuesO or 1
or with ascending values 1, 2, 3,... respectively.

Formula: If you select this sort of transformation you are free to define any transformation
statement you like. Columns are |abeled by the character 'c' followed by their column number. You
can use columns, constants, mathematical functions, or cals to user-defined functions in the Func
menu. You can use the symbolsi or n for the row number and (if you have chosen “Selection
only”) j or mfor the column number.

Examples:
x+sqrt (x) an expression
tan(cl10) tangent of valuesin column 10

CovarMatri x(i,j) the covariance matrix of the last fit
The size of such atransformation statement is limited to 255 characters.
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If the result of acalculation is not defined, either because a datafield used for the calculation is empty or
because there was an numerical error, the resulting datafield is cleared.

User programs

proFit lets you define your own data transform programs or macros. These programs can perform data
transformations in the data window, create a graph in the drawing window, etc. They are found at the end
of the Misc menu.

Chapter 9, “Defining functions and programs’ explains how to define such programs.

Data reduction

The command “Data Reduction” in the Calc menu offers several possibilities for data reduction, e.g. by
averaging over several datapoints or by skipping part of the points.

Data Reduction

i# Keep every
3 Remove every
) Average over

() Smooth over [ Selection only

) Keep selected rows
3 Remove selected rows

2 data

I'r..'l [ Mool I n Nk “
lﬂ ULl || ¥ Y !I

* Tokeep every nth row and to remove all other rows, select Keep every.

« Toremoveevery nth row and to keep al other rows, select Forget every.

» To replace groups of n consecutive cellsin a column by their average, select Average over. This
option decreases the number of rows by afactor of n. (For example, if n=3, the valuesin the rows 1,
2, and 3 are averaged and the result is stored in row 1. The average of rows 4, 5, and 6 is then stored
inrow 2 etc.)

» To replace every data value with the average of itself and its n-1 neighboring valuesin its column,
select Smooth over. Again, the average of nvaluesis calculated. In contrast to * Average over’, the
number of rows is not reduced! (For example, if n=3, the value in row i is replaced by the average
over thevaluesinrowsi—1, i, and i+1).

To transform only the selected cells, check Selection only. In this case only the currently selected cells
(highlighted in the data window) are affected.

If the selection is discontinuous (whole rows only), the above algorithms are applied to each continuous
block of the selection, one after the other. The various discontinuous blocks are treated separately and do
not interact with each other.

To keep only the rows that are presently selected, check K eep selected rows. To remove al the presently
selected rows, check Remove selected rows.
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Sorting data

To sort data, choose Sort... from the Calc menu:

Data Sorting ict0FceF——
Sortcolumn | year %]
Order: #® ascending

3 descending

(I selection only [2] [ Cancel |

Use the pop-up menu to select the column to be used as a reference for sorting. You can sort by
ascending or by descending values.

All the rows in the data window will be rearranged according to the new order in the sort column. To
order only the selected part of the data window, check Selection only.

Note that you can only sort by columns that contain numerical data. Y ou cannot sort by columns that
contain text.

Transposing data

The command Transpose in the Calc menu exchanges the rows and columns in the active window. It
automatically resizes the data window to make sure that all the datafitsinto it.

Statistical analysis of a data set

The command Statistics... in the Calc menu lets you calcul ate statistical data of a one-dimensional data
Set.
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Statistics

Input: ) Single column [ population in millio... ]

i3 All columns [ ] Selected rows only
i#® Selected cells

Output: [+] Basic information
(# data, sum, mean,variance, standard
deviation, mean absolute deviation)

[+ Median, Minimum, Maximum
[+ Skewness and Kurtosis

2 | Eancel]

The data set that will be analyzed by the statistical algorithms can either be a Single column (use the
popup menu to define it), All columns, or only the Selected Cells. If you specify a single column or all
columns, you can check Selected rows only to only use the data in the selected rows.

The following statistical values are calculated from a set of datax1 .. XN and are printed to the results
window:

The number of valid values N in the data set.

The median of the sorted data set (central value for odd N or average of the two central valuesfor even
N)

The minimum (smallest value) and the maximum (largest vaue)

The sum of al valid values S=3) x

i
1=1

N
Themean X = S-1 X,
N N 1=1
. 1 & \2
Thevariance Var =—— 5 (x - )
N _1|:1
The standard deviation o =~Var

N
The mean absolute deviation ~ ADev = % z X = x|
1=1
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¢ The skewness

* Thekurtosis

1 N
Skew = —

N2

01 N
Kurt =

N

The Skewness characterizes the degree of asymmetry of a distribution around its mean. The kurtosis
measures the relative “peakyness’ or flatness of a distribution.

Binning

Binning is the process of putting data into bins. Y ou define a data range that encloses all your data
values. Thisdatarange is divided into consecutive intervals, the “bins’. For each bin, the number of data
vauesthat lieinitsinterval are counted.

Example

Y ou analyze the height of 1000 people. Y ou put al height values into a data window. Now you want to
plot a histogram, each histogram giving the number of people that have aheight in agiven 2 cm interval.
For this purpose, you choose "Binning" from the Calc menu, choose your data, define bins of 2 cm

width, and run the command.

The binning command brings up the following dialog box:

__ Input data

# Column [ Column 2

[] Selected rows only

iy Selected cells

Data info

number of walues: 100
minirmun wal ue: 3256647
mhaxi munn wal ue: 6720594

__Bin parameters

First |3 Lastlﬂ |
#Bins |20 Scale
Bin info
binwidth: 0.25
amallest bin size; ]
largest bin size: 12

_ Preview

Data ||||||||||||uu_|_u_J_u.J_|_|_ﬂ_LLuLL|_LLHu_|_L|J]||||||||u||h|| i1

Bins _ .

| Cancel I
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Under Input data, you specify the data to be binned. Bin parameters defines the location and
distribution of the bins. The bins can be distributed linearly, logarithmically, or according to any other
scaling type supported by pro Fit. For example, if you want equidistantial bins, use linear scaling, if you
want to have one bin for each decade, use logarithmic sclaling, etc.

Under Preview, the position of the input data values as well as the the resulting bins are displayed.

When you click OK, the center and size of each bin is calculated and the results are displayed in a new
data window.

Fourier transforms

proFit can calculate Fourier transforms of numerical data. A Fourier transform is a transformation of
numerical datafrom the “time domain” into the “frequency domain”, or vice versa.

If you have a one-dimensional set of real valued data points, hk (k= 0 .. N-1), the discrete Fourier
transform Hp, of these pointsis given by
N-1 _

where n goes from —N/2 to N/2 (N is assumed to be even).The inverse Fourier transform is the inverse
operation: It allows the calculation of data hk in the time domain from data Hk in the frequency domain

by

1N 21ikn/ N
4 o 2rikn

Note that hk as well as Hk can be complex values.
A classical interpretation of the Fourier transformation is the following:

A signal h(t) issampled at aregular timeinterval At, resulting in a set of data points hk = h(At k). The
Fourier transform of this set of data corresponds to the frequency spectrum of the signal. Hnp
corresponds to the amplitude of the signal at frequency n/(N At) .

Note that the maximum frequency of the frequency domain is fc = 1/(2At ), the Nyquist critical
frequency.

The Fourier transform and its inverse can be calculated with two FFT
commands in the submenu Fourier Transform of the Calc menu: FFT
and Inverse FFT. (“FFT” stands for “Fast Fourier Transform”, an Inverse FFT...

efficient algorithm for the calculation of the Fourier transform.)

These built-in algorithms assume that the data set h of the time domain is real-valued and not complex.
In this case the frequency domain data set Hpy is complex but we have Hp = H-n* i.e. the values at
positive frequency are the complex conjugate values at negative frequency. It is therefore sufficient to
calculate only the positive frequency spectrum of the Fourier transform.

Note: The built in Fourier transform works on real valued data in the time domain. To work in
complex data, use the external module “FFT” that comes with pro Fit.

To carry out a Fourier transformation, bring the data window with your data in the time domain to the
front and choose FFT from the Fourier Transform submenu:
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Fourier Transformation

Input:

Data column | *x-Value |

Data interval 1 seconds

Output: # Real and imaginary parts
3 Amplitude and phase

Roal
AL 4N

nart
P“l L5

Ak ([ AF]]| 4

[
|
Imaginary part [
Freguency [

Select the column that contains your time domain data and the columns for the real and imaginary parts
of your frequency domain data. If you check the box Calculate frequency, you must enter the time
interval between two points of the time domain (Data interval) and a column (Frequency) for the
frequency values of the frequency domain data.

Instead of calculating the real and imaginary parts in the frequency domain, you can also calculate their
absolute value and complex argument (check Amplitude and phase, instead of Real and imaginary
parts).

To calculate the inverse Fourier transform, select Inverse FFT from the Fourier transform submenu. The
dialog box that appears for this command is very similar to the dialog box we have just seen:
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Inverse Fourier Transformation

inpiit & Real and imaginary parts
3y Amplitude and phase

Real part | * x-Value %
Irvs iy S pmr 53 o - [ = s i alean &l
INNNCARJnir y pPar L I. =y=ydiukE - |
Data interval 1 IHz

Output:
Data column | < Column 3 %
Time |  Column 4 3

[+ Calculate time 12 |Eam:e|| || 0K II

Y our input data are the complex values in the frequency domain. Y ou select the columnsfor the real and
the imaginary parts, or, alternatively (when you select Amplitude and phase instead of Real and
imaginary parts), you select the columns for the absolute value and the complex argument of your data.

The output column contains the real valued data points of the time domain.

If you want to calculate the time range (in seconds) for your output data, check Calculate time, enter the
frequency interval between consecutive data points of the frequency domain, and select a column for the
time values.

Note that if you have N pointsin the time domain, you obtain N/2+1 (complex) pointsin the frequency
domain and vice versa.

The FFT agorithm works only for N = 2m (wheremisapositiveinteger), i.e. for N=2, 4, 8, 16, ... If the
number of input data pointsis not a power of two, then the missing values to the next power of two are
assumed to be 0.

For further information on the subject of discrete Fourier transformations see e.g. W.H Press et a.,
Numerical Recipes, Cambridge University Press (Cambridge, 1989).

Defining a data set to work on

Some of proFit’s commands access data in the data windows. If you have several data windows open at
the same time, proFit uses some rules for selecting the data window it works on:

» The transformation commands in the Calc menu work on the active data window (the window in front
of all other windows). If the active window is not a data window, these commands cannot be used.
(Example: the Data Transformation... command is only enabled when the front most window is adata
window.)
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« Some other commands use the front most of all data windows. It does not matter if windows of other
kindsarein front. If the active window is not a data window, these commands look at all the windows
behind the active window and work on the first data window they find. Thiswill be the data window
that is closest to the front. (Example: the Spline function uses the data window that is closest to the
front.)

« The commands for curve fitting and for plotting data display dialog boxes where you can choose the
data window from a pop-up menu. (Examples: Plot Data... and Nonlinear Fit...)

The data window containing the data used in a particular operation is called the current data window in
this manual. The current data window is either the foremost data window or the window you have
selected yourself.

When a data window is used as the current data window by afunction or by some commands, four of its
columns can have a special meaning. They are the default x-, y-, Ax-, and Ay-columns. Y ou can define
these columns using the pop-up menu that appears when you click the column number of a data window
while holding down the command key (click on the “index” header of the index column to define the
index column as one of the default columns):

| |
O=——— 1

S Y |
Inde= Colurnn 1 AH

= 1 1.0000a0 AY

= 2 N alulalaly] =

For example, the * Spline’ function uses the data in the x- and y-columns of the foremost of al the data
windows (other windows of a different kind, e.g. adrawing window, can be active).

A smal ‘x’, 'y, "Ax’ or ‘Ay’ in the head of a column marks the default columns.
Note that the 'index' column can aso become the 'x' or the''y" column.
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5 Working with functions

Functions supported by proFit are of the form y=f(x) and can have one or more parameters. Y ou can use
these functions for fitting, plotting and analysis. This chapter gives an overview of what you can do with
functions.

proFit has a set of built-in functions, that you can use “as-is’, and gives you the possibility of defining
your own functions (there are also many external functions that already distributed with pro Fit). To do
this, you can use the built in programming language (see Chapter 9, “Defining functions and
programs’), or you can write your functions in your own compiler and import them as modules (see
Chapter 10, “Working with external modules’).

A list of the currently available functions can be found in the “ Func” menu.

Introduction

A function in pro Fit hasthe form
y = f(x a1, &, .. an) (1
where x isitsargument and y itsvalue. a1, a2, .. an are the parameters of the function. An exampleisthe
polynomia function, one of pro Fit’ s built-in functions:
y = ag+aix+agx2+ ...
Y ou can select the function you want to work with from the list in the Func menu. When you do this, a

short description of the function and its parameters appears in the Parameters Window. As an example,
the polynomial function has the following parameters window:

0= Polynom=————— B

| parameters 1r| =) = const + al *x +.. 4+ aZ*x"3

deq: degree of the polynomial

deq= 3. 0000000 canst = 00000000 al =l0.0a000a00 az= 1. 0000000

a% = 0.0000000

al Limits fram [none | ta [nane | [ Use for fitting

Parameters
In the Parameters window you can view and set the parameters of the function.

The upper part of the window lists all the parameters of the function. It a'so contains a popup menu
where you can save parameter sets for later use (see below). The lower left part of the window gives a
short description of the function, the lower right part lists some properties of the currently selected
parameter. What you can do here:

editing To change aparameter, click its value field and enter the desired value. Hit the tab key or
the enter key to move to the next parameter.
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copy, paste  You can copy and paste parameter values between the parameters window and data or
text windows using the Copy, Cut, and Paste commands from the Edit menu. If you
choose Copy with no parameter value selected, all parameters are copied to the clipboard,
separated by tabulators. If you choose Paste with no parameter value selected, the text on
the clipboard is assumed to contain several values separated by spaces, tabs or carriage
returns, which are then used to change al parameter values.

limits A parameter can have upper and lower limits, which are displayed in the lower right part
of the Parameters window. These limits are used to constrain the parameter during fitting
and function optimization. To change a limit of a parameter, select the parameter and
enter the limit in the corresponding field. To remove alimit, select the parameter and clear
itslimit.

fitting mode To change the fitting mode of a parameter, check or uncheck the option “Use for
fitting” in the lower right part of the window. If you check this option, the parameter will
be varied during fitting and optimization, otherwise it will be kept fixed. The fitting mode
of aparameter determines the style of its name in the Parameter window. Parameters with
names displayed in bold face will be varied during afit. Parameters displayed in normal
type face are kept fixed during a fit. As an aternative to using the “Use for fitting”
checkbox, smply click the name of the parameter to toggle its fitting mode.

Setting one of the parameters of a function to be equal to the value of x

Y ou can enter the expression '=x' when changing the value of a parameter in the parameters window:

| parameters 1r| ) = const + al *x +. 4+ aZ*x"3 2
deq: degree of the polynomial

deg= Z.0000000 const= 0.0000000 al =||= az2= 1.0000000

a3 = 0.0000000

al Limits from [none | to [none | [ uze for fitting

The selected parameter isforced to be equal to the current x-vaue of the function.

If you want to study the dependence of afunction upon various parameters, you can define your function
as a function of parameters only, without explicitly using the variable 'x'. Y ou then designate the
parameter treated as the x-value by entering ‘=x’ for its value in the parameters window.

If you explicitly use the variable 'x' inside a function and also define a parameter to be equal to x, both
will have the value of x: A function like y:=a[1]* sin(x) becomes the function y:=x*sin(x) if a[1] isset to
be equal to x in the parameters window.

If you define your own function, you cannot use this feature for parameters that you usein
the proceduref i r st because x is not defined in the proceduref i r st. If you set a
parameter to be equal to x, itsvalue will beundefined inf i r st . (See Chapter 9,
“Defining functions and programs’, for more details.). If you plan to set a parameter

o equal to x, never useit in the functionfi r st .
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Using functions

The following explains what you can do with functions. It does, however, not describe how to plot or fit
functions — these topics are covered in Chapter 8, “Fitting” and Chapter 7, “Drawing”.

Calculating function values

Y ou can calculate the y-value of the currently selected function for a given x-value by choosing Calculate
Function(x) from the Calc menu (the name of this command changes — it always uses the name of the
currently selected function):

You can calculate the y-value of the =—— Calculate Polynom{x)
currently selected function for agiven
x-value by choosing Calculate

Function(x) from the Calc menu (the X: I 0
name of this command changes — it

always uses the name of the currently ¥ 0
selected function).

: o [] Use fitted parameters
If you click OK, the function is

calculated for the given x-value, itsy- [ —I
valueis printed in the results window, Doit ¥D) |2 l CanEe I !

and the dialog box disappears.

If you click Do It, the function’s value is displayed in the dialog box and written to the results window.
The box does not go away and you can calculate other values of the function immediately.

If Use fitted params is checked, the resulting parameters of the last data fit are used for calculating,
otherwise the parameters displayed in the parameters window are used.

Choosing Tabulate Function(x)... allows you to create a table of the function’s values in a data
window. Y ou are prompted for the first and last value of the table and its step width:

Table of Polynom{x)

Tabulate by varying | x % |
Min: | 1400 Max: | 2100
Step: (0.5 (0.9, "auto’, ‘points")

[ ] Use fitted parameters

2| [ cancel |

If you enter a numerical value for Step, the function is calculated at equidistant x-values. If you enter
‘auto’ in the field * Step’, proFit chooses the x-values at which the function is calculated by using a
specia agorithm that decreases the distance between cal culated points wherever the function is strongly

Working with functions 47



bent.
To tabulate the function at the values of the x—column of the current data window, enter ‘points' in the

field ‘Step’.
Instead of ‘auto’ or ‘points’ you can enter asingle‘a or ‘p’.

Optimization of functions

The command Optimize from the Calc menu lets you find the maximum or minimum of afunction by
varying the function parameters and/or its x-vaue.

Optimize Polynomi{x)

i#® Find the maximum of the function
i3 Find the minimum of the function

by varying [« the active parameters

[ X
Starting value for X = II]

Precision of calculation [ High (slow) | # |

[+ Print full description

=1 [ - —a i . 1
(2] [cancel] oK |

_ ————————— 2

If you check the active parameters, the algorithm will vary all parameters that are presently marked as
active (i.e. which in the parameters window have a bold face name and “use for fitting” checked). The
parameters are only varied within their limits, if such limits are specified.

If you check X, the algorithm will vary the function’s x value. Otherwise the x-value is kept fixed at the
givenvaue.

The settings under precision affect the accuracy and speed of the calculation. If your function is slow,
you should first choose a low precision and, once you are satisfied with the results, choose a higher
precision.

Print full description controls the amount of information to appear in the results window.

Note that the command “ Optimize” is designed for multi-dimensional optimization. If you only want to
vary the function’s x-value but not its parameters, you should use the faster command “Extrema’
described below.

Finding roots

The Analyze submenu in the Calc menu allows you to calculate the roots, the extrema and the integral of
afunction:
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Fit... #F

hMonte Carlo Fit... 3 M
Optimize...

Params =-x> #* B

Calculate Polynom{x)... ¥K
Tabulate Polynomi{x)... 3T

Roots...
Data Transform... HEY Extrema...
Data Reduction... Integral...
Sort.. Table of Roots...
Transpose Table of Extrema...
Statistics... Table of Integral...

| SRR R, (S — S —— [ 9 |

Roots

The roots of a function f(x) are those values of x for which f(x) takes a given value, such as O.
To calculate the roots of afunction, choose Roots from the Analyze submenu (menu Calc)

Roots of Polynom{x)

Between | 1400 and | 2200

Mumber of subintervals 10

Look for f{x) = 0
12 | Eancell |mr;|

Here, you can select the range within which to look for roots. Thisrangeis divided into a given number
of sub-intervals.

Example: If you look for the roots f(x) = O of a function between x = 0 and x = 1 and specify ten sub-
intervals, proFit looks for rootsin theintervals [0, 0.1], [0.1, 0.2], etc. In each interval [a, b] it checksif
the sign of f(a) is opposite to the sign of f(b) (or if one of these values is undefined and the other de-
fined). If thisis the case, the corresponding interval is searched for aroot.

Enter avalue Y in thefield L ook for f(x) = to find the roots of the equation f(x) — Y= 0. Per default, this
valueis 0. For example, you can use this feature to find all x-values where a function becomes equal to
1.0.

Table of roots

By choosing Table of Roots from the Analyze submenu, you can create a table of the roots of your
function for different values of one of the function’s parameters:
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Table of Roots of Polynom(x)

Between | 1400 and | 2200

Mumber of subintervals 10

Look for f{x) = 0

Tabulate by varying | const | 3|

from |1 to |4

step |05
(2] [cancel] [[_ok ]I

The top part of the box contains the same entries as the Roots dialog box (see above). In the lower part of
the box, you can enter the parameter you want to make the table for, its range and the step width for
tabulating.

Note that if you have more than one root for a given parameter value, only the first root will be found and
entered in the table for every vaue of the parameter you vary.

Finding minima and maxima

To find the extrema of a function (i.e. the x-values where f(x) becomes largest or smallest), choose
“Extrema’ from the Analyze submenu (menu Calc). A dialog box similar to the one for the Roots
command appears. Y ou enter the x-range within which extrema must be found and a number of sub-
intervals. proFit triesto find one local extremum (minimum, maximum) within each sub-interval.

To tabulate the extrema of afunction (i.e. the x-values where f(x) becomes largest or smallest) for diffe-
rent values of one of its parameters, you choose “Table of Extrema’ from the Analyze submenu. The
dialog box displayed by this command is again the same as for the roots command (see above)

Note: If you want to find the extrema of afunction by varying not only its x-value but also its parameters
(multi-dimensional optimization), use choose “Optimize” from the menu Calc. This command is
described above.

Integration

To calculate the numerical integral of afunction, choose Integral from the Analyze submenu (menu Calc).
In the dialog box that appears you can enter the limits of the integral aswell as the number of iterations
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Integral of Polynomi{x)

Between | 1400 and | 2200

Iterations {5-13) a2

12 | Eﬂncell

The number of iterations affects the accuracy of the results. A larger number of iterations yields a more
accurate result but more time is needed for the calculation.

To tabulate the integrals by varying a parameter of the function or one of the integral's limits, choose
Tabulate Integral from the Analysis submenu.

The Spline function

Thereisone special function in the list of predefined functions: the Spline function. The Spline function
is defined as a smooth cubic Spline curve going through all your data points. The Spline function is
useful for interpolation, especially when you do not have a mathematical model for your data. Thisisa
simple data set together with its Spline function.

100 | T T T T | T T T T |
[ |— Spline i
sol O data points 7
(O] L .
>
= B i
> C ]
> 0.0F -
-5.0 i 1 1 1 1 1 1 1 1 1 1 1 ]
-1.0 0.0 1.0
x-Value

To use the Spline function for agiven data set:

1. Choose the Spline function from the Func menu.

2. Bring its parameters window to the front and click the “Select Data” button.
A dialog box appears:
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5pline 5ettings

The set of coordinate points used by the Spline function is given by:

{3 Current data set

i# Data Window [pupulatiun data = I

H Column [- year - I ¥ Column [- populationin ... = I

3 Function Parameters

Mumber of points: (B

[+ Set #-coordinates to equidistant values in the current range

| Cancel I

Check Current data set to use the x- and y-column of the frontmost data window. It will then use
the set of data points (Xj, yj) in adatawindow, where the x; column and the y; column are identified by
small ‘x’ or ‘y’ labelsin column head (change the default x- and y- columns by clicking the header
of acolumn while holding down the command key.).

Check Data Window to use another data set from a data window.

Check Function Parameters to use the parameters of a function as x- and y-values. This allows,
e.g., to fit a Spline function to some set of noisy points, in order to get a smooth guide-to-the-eyes
curve. When doing this, be careful not to choose too many points for Spline-definition. Other types
of functions that are useful to draw a smooth line through a set of noisy points are available as
external functions, as part of the pro Fit distribution package.

If you do not use the “ Select Data’ button in the pararameters window, then the Spline
function will use the datain the frontmost data window (Select the appropriate x- and y-
column by clicking the desired column number while holding down the command key).

[ If you did use the “ Select Data” button, but you close the data with the data set used by
Spline, then the Spline functions reverts back to using the data set in the frontmost data
window.
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6 The Preview Window

There are generally two different approaches that are used by plotting applications for managing graphs
and the data used to generate them:

» Thefirst one consists in maintaining a permanent link between the data you plot and the result of the
operation (the graph). In this approach whenever you edit the data you used for creating the plot, the
plot automatically changes to reflect the new values of the data set. Since the link between data and
plot needs to be maintained, it isin generally not possible to save data and graphs separately, and they
must be saved in the same document. In applications using this approach, the graph isonly a different
“view” of the data, but does not lead an independent life.

* In the second approach, graphs and data are independent. Although a graph can be created from data,
and data can be recovered from a graph, the two documents lead separate lifes. After it has been
created, the graph does not know anymore about the origin of the data used to create it, and if you
modify that data, the graph remains untouched.

pro Fit uses the second approach. There are data documents, and there are drawing documents. From the
data you can create graphs. From the graphs you can recover the data used to plot them. Drawing and
Data documents can be stored and maintained separately and don’t affect each other. In Chapter 7,
“Drawing”, you will see how you can use the Draw menu to plot a function and a data set, obtain
graphical representations of your data and functions, and edit the graphs to obtain the precise graph style
you are looking for.

There is an ongoing discussion between the supporters of the first approach outlined above and the
supporters of the second approach used by proFit. A link between data and its graphical representation is
in fact also useful. proFit’'s answer to this dilemmais the Preview Window.

The preview window is a graphical representation of the current function and/or the current data set. It
gives you a graphical “view” of the function and the data set. Any change in the data set or in the
function isreflected in the preview window. Y ou can even use the preview window to graphically edit the
function parameters or the data set.

Use the preview window to have a“quick look” at afunction or a data set without actually plotting it.
For instance, you can let the Preview Window be a floating window and keep it in front while you load
many different datafiles. The preview window will automatically display all data contained in the current
x- and y- columns of the front window.

Y ou can also use the preview window to view functions, graphically edit function parameters, select a
range of data points, compare afunction to a data set, etc.
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Choose Preview from the Windows menu to see proFit’'s Preview Window. This is how the Preview
Window looks like when it has its smallest size and is not working as a floating window.

=S8 Previnn=a=ama/mmHHE
|:| Floating E Crata E Fun:tion IE Fit params [ Crata... ” Fedraw ]
[14000 | k selector tool
drag tool
[] tuta Cl zoom tool
marker "
[]Leg <« -l fitting tool
g : ~ marker tool
[0.0000 | v
M aute  [JLog
i= 2 :-=:=|—III.4'§:13 | =[05517 | E

N\
\ marker's coordinates

On the left side of the Preview Window there are some check boxes that determine how the window
behaves and what it shows. The main part of the window is arectangular viewport that shows a graphical
representation of the current function and data set. On the right of the window thereisatool palette with
tools for changing the coordinates displayed by the viewport, for graphically editing the function and the
data set, and for determining precise x- and y- coordinates.

Check Floating to make the preview window a “floating window” which aways stays in front of all
document windows. Uncheck this option to transform it into a normal window, which you can be hidden
by other windows.

Check or uncheck Show data and Show function to choose what is shown in the window. When Show
data is checked, the window displays the current data set, i.e. the x- and y- columns of the current data
window. Y ou can select the data set to be shown in the preview window by clicking the Data button or by
directly setting x- and y- columns in the data window

The Fitted params check box appears whenever a fit was successful, to give you the option of seeing a
plot of the function using the parameters obtained in the last fit, instead of seeing the function with the
parameters shown in the Parameters window.

Click the Redraw button if you want to let pro Fit redraw the complete function at maximum resol ution.
proFit automatically decreases the resolution at which it draws the function if it notices that the function
istoo slow. Y ou can override this by clicking the Redraw button.

The Undo button appears only when the Preview Window is floating, and it allows you to undo the last
operation. When the Preview Window is not floating, you can undo the last operation as usual, by
choosing Undo from the Edit menu.

At theright end of thetitle bar there isazoom box. Click it if you want to work with alarger window.

At the edges of the rectangular viewport that displays the function and the data set are four edit-fields
giving the coordinate range to be displayed. Y ou can edit the values to change the x- or y- range. Between
these edit-items there are check boxes labeled auto and log. Check them to let proFit automatically re-
calculate the ranges based on the ranges of current function and data set, or to use logarithmic scaling.
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There is a permanent link between the preview window and the data or function it displays. The
preview window always displays an up-to-date representation of the current function and data set.
Change a coordinate in the data window, or add a data point, and the corresponding point will
automatically appear in the preview window. Change a function parameter and the representation of the
function in the preview window will be updated automatically. Modify afunction definition and add it to
the menu once again, and the preview window will automatically display the new function.

If you select data points in the preview window, the corresponding rows are selected in the data window.
If you select some rows in the data window, the corresponding selection is shown in the preview window.
There is even the possibility of clicking and dragging data points in the preview window. Doing so
changestheir coordinates in the data window.

Preview Window Appearance

You can set the color and appearance of data points, function curve, and markers by choosing
“Preferences...” from the File menu.

Preview Window Tools

To theright of the preview window there is a palette of five different tools. Y ou can use them to
select data points and change their coordinates graphically, to change the ranges of the preview
window viewport, to graphically change the value of the function parameters, and to set
coordinate markers.

sl

Selecting data points with the arrow tool

h; Use the arrow tool to select data points. Simply click a data point to select it. Click and drag to
select arange of points with a selection rectangle. Hold down the shift key to add points to the
current selection, or to remove points from the current selection. If you hold down the shift key
while dragging a selection rectangle, the selection state of the data points contained in the
rectangle toggles between selected and not-selected. Hold down both shift and option keys to
always add the points inside the selection rectangle to the current selection.

You can set the color of the data points and the color used to mark selected data points using the
Prefer ences... command in the File menu. If you have a monochrome monitor, pro Fit will use a dithered
pattern to mark the selected points.

Whenever you select a data point in the preview window, the corresponding row is selected in the data
window. If you then choose Data Transform... from the Calc menu, you can perform cal culations on the
datain the sdlected rows only.

Selecting adata point in the preview window always sel ects the whol e corresponding row
in the datawindow. If you sdlect arange of data pointsin the preview and then delete them,
you will delete all datain the selected rows and not only in the current x- and y-columns
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Changing the ranges of the preview

Y ou can change the ranges of the preview either by editing them manually, or by using the drag tool or
the zoom tool.

Click in the viewport area with the drag tool and drag the area of the data set or function curve
displayed by the preview. The ranges of the preview will change accordingly. Y ou start dragging
inside the viewport, but you can go on dragging also outside, thus changing the coordinates by a
large amount.

> Click in the viewport area with the zoom tool (the lens) to zoom in and magnify the clicked area.
u Hold down the option key while clicking to zoom out.

If you hold down the command key you can click and drag with the zoom tool, thus selecting the precise
areathat will be displayed in the viewport after zooming.

Dragging the function curve

;}i Select the fitting tool and click in the viewport. Hold down the mouse button while you move
the mouse. The curve of the function follows the position of the mouse while the selected
function parameter is adjusted accordingly.

When using the fitting tool, you must specify which parameter you want to vary. Y ou can do this either
by clicking it in the parameter window, or by choosing its name from the small popup menu that appears
below the tools palette in the preview window. Y ou can only vary one parameter at atime.

When you select the fitting tool and click into the preview, the selected parameter is varied until the
function curve goes through the point indicated by the mouse. proFit does this by numerically solving
the function f(a,x)=y, where a is the selected parameter and (X,y) isthe point indicated by the fitting tool.
If it ismathematically not possible for the function to go through that point, no matter what the value of
the selected parameter is, then you will not be able to drag the function curve to that point. The same
appliesif proFit fails to find numerically the correct value for the parameter.

If you use the fitting tool with aslow function, proFit will automatically reduce the resolution with which
the function is drawn, so the function will not appear to be smooth anymore. The resolution will be
increased again once you are finished dragging. Click the Redraw button to achieve the maximum
resolution.

Inspecting and editing coor dinates

i Thelast tool in the tools palette can be used to place coor dinate markers on a given data

1 point, or on the function curve. Select the marker tool and click the curve or a data point.
proFit creates anew marker at the indicated position

While you move the marker tool around inside the viewport of the drawing window, the corresponding
coordinates are displayed in the bottom |eft corner of the preview window.

When you create a new marker, it becomes the active marker. The active marker is always flashing on
and off.

You can create any number of markers. The first marker you create is the reference marker.
Subsequently created markers are auxiliary markers and are numbered starting from 1. Their number
appears when they are active (when they are flashing).

To set the color of the reference marker and of the auxiliary markers, choose Preferences... from the File
menu. If the reference marker cannot be distinguished by its color, proFit automatically drawsit larger.
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Marker coordinates are displayed in the bottom |eft corner of the preview window. If there is more than
one marker, there can be two other coordinates displayed to the right of the marker coordinates. They
correspond to the distance between the reference marker and one of the other markers.

What the coordinates mean:;

X,y are the coordinates of AX, Ax are the
distances from

No active markers around the reference marker the other marker
(if there is only one)

One active marker the active marker the reference marker

If amarker is active, its coordinates are displayed in editable fields. Edit any of these fields to set the
coordinate of the marker.

If the marker is a data marker and the preview window is big, the data window row number that
corresponds to the marked data point is also displayed. It is found above the x-coordinates and is labeled

The behavior when changing the text in the edit fields containing the marked coordinates
varies depending if the marker is on adata point or if it is on afunction curve.

» |If the marker is on a data point, the coordinates displayed in the edit field correspond to the
coordinates of that data point in the data window. Editing them changes the values in the data
window.

« If the marker ison afunction curve, editing the coordinates sets the position of the marker. If you edit
the y-coordinates, proFit numerically inverts the function to find the corresponding x-value.
Y ou can use this feature also as a shortcut to calculate the inverse of afunction, or its root.

Coordinate markers can be accessed from proFit programs using the predefined functions
Get Mar kedX, Get Mar kedY, and Get Mar kedCoor ds.

Managing coor dinate markers

We aready saw above how to create markers and look at their coordinates. There are afew other simple
operations that can be applied to markers.

» Click amarker to makeit active.

* Click amarker while holding down the option key to transform it into the reference marker

« Hit the delete key (backspace) while amarker is activeto deleteit.

* Click and drag a marker to move it to anew position.

* Move afunction marker to the right or left border of the viewport to delete it.

To move amarker, click and drag it, or use the left and right arrow keys. A data marker jumps to the next
point to itsleft or its right, a function marker will move along the function curve. proFit makes sure that
you don’t move a marker outside the ranges of the viewport. Y ou can override this by holding down the
option key while moving the marker with the arrow keys.
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When you have markers on the function and you uncheck the show function checkbox, all of them are
deleted. The same applies to markers on data points when you uncheck the show data checkbox.

Uncheck and check the show function and/or show data checkboxes if you have many markers around
and want to get rid of al of them in one rapid move.

Data markers store their position as the number of the data point they mark. If you have data markers
around and you delete or add points to the data set, the data markers might move to a new data point. If
no new point corresponding to the old index is found for agiven marker, that data marker is destroyed.

If you have function markers and you change the ranges of the display in such a way that their x-
coordinates are not visible anymore, those markers are destroyed.

Tips and tricks

Using the preview window during a fit

If Show function is checked during a fit, the function is redrawn from time to time to show how it
changes during the fit. This lets you monitor how well the fit converges. However, drawing the function
takestime. Y ou should close the preview window or uncheck Show Function to obtain the fastest fitting.

The same thing happens when you use the Error Analysis feature. To perform error analysis, proFit
generates random sets of synthetic data points and fits the function to it. If Show Function is checked in
the preview window, you will see how the function curve varies in correspondence to the fitted
parameters.

See Chapter 8, “Fitting”, for more details on the fitting process and the Error Analysis algorithm.

Choosing initial values of function parameters

Y ou can display the data you want to fit together with the fit-function in the preview window. Y ou can
then use the fitting-tool to drag the function in such away that it follows the data points as closely as
possible. Try using the fitting-tool with the various parameters you want to fit.

Thisis akind of “hand fitting” that can be a very useful and fast way to set up a reasonable set of
starting parameters for afit.

For special applications, you can also mark certain features of your data set using coordinate markers and
write a small program which reads the coordinates of these markers and uses them to calculate the
optimal initial valuesfor the parameters of the current function.

58 Preview Window



7 Drawing and Plotting

Drawing and plotting takes place in a drawing window. This window supports most features of
commonly used drawing applications.

We will first describe the drawing window and its general features.

The section “Drawing” discusses standard drawing objects and editing techniques.

The section “Plotting” is devoted to the plotting commands used to produce graphical representations of
your data and functions. It discusses how to manage graphs and how to edit them.

The drawing window

A drawing window always contains one single page. Y ou can select its size and orientation by choosing
Page Setup... from the File menu. Before choosing Page Setup, make sure that you have selected a
printer in the Chooser that you have selected your preferred desktop printer in the Finder.

A dotted rectangle frames the printable area of the page. Objects that lie outside this rectangle do not
print. See your printer’s manual for more information on printers and paper sizes.

Y ou can view the page in adrawing window using various zoom factors, which you can set using a popup
menu in the drawing window tools palette.

Drawing tools

pro Fit provides various tools for editing drawings. These tools are collected in a“tool  |H i B
box”, which is either placed in the left margin of a drawing window or in a separate
floating window.

To place the tools in a separate drawing window, choose “Drawing Tools” from the
Windows menu. The floating tools pal ette appears. To move the tools back to the drawing
window, smply close the floating window.
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If you will never want to have drawing tools inside the drawing windows, you can disable
this option: Choose “Preferences’ from the Files menu and check “ Always use floating
toolbox” in the “Drawing” panel.

The upper part of the tools palette contains tools that are used to select, move or create
simple objects, such as rectangles and text. Then thereisatool that can be used to pick up
acolor and apply it to another graphic object and atool that lets you draw the individual
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data points such as those used in graphs. A further tool is provided for generating control AFF o
shapes, such as buttons. The rest of the tools palette contains popup menus for setting
line styles and fill patterns, and for choosing the zooming factor of the current view in the Zoom

drawing window. The drawing window can be viewed at zoom factors from 25% to
400%. To learn more about these tools, refer to the section “Drawing” later in this
chapter.

(o] E
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Coordinates, accuracy and drawing info

pro Fit uses floating point numbers to store the size and position of the various drawing objects. This
provides a positioning precision that is much more accurate than any output device (printer or monitor).
This is important because all drawing objects can aso be created by a user-program. If you write a
program that produces graphical output, then you are likely to need a high precision coordinate system.
proFit gives you just this. Any drawing that you generate from a program is produced at very high
resolution and it will give optimal results when printed on any output device or when exported to other
applications as a picture or a QuickDraw GX shape. The precise coordinates of any drawing objects can
also be viewed after it has been created using the pro Fit Drawing Info window, which will be described
later in this chapter.

Although all coordinates are precise floating point numbers, apparent accuracy will obviously suffer
when drawing on alow resolution device, such asanorma monitor. In order to represent your drawing at
a certain resolution, determined by the zoom popup menu, proFit must round the floating point coor-
dinates describing a drawing object.

When you draw something at a low resolution, proFit must figure out reasonable floating point
coordinates. It does this by “extrapolating” from the low resolution appearance in such away that a high
resolution view would give the same symmetry. For example, at the 100% view you can draw three
overlapping lines with thicknesses of 0.25, 0.5 and 1.0 pts. All three lines have exactly the same
appearance (e.g. they appear 1 pt thick). proFit sets up the floating point coordinates of the linesin such
away that the thinner lines are centered on the 1 pt thick line.

Thanks to this interpretation you get the same result, at 100% view, if you draw a1 pt line and then make
it 0.25 pt thick, or if you draw a 0.25 thick line directly. On the other hand, if you draw a 0.25 pt thick
line at 400% view, go to 100% view, and draw another 0.25 pt thick line on top of it, the two lines will not
overlap. Thisis because the first line was positioned with amuch larger precision than the first line. Use
the Align submenu in the Draw menu to make sure that such lines really overlap, or look at their
coordinates using the Drawing Info window (see later).

Likewise, if you have two graphs or rectangles, set their size to be exactly equal, and overlap them at
100% view, one of their borders might be off by one pixel if their position is not exactly the same. Thisis
because roundoff errors must occur when calculating their rounded coordinates at 100% view. If you set
their position to be exactly equal (using the Align command or using the Drawing Info window), the
roundoff errors are exactly the same for the two objects, and they do overlap exactly in the 100% view,
too.

If you are concerned with precise positioning, e.g. when drawing overlapping lines or placing arrows on
the axes of a graph, always go to a larger zoom factor (e.g. 400%) or have alook at the underlying
floating point coordinates. Y ou can do thisusing proFit’s Drawing Info window.

Choose “Coords’ from the Windows menu to see this floating window.
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Whenever a single drawing shape is selected, the Drawing Info window
shows its floating point coordinates, i.e. its size and its position in [ Coords . B

coordinates that make sense for the particular shape which is currently ([ a7ro, Tern]

selected. [5zez |[7255 |

Thefirst row of the Drawing Info window gives the absolute coordinates on || “idth /Height

the paper, the second row gives the dimensions of the selected shape, andthe || [4.092 | [0.523 |
third row gives the angle of its diagonal and its length. The last row shows || angle /Diaganal

the current coordinates of the mouse. The units used to display the |[[Fz7 |[a.126 |
coordinates can be chosen using the “Preferences...” command.

. . . ) ) ] Fouse [JLenz
All the coordinate fields are editable. Simply click acoordinate and enter a || 14 z52 10029

different number to change the size or the position of the selected shape. For
example, you can set the precise length and orientation of aline by entering
the corresponding coordinatesin the edit fields in the third row.

The Lens check box lets you open asmall viewport with an enlarged version -E-___.
|

of the region around the mouse.
j I

A drawing contains different objects. There are four different classes of objects in adrawing window:

» Objects that are created by choosing Plot Function or Plot Data from the Draw menu, such as a
graph and its associated legend.

» Objectsthat are created using the tools in the upper part of the tools palette, such astexts, lines and
rectangles.

» Objects that were created in another application and that are imported as pictures to proFit by
choosing Paste or Subscribe To in the Edit Menu (or by dropping them in a drawing window).

 Publishers created by Create Publisher in the Edit menu. Everything within a Publisher’ s rectangle
is part of the picture that is made available to other applications.

Drawing objects

Thefirst class of thislist (graphs and legends) is discussed in the section “Plotting”. The other classes
(objects created by using the tools palette, imported pictures, Publishers and Subscribers) are discussed
in the following section.

Drawing

This section describes the general drawing commands and the use of the tools palette.

General drawing commands

Genera drawing commands apply to al types of drawing objects. These commands are probably already
known to you if you ever used any drawing application.

Here we shortly review them one by one.
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To select an object in the drawing window:

1. Choose the arrow tool in the tools palette by clicking the box containing the
arrow symbol.

2. Click the object you want to select.

A selected object has four small black rectangles (selection handles) at the corners of its ™ /\/'
enclosing rectangle. - -

To select multiple objects, you can either click on the desired objects while holding down the shift key,
or you click into an empty part and drag the mouse to generate a dotted selection rectangle: every object
enclosed by the rectangle will be selected. Click on an object while holding down the shift key to deselect
it.

To move an object:

1. Click the object and hold down the mouse button.

2. Drag.

If you hold down the shift key while dragging, movement is constrained to horizontal or vertical
directions. If you hold down the command key while dragging, movement is constrained to diagonal
(45°) directions.

In MacOS 7.5 and later, or if you have the Drag and Drop extension installed, you have a few more
options available:

- If you hold down the option key while dragging, the object isduplicated, i.e. acopy of the original
Is created at the destination instead of simply moving the original.

- You can drag one object from one drawing window to another. If you do this, a copy of the object is
created in the destination window.

- You can drag objects to any other application (supporting drag and drop), or to the Finder’ s desktop.
In the latter case the Finder will produce a small picture clipping, which you will be able to use later
on, either by dragging it back to a proFit window, or by using it in another application.

- You can drag objects into the Trash to delete them.

To change the size (resize) of an object:

1. Select the object.

2. Click into one of the four black selection handles at its corners and drag.
While dragging, the new outline of the object is shown.

If you hold down the shift key when resizing, the proportions of the object are maintained, or the height
or width remains constant. If you hold down the option key when resizing, the horizontal and vertical
dimensions of the object become equal. If the object is a group of different objects, hold down the
command key to tell proFit to resize all of the objects of the group, regardliess of their type (normally
pro Fit would not automatically resize texts or data points).

Torotate an object:
1. Select the object.

2. Choose the desired rotation from the Rotate submenu in the Draw menu.
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All objects except graphs and legends can be rotated by angles multiple of 90°. Lines, Polygons, and
Rectangles can be rotated by any angle, not just multiples of 90 degrees.

Toflip an object, i.e. to exchange its left and right sides or its top and bottom:
1. Select the objects to be flipped.

2. Choose the desired operation from the Flip submenu in the Draw menu.

“Flip Horizontal” exchanges the left and right side of the objects. “Flip Vertical” turns it upside
down.

Note that you can only flip lines and polygons. It is not possible to flip graphs, legends, imported
pictures, or text. (Flip has no effect on rectangles and ovals).

To changetheorder inwhich severa objects overlap:
1. Select the appropriate objects.

2. Choose the desired operation from the Send submenu in the Draw menu.

Y ou can move objects one position forward or backward (commands “Forward” and “Backward™)
or you can bring them to the front or to the back of al other objectsin the window (“To Front”, “To
Back”).

To align objects:
1. Select the objects to be aligned.

2. Choose the desired operation from the Align submenu.

Using this menu, you can align objects to each other, or distribute them regularly. If the objectsare a
group of text objects, then every object retainsits alignment when you edit it.

To group objects:
1. Select all objects to be grouped.

2. Choose Group from the Draw menu.

Objects that can be double-clicked to change them (e.g. text objects, a graph, or its legend), can also be
double-clicked and changed while they are part of a group. You don’'t have to ungroup them. If the
objects are text objects and you aligned them with the Align command before grouping them, their
alignment will be maintained when they are edited.

Choose Ungroup from the Draw menu to ungroup a group.

If you resize a group containing text objects or data point symbols, the proportions and
size of the text and data points remain the same. If you want to resize them proportionally
with the group, hold down the command key while resizing the group
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Objects created with the tools palette

The upper part of the tools pal ette contains the drawing tools needed to create some of the

more simple drawing objects.

The lower part contains pop-up menus to select background patterns, line widths and
dashing, and arrows. Their useis explained in the section “ Editing drawing objects”.

Text objects

5

{T,.f

Bl [% O] O

E!] Usethe text tool to create text objects:

1. Select the text tool from the tools palette.

2. Click inside the drawing window.

Thetext dialog box appears:
Text Settings
+
Elechric field gradisnt Eij [Wm3] 4
=
| Helvetica s |12 m%
[+ Plain
[1 Bold #B | Subscript
] Italic %1
[JUnderline | Superscript
[1 Outline
[] Shadow | Normal |
] Condense

Here you can enter your text and specify font, font size, text styles and the vertical position of each
character. proFit uses the command key equivalents“H”, " T”, and S’ for the fonts Helvetica, Times,

and Symbol, respectively.

The Super script and Subscript buttons (keyboard equivalents and ) switch to superscript or
subscript characters with smaller font size. The Normal button (keyboard equivalent: command key —
space bar) restoresthe vertical position and the font size to their previous settings.
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To set the vertical position of the selected characters, click and drag the baseline indicator (black
triangle at the right side of the text box). To shift the vertical position, click the white triangles above and
below the baseline indicator. Clicking the white triangle above (bel ow) moves the selected text up (down)
by three points. If you hold down the option key while clicking the triangle, the offset is only one point.

The size of the selected text can be set by changing the font size in the size field or to use the pop-up
menu to its right. To increase or decrease the size of all selected text proportionally, click one of the
triangles at the right of the size pop-up menu. Doing so increases or decreases the text size by
approximately 10 — 20 %. To increase or decrease it by just one point, hold down the option key while
clicking the triangles.

Each text object contains only asingle line of text, for multiple lines you must create a text object for each
new line.

Hint: To write atext having several linesin adrawing window, edit the text in afunction window or in the
results window. Then copy or drag and drop it into the drawing window — each line is converted to atext
object. If your original text contains tabulators, pro Fit will use them as column delimiters to order the
text in atable. Ungroup the resulting text group if you want to edit the position of the columns.

Y ou can set the justification of atext object (right justified, left justified or centered) by using the align
commandsin the Draw menu (l€ft, right, center horizontally). The default justification is centered.

If you have several lines of text objects (use distribute in the align menu to make equidistant lines), you
can set the justification of these texts and then group them. They will preserve their justification when the
group is resized or the texts are changed within the group by double-clicking them.

If your text object is part of agroup object, it is not resized when the group is resized. If
you want to resize the text objects within a group, you must hold down the command key
while resizing the group.

Rectangles and ellipses

| Rectangles and ellipses are created using the corresponding tools of the palette. Select the
— appropriate tool, click the desired position of one corner of the rectangle (or the enclosing
rectangle for an ellipse) and then drag the mouse to the opposite corner.

Lines and polygons

Crating lines and polygonsis easy as well. Select the appropriate tool, click the start of the line and drag
toitsend. For polygons, click at the positions corresponding to the corner points of the polygon (release
the mouse when moving from one point to the next). Double click when finished.

Y | By holding down the mouse button for awhile when you select the polygon tool,
3 ‘ot i you can change the tool to the one for closed polygons

Hold down the shift key to constrain lines (or polygon sections) to horizontal, vertical, or diagonal
directions.

When drawing a polygon, hold down the command key and double-click to create a corner that remainsa
corner even when the polygon is smoothed.
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Lines and polygons can have arrows. To define at which ends of the line (polygon) arrows must be
drawn and to select the type and size of the arrow(s), use the arrow pop-up menu in the tools pal ette.

To smooth polygons:
1. Select the polygon you want to smooth.

2. Choose the appropriate smoothing method in the Smooth submenu in the Draw
menu.

The two possibilities for smoothing can be seen in the figure below. Y ou can
either select a standard Bézier curve that does not touch the corners of the
polygon, or you can select a smoothed curve that goes through al the corners
of the polygon.

A A%

An unsmoothed polygon and its two smoothed versions.

z:zzﬁ

To reshape polygons:
1. Select the polygon you want to reshape.

2. Make sure it is in reshape mode.

If the selection marks of a polygon appear at the corners L] L]
of its enclosing rectangle, the polygon is not in reshape
mode. If the selection marks appear at its cornersitisin
reshape mode:

3. If the polygon is not in reshape mode, choose Reshape from the Draw menu,
double-click it, or type the Enter key

This puts the polygon into reshape mode.

To move one of the corner points of a polygon, click and drag it. To remove one of the corner points,
click it while holding down the option key. To add a corner point, click a line of the polygon while
holding down the option key. Note that you can only add points to unsmoothed polygons.

Points

When plotting data, the data points are represented by special symbols. Y ou can create such plot symbols
manually anywhere in a drawing window. Thisis useful for creating your own legends or for exporting
single point symbols to other applications (e.g. for figure captions).

Since the point symbols can assume a quite large size, they can also be used as parts of standard
drawings. Data point symbols can be edited using a particular set of tools that let you achieve effects not
easily achieved with other drawing objects (below you will find more details about editing data point
symbols).

To create a point object:
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1. Choose the point tool from the tools palette. EEERE L
. + &
Keep the mouse button down for alittle while to select the symbol | ; 5 ; i N {i‘
that you want to use. A pop-up menu with a choice of data points
} . . N N AN
appears. Its top part contains a set of standard, predefined point
symbols. The last line contains user-defined symbols, and the |* @ BH ™ * ¥ ¥
Other... field lets you define new point symbols. "ee @YY
e 0 O D@ ® 4O
or gy = [
Other
2. Click the desired position within the drawing.
A new point symbol drawing object is created.
1.  Choosethe point tool from the tools palette. <>
To change the plot symbol of a point object, select it and choose the desired N3 A
symbol from the point style pop-up menu in the tools palette (or double-click it to
go directly to the custom points dialog box). + A
If the selected object is a graph or alegend, the new point style is applied to the X v
data plots contained in the graph. See the section * Graphs and legends’, later in | \V4
this chapter, for details.
P 0 ®
. . . _ ® ®
On the right you see a selection of the data point styles offered by proFit. Choose
Other... from the point style menu to create your own data point symbols using the O o
“Custom Points’ dialog box: < g
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Custom Points

— Background 400% @ & |view:

4SO Size | M
OCATVIEY  pre

Fill Symm.

[ Frame Mirror [ JY [ |H

— Foreground

" F <[] Size|205
OOAVEY]  wpre

il symm.

[ Frame Mirror ]V [ H

L || M2
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Point line thickness | 0.25 %

[ Copy to Menu...l 2 |Eance|| | 0K I

proFit defines a data point symbol as a background shape and a foreground shape. With this dialog box,
you can design both of them. proFit offers some predefined simple shapes, and lets you edit any closed
polygon to define a new data point symbol. In the above example, both foreground and background
shapes are defined using a closed polygon. Y ou can use this dialog box simply to change the size of an
existing point symbol, or to design more complicated point symbols.

Draw the foreground and background shapes in the preview area at the right of the dialog box. Use the
popup menu above it to set the magnification of the preview. The center of the preview area definesthe
“hot spot” of the data point symbol. When plotting, the “hot spots” of data point symbols are
positioned on the correct mathematical coordinate.

Draw a closed polygon by dragging the polygon handles (the little circles or squares at the edges of the
polygon). To make your work easier, proFit lets you define a rotational symmetry and mirror
symmetries. Choosing 5 from the Symmetry popup menu (like in the above example) tells proFit to
draw the definition points a 5 positions 360/5 degree apart before connecting them with lines. Use the #
Pts popup menu to set the number of definition points. Checking the H or V check boxestells proFit to
draw the definition points at the 2 positions obtained by mirroring them at a horizontal or vertical axis,
respectively. Y ou can achieve quite astonishing effects by combining these symmetry settings and using
only one or two definition points.

Hold down the shift key while dragging a polygon handle to constrain the dragging along radial
directions. Hold down the command key while dragging a polygon handle to resize and rotate the whole
polygon in one single move.

Choose a Symmetry of “1” and no mirror symmetriesto draw a polygon free-hand.
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Notethat if you do this you can draw a polygon that is not centered inside the preview area.
This meansthat if you use such symbols for plotting, the symbols will not be centered on
the mathematical coordinates of the data points.

Click the Copy to Menu... button to add the point symbol you just defined to the point symbols menu
for later use.

The data point symbols you define are normally used when plotting (see the section “Plotting”, below,
for more details on this). However, you might also want to use them to achieve some specia effectina
drawing. For example, you can use atriangle or arectangle to define a point, and you can rotate them by
any amount. You can’t do this that easily using the standard drawing tools. Y ou can also define closed
polygons with any special symmetry. The data point symbols you define can then be used as drawing
objectsin the drawing window (their size can be quite big). Y ou will be able to resize them as usua by
dragging a selection handle, and you can always modify them by double clicking them.

Control shapes

+ Button Control shapes allow you to add buttons, check boxes, radio buttons,
Checkhox text fields, popup menus and image wells to a drawing window.
Radio Button These shapes can be accessed by a program for generating
Text Field complicated dialog boxes.

static Text Field Chapter 9 of the manual, section “Attaching programs” tells you
Popup Menu more about how to use control shapes.

Well

The following are the control shapes that you can be used:
Buttons. These are simple objects that hilite when clicked.
Checkboxes. They change their state when they are clicked.

Radio buttons: They are checked when they are clicked. They

usually come in groups. The program that manages the radio buttons

[l Checkbo# is responsible for unchecking all other radio buttons when one radio
button is clicked.
(J Radio button Text fields: These are objects that contain text. Generally, text fields
N can be edited. If you don’t want the text field to be editable, use a
Text field “Static text field".

Popup menus. These are objects that have several “values’ which

Static text field can be selected by choosing them from a popup menu.

Popup [ item 1 = I Wells: These shapes are usually used as background for other
objects, e.g. agraph. They consist of awhite rectangle.

well:
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For a more detailed description on how to use control shapes, see Chapter 9 of the manual, section
“ Attaching programs’.

Editing drawing objects

You can change many attributes of drawing objects, such as color, line thickness or | _Fi
background pattern. To do this, first select the desired object(s). Then change the attributes El
using the Fill, Pen, Dash, and Arrow popup menus. Pe

I
[E]
n

A fill pattern and afill color can be specified for all drawing objects, except simple lines. El

See Chapter 10, “Printing” for a list of limitations on patterns when printing with E|
PostScript.

A line color can be specified for al drawing objects except imported pictures.

The two Pen popup menus are used to select a thickness and a line color. The dash
pattern of aline is selected using the Dash popup menu. Choose Other... from this |+
menu to design your own dash pattern and add it to the Dash meu. | e

The line thickness and dash pattern can be specified for all objects containing lines. If

the selected object is a graph, the line styles of the axes, ticks, grid, and frame will be
changed. The color also applies to the labels. (More complex options are available for
the graph. See section ‘ Graphs and legends’ in this chapter.)

If the selected object is alegend, you can change the appearance of the curvesanddata | -------

sets displayed in the legend and the corresponding graph. See the section ‘Graphsand | -------
legends, later in this chepter, for details. | -—-—--

Other...

[k

!
Ch it

—

—t=

—=
[
=

Arrows can be added to al lines and polygons, smoothed as well as unsmoothed.

Choose Other... from the Arrows menu to design your own arrows and add your personal arrow stylesto
the Arrow menu.
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Custom Arrows

Type: Edit arrow atline & end (0 start Arrow size:

[+ Equal arrows at both ends

S~

slslsle] Yols
YOoovyv |

‘qu N

O
1

[ White
] Cap

[+ Half-sided: @& Left () Right

| Copy to Menu... | _Cancel |

Y ou can define a different arrow to be used for the start and the end of aline, use half-sided arrows,

define various other types of line caps, etc.

Fill colors and line colors are set using the corresponding popup menus.
To copy the line color from one object to another
1. Click the color measuring tool ()in the tool palette.
2 Click the color you want to copy to pick it up.
The shape of the cursor changes and becomes a paint bucket.

3 Click the drawing object to which you want to transfer the color.

Theline color of the clicked shape takes the color you picked with the color measuring tool.

To picked up afill color for the target shape, instead of aline color, hold down
the shift key while clicking with the color measuring tool.

proFit stores the color that was measured with the color measuring tool inside the
standard color popup menu. This opens up an other, even more flexible possibility
to copy colors.

1. Click the color you want to copy with the color measuring tool.

ﬁf

White

Qther ... E:

2. Select an object and apply the measured color using the standard Fill-

or Line-color popup menus.

Drawing and Plotting 71



On black and white monitors proFit displays a simpler version of the color menus, with amore limited
choice of color. To see the standard color menu which is displayed on color monitors, hold down the
option key while clicking the popup menu symbol.

Exporting pictures
There are anumber of ways to export proFit drawings:

saving thewhole drawing asaPICT file,

using the Copy or Cut commandsin the edit menu,
dragging them and dropping them to their destination,
choosing Create Publisher from the Edit menu,
saving the whole drawing as an EPSfile.

saving some or all shapesasaGlFfile.

e saving some or al shapesasa JPEG file.

In the first four cases the drawing is converted to a picture (adata structure in the so called PICT-format)
or aQuickDraw GX shape. A picture can be imported into most other Macintosh applications.

Use the Prefer ences... command, in the File menu to set various options that determine which kind of
pictureis created. The original definition of the QuickDraw PICT format defined only pictures with the
resolution of the original Macintosh screen, i.e. 72 dots per inch. To print a picture on a printer with
higher resolution, additional data must be included in the picture. There are several ways of doing this,
and the choice of method depends on the printer you are using and the application you are working with.
See Chapter 12, “Printing”, for more details on this subject.

Saving adrawing asa PICT or EPSfile

To save adrawing as a picture to be exported to other programs choose Save as from the File menu and
select PICT file from the format menu in the dialog box that appears. The current PICT Optionswill be
used for creating the picture. PICT Options are discussed in Chapter 12, “Printing”.

To save adrawing as an Encapsulated PostScript (EPS) File, choose Save As from the File menu and
select EPSfile from the format menu in the Save As dialog box.

The size of EPSfiles created in thisway iskept as small as possible. This small sizeis useful when you
want to transmit your pictures over e-mail to a publisher. However, keeping a small size introduces some
limitations on the number of text formatting options you can use. If a certain text-formatting option is not
supported by the PostScript font you plan to use, like “Outline” or “Shadow”, or “Underline”, then
these text formats are ignored when storing your document as an EPS file. Typographical formatting
styleslike Bold Face or Italic are nearly always available in al common PostScript fonts.

There is another point involved in keeping the size of EPS files small, and it is again connected to fonts.
proFit does include information on the fonts used in your document, but does not include the fonts
themselves. So make sure that you use fonts that are available to the application to which the proFit EPS
files areimported.

An alternative way to generate an EPS file is to choose Print... from the File menu and select “File” as
destination. If you do this, the created EPS file will be much larger, but it includes the whole definition of
the fonts you use in your drawing, and it also includes and PICT-data, such as drawings pasted from
another program.

A proFit EPS file contains a PostScript representation of the drawing for printing, and a picture to
display on screen (called the template). The format of the picture template that isincluded in EPSfiles
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can be selected using the PICT options panel of the Preferences dialog box (File menu). All PICT
options can be used except the “ embedded PostScript” option (which will automatically be replaced by
“normal™). It isadvisable to use the high resolution bitmaps only if the high resolution information is
really needed. Otherwise use a normal picture or a low resolution bitmap because they require less
memory. PICT Options are discussed in Chapter 12, “Printing”.

A drawing saved as an EPS file cannot be opened by proFit anymore. And PICT files will
be opened as a single picture shape.

o To be able to modify it later, save a copy in the proFit format!

Saving adrawing asa GIF or JPEG imagefile

To save adrawing as a Graphics Interchange Format (GIF) image or as a Joint Photographic Experts
Group (JPEG) image, choose Save as from the File menu and select GIF file or JPEG file from the
format menu in the dialog box that appears. Then you select from these options:

JPEG Oplions

Color depth | 256 Colors :]

Background color

Interlaced
[] Smooth (anti-aliasing)
[] Selected shapes only

Resolution | 72 > I dapi

Compression | medium s |

| Cancel | | 0K |
Color depth: The maximum number of different colorsin the image.
Background color: The background color, e.g. between different shapes.
I nterlaced: The image reconstruction will happen step by step. For GIF files only.
Smooth: Anit-aliasing by 2x enlarged drawing and subsequent image reduction.
Selected shapesonly:  If checked, only the selected shapes are taken from the drawing window.
Resol ution: If thereis aneed for higher resolutions, select a number larger than 72 dpi.
Compression: Select the compression quality.

A drawing saved as a GIF or as a JPEG image file will be opened as a single picture shape,
and, therefore, not be editable.

o To be able to modify it later, save a copy in the proFit format!
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Exporting pictures over the clipboard

To copy apart of adrawing in order to export it to another application, select the objects you want to
copy and choose Copy or Cut from the Edit menu. Alternatively, you can drag the selected objects
directly to their destination. The current PICT Optionswill be used to create the exported picture. PICT
Options are discussed in Chapter 12, “Printing”.

Exporting pictures using Publishers

To make a portion of a drawing available to other applications or other users, you can also use the
command Cr eate Publisher in the Edit menu.

A Publisher creates a picture of arectangular part of your drawing window, e.g. of aplot of some data.
Creating a publisher will create an Edition Container — afile containing this picture. When you change
something within the Publisher rectangle (e.g. you add some points to your plot), you can tell the
Publisher to send this newer Edition of the picture to its Edition Container. In this way, the Edition
Container always contains the latest version of the picture. By default, the new edition is always sent to
the Edition Container when you save your file.

If you are defining a series of drawings to be included in some publication written by somebody elsg, itis
useful to Publish the drawing using this feature, and load them into their destination using the Subscribe
mechanism. Another application can import the picture in the Edition Container by selecting Subscribe
to from the Edit menu. In thisway you can be certain that the publication always contains the latest
version of your graphs or drawings. Whenever the contents of the Edition Container are changed, the
subscribing application will be informed of the changes and will oad the newest version.

To create a Publisher:
1. Select the objects you want to publish.

2. Choose Create Publisher from the Edit menu.

The following dialog box appears:

Preview |Gg screenshot and examples.. $| - me too
B A nice publisher ~ [ Eect |
< Batch =
; ] £ Batch2 _Desktop

[ BullsEye |Gl New

|E Calc Menu Screenshot

Name of new edition: [ Cancel ]

Lintitled Edition || Publish ||

PICT Options ...
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Click the button PICT Options to choose the PICT options for the publisher you are about to create.
(By default the current PICT Options are used.). Find more information about PICT Optionsin Chapter
12, “Printing”.

3. Select the appropriate name and location for the Edition Container and click
Publish to create it.

In the drawing window a Publisher is enclosed by a gray rectangle. This rectangle can be moved and
reshaped like other drawing objects. The publisher contains everything inside its rectangle.

Double-click the publisher rectangle to see the Publishers Options dialog box (or choose Publisher
Options from the Edit menu). Apart form the standard items, this dialog box also contains a PICT
Options button in the bottom left corner. Useiit to change the picture format used by the publisher.

Importing pictures

Every picturein the standard PICT format or imagesin the formats GIF or JPEG can be imported into a
drawing window. A single picture shape will be generated. (Note that you cannot paste QuickDraw GX
shapesinto proFit 5.0.)

If you use FileExchange (standard Maclntosh system software) you may convert even more file formats
into PICT format which can then be imported into pro Fit. Look into the Apple manuals for more detailed
information.

There are two ways of importing pictures. over the clipboard (by choosing Paste in the Edit menu) or via
an Edition Container (by choosing Subscribeto in the Edit menu).

Importing pictures over the clipboard or using Drag& Drop

When you create a picture in any application you can transfer it viathe clipboard by copying and pasting
it or by directly dragging and dropping it into a pro Fit drawing window.

Note that proFit imports pictures ‘as a whole’ and does not take them apart. If you use a drawing
application to create a line and a rectangle and paste these objects together into proFit, they are
interpreted as one picture, not as aline and arectangle.

An imported picture can be resized or rotated, but it cannot be edited in any other way. Rotating and
resizing may not work with imported pictures if they contain any non-standard information, such as
PostScript commands.

Importing pictures by subscribing

Another method to import pictures is to subscribe to an Edition Container by choosing Subscribe To...
from the Edit menu.

To open the application that created the Edition container, Click Open Publisher in the Subscriber
Options dialog box (Choose Subscriber Options... form the Edit menu to see this box), or double click
the Subscriber while holding down the option key.

If you have resized a Subscriber (or rotated it), Go to the Subscriber Options dialog box and check
Original size and orientation to go back to the original subscriber.
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Plotting

proFit generates graphical representations of functions and data sets inside drawing objects called
graphs. The coordinates of the data points are stored in the graph with double precision, and can always
be recovered fromiit.

A graph can have various components (read more about this later in this section). The most important of
these are its coordinate axes. A graph can have multiple x- and y- coordinate axes, which can have
different ranges and scalings.

A graph always maintains two special coordinate axes, which can never be deleted. This are the main
coordinate axes, and are called X1 and Y 1. The other axes are called X2, X3, Y2, Y3, and so on.

The axes can have linear-scaling, logarithmic-scaling, 1/x-scaling, or probability-scaling.

8 The linear scaling type is the standard scaling type. It indicates that there is a linear

— relationship between the coordinates of the graph and your paper.
4

linear

A logarithmic scaling indicates that there is a logarithmic relationship between the
coordinates of the graph and your paper — it expands the lower end of an axis and
compresses its upper end. The min and max values for logarithmic axes must both be

=

o
N

m

logarithmic
H
o
2
T

positive.
100 L
1r- The 1/x scaling type can be used to plot a function whose y-value is expected to be
< | proportional to 1/x. If you plot such afunction on a“1/x” scaled x-axis, the functionisa
S 20 straight line. The min and max values for 1/x-axes must both have the same sign.
100
. 0.99 The probability scaling type can be used for plotting normally distributed data— or, to
= 0.90 be more accurate — their integral. If you have a sample of sand, and you determined the
‘.g 0.50 percentage of grains having a diameter smaller than x, plot this percentage as afunction
g 0.10 of x using probability-scaling for the y-axis. If the size of the grains is normally
0.01 distributed, your data points will lie on astraight line.

With proFit, you can plot on any one of the coordinate axes contained in a graph, you can add new
coordinate axes, and you can change their characteritics.

The next section discusses the general options that are always available when plotting. Then we discuss
the procedures for plotting functions and data sets, and finally we describe how to edit and use existing

graphs.

General plotting options

Whenever you plot afunction or a data set, you can choose if you want to plot it into an existing graph,
or if you want to create a new one. Y ou can also choose if you want to plot into an existing drawing
window or to open anew one. And finally you can choose which coordinates axes you want to use for

plotting, their ranges, and their scaling.
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To plot afunction or adata set, choose Plot Function... or Plot Data... from the Draw menu. The options
outlined above are common to function and data plotting and can be set in both the plot function dialog
box and the plot data dialog box. Therefore, the upper part of both dialog boxes looks more or less the
same;

Plot Data

H-aHis __Y-axis

[21 [ #][lin | %] [AAuto range [¥1 | #][lin | %] [ Auto range

__bGraph
[] Hew window

[ ] Plot into current graph
Style [Eurrent i]

The group titled Graph lets you choose the following options:
» Check New window if you want to create a new graph in a new drawing window. Uncheck this, if
you want to use the frontmost drawing window.

» Check Plot into current graph to plot into the current graph. The current graph is usually the one
where the last plotting took place. However, you can define any graph to be the current graph by
double-clicking it and checking Current Graph in the dialog box that appears (Read more about this
dialog box later in this chapter.). As a shortcut, you can hold down the command key and double-
click the graph. If both “Plot into current graph” and “New window” are unchecked, anew graphis
drawn in the frontmost drawing window.

» Use the popup Style to select the graph style for the new graph. A more detailed explanation of
graph stylesis given below.

The groups labeled X-axis and Y -axis determine which axes will be used, their ranges, and their scaling:

» The two popup menus in the top left corner of the fields “ X-axis’” and “Y-axis’ are used to choose
the axisto be used for plotting, and to determine its range. The second popup menu determines the
scaling type of the axis.

» Check Auto rangeto let proFit automatically calculate the ranges of the axes, starting from the y-
values returned by your function, or from the range of the selected data. If you plot into an existing
graph, the ranges of the axes you use for the plot will be extended, if necessary. If you uncheck
“Auto range’, you can enter the ranges manually.

Plotting a function
To plot afunction:

1. Choose the function you want to plot from the Func menu.
2. Set its parameters in the parameters window.

3. Choose Plot Function... from the Draw menu.
The Plot Function dialog box appears.
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Plot Function 'Polynom’

H-aHis ¥Y-axis
| 1 #“Iin #I | ¥1 #”Iin #I [] Auto range
from | -1 to | 2 from |-1 to |4
Graph
- @ From X min to X max [] Mew window
. Plot into current graph
— Style [[:urrent i]
Step: |auto .
Line [— 4 || | 4|

Use fitted parameters

(2] [cancel| || oK I

The top part of this dialog box has aready been discussed above. Here we go on to explain the rest of its
contents.

The function can be plotted over the whole given range. Alternatively, you can specify start point and end
point manually using the “From .. to” edit items at the bottom left of the dialog box.

1.0 - 1.0 -
0.0 o.o-/\
-1.0 4 1.0 -

T T T T T T 7 LIS L L B B

0 1 2 3 4 5 0 1 2 3 4 5
A graph with its curve from min to max (left) and a graph created using the “From.. To” option.

If Usefitted parametersis checked, the function is plotted using the parameter values calculated in the
last fit. If Usefitted parametersis not checked, the parameter values in the parameters window are used.

If you are using linear x-axis scaling, the entry in the field Step determines the distance (step width)
between consecutive calculated x-values. If you are using any other x-axis scaling, the field has the name
#Steps and determines the number of x-valuesthat will be calculated to plot the function.

The default value for step is “auto”. This invokes a specially designed plotting algorithm that
automatically selects the x-values at which the function is calculated. If the curve representing the
function is strongly bent in agiven interval, then the number of points that are required for drawing the
function is large. On the other hand, if the function is a straight line, the number of points needed is
smaller. The following figure illustrates this.
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— function
= caclulated points

Note that the number of calculated pointsis optimized for the range afunction is plotted

in. If you change the axes range of a graph later (e. g. for “zooming” into a detail), the

number of calculated points may not be sufficient anymore for representing the curve

accurately. In this case you should redraw the function to create an optimized plot for the
o new range.

Note that plotting with the “auto”-option results in the smallest number of data points stored to
represent afunction’s curve. In thisway you can create a plot that uses a minimum amount of memory
and that is redrawn at maximum speed. However, to create such a curve, the function has to be calculated
at amuch larger number of points. If you are working with a dlow function, you may prefer to use afixed
step to obtain faster plotting, and to go over to auto step only when you want to produce afina graph.

Plotting a data set
To plot data:

1. Open a data window with the data you want to plot.
2. Choose Plot Data... from the Draw menu.

Thefollowing dialog box appears:
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Plot Data

__ H-axis __Y-axis

| X1 =I|Iin :I ] Auto range Yi || tin :I ] Auto range
from (-1 to |2 from [-1 to (4

_ Data [ populationdat.. 3] Graph

;] [] Hew window

X column [year
[+ Plot into current graph

Y columns
year Style [[:urrent i]
population in millions

_ Plot type [ [ Scatter Plot | 2|

Point @ ] Connected

Line [ ¢ |—— ¢ ] <)

]

[]Selected rows only

(2] [ cancel |

The upper part of this dialog box was discussed above.

Specia attention must be paid to the Auto range check boxes, because they a so influence which parts of
the complete data set are transferred to the graph.

If you do not use Auto range but define your own ranges in min and max, all data points
outside these ranges are ignored — only data points within the ranges of the graph are
plotted and stored together with the graph. If you always want the compl ete data set to be

® stored with the graph, check Auto range and resize your graph after plotting..

Use the Data pop-up menu to select the data window that contains the data to be plotted.

Use the X column pop-up menu to select the column that contains the x-values of your data. Y ou can
only select one x-column at atime. Usethe Y columnslist to select the columns that contain the y-values
of your data. Y ou can select multiple columns by holding down the shift key while clicking.

To plot only part of the data in the x- and y-columns, check Selected rows only. In this case only the
datain the currently selected rows will be used for plotting. To use this feature, first select the rowsyou
want to plot in the data window or with the help of the Preview window and then choose Plot Data... from
the Draw menu.

to select if you want a catter plot, bar chart or skyline plot.:
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scatter plot bar charts skyline plot
T ‘ T | T | T | T | T | T T | T | T | T | T | T | T T | T | T | T | T | T | T

4l . 4l -

2| o - 2| -
- . - - -
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- . . - - -

2 ° 4 - 4 -2F .
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0 1 2 3 4 5 6 7 0 1 2 3 4 5 6 7 0 1 2 3 4 5 6 7

When using scatter plots, use the Point style pop-up menu to select a plot symbol. If you are plotting
multiple data sets, only the first set will be drawn with this symbol. The symbols of subsequent sets are

chosen according to the current graph style. See section “Styles’, later in this chapter for further
information about graph styles.

Bar charts and skyline plots can also start from the vertical axis:

8 L L T T T T T T T 11 8 LI L L LI LI LI LI L
6 — —
4_ - -
2 — —
0-||||| |- 0 |I|I|I|I|I|I|I|-
-3-2-120 1 2 3 4 5 -3-2-120 1 2 3 4 5

The main differences between bar charts and skyline plots are:

* In bar charts, the bars have always the same width. The width is either derived from the smallest

distance of two data points or is a fixed value. In skyline plots, the “steps’ can have varying width
depending on the distance of the data points:

bar chart skyline
I|I|I|I|I|I|I|I 6I|I|I|I|I|I|I|I

01 2 3 45 6 7 8 01 2 3 45 6 7 8

» When plotting multiple bar charts, the bars can either be behind each other or on top of each other. In
skyline plots, the plots are always on top of each other.

bars side by side bars behind each other

T | T | T | T | T | T 4 _I | T | T | T | T | _

q - I :

oL [] h

2| - -2 -
PO I T T A T A PO I T T A T A

0 1 2 3 4 5 6 7 0 1 2 7
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Most of the options for bar charts can be set by double-clicking the graph and selecting the “Bar charts’
panel. This panel is desribed below, in the section “Bar charts panel”.

Graphs and legends graph
When you plot data or functions, you X’
create a graph object and a legend
object.. 2.0 - — y=x05
Graphs and legends are the most | D data
important drawing objects. > 1.0 5 \
0 O -CI" T | T | T | T | T
0 1 2 3 4 5 legend
X
Editing legends
A legend contains a description for each curve or data set of its graph. The e Istset
description consists of a symbol identifying the plot and a text. Y ou can change 1st fit
the line and point style of a plot as well as the text by double-clicking the
respective itemsin the legend. X 2nd set
« Double-click thetext of alegend to change a the name of aplot. ---- 2ndfit

* Double-click the plot symbol to choose the color, plot symbol and line styles for a plot.
Find more information on thistopic later in this chapter.

To change the space alocated for the plot symbols or the distance between lines in the legend, ssimply
resize the legend by dragging its selection points.

A graphislogicaly linked to its legend and vice versa. If you change the appearance of aplot, the change
isreflected in both the graph and its legend.

To mantain this relationship, pro Fit does not let you duplicate alegend. However, you can
select alegend and choose Ungroup from the draw menu. This transforms the legend into
a set of smple drawing shapes, which then can be copied.

If you do not need the legend, delete it. You can always create a new legend for a graph by double-
clicking the graph and checking “Draw legend” in the dialog box that appears.

Note that you can change the text style, font, and font size of alegend by selecting it and choosing an
appropriate setting from the Style, Font, and Size submenu in the Misc menu.

Y ou also can change the line styles and color of curves and linesin alegend by choosing the appropriate
setting from the “Pen” and “Dash” pop-up menus in the drawing tools palette:
» To change theline style of thefirst item in alegend that is drawn using aline (either connected data
points or a function curve), select the legend and choose the line style in the “Pen” and/or “Dash”
pop-up Menus.
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» To change the line style of all itemsin alegend, select the legend and choose the line style in the
“Pen” and/or “Dash” pop-up menus while holding down the shift key.

« To add a connecting line to the first data point in alegend, select the legend and choose a line style
from the “Pen” or “Dash” menu while holding down the option key.

» To add a connecting line to all data points in alegend, select the legend and choose a line style the
“Pen” or “Dash” menu while holding down the shift key.

By default alegend lists every plot of the related graph. Y ou can, however, hide one or more plots from a
legend by unchecking “ Appearsin legend” in the dialog box for editing curve styles. Thisis explained
later in this chapter.

A legend can be ungrouped by selecting the legend and choosing Ungroup from the Draw menu. When
an legend is ungrouped, it istransformed into a set of lines, data points and texts.

Editing graphs

The nearly unlimited possibilities for changing and editing a graph are one of proFit’'s key features. A
whole set of specialized options lets you create the graph you need. These options are accessed either by
double-clicking the graph or itslegend, or by using the Graph submenu in the Draw menu. (This sub-
menu isonly availableif asingle graph is selected or if adrawing window contains only one graph.)

When you double-click a graph or choose “General...” from the Graph submenu, the following dialog
box appears.

Graph 5ettings

- Oraw: [1legend [ 1Current graph
B e L S
Genetal ] Frame
] Grid
H-axes
Drawing sequence | Grid - Curves - AXes/Frame =
Y'-axes
| Graph width |[4.692 cm
Curves
Graph height | 2.893 cm

===

Grid

| [=
Bar charts |+ El [M]
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The icons (“panels’) in the list to the left of this dialog box correspond to the items in the Graph
submenu. Click the icons to access and edit the various parts of a graph. Click the Apply button to see
the effects of your changes.

Panedl “ General”

Check Current graph to make this graph the currently active graph. This is the graph where plotting
takes place per default.

The three Draw check boxesindicate if legend, frame and grid should be drawn or not. If you uncheck
the box named legend, the legend is deleted. If you check it again the legend reappears to the right of the
graph.

The Drawing Sequence popup menu defines the order in which the various parts of a graph (curves,

axes, grid) are drawn. Thisis especially important if you use color to highlight your curvesor if you use
very large datapoints. A grid in front of a curve can then look quite different from agrid behind a curve.

The Graph width and Graph height edit fields let you enter precise dimensions for the graph. Y ou can
also do this by selecting the graph in the drawing window and editing its size using the Drawing Info
window.

The button Styles lets you save and load the current settings of a graph. A more detailed description of
graph stylesis given at the end of this chapter.

In the following sections we discuss the various parts of agraph and how to edit them.

Panel “ Axes’

When you want to edit an axis, double click it. Alternatively, you can choose Axes... from the Graph
submenu in the Menu Draw, or you can reach the axis editing panel using the list of iconsin the Graph
Settings dialog box.

The axis editing panel for x-axes looks like this:
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Graph 5ettings

= [ [e] e L
— @ General ) Labels ) Prefidx ) Lines

] First|-3 Last |5 [lin %

v
H-axes
— Draw Ticks [ custom
Y-anes [ axis 15t major |-3
ticks .
| b Distance |1
Curves [+ labels
. # minor |1
] minor
Frame
EEH T T T T T T I T N |
Grid 2 -2-1 01 2 % 4 5

]| [=
Bar chartz | = EI [M]

Use the popup menu in the top |eft corner to navigate between the various axes, to create a new axis, or to
delete the current axis. (The X1 and the Y 1 axes are the main axes and cannot be deleted.).

The edit field in the top right corner gives the position of the selected axes in the main axes coordinate
system. Use this field to change the position of a horizontal (or vertical) axis with respect to the vertical

(horizontal) main axis coordinates. The position is set by default to the minimum and maximum bounds
of aplot whenitisfirst created.

1.0

A RN

0.0 2.0 4.0

1.0
0.0
1.0

0.0 2.0 4.0 6.0
Two graphs with different vertical positions of the horizontal axis.

If the dialog box does not show the main axis (X1 and Y 1 are the main axes) an additional check box is
present. It iscalled Same as X1 (or SameasY1).

X2 - [+ Same as X1

If Same as X1 is checked, most settings of the selected axis (such as the range, scaling, color, line
thickness, tick positions) are taken from the main X1 axis.
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If you want to use two different axes for the top and for the bottom of your plot, you have
to uncheck this box before making any changes.

The radio buttons General, Labels, and Lines let you switch between different sub-panels that are used
to edit the general appearance of an axis, the appearance of itslabels, and the kind of lines that are used to
draw the axis and itstick marks.

If you check General, you can set the following options:
— @ General ) Labels ) Prefid ) Lines

First|-3 Last |5 e
— Draw Ticks [ custom
[ auis 1st major |-3

ticks
i Distance |1
[+ labels

. # minor |1
] minor

The Draw check boxes determine which parts of an axis are drawn.

The First, Last fields and the popup menu to their right are used to edit the range of the axis and its
scaling type. See the beginning of this section for a discussion of scaling types. Note that First can be
larger than Last if you want to reverse the axis.

The Ticksfield to the right of the Draw check boxesis used to edit the tick marks. Enter the first major
tick, the distance between major ticks, and the number of minor ticks between two consecutive major
ones.

The edit field 1st major gives the coordinate of the first magjor tick on the axis.

For alinear axis the Distance field defines the distance between the major ticks. For alogarithmic axis
this field changes its name to Decades and defines the number of decades between mgjor ticks. For a
1/x-scaling the edit fields work in the same way asfor linear scaling. For probability scaling, you can edit
thelist of tick marks directly using the Custom check box.

For alinear axis the # minor field gives the number of minor ticks that are drawn between two major
ones. For alogarithmic axis this field is replaced by a check box called small ticks, which must be
checked to draw the minor ticks. If major ticks are drawn for each decade, the minor ticks are drawn for
each multiple of ten. If there is more than one decade between major ticks, the minor ticks are drawn at all
the powers of ten between the positions of the magjor ticks.
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Instead of automatically calculating the positionsof —— Ticks [¥] custom
individual ticks, you can set them manually. Check
the custom check box. This changes the contents || -3
of theticksfield.

A list appearsthat contains al the ticks of the axis.
To add atick, click afree spacein thelist (thereis
always a free space at the bottom of the list) and
enter the desired coordinate.

] major

[ Standard

Toremove atick, select it in the list and press the delete key. To change the position of atick, click it and
enter anew value. Check major to create amajor tick. Mgor ticks are written in bold face in the ticks
list. Click the Standard button to automatically re-calculate the tick positions according to the present
axis settings.

To set the label of atick mark to some general text instead of a number, double-click the label in the
drawing window. The text edit dialog box appears and you can then enter any kind of text you want.

Click Labelsin the axis dialog box to edit the format of the labels. The inner part of the dialog box now
looks like this:

— () bGeneral @& Labels Prefids ) Lines

-Format — Font
[ Auto s | [ Geneva s
Digits E Size |9 B
— [E Style [ulﬂln s |
Location | below axis 2| by|3 pt
Rotation | @° + |

Use the Format field to set the format of the numbers. Use Decimal to Auto
suppress exponential representation, Auto exponent to have all labelsin
exponential format with varying exponent, Fixed exponent to have all Auto exponent
labels in exponential format with a common exponent. The Digits field
defines the number of digitsto be shown after the decimal point.

Fixed exponent

Use the Font field to specify the text font, size, and style to be used for the labels of the current axis.

The L ocation popup menu defines where the labels of an axis are drawn. above graph
The edit field to its right defines the distance between the labels and the above axis

axis or the frame of the graph The value in thisfield isin points (= 1/72
inch or 0.35 mm). Note that it can aso be negative. below graph

Click Linesto change the appearance of the lines used for drawing the axis and its tick marks, and to set
the position where the tick marks are drawn. The inner part of the dialog box now looks like this:
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— i b6eneral ) Labels Prefidx & Lines
Axis line style [ - I[ - I[. s |
Ticks location | top + |
Major ticks ————— Minor ticks
length |5 I pt length |3 pt
—2l—: M2 ||[=2)—=)M 2]

Use the Ticks location popup menu to set the position of the tick marks. In the Major ticks and
Minor ticksfields you can set the line style, length and color of maor and minor tick marks. The line
style used to draw the axis can be edited using the “Axis line style” popup menus.All the options
outlined above for editing axes let you create many different kinds of graphs. Note that you can create
new axes and change their scaling, tick marks, etc., also if you don’t use them to plot any curve.

For example, you can uncheck the “Same as X1” check 100 101 102 103
box in the X2 axis panel and edit it to reflect a completely 10 ol vl v
different scaling, labels style, and range than the X1-axis. i

A typical application for thisis a graph that displays its x- 0.0

values on its horizontal bottom axis and the reciprocal x- .

values on itstop axis. -1.0 — T T T+ T

0.0 2.0 4.0 6.0

A graph with a different coordinate axis
as the “X2” axis..

As an example, imagine that you have a set of data that was measured for different light wavelengths
between 400 and 1000 nm. Y ou would like to plot your data as a function of wavelength, but you would
aso liketo have areading for the light energy in €V on the top axis. The energy of the light isinversely
proportional to the wavelength, so you have to use 1/x scaling for the top axis.

To create such agraph:

1. Create a graph with an x-axis from 400 to 1000.

Simply plot your data between these limits. Choose Plot Data... from the Draw menu. Make sure
that you create a new graph by unchecking ‘Plot into current graph’ in the dialog box that comes up.

2. Double-click the upper x-axis (“X2"-axis).
The axis dialog box (see above) for the top axis appears.

3. Uncheck “Same as X1".
Do thisto make sure you only change the top x-axis, leaving the bottom x-axis aone.

4. Change the axis scaling to “1/x”.
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Be sure that the “General” radio button is selected and use the scaling popup menu, found to the
right of the edit fields for the axes ranges.

5. Enter 1.2398 for First and 3.0996 for Last.

A wavelength of 400 nm corresponds to an energy of 3.0996 eV, while a wavelength of 1000 nm
correspondsto an energy of 1.2398 eV.

6. Edit the tick marks

Do this by changing the valuesin the Ticks field. Note how the density of ticks tends to increase for
larger values. Go over to custom ticks and edit the ticks list directly if necessary.
The end result could be something like this:

Energy [eV]

3.0 2.5 2.0 1.7 15 1.3
1-0 1 LELEL 1 T T T T 1 T T 1 T 1 T 1

Absorption [cnT]
o o
N AN
1 1
|

00 1 | 1 | 1 | 1 | 1 | 1
400 500 600 700 800 900 1000

Wavelength [nm]

Note that the top axis, which has 1/x scaling, has the smallest value to its right and the largest value to its
| eft.

Click Prefix in the axis dialog box to set pre- and postfix for the labels, to multiply them with a given
factor or to offset them by agiven value:

— {JGeneral ) Labels & Prefidx ) Lines
Factor Il
Offset |8
[ Prefix ... Postfix ...
= Yo

Click Prefix or Postfix to prepend or append a string to each label.

Drawing and Plotting 89



Thevauein field Factor is multiplied with the value of each label beforeits string is generated. Y ou may
e.g. enter 100 here to display values between 0 and 1 in percent.

The vauein the field Offset is added before the string of the label is generated.

Panel “ Curves’

Y ou can change the appearance of curves and data pointsin a graph in many ways. Choose Curves from
the Graph submenu (Draw menu) or click the Curves icon in the Graph Settings box. Y ou can also
double click aplot symboal in the legend.

The Graph Settings dialog box now displays the curves editing panel.

Graph Settings

Tl I N B I A= Acos[KE) etita E _ Plot type [ [1 Functio... = I_

Ores

Gener al '
Enera o expefimental data Points E] Thick

[ ]Connected
LinE[— :I[ ................ :I[.:

Y-axes ] Fill E] to ﬂHiSD
- __ Coordinate axes

H-axes

Curves B (1 s [v1 ¢
Frarme d [+ Appears in legend

B [ Forward [EEI[:ICLI.IEIr[l [Errur Bars...] [TahulﬂtE :id)
G id | To Front | | To Back | Edit Text... | | Delete 2D
| =

Bar charts |+ |£I ||:EII1I3E|I

Here you can select and change or delete all curves and data sets of a graph.

To change the drawing order of the plots, select aplot (by clicking it in thelist) and click Forward, To
Front, Backward or To Back to move it one position backward or forward or to move it to the back or
front of all plots. Thefirst plot symbol at the top of the list is drawn first, so back meanstop of the list,
and front means bottom of the list.

Change the drawing order if you have white data points behind a curve and JZ/Z(B\S(
you do not want the curve to go through the points.

To change the text describing a curve or a data set, select the curve in the list. and click Edit Text....
Instead of doing thisyou can also double-click theitem in thelist of curves and data sets.

To select if adataset isto be show as scatter plot, bar chart or skyline plot, use the menu Plot type.
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The pop-up menustitled Line let you edit the line that draws a curve or connects the data points.

The pop-up menu Points lets you select the symbol for data points. Check Connected (or With line)
to draw lines between successive data points or for a skyline plot. The menu Thick defines the line
thickness used to draw the data point symbols. It can be set to auto, in which case the line thickness will
be chosen depending on the size of the data points.

Y ou can aso fill the region between a curve and one of the axes with a color of your choice. To do this,
check Fill and select the axis towards which the curve must be filled and the fill color using the two
popup menus to its right.

The Coordinate Axes popup menus define the coordinate axes used by the selected curve or data set.
With these pop-ups menu you can change the reference axis of any given curve.

Doing this for function curves which were drawn with auto step is not recommended. If
the scaling of the original axis and the one of the destination axis differ considerably, the
results can be disappointing. Remember that a function curve is only defined by a set of
points. proFit calculated these points in an optimized way when it plotted the function for

o the axis scaling and range on which the function was plotted. If you then change scaling
or range, your curve may loose its smoothness. In such a case it is better to redraw the
function curve on the new axis

Check Appearsin legend to make the curve or data set appear as an entry in the legend. Uncheck this
check box to hide the corresponding entry in the legend. When an entry isvisible in the legend, you will
usually change its style by double-clicking it. When an entry is not visible in the legend, you must
choose Curves... from the Graph submenu to access and change the style of the corresponding curve or
data points.

Click Tabulate to recover the origina data points that were used to draw the plot. In this way you can
retrieve data points from a drawing when you have lost the original data set, or you can obtain alist of the
data pointsthat proFit calculated to draw a particular function.

Click Delete to delete the curve or data points from the graph. Y ou can use the del ete (backspace) key as
akeyboard equivalent for this button.

Click the Error Bars... button to define error bars for the selected data set (this button is dimmed for a
function).
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Error Bars

Bar thickness @ Error bars as box [ 11
— 1 " ——
Cap thickness E Cap length = | auto I HT

[1Selected rows only
[+ Skip empty data fields

— Read errors from

Window | population.data | % |

— Yertical: ] Use asymmetric errors
Type [ Individual %]
Column | year 2 |

— Horizontal: [ Use asymmetric errors
Type | None % |

Here you can specify if you want to use error bars for your data points and if you do, what they should

be.

Y ou can use symmetric or asymmetric errors. To use asymmetric errors, check Use asymmetric errors
for horizontal and/or vertical direction, otherwise leave this option unchecked. If you check the option,
you can select the errors on the top/bottom (or left/right) of the data pointsindividually.

Using the menustitled Type or Top, Bottom, Right, L eft, you can select the type of errorsto add:

Choose I ndividual if each point should have its own, unique, hon-percent error. In this case, you
must have stored the error values in a data window. Choose this window from the Window pop-up
menu. Choose the column that holds your error values from the pop-up menu Column. The
numbers found in the chosen column are assigned to each point in the plot sequentialy. If you don’t
check skip empty data fields, an error of zero is used for each empty data cell. Otherwise, proFit
only uses data cells that contain avalid number.

Make sure that the column you select contains the correct number of error values and in the right
order (i. e. the same order as the data which was plotted originally). In general, you can add error bars
months after you plotted the original data set, and proFit does not know the origin of the data set
anymore. It will smply take the error column you specify and apply the data values sequentially to all
data points. Therefore, the order in your error column must be the same as the order of the origina
data points when they were plotted.

Choose Constant if each data point has the same error. Enter the error value in the edit field that
appears.

Choose Per cent if the errors are a percentage of the x- or y-values of the data points. Enter the error
value (in percent) in the edit field that appears.

Choose None to remove the errors from you data set.
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» Choose Unchanged if you don’t want to change the error barsin a given direction.

Pand “Frame”

A frameisarectangular box around your graph:

0.40 - 0.40 |-

0.20 |- 0.20 [

0.00 1 | 1 | 1 | 1 | 0.00 1 | 1 1 1 | 1
-20 -1.0 0.0 1.0 2.0 -20 -1.0 0.0 1.0 2.0

An unframed and a framed graph.

To change the appearance of aframe, either double click a graph and click the Frame icon, or choose
Frame from the submenu Graph in the Draw menu

Graph 5ettings

General [+ Draw frame

H-axes Lines { = { = I[. :I

] Draw ticks inside frame

: ] Draw ticks outside frame

Bar chartz |+ |g| ||:HI'IEE|I

In the dialog box that appears you can edit the Line style of the frame, and determine if tick marks must
be drawn on it. Thetick positions of the main coordinate axes (X1 and Y 1) are used. If you draw aframe

with ticks, you usually do not wish to draw the axes ticks as well: Uncheck the corresponding check
boxes in the axis dialog box.
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Pand “Grid”

Grid lines are horizontal and vertical lines at the positions of the ticks.

1000 1000g
[} E EZI
O - O
100 o 100k
O E O
50 . =
10 O 10k {1
O E O
S N PO L P R B
lO 2 4 6 8 10 12 lO_DZ 4 6 8 10 12

A graph without and with grid lines.

To add grid lines to your graph, double click agraph and check Draw grid. Thiswill add horizontal and
vertical grid lines. To customize the grid lines click the Grid icon in the same dialog box or choose Grid
from the Graph submenu:

Graph 5ettings

B M Draw grid  —Horizontal grid lines
General Oraw at Line Styles
[4 major ticks [— £ || Sl IE
H-anes [ minor ticks [— 4 || SICE
........... Use ticks of 1 -
T-axes
: — Uertical grid lines
Curves Draw at Line Styles
[« major til:lcs[ :I[ :I[. -

Frrame [ minor ticks [— 4 || SICE
- Use ticks of [E

Grid

Bar chartz = |I__'?‘| Cancel |

In the Grid editing panel that appears you can define where you want to have horizontal and/or vertical
grid lines, and if you want to see them at minor ticks, major ticks, or both. Y ou can aso choose which
axes must be used as areference to draw the grid lines. The grid lines are drawn at the tick marks of their
reference axis. By default, the ticks of the main axes (X1 and Y 1) are used.
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Panel “Bar charts’
To select the options for displaying bar charts, double-click the graph and select the “Bar charts’” panel:

Graph 5ettings

i Multiple charts | [iiflyl Side by side -
General Al
— _ Bar width Group width
H-axes
a8 [uer:ent — I 98 [ percent 3
Vraes _Base line
S Position of horizontal line |8
Position of vertical line i)
Frame
ey b4 Draw line |— # || + M %]
Grid .
- [l Frame bars with rectangles
Miee =k oond o - - 1 = 'y ] I'Jl—:hl
Cdr clndr L= | HI]I]III_.I I ._i | EH“EEI I |! I]K !I

The pop-up at the top defines how to draw multiple bar charts in a single graph. They can either appear
side by side or on behind each other:

bars side by side bars behind each other

T | T | T | T | T | T 4 _I | T | T | T | T | _

q - I :

oL [] h

-2F — -2k -
PO I T T A T A PO I T T A T A

0 1 2 3 4 5 6 7 0 1 2 7

The settings under Bar width define the width of individual bars. The width can either be a percentage
of the available space or an absolute value (in pixels, centimeters or inches).

The settings under Group width are used when drawing multiple barsin “side by side” mode. In this
case, each group of bars (bars for the same value) has the given group width, which can again be a
percentage of the available space or an absolute value (in pixels, centimeters or inches).

The Base lineisthe line the bar charts start from. There is a horizontal base line for vertical bar charts
and avertical base linefor horizontal bar charts. Y ou can set the position and line style of each base line.
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Check Frame barswith rectangles to select how bar charts are framed:

framed with rectangles standard framing
T | T | T | T | T | T | T T | T | T | T | T | T | T
4 = 4 -
= F op P g -
-2F — -2F -
PO [ T I T AT AT A PO [ T N T AT AT A
0 1 2 3 4 5 6 7 0 1 2 3 4 5 6 7

(Note: You must check the option “With line” in the Panel “ Curves’ for the framing to appear.)

Graph Styles

The appearance of a graph is defined by many parameters, such as its size, the ranges of its axes, the
number of minor ticks, the symbols used for plotting, etc. These settings are called the style of a graph.
Y ou can save the style of agraph to use it (or parts of it) later for another graph. Styles are saved in the
preferencesfile.

By using styles, you can create graphs with equal formats, e.g. graphs having the same size, the same
length of the ticks, the same fonts, etc.

To save the style of agraph you can either double-click the graph and click the button Style in the dialog
box that comes up, or you can choose Styles... from the Graph submenu (in the Draw menu) after having
selected your graph:

Graph Stvles

Saved styles:

Extra Large -
Standard

Save style as: ] Default
Mew Style

| Delete I 2| | cancel I

This box shows alist of the styles that are already saved in the current preferencesfile. You can delete
one of these styles by selecting it and clicking Delete. To save anew style, enter its name and click Save.
Toload a style, select its name in the scrolling list and click L oad. The name of the button changes from
Save to Load when you move from the Style name edit field to the Saved styles scrolling list.
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If you click the Default check box when saving a style, or if you define a style with the name
“Normal”, this style becomes proFit’s default style. The next time you start up proFit, the first graph
you create will usethis style.

When you load a style, adialog box appears, asking you to choose which parts of the style you want to
apply to your graph:

Apply Style

Select the characteristics you want to use ;

[+ Bounds {Xmin,Xmax, ..}

[+ Axes and grids styles {thickness, color, ...}
[#] Curve styles {thickness, color, ...}

[+ Text styles (font, size, ...)

[+ Label styles {(number of digits, ...}

[+ Tick styles {(number of minor ticks, ...}

[+ Graph size
[Eancel] || OK ]I

The characteristics of astyle are:

Bounds: The ranges of the graph, i.e. the minimum and maximum of all the axes; the positions of the
first ticks; the distance between mgjor ticks; the number of minor ticks.

Axes and grid styles: The line thickness, dash and color of the axes, the frame and the grid; the
distance of the labels from the axes; the location of the ticks (inside or outside).

Curve styles: Theline style of al plots, i.e. curves and data points.

Text styles: The font, size, and text style of the labels.

L abel styles: The number format of the labels. The number of digits after the decimal point and the
representation (exponential, auto, decimal) of the labels.

Tick styles: The number of minor ticks, the axes scaling (logarithmic or linear) and whether the
labelsare visble.

Graph size: The horizontal and vertical size of the graph (Iength of the coordinate axes).

Graph coordinates and zooming

Normally you can look at coordinates and analyze data sets and function using the Preview window.
However, options similar to the ones available in the preview window, athough more limited, can be used

when editing graphs.

Hold down the command and option key simultaneously and click and #=0.41 y=0.80

drag over a graph object. proFit displays the mouse location in the main
axes coordinate system. The coordinates are displayed to the right of the
cursor and in the bottom left corner of the drawing window.
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If you now press the shift key, you can select a part of the graph. The
ranges of the graph will be changed to display only this part. Thisis
useful for zooming in on some part of the plotted data set.

Shape properties

All shapes (objects) in a drawing window have “properties’, such as their position or size. These
properties can be read and set from a program, so it can manipulate shapes in a drawing window. For
more information, see the documentation on GetShapeProperty and SetShapePropertiesin Appendix A.

Most of these properties can aso be set and changed manually. For instance, when you move a shape to
a new location, you change its position properties. Some of the properties can also be accessed by
choosing “ Shape Settings...” from the Draw menu. (Y ou can also double-click most shapes for getting
into the corresponding dialog box. When awindow isin dialog mode, command-double-click the shape.)

The most important setting you can access through this box is the shape’s name. Thisis a unique string
attributed to each shape and used by programs for accessing the shape.

For more information, see Appendix A and Chapter 9 of this handbook.

Drawing windows in dialog mode

Drawing windows can be put into “dialog mode”. In this mode, the window obtains a “grayish”
background and looks like a dialog box. Thisis required when you want to create a complex dialog box
using control shapes. Y ou create and edit the control shapes while the drawing window isin its normal
state. When you have finished, you switch the dialog window to dialog mode. In this mode, the drawing
window cannot be edited anymore.

[0 == #} simple button example = 0B

.‘k A E norma mode
O

) W

o

_

=5 [ Multiply by 2
#:9.821 o oy 5009 cm { | L | | k|
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] Simple button example

dialog mode

| Multiply by 2 |

To switch adrawing window into dialog mode, hold down the control key while clicking anywhere into
the window and choose “Display As Dialog”. Alternatively, choose “Get Info...” from the File menu
and check the option “Display As Dialog”.

For more information on creating dialog boxes, see Chapter 9, section “Working with control shapes”’.

Drawing and Plotting 99



8 Fitting

This chapter describes what pro Fit does when you perform afit.

‘Fitting the parameters of afunction to adata set’ roughly means finding those parameters that make the
function’s curve follow the data points as closely as possible.

There are various possible definitions of the term ‘as closely as possible’. The correct definition is often
determined by the origin and characteristics of the data set to be fitted. For example, a data set might be
subject to large errors in the x-coordinate and to smaller errors in the y-coordinates. The probability of
incurring in a given measurement error can decrease in some known way when the magnitude of the error
increases.

There are also various possible methods of looking for the best parameter set.

proFit provides a choice of different ways for “measuring the distance” of the data points from the
function, aswell as a choice of different methods to reach the best parameter sets.

The first part of this chapter deals with the definition and mathematical description of deviation functions
and fitting algorithms, the second part shows you how to select these optionsin proFit and how to run a
successful fit.

Mathematical background

In order to find the best parameter set describing a given measurement, it is necessary to establish a
quantitative method to “measure the distance”’ between a data set and the function that should describeit.

This requires the introduction of weights for the data points and of probability distribution functions.
They are described in the next sections.

Distribution functions and data weights

Consider afunction f(a,,..,a,,Xx) =f(x) (wewon’'t write explicitly the function parameters every time)
and ameasured dataset { (%, ¥),-, (X, ¥ ), (s Yo} -

Let’s assume that the function, with its “true” parameter set, correctly
describes the quantity that was measured. We further assume that,
when the data point (x,y,) was determined, the “true” system (the
one described by the function f(x)) was at the coordinates (x;, f (X.)).
When the x-coordinate was determined, an inevitable experimental
error occurred, and x; was measured instead of X. When the y-
coordinate was determined, another inevitable experimental error
occurred, and the measurement gavey; instead of (X).

In rea life the true parameter set is not known. One has to measure it by measuring many data points at
different coordinates and fit f(x) to the complete data set. Thisisthe way we usualy find a parameter set
which best describes the measurement. The parameter set obtained in thisway is not the true (unknown)
parameter set, but it should be a good approximation for it. (See the section on Error Analysis to find out
how to estimate the errors of the fitted parameters.)
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Thefitted parameter set corresponds to a function f(x) which maximizes the probability that the measured
data set came from the system described by f(X). To maximize this probability, we have to minimize the
deviations between the measured data points and the function curve. This deviation can be defined in
different ways, depending on the way in which the experimental errors are distributed, but it isusually a
function of the weighted distances

d, = Xia_ X (1a)
f(x)-v
d, = —(‘G) Y (1b)

yi

0,; and 0,; give the magnitude of the errors expected when measuring the x; and y;, respectively. The
role of these x- and y- errorsis to define the correct scaling of the x- and y- deviations between a
measured data point and the function that should describe it. The errors normalize the deviations,
introducing dimension-less numbers dy; and d,; . Data points are weighted differently (given more or
less importance) depending on their errors. A small error will magnify the importance of a given
difference, alarge error will make the normalized difference less important.

The distances dy; and d,; give the difference between measured coordinates and “true” coordinates.
Obviously, we don’t know the true coordinates, otherwise there wouldn’t be any need for a fitting
program in the first place. But we can estimate the true coordinates by minimizing some function of the
distances dy; and dy;. This function describes the “difference” between the model function and the set of
data points, and it Is chosen in such a way that its minimization corresponds to the situation with the
highest probability of producing the measured data set.

If the x- and y-errors are independent, afitting agorithm must generaly minimize amean deviation xg
of thetype

=Y [R@) +R(@,)]. @

where the functions Ry , are deviation functions that tell usin a quantitative way how bad it is that a
certain (normalized) d stance d is found for a data point. They are normally related to the error
probability distribution. Thisis the function that gives the probability that a certain measurement
error occurs. For example, Ry \, can be the negative logarithm of the corresponding probability
distribution for the distances dXI and dy -

Minimization of g as defined in Eq. (2) adjusts the function f(x) in order to maximize the probability
that the measured data set corresponds to an underlying “reality” described by the adjusted f(x).

Thisistrue aslong as the following assumption is fulfilled: the measurement errors for each data point
must be uncorrelated and described by probability distributions centered around the “true” values
(%, F(%)).

The above assumption might appear harmless, but it isin fact more stringent than one would causally
expect. For example, in most cases one tends to assume that the probability distribution is Gaussian, but
the actual probability distribution for the measurement errors might be different, with a sizable probability
of finding larger errors from time to time, i.e. points that are clearly outside the expected trend
(“outliers™).

To alow for an analysis of such cases, proFit provides a set of deviation functions R which correspond
to various error probability distributions.
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The most common deviation function provided by proFit isthe squared deviation

R(d) = d2. 3
When using this deviation function, Eq. (2) becomes the mean squar e deviation between data points
and function. Eq. (2) then corresponds to the negative logarithm of the probability of obtaining the data
set in the presence of normally distributed measurement errors. The deviation function (3)

corresponds to a Gaussian error distribution. In this case the probability density that a certain error
occurs when measuring X; or y; is given by a Gaussian distribution (or normal distribution)

The next deviation function provided by proFitis

R(d) =|d, (4)
and corresponds to a two-sided exponential error distribution exp(-|d|). It leads to the calculation of a
mean absolute deviation instead of a mean sgquare deviation.
The deviation function

R(d) = Iog(1+%d2), (5)
corresponds to a L orentzian error distribution 1/(1+ d*/2).

The last deviation functions available in proFit are
[c[l cos(d/c)] |d<cm

R(d) = D |d>cr’ ©)
withc=2.1 and
%% 3-3000 <
Rd)=PH O 08 : (7)
S > c

with ¢ = 6. These deviation functions are called Andrew’s sine (the derivative of (6) is sin(z/c)) and
Tuckey’s biweight, respectively. They don’t correspond to a particular probability distribution for the
errors. They are designed to decrease the weighting of data points with very big errors (outliers) in order
to alow a “robust” fitting through the more “reasonable” data points. It should be obvious that this
procedure should only be used if you know your experiment and data set well enough, and we repeat the
usual callsfor caution!

Note that using the deviation functions (6) and (7) with another constant c is equivalent to changing all
errors of the data points and the resulting mean deviation value by a constant factor.

Each term in the sum (2) describes a deviation between the measured data point (x;,y;)and the “nearest”
point on the function curve (X, f(X)). The coordinate X, must be chosen in such away that each termin
the sum (7) is minimized for each data point.
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When the deviation function R is the squared deviation R(d)=d?, then
each term in (2) gives the sguare of the Euclidean distance between
(x,y,) and (X, f(X)). The term is minimized when the line connecting
the data point to the function curve is perpendicular to the function
curve. A fit-algorithm must thus adjust the function until the sum (2) of
the squared perpendicular distances between data points and function
curve reaches aminimum.

We refer to the literature for more detailed discussions of the above deviation functions. A short
description is also found in the classical book by W.H. Press, B.P. Flannery, S.A. Teukolsky, W.T.
Vetterling, Numerical Recipes - the Art of Scientific Computing.

The mean square deviation: Chi-Squared
When squared deviation functions are used, (2) gives the mean square deviation, which is often called x2:

Xzzz(&a—}zq) +(f(>2—2yi) )

1 Xi yi

The mean square deviation (chi-sguared) is used when the measurement errors are described by a
Gaussian probability distribution, and in this case the errors O,; and O.; correspond to the standard
deviations of the Gaussian distributions.

The denomination “chi-squared” has become so common that it is often used to indicate the result of
(2), and not only to indicate the particular case (8).

For the sake of simplicity, proFit follows this somewhat “dirty” convention and uses the

denomination “chi-squared” when referring to the result of (2), even if deviation functions

other than square deviations are used. The same is true for the predefined function

Chi Squar ed, which can be used in proFit programs to retrieve the value of (2) obtained
o in the last fit.

Zero X-errors

In most experiments it is possible to determine the x-coordinate much more precisely than the y-
coordinate. In such a case the x-errors can be assumed to be very small. The only way to minimize the
mean deviation (2) isthen to have X = x.. The mean deviation function becomes much simpler:

—yv U
& (©)

Of (x
Yo=Y R f(‘a)y'

The function is evaluated at the x-coordinates of the measured points. The function value and measured
y-coordinate directly give the normalized distance, when weighted with the measurement error.

The “usual case’: Chi-squared and zero x-errors

In many experiments it is not only possible to make the x-errors so small that they can be considered
zero. It is aso common to have (or hope for) Gaussian distributed measurement errors. In this case we
have to minimize a particularly smple expression for chi-squared:
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XZZZ(f(Xl) 2y|) ’ (10)
] ayi

Since this case is easy to handle from an algebraic and numerical point of view, many common fitting

algorithms and applications work under the assumption that the mean deviation is the mean square

deviation given by Eqg. (10). A classical fitting algorithm that works on this basis is the Levenberg-

Marquardt algorithm in its unmodified, original form (see below).

Error analysis and confidence intervals

Although some fitting algorithms (most notably the Levenberg-Marquardt fitting algorithm) do provide
estimates for the error of the parameters, these estimates are often not sufficient or too imprecise.

proFit provides ageneral way for estimating the confidence intervals within which the “true” value of a
fitted parameter can be assumed to lie with a certain probability level.

The influence of variations in the data points on the fitted parameters is analyzed with the help of aMonte
Carlo simulation. For this purpose, synthetic data sets are generated starting from the points (X, f (X))
that were obtained in the fit (see above). For each of the original data points asimulated data point is ge-
nerated by random variation around (X, f (X)) within the specified errors and using the specified error
distributions. This produces a synthetic data set that effectively ssmulates a measurement. The smulation
of the measurement is based on the function that was determined in the last fit (which is assumed to
correspond to the underlying “reality”) and on the measurement errors that were specified.

A short description of this error analysis technique is found in “W.H. Press, B.P. Flannery, S.A.
Teukolsky, W.T. Vetterling, Numerical Recipes - the Art of Scientific Computing”.

For each of the synthetic data sets, afit is performed. Once that all synthetic data sets have been fitted, the
confidence intervals are calculated by analyzing the values obtained for each parameter. The confidence
interval thereby corresponds to the range enclosing a given percentage of the values.

When error analysis is complete, the results are printed in the Results window and a list of the fitted
parameters for each synthetic data set appears in a new data window. Y ou can use the set of simulated
parameters for further statistical analysis.

Fitting algorithms

In the previous section we gave a short overview of the most important mathematical tools used to
establish criteria distinguishing a good fit from a bad one. Once these criteria are established, one can use
them to analyze parameter sets, and to find out in which direction the best parameter set can be found.

The search for the best parameter set is the responsibility of a fitting algorithm, and proFit lets you
choose between three different ones: The Monte Carlo, Levenberg-Marquardt, and Robust algorithms.

The algorithms differ by the method they use to orient themselves in parameter space and to find the
location of the best parameter set.

The Monte-Carlo algorithm minimizes (2) with any definition of R by randomly varying the parameters
and (if the x-errors are not zero) the set of x-coordinates )?i and looking for the smallest value of (2).
This algorithm is often useful to scan parameter space and find good initial values for a Levenberg-
Marquardt, or Robust fit.

The Levenberg-Marquar dt algorithm minimizes the mean square deviations using (8). It finds at the
same time the set of x-coordinates X and the function parameters that minimize the mean square
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deviations between the data points(x;, y;) and the function vaues (x;, f(X)). When the x-errors are zero,
the Levenberg-Marquardt algorithm minimizes (9).

The Robust fitting algorithm minimizes (2) with any definition of R by continually moving “downhill”
in parameter-space until the bottom of avalley isfound.

The Linear Regression and the Polynomial fitting algorithms are specialized for polynoms of 15t and
nth degree. While the Linear Regression allows for x-errors (we use a straight forward algorithm if there
are no x-errors), the Polynomial fitting algorithm isrestricted to y-errors only.

The mathematics used by the various algorithms to perform their job is outlined in the next sections.

The Monte Carlo algorithm

This method randomly varies the parameters of a function within given intervals. When x-errors are
defined, the algorithm also varies randomly the set of x-coordinates X; while observing the given errors
and error distributions.

For each random guess, xR is calculated according to Eq. (2) and the parameter sets corresponding to the
smallest values of xR are remembered.

The strength of this method is also its biggest disadvantage. It looks for the best parameter set by
shooting blindly inside the given region of parameter space. Although there is an option of letting this
parameter space region follow the position of the currently best parameter set, this algorithm can only
converge very dowly towards the best parameter set.

Itsmain useisto “scan” parameter space in order to find good parameter starting values for one of the
deterministic fit algorithms, or to try to “jump out” of alocal minimum where a deterministic fitting
algorithm is stuck.

Since the agorithm is normally used for afirst estimate of fitted parameters, it is not recommended to run
it with non-zero x-errors — this merely slows down the algorithm without substantially increasing the
accuracy of the estimates.

The Levenberg-Marquardt algorithm

The Levenberg-Marquardt algorithm is derived directly from the mean square deviation expressions (8)
or (10) and cannot be used with deviation functions R other then the square deviation R(d) = d?.

The Levenberg-Marquardt algorithm isin principle the fastest fitting algorithm available in proFit. Its
performance, however, depends strongly on the behavior of the function to be fitted as well as on the
selected starting parameters.

The classical version of the Levenberg-Marquardt algorithm does not alow for x-errors and minimizes
the mean square deviation (10). The agorithm can be described in words as follows:

Starting from a given set of parameters, the mean square deviation x2 is calculated. Then the parameters
are varied slightly to observe their influence on x2. From this, the direction in which x2 decreases most
rapidly can be evaluated and a new set of parametersis chosen. This procedure is reiterated with this new
set of parameters . When the minimum is near, the algorithm goes over to a more deterministic “ guess-
ing” at the position of the minimum and solves some equations to find it. The fitting stops when the
value of x2 does not decrease anymore between successive steps.

The algorithm is described in W.H. Press, B.P. Flannery, S.A. Teukolsky, W.T. Vetterling, Numerical
Recipes - the Art of Scientific Computing, Second Edition, University Press, Cambridge, 1992.
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When x-errors are specified, the agorithm is modified in such away that it minimizes (8). It finds at the
same time the set of x-coordinates x. and the function parameters that minimize the mean square
deviations between the data points(x;,y:) and the function values (X, f (X)).

The extensions to the Levenberg-Marquardt algorithm that allow the interpretation of x-errors are
described in P.L. Jolivette, “least-squares fits when there are errorsin X,” Computer in Physics, Vol. 7,
No. 2, 1993.

Partial derivatives

To fit a function of the type y =f(a,,..,a,,X) the Levenberg-Marquardt algorithm needs the partial
derivatives of the function with respect to its parameters. It uses the partial derivatives when it estimates
the influence of the parameter set { aj} on x2. The partial derivativesfi' are given by

fi' (x) = m(aié—a’lan’x) (11)

and they are calculated for al x-coordinates )A(i during every iteration.

When you define your own function for fitting and you find that the fitting process is too
slow, then you should define these derivatives explicitly (in the procedure called
deri vati ves). If you do not define the derivatives yourself, pro Fit must calcul ate them

° numerically. This makesfitting considerably slower.

More information on how to define functions and their derivatives is given in Chapter 9, “Defining
functions and programs’.

Estimation of parameter errors

The Levenberg-Marquardt algorithm allows the determination of the standard deviations of the
parameters. These are the values that are printed in the results window after a successful fit, under the
heading "standard deviations'. The standard deviation defines the region that contains 68.3% of the total
integral of a Gaussian distribution.

The standard deviation Ty of the parameter value 8 obtained after a successful fit isfound from

i (12)

where C;; is the diagonal element of the covariance matrix C. The full covariance matrix of the
parameters used in the fit isthe inverse of amatrix A: C=A-L,

The matrix A isaso called curvature matrix, and it is defined by the errors (standard deviations) of the
data points and by the partial derivatives of the function with respect to the parameters. When x-errors are
specified the derivative of the function with respect to x must also be calculated and the curvature matrix
A isgiven by

_ EBf(Xk) af(Xk)D
A, =
i Z 0')2”( . a f(Xk g 0a aaj

(13)

If the x-errors can be considered to be zero, the curvature matrix A has the smpler form:
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1 EBf(xk)af(xk)D
aykE da  Oa

I

A = (14)

Loosely speaking, this matrix describes the propagation of the errors from the data points to the
parameters. We refer to the speciaized literature for more details.

If the x-errors can be regarded as zero, proFit lets you specify “unknown” y-errors. In this case, the y;
are assumed to be normally distributed all with the same standard deviation o . For fitting, g,; istaken to
be 1 foralli. The“real” 0,2 isthen estimated from 02 = x2/ v (where v isthe number of degrees of
freedom, i.e. the number o¥ data points minus the number of parameters) and oy; is calculated from the
expressions given above.

It isinteresting to consider the case where a parameter reaches one of its limits during afit. Asyou know,
proFit lets you specify, for each function parameter, an interval of alowed parameter values. If a
parameter is at one of the boundaries of thisinterval after afit, its standard deviation cannot be cal culated.
The parameter is then considered to be constant (i.e. it is not a free parameter anymore). The standard
deviations of the other parameters and x2 are cal cul ated using the effective number of active parameters at
the end of the fit. The results obtained are the same as those that would have been obtained by fitting with
the parameter fixed at itslimit from the start.

The standard deviations of the parameters (and the covariance matrix) that are obtained in a

Levenberg-Marquardt fit have aclear quantitative interpretation only if the errors of the data

are normally distributed. If the data errors are not given, the calculations for evaluating the

standard deviations of the parameters assume that the y; are normally distributed and that
o the function isthe correct description of redlity.

Interpret the results carefully !

An alternative, more general way to estimate the errors of the fitted parametersis described in the section
“Error analysis and confidence intervals’.

The Robust minimization algorithm

This method minimizes xg (2) with any definition of R by continually moving “downhill” in parameter-
space. Starting from some initial value, the parameters are varied and the resulting value of xR is
calculated. From this, the algorithm finds the direction in which xR decreases and moves that way. Then
it samples again the surroundings by varying the parameters. It stops when aminimum is reached.

When the x-errors are not zero, the )A(i necessary for calculating the “minimal distance” between a data
oint and the functipn curve are calculated for each data point by an explicit minimization of the term
[R(d,)+ R, )| inEg. @

Minimization is performed with limited precision in order to save processing time. The X, will be
determined to an accuracy which is a fraction of the x-error specified for each point. proFit will also
count the number of function callsit is using to determine one )?i and will stop after a maximum of 50
function calls (normally much less function calls (<10) are needed to find the minimum). This procedure
introduces a small uncertainty in the determination of xr. However, the statistical significance of such an
uncertainty will be limited, because the precision with which the X are determined is in any case much
better then the errors of the data points.
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A robust fit with x-errors larger than zero will be considerably slower than the same fit
performed with zero x-errors. When for zero x-errors evaluation of (9) requires a number
of function calls equal to the number of data points, evaluation of (8) will require more or
less ten times more function calls when x-errors are defined.

The Linear Regression algorithms

In this case we assume a straight-line mode! for the measured data with normally distributed errors.
y(X)=a+ bx (15)

A) If there are no x-errors and the y-errors are assumed to be known (gj is the uncertainty of yj) equation
(9) can easily be smplified. At its minimum the derivatives after the two parametersa and b vanish. This
leads to a set of linear equations that are solved analyticaly:

S8 -S8Sy .55 "SS
a= A , b= A (16)

using the following definitions:

N

= 10|,sx z 5=y

Su = Z% = i XJZ (17)
A=SS, ‘(SX)Z

From these we are also able to calculate the variances of a and b, and the correlation coefficient between
them:

=Su/D, 06=S/A,

oS 09

B) If the measurement shows errorsin the xj the minimization of (8) becomes more difficult, i.e. the set
of equations derived for a and b are not linear any more. However, they are solved with numerical means,
I.e. with a standard root finding algorithm.

Together with the fitting parameters and their variances the correlation coefficient r is calculated
(Pearson's r). It takes a value between -1 and 1 depending on how much the x-values and the
corresponding y-values are correlated. r = +1 if there is a complete correlation with a positive slope, r =
-1 if there is a complete correlation with a negative sope, and r = 0 if thereisno correlation at all.

The significance of the correlation is the "probability that |r| should be larger than its observed valuein
the null hypothesis’ (x and y being uncorrelated). It ranges from O (= good correlation) to 100% (= bad
correlation).

We refer to the specidized literature for more details.
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The Polynomial fitting algorithm
Our model is the genera linear combination of arbitrary functions

M
= Z acFi(X) (19)
=1
The functions Fk can be wildly nonlinear functions of x. "Linear" refers only to the model's dependence
on its parameters ak.

Once again we assume that the measurment errors gj of the ith data point are known. By defining the
matrix A and the vectorsb and a as

Fi(x) b= i
gi ’ i

A = , & (20)

it is possible to describe the minimization equations in matrix form
(ATA )&=ATDb (21)

The variances of the parameters can be found as the square root of the diagonal elements of the inverse
matrix A™.

To solve equation (21) we use the method of Singular Value Decomposition (SVD). It isavery robust
algorithm for overdetermined as well as for underdetermined systems, athough it is alittle slower and
needs more memory resources than solving the normal equations.

For further details see the literature listed bel ow.

Goodness of fit

It isvery important to know the quality of afit; otherwise the minimizing parameters found are in general
not meaningful. The goodness of fit, which is the probability Q that a value of chi-square X should
occur by chance, is calculated by the incomplete Gamma function

Q= gammqg; v ); 0 (22)

It depends on the degree of freedom, defined as the difference between the number of measured points N
and the number of varied parameters M.

If Q islarge, e.g. > 0.1, thefit seems reasonable. If it is small, e.g. < 0.001, there might be something
wrong.

Literature and suggested reading

W.H. Press, B.P. Flannery, S.A. Teukolsky, W.T. Vetterling, Numerical Recipes - the Art of Scientific
Computing, Second Edition, University Press, Cambridge, 1992.

P.L. Jolivette, “least-squares fits when there are errorsin X,” Computer in Physics, Vol. 7, No. 2, 1993.
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The fitting process

General features

With proFit, fitting is a highly interactive process. Y ou can decide which parameters have to be varied, set
thelr starting values (estimates) and choose afitting method. Y ou can inspect the fitting processwhileitis
running, and interrupt it if you don't like it. Y ou can reiterate the process and change fitting algorithms..

The fitting process starts from the parameter values given in the parameters window. Y ou can change
these values (click the numbers and edit them). The window also shows which parameters are to be fitted:
Only those whose name is shown in bold face will be fitted (for these parameters the check box “Use
for fitting”, which appears when you select a parameter, is checked).

The following is the parameters window for the function Polynom. All parameters will be fitted except
the parameter named ‘deg’:

parameters | | & !
deg = 3.0000000 eonst=[000 | al = 0.0000000 a2 = 1.0000000

a3 = 0.0000000

flx) = conzt + al ¥+ + a3 %13 selected parameter

deq: degree of the polynommial const (y-offset]

Tower limit=[none | [EUse for fitting

Iih;l

To change the fitting mode of a parameter (e.g. from ‘fit’ to ‘not-fit’), click its name. It will switch from
bold to normal or from normal to bold. Alternatively, you can click the check box Usefor fitting, in the
“selected parameter” field.

Some parameters can never be fitted. For example, it does not make sense to fit the degree of a

polynomial. The name of such a permanently fixed parameter cannot be made bold by clicking it. The
Usefor fitting check box is disabled.

Parameters that can never be fitted are called constant parameters, those that are currently not fitted are
caled inactive parameters, and those that are currently fitted are called active parameters.

Parameter limits

The value of a parameter can be limited to any specified interval by entering the boundaries of the allowed
interval in the corresponding edit fields. The edit fields appear in the “ active parameter” field once you
select aparameter. A parameter is not allowed to leave the specified interval during fitting, optimization
of the function, or when you enter a new value in the parameters window.

See Chapter 5, “Working with functions and programs’, and Chapter 8, “Defining functions and
programs’, for more information on how to set parameter limits in user-defined functions. If no limits
are specified, the default values are -co and oo (-Inf..Inf).
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During fitting, each parameter is constrained to the interval specified by the parameter limits.

Running a fit
Running afit consists basically of three simple steps:
1. Choose the function to fit in the Func menu.
Add your own function to the Func menu if it is not already there.

2. Define which parameters you want to fit and their starting values.

Y ou can do thisin the parameters window as described above. Look at the function and the data set in
the Preview Window to see how good your starting values are. Use the Fitting-tool in the Preview
Window to “push” the function towards the data points.

The importance of good starting values depends on the function to be fitted. Some functions, like the
Gauss function are more difficult to fit. A polynomia can be fitted with almost any starting parameter
Set.

3. Choose Fit from the Calc menu.
The Fitting Setup dialog box appears:

Fitting Setup

Algorithm | Polynomial |
—Data Use last choice —
Window | Untitled Data1 % | [ Selected rows only
X column | year 4| Ycolumn| population in milli... 4 |
X errors | Zero — - Yerrors| Unknown | $}———
Column Column
Distribution Distribution

Error analysis:

[+ Print full description

[] Print active parameters only 12| | cancel I |DH|

Using this dialog box, you can set a number of fitting options. Once you are satisfied with them, click
OK and fitting will start.

Y ou can switch from one fitting algorithm to the other using the Algorithm popup menu. More details
about particular options for each agorithm are given below.

The Window menu lets you select a data window (by default the foremost data window).
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The X column and Y column menus define the data set coordinates xj and yj. If Selected rowsonly is
checked, only rows intersecting the current selection are used for fitting. Otherwise, all datain the X- and
Y -columns will be used.

The popup menus X-Errorsand Y-Errorslet you specify the errors of your data. In the X-Errors menu,
choose zer o to use zero x-errors (the usual case). In the Y-Errors menu, choose unknown if you don’t
want to specify y-errors — in this case, a value of “1.0” will be used as the error for al data points
(regardless of the order of magnitude of the y-values) and all points will have the same weight in the
calculation of g (whichis calculated with g, = 1). Choose Constant to set the standard deviation of
all pointsto agiven absolute value. Choose Per cent if you want to enter the error as afraction of the data
valuein %. If you have the errors stored in a column of your data window, then select Individual and
choose the appropriate column in the pop-up menu that appears.

Make sure that the columns you select contain the correct error values in the correct
positions. For each row in the table, there must be a one to one relationship between the
valuesin the x-, y-columns and the values in the error columns.

The Distribution popup menu, which appears when you define errors, gives the error-probability
distribution that will be assumed for the fit. This popup menu is dimmed if the Levenberg-Marquardt
algorithm is used, because this a gorithm only works with Gaussian error distributions.

The check box Use last choicetells proFit to use the data window and error settings of the previous fit.
Thisfeature israrely used, but it makes fitting easier when you have to fit the same data columns severa
times but want to work with other data windows before and after afit.

The results of the fit are shown in the results window. Check Print active parametersonly if you only
want to see the values of the parameters that were fitted. Use this option if your function has many
parameters that you do not fit and you do not want all the values of inactive or constant parameters to
clutter the results window. Check Print full description to get, for each fit, a header that describes the
settings that were used for fitting.

Check Error Analysisif you want to obtain more information on the accuracy of the fitted parameters.
Confidenceintervals for each fitted parameter will be determined by a Monte Carlo method that simulates
alarge number of fits with a series of synthetic data sets. More about thisin the Error Analysis section,
below.

To start fitting, click OK. Fitting can run for fractions of a second or for hours, depending on the
execution speed of the function you selected, the number of parameters to fit, and the number of data
points. The results of the fit appear in the result window. Y ou might want to choose its name from the
windows menu and position it in a comfortable place before running afit. You can let proFit always
bring the results window to the front after afit by using the Preferences... command.

To speed up fitting when you are using one of your functions, you should define the function’s partial
derivatives with respect to its parameters. The section “The role of the partial derivatives’ below gives
more information on this topic.

Y ou can interrupt fitting by holding down the command key 4) and the period-key (.) simultaneously.

Note that proFit can run any fit in the background, this means that you can work with another application
while proFit isfitting. Y ou may want to place proFit's progress window in a corner of your screen to
watch what is going on.
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I nspecting the progress of a fit

During lengthy fits, you can inspect what is going on and see if the fitting algorithm is behaving
correctly. proFit displays information on the current fit in its progress window:

pro Fit
Fitting ...
iteration: 54913
chi squared: 2.87035e-5

best chi squared: 0.0000

const  9EETE]35e-2
al -0.4203237
az 11050943
az 0.ET45426
type to interrupt Y

Thiswindow lists the total number of iterations, the current values of chi squared, and the current values
of the best parameter set.

Y ou can see the progress of the fit graphically if you open the Preview Window and check the Show
Function check box. During afit, proFit will periodically draw the function corresponding to the best
parameter set. This allows you to see how the function approaches the data set during a successful fit.
Because of this previewing feature, you will notice soon enough if thefit isnot converging correctly, and
will then be able to interrupt it.

If your function performs many lengthy calculations, redrawing the function periodically
can slow down the fit. Hide the Preview Window, or uncheck “Show Function” if fitting
Speed matters.

Error analysis and confidence intervals

Check Error Analysisin the Fit dialog box to get more information on the confidence intervals of the
parameters.

When Error analysisis checked, two more edit fields appear in the Fitting Setup dialog box.
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Fitting Setup

Algorithm | Robust 4 |
~Data [ VUse last choice —
Window [ Lintitled Data 1 — ] ] Selected rows only
X column | year 4| Y column| population in milli... % |
Xerrors| Constant 4 |——— ~Yerrors| Constant | 3 |———
Error = 0.2 Error = 0.3
Distribution | Gaussian 4 || | Distribution | Gaussian % |

[+ Error analysis: Iterations = ,cunﬁdence intervals = [68.3 [T

[+ Print full description

[] Print active parameters only 2 [ Cancel I

The Error Analysis algorithm simulates a number of data sets equal to the value specified in the
iterations edit field. For each iteration, the corresponding parameter set will be determined by the fitting
algorithm you selected (either the Robust algorithm, or the Levenberg-Marquardt algorithm).

Y ou should always use the Levenberg-Marquardt algorithm when performing error

analysis. Using the Robust algorithm is not recommended because this algorithm is

inherently slower than the Levenberg-Marquardt algorithm. Since error analysis can

need thousands of iterations, the convergence speed of the algorithm is very
o important.

All parameter sets generated during error analysis will be collected and displayed in a data window once
Error Analysisis completed. Y ou can then use them for a more complete analysis of the distribution of
each parameter.

Based on the simulated parameter sets, pro Fit estimates confidence intervals. Y ou must specify which
confidence interval you want proFit to calculate by entering the corresponding probability in the
confidence intervalsfield. proFit calculates a confidence interval in such away that the given percent of
the simulated parameter values are contained inside it.

During error analysis, pro Fit shows the status of the calculation in its progress window:
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pro Fit

Ertar analys=is

0% 100 %

const -5.0727349e-2 01372937

al -0.6T20323 -0.2383504
az 09871284 1.3241684
a3 03292300 053326530

type to interrupt

The window shows the status of the calculation and the confidence interval estimations based on the
currently available data. The calculation is a Monte Carlo calculation, so the boundaries of each
confidence interval will converge dowly and randomly towards some stable va ues.

If you want to see what happens during error analysis and your function draws itself fast enough, open
the Preview Window and make sure “Show function” is checked. proFit will redraw the function
periodically during error analysis and you will be able to see how the fitted function changes depending
on the smulated data sets which are generated randomly. However, doing so will waste time for drawing
the function and slow down the error analysis procedure. Hide the Preview Window, or uncheck “ Show
function” to make the error analysis procedure as fast as possible.

Fitting results

When fitting is completed, a summary of the results of the fit is displayed in the results window.
Depending on which fitting algorithm you used, the data printed to the results window can vary dightly.

Y ou may often want to transfer the values of the fitted parameters to the parameters window to use them
as starting values for afurther fit. Choosing Params ->> from the Calc menu transfers the best set of
parameters to the parameters window.

The results of a fit are made available to custom functions and programs through a set of predefined
functions used for accessing the fitted parameters, the confidence intervals, the value of chi squared, and,
for the Levenberg-Marquardt algorithm, the full covariance matrix. See Appendix A for more details.

If you want to save the parameter sets obtained in every single fit, store them in a dedicated data window.
Y ou can copy them from the parameters window and paste them into a single row of the data window, or
you can write a small macro (aproFit program) that transfers the fitted parameters directly to their data
window. See chapter 9 “Defining functions and programs’ to see how to do this. An example program
for transferring parameter values to a data window is found on the proFit distribution disks.

Using the various fitting algorithms

proFit provides three different fitting algorithms: The Monte Carlo, Robust, and Levenberg-Marquardt
algorithms. They are described in the preceding section.

The following sections describe how each of these fitting algorithmsis used, and what particular options
you can set for each algorithm.
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Using the Levenberg-Mar quardt algorithm

To start a fit with the Levenberg-Marquardt algorithm, choose Fit from the Calc menu after having
selected the appropriate function from the Func menu. The Fitting Setup dialog box appears with
Levenberg-Marquardt pre-selected in the Algorithm popup menu. :

See the preceding section for a description of this dialog box.

When you define errors, the Distribution popup menu is dimmed and set to a Gaussian distribution.
The Levenberg-Marquardt algorithm can only work if the errors of the data set are normally distributed.

The Levenberg-Marquardt fit stops running when the chi-squared determined from the current parameter
set doesn't decrease appreciably anymore from one iteration to the next.

When finished, the parameter values and their standard deviations are printed to the results window. If
you need to access the complete covariance matrix, you can define a program that uses the predefined
function Covar Mat r i x. See Appendix A for more details on how to use this function.

Using the Robust minimization algorithm

To run a Robust fit, choose “Robust” in the algorithm popup menu of the fit dialog box. This dialog
box appears when selecting “Fit” from the Calc menu, and it was described above.

Using the Distribution popup menu, which appears when you define errors, you can select the error
distribution that best describes your experiment. Robust fitting will deserve its name if you select a
distribution that diminishes the importance of outliers (like Andrew’s sine or Tuckey’ s biweight).

When finished, the resulting parameter values are printed to the results window. This agorithm does not
determine a“ standard deviation” for each parameter, like the Levenberg-Marquardt algorithm does. To
obtain error estimations you have to run a Levenberg-Marquardt fit after the Robust fit converged, or you
have to check the Error Analysis check box and perform a Monte Carlo analysis. See the
corresponding section for more details.

Using the Monte Carlo algorithm

To run a Monte Carlo fit, choose Monte Carlo Fit from the Calc menu or chose Monte Carlo in the
Algorithm popup menu of the Fitting Setup dialog box.

When you do this, two more items appear to the right of the Algorithm popup menu (Please refer to the
beginning of this section for a basic discussion of the Fitting Setup dialog box.)

Fitting Setup

Algorithm | Monte Carlo +| [ Auto search

|—Dﬂta ] Use last choice .

Clicking Ranges... presents another dialog box where you can define the ranges within which the pa-
rameters can be varied:
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Fitting Ranges for "Monte Carlo® Fit

Parameter From To %
const =0 I-I 1 o [
al =0 -1 1 Yo
az =1 =10 10 [ %o
al =0 -1 1 o

ol Cancel I |DH:I

By default, these ranges are the ten percent deviations of the starting value of the parameter (or —1 and 1
if the starting value is 0).

Checking Auto sear ch tells proFit to make a more flexible search for the best set of parameters.

The Auto search check box determines whether the limits within which the parameters are varied will be
kept fixed (auto-search unchecked) or if they will be adapted during the fit (auto-search checked). In the
latter case, the limits will be shifted after every iteration to keep them around the best parameter set. (Note
that the parameters are never alowed to leave the parameter limits defined in the parameters window.)

The Monte Carlo Fit runs until you interrupt it by pressingd-‘.". If you don’t stop the fit yourself, the
Monte Carlo Fit runsfor ever.

The three best sets of parameters are displayed in the results window after you interrupt the fit.

The Monte Carlo fit dows down exponentially when the number of parametersto be fitted
isincreased.

Using the Linear Regression algorithm

To run a Linear Regression fit, choose “Linear Regression” in the algorithm popup menu of the fit
dialog box. This dialog box appears when selecting “Fit...” from the Calc menu, and it was described
above.

Asthe name indicates, this agorithm forces you to select the Polynomial function of degree 1, with both
parameters being fitted. It assumes a Gaussian distribution of errors. X-errorsand Y -errors are possible.
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When finished, the parameter values and their standard deviations are printed to the results window.
Additionally, the correlation coefficient r is calculated, as well asits significance, which is the probability
that |r| should be larger than its observed value in the null hypothesis (x and y being uncorrelated).

Using the Polynomial fitting algorithm

To run a Polynomial fit, choose “Polynomial” in the algorithm popup menu of the fit dialog box. This
dialog box appears when selecting “Fit...” from the Calc menu, and it was described above.

As the name indicates, this algorithm forces you to select the Polynomial function of any degree. It
assumes a Gaussian distribution of errors. Only Y -errors are possible.

When finished, the parameter values and their standard deviations are printed to the results window.

Fitting multiple functions and x-values

Y ou may sometimes want to fit simultaneously several functions (f4 .. f5) with one or more common
parameters. Or you may want to fit afunction that does not depend on asingle x-value but on a set (X1,
X9 ... xp) of x-values. Or you might even encounter a combination of these two cases.

In the most general case, you have g functions, each of them depending on one or more x-variables. Each
function has some parameters, some functions can share one or more parameters.

y1="F1(x1, X2 ... Xpy)

y2 =f2(x1, X2 ... Xpy)

yg = fg(XL, X2 ... qu)
For each function, you have a set of data points that should be described by it. Now you want to fit all
these functions simultaneously.

There are several methods of tackling this kind of problem with proFit. Some of them are described in
the following section.

Functions with multiple x-values
Let usfirst consider the specia case of a single function that depends on more than one x-value:

y=f1(x0, %0 . Xp)-
Example: The photoconductivity o of some light detectors as afunction of the incident light intensity |
and the operating temperature T obeys arelation of the form

o =sleToT,

where | isthe intensity of the incident light and T is the absolute temperature (in Kelvin). sand T, are
parameters.

In our example, we have a number of measurements of the conductivity o at different temperatures T and
different intensities 1. The values are given in the table bel ow.
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Temp Intensity conductivity

[K] [mW/cm?] [10-8 Q-1cm-Y
200 0 0.00
200 20 8.45
200 40 16.90
200 60 25.35
300 0 0.00
300 20 14.64
300 40 29.29
300 60 43.93
400 0 0.00
400 20 19.28
400 40 38.56
400 60 57.84

Hereisagraphical representation of this data set:

60 -
_ o T=200
- o T=300 o
§, 40 4 © T=400 -
C - o
0 &
S) T &
0 -(‘: T I T I T I
0 20 40 60
| [MW/cm2]

In order to fit these points with our function, we must define the function and the data set in such away
that the function can obtain its two x-values from the current data window. We enter the temperature T
(which is our xq value) into column 2 of a data window, the intensity | (which is our x5 value) into
column 3, and the conductivity (which isour y value) into column 4. Wefill column 1 with numbers from
1to 12, thus numbering all our measured points.
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= B cond data=—"——=—~FH
F. |"$'* [[f 1 =1 7 Rl Il % 1] 4 |
| e M T[K] I [m' femz] cond ’;
= 1 1.00000 20000000 0.00000 0.00000
= Z Z.0000a S00.00000 2000000 a.45020
= 3 3.00000 Z00.00000 A40.00000 16.900359
= 4 4,.000010 20000000 e0.00000 25.55059
= 5 S.00000 A00.00000 0.00000 0.0000a
= 7] &.00000 A00.00000 Z0.00000 14646535
= 7 7.00000 20000000 0.00000 2929266
= 8 a.00000a A00.00000 a0.00000 43 93595
= ) Q.00000a A00.00000 0.0oo000 0.0000a
. = 10 10.00000 S00.00000 20.00000 19.28234
; = 11 11.00000 J00.00000 0.00000 A5.56465
= 12 12.00000 A00.00000 &0.00000 5784702
= 13
= 14
= 15 -~
= 16 -

Conductivity data entered into a data window. Note the auxiliary column 1, providing a unique number for
each data point.

Now we define afunction y = F(x) that returns the conductivity as its y-value (see Chapter 9, “Defining
functions and programs’, on how to define your own function) and takes the number of the data point
(in column 1) as x-value. When this function is called with a given value of x, it looks up the values of
temperature and intensity (i.e. the values for yq and y5) from columns 2 and 3 of the current data
window. Then it calcul ates the conductivity according to our model o= s exp(=Ty/T):
function conductivity;
begi n

y := a[1l] * data[x,3] * exp(-a[2]/data[x,2]);
end;

Note that data[x,3] isthe value of the x-th cell of the third column in the data window that was chosen for
fitting, data[x,3] isthe intensity and data[x,2] is the temperature.

Now we can fit this function to our data. We use the first column as its x-value and the conductivity
column asits y-value. Before fitting, don't forget to set reasonable starting values for the parameters (in
this case most positive numbers will do). Thefit returns a[1] = 2.2 and g 2] = 330.

The general idea of this method is to replace a function (x4, x5... X5) by asingle valued function F(x)
which takes an index as its x-value. From this index, F can find the cells in the current data window
where the values x, .. x, are stored. Once xy .. x are known, F can calculate f(x ... xp).

Multiple functions with one x-value

Another specia case that we can easily lead back to the form y = f(x) is the case of multiple functions
with one x-value. These functions can share one or more common parameters.
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y1="1(x),
y2=12(),

yq = fq(X) .
One method to transform this problem into a ‘fittable’ form is the following:

Let us assume that we have x-values ranging between 0 and 1000. We now define a function f of the
form:

f,(X) if x=0..999 O

_ Of,(x-1000) ifx= 1000..1999%

- @g(x -2000) ifx= 2000..2999§
C.

Now we can enter the x-values of our pointsin the first column of our datawindow and al y-vauesin the
second column. The first N1 rows (where N1 isthe number of data points we have for f1) contain the
values of x in column 1 and the corresponding values of y4 in column two. The next No rows (where No
is the number of data points for f5) contain x+1000 in the first column and y5 in the second column., and
so on. In thisway we have reduced a set of multiple functionsto a single function.

When fitting multiple functions, it is very important to specify the standard deviations of
the y-values of each function. The reason for thisliesin the fact that the y-values for each
function may have a different order of magnitude. E.g. f1 might return values in the order
of 1010 while f2 returns values in the order of 1. If you do not specify the error range of

o the y-values, the fitting algorithm weights them all equally and a given deviation of a data
point from the function f1 has the same weight as a deviation from f2. For most cases,
however, it would be more reasonable to give a stronger weight to deviations from f2 than
to deviations from f1. This can be achieved by specifying percentage errors in the Fitting
Setup dialog box.

Multiple functions with multiple x-values
Thisisthe general case as described in the equations
y1 = f1(X1, X2 ... Xpy)
y2 =f2(x1, X2 ... Xpy)
yg = fq(X1, X2 --. qu)
We have a set of g functions. Each function has a certain number of x-values (which do not need to be
the samefor al functions). The functions share some parameters that you would like to fit.

The solution to thiskind of problem is acombination of the two methods explained above. We define a
single valued function @(x) that takes an index as its argument. @ returns the value of one of the
functionsfy ... fq for given x-values (X1 .. qu). The x-value of @tells

(@) which function of f4 ... fq should be evaluated;
(b) for which x-valuesit should be eva uated;

The x-values are found in certain columns in the current data window.
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Example:

Y ou have two data sets, which are described by two functions. One of these functions has only one x-
value (called t), the other has two x-values (called u and v): f1(t), fo(u, v). The functions have some
parameters in common.

The data set for f1 consists of nq pairs of values {tq, y4;}, the data set of f5 consists of n triplets of
values{u;, vj, yoi} . You aso have error etimates for all y-vaues (iji).

In order to fit the parameters of all functions simultaneously, you must first choose a method of
arranging the data sets in a data window. We propose to put the x-values into separate columns. All y-
values must be in one column since you will need them for fitting. Asthe x-value for fitting you create an
index k which is constructed from the formula:

k = 1000 i + |

wherei isthe number of the function and j the index of the data point in the data set of thisfunction. This
works fine as long as we have less than 1000 pointsin each data set. Note that this scheme of coding can
also be used for more than two functions.

A datalist for this problem will befilled up like this:

col.1 col. 2 col. 3 col. 4 col.5 col. 6
1001 y11 Ay11 t1 u1 V1
1002 Y12 VD) t2 :
. . . . un2 vn2
1000+n1  y1m Ay1n1 th1

2001 y21 Ay2q

2001+ny  yomp Ayonp

The function you define for fitting first converts the index (which isits x-value) to the number of the
function it hasto call (by testing if it islarger or smaller than 2000), then gets the appropriatet or uand v
valuesand callsfq or fo:

function twoFuncti ons;
var u,v:real
begi n
if x < 2000 then begin
X := data[ x- 1000, 4] ;
now calculate y := f1(x)
end
el se begin
u : = data[ x-2000, 5];
v : = data[ x- 2000, 6] ;
now calculate y := fa(u,v)
end;
end;

For fitting you use column 1 as the x-value, column 2 as the y-value and column 3 asthe error value.
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If you often have to perform this kind of fitting and for alarge number of points, it may be convenient to
write asmall program that, starting from separate columns for al data sets, creates a datalist as shown
above by merging al y-values and their errors and by creating an appropriate index column.

General hints for fitting

Starting parameters

As already pointed out, the success of afit often depends critically on the choice of agood set of starting
parameters. Bad starting parameters can cause convergence to afalse (i.e. local) minimum of the mean
deviation xR. It isgood practice to always try to figure out reasonable values for starting parameters.

Redundancy of parameters

Sometimes a fit converges slowly or is even stopped with the cryptic error message ‘A singularity
occurred’. This can be caused by badly chosen starting values for fitting. However, this error is often a
conseguence of poorly defined or redundant parameters. For example, consider the exponential function

X_
y=Ax expE-(?xo)@ const.

This function has four parameters: A, X, tg and const. However, the parameters A, tg and X are not
independent, asit is easlly seen when writing (5) in factors:

X
= Axex x ex %@+const.
Y pgaog P 0

The first two factors (A and exp(xg/tg)) both have the same influence on'y. A change of x can be
compensated by a change of A. These parameters are redundant. When trying to fit them simultaneoudly,
thefit falls.

Another problem often encountered during fitting is caused by the ‘poor’ definition of a
parameter. Example: If you are trying to fit the datapoints (xq = 1, yq = 2.01), (2, 3.99), (3,
6.00), (4, 8.02), (5, 9.98), (6, 12.00) to a polynomia of second or higher degree

o y = agt+agx+an@+agxd+ ..,

you will get avery poor estimation of the parameters a,, aq, ... because your data points are
nearly on a straight line and are sufficiently described by the parameters an and a4. The
standard deviations of the coefficients ay, ag, ... will be accordingly large.

Theerrorsof thedata set

When using errors (standard deviations) for your data, it is useful to keep some pointsin mind:
» Multiplying al errors of your data points with a common factor does not affect the results of fitting,
but changes the estimate of the standard deviations or the confidence intervals of the fitted
parameters.
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» Changing the relative errors of your data points affects the numerical weight of the data points.
Example: If you have alarge number of pointsin one area (e.g. between x = 1 and 2) and just one or
two pointsfar out (e.g. at x = 50), it is necessary to decrease the error for these ‘lonely’ pointsif you
want to force the function to come close to them.

» When plotting a curve in agraph with alogarithmic y-axis, a deviation of the curve from asmall y-
value appears much larger than the same deviation from alarger y-value. If this astonishesyou, it is
probably because your measurement errors are proportional to the measured value. When plotting a
fit on a graph with alogarithmic y-axis, the errors of the y; are often given in percent. Thisresultsin
smaller deviations from points with small y-values. Here is an example of logarithmically plotted data
with fits using percentage errors and constant errors.

®

106 .

103 .
100 \ \ \

0 2 4 6 8

A fit with percent errors gives amore satisfying visua agreement between curve and data. Obviously, for
serious data fitting you should always specify the real measurement error you expect for every data point.
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9 Defining functions and programs

proFit allows you to define functions and programs:
e A function is added to the menu ‘Func’. It behaves like any of proFit’s built-in functions and you
can useit for fitting, plotting, etc., see Chapter 5, “Working with functions”.
» A program isadded to the menu ‘Prog’. A program performs a sequence of tasks. Programs can be
used for scripting pro Fit.

Both, functions and programs, can be defined in the same syntax, which is based on the Pascal
programming language. In addition to this, programs can be written in Apple Script.

All commands that can be given to pro Fit using its menus, can also be issued through pro Fit’'s program
definition language or through AppleScript. Y ou do not need to know much about the syntax of these
“programming languages’ in order to do this. The command that corresponds to any user-action can be
generated automatically by switching on “recording”, either in pro Fit, or in Apple's Script Editor, or
other equivalent scripting utilities.

Programs can be considered to be “macros’ that can be used to automatize tasks. However, a proFit
program can do much more than what you would normally expect a macro to do, such as complicated
calculations and data transformations.

Hereisasmal list of what functions or programs can do:

e Calculate any kind of numerical value, even if it cannot be expressed in a closed mathematical
formula

» Access the datain a data window, write results into the results window, use dialog boxes and alert
boxes.

» Execute any command from pro Fit's menus, open and save files, create and close windows.

* Runfitting operations and predefined numerical algorithms and retrieve their results.

» Create graphs and other drawings in a drawing window using a precise, floating point coordinate
system.

» Access the properties of drawing objects in drawing windows, and mange buttons, check boxes,
popup menus, or other interface e ementsthat can be drawn there.

Note:  All the above can also be done from an external module — a piece of code generated by your fa-
vorite compiler. If you are used to programming your own code for data or function analysis,
you can consider proFit as a big library offering routines for numeric analysis, data
input/output and high resolution graphics. Information on how to define external modulesis
found in Chapter 10, “Working with External Modules’.

When you are defining your functions and programs within proFit, they are trandated (‘ compiled’) into
native computer code when they are added to proFit’s menus. This code can be executed very quickly by
your Macintosh.

Simple programs and functions can be defined very easily and quickly.

Even very complicated programs can be defined without much work by simply recording your activities
using pro Fit’s automatic macro recording feature.
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This chapter first gives a short overview on the principles of programming in proFit. It then explainesthe
automatic macro recording feature, and finally it lists the features of proFit’s built-in compiler in detail.
At the end, it explains how to save programs and functions as modules for later use.

Simple examples

Defining functions
Imagine you want to analyze afunction of the form
y = asin(x) xIn(x) +b (8.1
with the parametersa and b. To defineit in proFit:
1. Choose ‘New Function’ from the File menu.

This opens a new, empty function window.

[0 = untitled Function 2 "= 01 H

E| DDehug| Help (2] Eunst[zﬂ
| -

NE

Browse |4 |||||I | M

2. Enter the formula of your function in the new window.

The formulalooks as follows:
a[ 1] *sin(x)*I n(x) + a[2]

Used 1], g 2] for the parameters a and b.

3. Click ‘To Menu in the function window or choose ‘Compile & Add To Menu’ from
the Customize menu.

pro Fit analyses the contents of the window. Since you have entered a simple mathematical
expression using the value x, pro Fit assumes that you want to define a function. Your formulais
trandated into a Pascal-like function definition, it is compiled and added to the menu ‘ Func'.

The function window now shows the Pascal definition of your function:
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[0 == untitled Function ?="=—=0 H
(=] (]| (e Henw) 3 pebus | Hetp (B comst (B)
function User_Function; -
bagin —

g = alll*sint=2 ndz2 + alZl
end;|
[+ |
Browse | 4 |ﬂl [ |

The new function appears under the name “User_Function” in the menu ‘Func’. It is automatically
selected and the parameters window showsiits parameters a[1], g 2].

After adding the function to proFit, you can change its parameters in the parameters window. Y ou can
plot the function, use it for fitting, calculate atable of its values, etc. (To view the function in the preview
window, make sure that the option “ Show function” is checked.)

The above method is an abbreviated way for entering functions. you simply enter the function’s
expression and pro Fit translates it into a Pascal function definition before compiling it. In many
situations you will, however, want to write or edit the function definition directly. Therefore, let’shave a
closer look at it:

function User_ Function;

begi n

y = a[l]*sin(x)*In(x) + a[2];
end;

Thefirst word of our exampleisf unct i on. It tells proFit that the definition of afunction follows. The
next word (User _Funct i on) gives the name under which the function will appear in the Func menu.

The function’s actual definition is given between the keywordsbegi n and end. Thefunction’svaueis
calculated and then assigned (by the := operator) to the variabley. The variable x contains the function’s
x-vaueanda[ 1], a[ 2] etc. arethefunction’'s parameters.

a isapredefined array that represent the function parameters. The parameters can be accessed by their
index, i.e.a[ 1], a[ 2] etc. Instead of usinga[ i ] for the parameters, you can also use parameter names
of your own by declaring them (as in standard Pascal) in the header of the function. See the section
“Alternative function syntax” later in this chapter.

Our sample function is not defined for x<=0. If you use it in calcul ations with negative x-values, arun-
time error is generated. However, the function converges to y=a[2] for x=0. Y ou may want to expand its
definition range by defining y(x) = a[2] for al x <= 0. This can be done easily in a new version of our
function:
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function LogSi ne;

begi n
if x <=0
then y := a[2]
elsey :=a[l]*sin(x)*In(x) + a[2];
end;

Note that you can insert additional spaces or lines anywhere between keywords.

The new version of the function (which now has the name ‘LogSine’) shows how you can use thei f
statement for conditiona execution. It takes the general form

i f conditiont hen dothisel se do that
‘do this’ isexecuted if the condition is met, ‘do that’ if it is not met.

If you work with your function more often, you might want to make sure that the Parameter window
shows reasonable default values for the parameters and a short description of what the function does.

Here is a final and more complex definition implementing this (note that texts between curly brackets
(‘{’ and‘}’) are used as comments and are ignored):

function Myfunction;

description
{ text to appear in paraneters w ndow }
"X > 0: y = Asin(x) In(x) + B,
'X <= 0: y =B;

defaul ts

{ names and defaults for the parameters }
a[l] := 1,active,'A;
a[2] := 0,inactive,'B;

begi n
if x <=0
then y

a[ 2]
a[1] *sin(x)*In(x) + a[2];

else vy :
end;

When you add this function to proFit, its parameters window looks like this:

D | H!_.lfl]ﬂl:til]ﬂ — E
| parameters 1r| ¥ 00w = & sinlx) In(x)+ B e
wea=0: ¢w=B
& =11 0000000 B= 0.0000000
o Lirmits from | none [4a lnone | [ U1ze for Fitting
L ] =3 ="

In the last version of our sample function two additional elements have been added:

* A keyworddescri pti on followed by two texts between quotes ('..."), which appear at the bottom
left of the parameters window.

128  Defining functions and programs



» A keyword def aul t s, which isfollowed by additional information for each parameter, and takes
theform: a[i] := value, node, nanme, |lowLimt, highLimt,whereval ueisthe
default value of a parameter, node its default fitting mode (it canbe ‘act i ve’ (i.e. the parameter
will be fitted), ‘i nacti ve’ (will not befitted) or ‘const ant’ (cannot be fitted)) and nane (its
name between quotes (' ) used in the parameters window). Using the keyword def aul t s, you can
also define arange of acceptable values for a parameter given in the optional parameters| owLi m t
and hi ghLi m t . Seethe detailed description of the def aul t s keyword, later in this chapter.

Once you have successfully defined afunction and you have added it to the Func menu, you can save it
asa module. A moduleisafile that contains the computer code for your function and that can be loaded
by proFit at start-up, or at any other time. Go to the last section of this chapter for more information on
modules.

Defining programs

Programs are generally used to create or transform data in a data window or for scripting pro Fit
operations. In the following we give some very simple examples of programs.

In afirst step, we will write aprogram that fills the first column of a data window with the powers of two:
2,4, 8,16, etc.

1. Choose New Function from the File menu.
This opens a new, empty function window.

2. Enter the definition of your program in the new window.
Enter the following definition:

pr ogram Power sOf 2;

var i: integer;
begi n
NewDat aW ndow,
for i := 1 to nrRows do
data[i,1l] :=2 " i;
end;

Note that a program definition starts with the keyword pr ogr amfollowed by its name. After that we
first have avariable declaration for the variable i , which is of typeinteger.

The body of our program between begi n and end starts with the call NewDat aW ndow, which
tells pro Fit to open a new, empty data window. Then follows a so-called for-loop, which takes the
generd form

f or variable: = startValuet o endValue do statement;

A for-loop executes its statement for all integer values of its variable between startValue and
endValue. If startValue equals endValue, the for-loop is executed only once. If startValueis larger
than endValue, the for-loop is never executed.

The end value in our for-loop is nr Rows, nr Rows is always equal to the number of rows in the
current data window.
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The statement in our for-loop is an assignment (: =) to the array element dat a[ i , 1] that
corresponds to the ith data cell in the first column of the current data window. The expression 2/
stands for 2! (you can also use 2* *i instead of 2/i )

3. Click ‘Add’ in the function window
or choose ‘Compile & Add To Menu’ from the Prog menu.

The program is transformed into computer executable code (it is compiled) and its name appearsin
the at the end of the menu * Prog.

4. Choose PowersOf2 from the menu ‘Prog’.

The program is executed. It opens a hew data window and fills its first column with the desired
values.

Our next example program is somewhat more complex. Imagine you have a data window with some data
in the first column. Y ou want to write a program that fills the second column with the square root of the
values of the first column. Y ou want to take some special cases into account:
 If acdl inthefirst columnis negative, the corresponding cell in the second column should be O.
 If acell inthefirst column is empty, the corresponding cell in the second column should be empty
too.
 If any cell in the first column was empty, the program should give the user a warning when it has
finished.

The program which does thistask looks like this:

pr ogr am MakeRoot ;

var i: integer; {the row counter}
doAl ert: boolean; {true if a cell}
{was enmpty}
begi n
doAlert := fal se;
for i:=1 to nrRows do
if DataOK(i,1l) then {if cell not enpty}
if data[i, 1] >=0
then data[i,2] := sqrt(data[i, 1])
el se begin
data[i,2] := 0;
doAlert := true;
end;

if doAlert then
Alert(' Some data was negative');
end;

This program shows some additional features of the definition syntax:
» An additional variable of type bool ean has been introduced. A bool ean variable can take the
valuest rue or f al se whichcanbeusedini f statements.
» Before accessing the datain acell, wetest if thereisrealy anumber in thiscell. Thisisdone with the
function Dat aOK( r, c), which returns true if the cell in row r and column ¢ contains a valid
number. If the cell isempty or if it containstext, it Dat aOK returns false.
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e Theinnermosti f statement (i f dat a[ i , 2] >=0) hastwo statementsinitsel se branch. They
are grouped by the keywords begi n and end to make it clear that they both belong to the el se
statement.

» At the end of the program ani f condition checks whether any data was negetive. If there were
negative numbers in the input column, the procedure Al ert iscalled. Al ert takesoneargument, a
string (i.e. atext between quotes). It displays an aert box that shows this string. Here is the alert box
that appears in case negative numbers are found when the above program is executed:

Some data was negative

This alert box has two buttons; * Stop’ and *OK’. If you click Stop, the execution of your program is
immediately aborted. If you press OK, the execution of your program continues. For our sample
program, it will not make any difference if you press Stop or OK: when the program callsAl ert ,itisat
its end anyway.

Y ou can now add the sample program MakeRoot to the Prog menu (click Add in the function window).
Then prepare a data window with some data in its first column and run MakeRoot (by choosing
MakeRoot from the Prog menu).

A shortcut

As mentioned at the beginning of this chapter, you can abbreviate the definition of afunction by simply
entering its expression (using x and the parameters a[1], g 2], etc.) in afunction window. When you click
the button “To Menu” or choose “Compile & Add to Menu” from the ‘Customize’ menu, pro Fit
scans the contents of the text window.Compile & Add to Menu If it encounters a simple expression
using X, it assumes that you want to define a function and adds the corresponding Pascal syntax around
your expression.

You can use the same mechanism for defining programs. For example, you can simply enter the
following linesin an empty text window:

NewDat aW ndow;
for i := 1 to nrRows do
dataf[i,1] :=2 ~ i;

When you click the button “To Menu” or choose Add to Menu from the 'Customize’ menu, pro Fit
finds that you have entered the body of a program and that you have used the variablei. It therefore adds
the necessary Pascal syntax and then compiles your program. Y our complete program will look like this:
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[0 === Untitled Function 2 =""= =
program User_Program; -
uar i —
bagin

Hewbatalindow;
for i = 1 to nrRows do
datali,1] =2 " i;
end ;
[
Browse | 4 [ DE

On-line help for programming

The help menus

When defining functions and programs, you can use a series of predefined names, functions and
procedures. To help you use them, proFit provides a popup menu “Help” in the header of all function
windows.

[0 === untitled Function 2 ="==—FHH
.. Tn:n Menu .
program User_Program;
var i L—J

The“Help” popup menu lists all predefined routines, names, and syntax elements that you can use. The
items are organized hierarchicaly. It is easy to find an item by moving the mouse over al the different
headings.

In addition to this, the function window provides a popup menu called “Const” that provides alist of
some of the most important nature constants in science and engineering.

When you move the mouse over an entry in the menus “Help” and “Const”, a help balloon is shown
giving a short description. When you choose an entry and rel ease the mouse, its definition is pasted into
the function window.

Y ou can enable/disable balloon help for these two menus by choosing the entry “ Show Balloons” from
the popup menu “Help”. Note that when choosing ‘Show Balloons from the Help popup menu,
balloons are only enabled for the two popup menus — not for any of the other menus or dialog boxes of
proFit. To switch on balloons for other parts of pro Fit, choose Show Balloons from the Apple Help
menu (the question mark that appearsin the menu bar).

Browsing functions and programs

Navigating a lengthy function or program definition can be difficult. To get a quick overview of your
definition, click the popup menu “Browse” at the bottom left of the function window.
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[0 == DataAnalysis

—HH

E.Elm [ bebug | Help [$] Const

program Datafnalysis;
var i, autFile;
Ingnut;

procedure Openlutput;
begin

| ogou
end ;

DataAnalysis
OpenQutput
CloseQutput
CalculateRow

procedu
begin
Close

outFile = CreateTextFilel'myFile’?X;

begin...end

[~
S

The menu shows allist of all functions, procedures and programs defined in the file. Choosing an entry

from thislist takes you there.

Finding the definition of a symbol

If you want to find the definition of a symbol, variable our command that appears in a function window,
double-click it while holding down the option key. For example, if afunction window looks as follows:

D =———————— Correlation

2j=]

EE| [ Debug | Help (3] Eunst[E”

| =

2

t1 := datali,calll-meani;
t2 = datali,col2l-mean;
=11 =11 + sgritls;
=12 = =12 + L1#t2;
S22 = =222 + =qritdl;
end ;
o= s12/sqrtis 1 1#s22 0,
SelectHindows 'Results"J;

Hritelnd'set 2@ column ',cal2l;
Hritelnt ' number of data points:

Hriteln; Hritelnd'set 1: column ',

colll;

tLoocountl;

.
—

Browse | L | ||IIII

| b

SR m

and you want to know how “SelectWindow” is defined, double-clicking it while holding down the

option key brings up its definition in an Apple Guide panel:
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SelectWindow

procedure SelectWindow(wind: String or Longint)
Iloves the specified window in front of all other
windows, wind is the windowlID or the naine of the

wrirud o,

Zee alao: FrontwWindow, Frofntimostiirndow

| ? Topics [ ] 1

Automatic Macro Recording

pro Fit can “record” most operations that you perform and generate a Pascal program or an Apple
Script therefrom. (Open Apple's script editor to record your activity as an apple script. See chapter 11,
Apple Script, for more information.)

If you do not know how to program a certain action with pro Fit's definition lagnuage, switch on
recording, perform the action you want to program, and look at the recorded commands.

Each text window has record, play and stop buttons:

[[] = Untitled Function 1 =—"—=HH

[ ] ] ] [] Debug) Help(#] Const[2]

}‘

The record button is the one with the circle in its center, the stop button is the one with the square, the
play button is the one with the triangle.

To record your actions, click the record button. pro Fit will automatically generate a Pascal script for
nearly everything you do. When you have finished recording, click the stop button. Then you can replay
what you did by clicking the play button.

Alternatively, you can use the commands “ Start Recording”, “Stop Recording” and “Run” (or “Run
Selection”) from the Customize menu.

If you only want to run a part of a script, first select it and then click the play button (or choose “Run
Selection”) from the Customize menu. If you don’t select a part of the script before clicking the play
button, then the whole script isrun. If there are function or program definitionsin the midst of the script,
they will be added to pro Fit's menus.

The recorded commands appear at the current insertion point in the text window. Y ou cannot edit the text
window whileit is recording.
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Y ou can record new commands at any place inside an existing program definition. Simply position the
cursor where you want the new commands to appear, and click the “record” button.

Syntax of function and program definitions

This section gives a full description of the elements of proFit's syntax for function and program
definitions.

Information on how to define programs is found under “program definition syntax”. Information on
how to define functions is found under “program definition syntax” and under “function definition
syntax”. Y ou need to look under both headings because the function definition syntax is based on the
program definition syntax. Read the sections devoted to programs to obtain an explanation of all the
general features that are available to programs as well as functions.

Program definition syntax

The structure of a program definition is basically identical to that of a program in standard Pascal. It
starts with the keyword pr ogr amfollowed by the name of the program and a semicolon. Then you can
optionally define some variables, constants, procedures or functions for your own use. The main part of
the program (where the execution starts) is placed between begi n and end at the end of the program.

the name of the program, myProg, will appear in the Prog

pr ogr am myPr og;

const ¢ = 3e8;
var u,v: real;
done: bool ean;

procedure MyProc;
begi n

statements...
end;

procedure Initialize;

begi n
statements...

end;

begi n
statements...

end;

menu.

optional, definition of constants and variables.

optional, definition of a local procedure or function used by
the program.
Note that you can call local procedures recursively.

more definitions of functions or procedures can follow here

optional, the procedure Initialize that is called once when
the program is compiled and added to the function menu.
Any initialization of global variables can be done here.

the main body of the program where execution starts.
Note the ‘;’ after the end.

After thetitle of the program, you can define constants and variables.

The definition of constants is preceded by the keyword const , which isfollowed by the name of each
constant, the operator ‘=" (not ‘:=’), and the value of the constant. Example:
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const ¢ = 3e8;
startVal ue = 22;

Once you have defined the value of a constant, you cannot change it anymore.
The definition of variablesis preceded by the keyword var , which isfollowed by alist of variables.

var u,v: real;
done: bool ean;
m matrix[ 3];
c: conpl ex;

Note that you can specify the type of each variable (such asr eal , bool ean, conpl ex). If you omit
the type specification, it is assumed that the variable is of typer eal .

Variables and constants that you define in the head of a program can be accessed by al statements within
the program and the program’ s procedures and functions.

Y ou can use any name you like for a constant or variable (aslong as it is not yet used for any other
purpose). It can contain letters and digits but must start with aletter. Examples for names are:

myFunc, xx, JO lega names
2ToX illegd (startswith adigit)
t hen illegal (reserved keyword)

The same rules apply to the names of procedures and functions (see below).

Following the definition of constants and variables, you can (optionally) define local procedures and
functions. The genera form of their definitionis:

... for aprocedure:

procedure MyProc(mn:real; i: integer);
variable and constant definitions ...

begi n
statements, separated by semicolons

end;

... for afunction:

function MyFunc(mn:real; i: integer):real;
variable and constant definitions ...

begi n
statements, separated by semicolons;
myFunc : = return value

end;

In thiscase, MyPr oc (or My Func) is the name of the procedure (function). The nameisfollowed by a
list of arguments in brackets. If the procedure or function has no arguments, this list (including the
brackets) is omitted. In our examples we have three arguments: m n and i together with their type
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definitions. If you define afunction, the declaration of its return type follows after the argument list. Then
follows a semicolon.

After the line defining the name of the function or procedure you can define constants or variables using
the same syntax as described for the program (see above). These items are only known within this
procedure or function.

The statements of the procedure or function follow, enclosed by begi n and end,;
Y ou can call aprocedure or function anywhere after its declaration, like this:

MyProc(1.72,3.13, 20);
r := MyFunc(1.71, 3.14,10);

Local functions and procedures can also have var parameters. When you change a var paramter, you
change the va ue of the corresponding variable of the calling function. Example:

program Test;
procedure | ncrease(var a:Real);
{increase value of a by 1}
begi n
a := a+l,
end;
begi n
k :=1;
I ncrease(k); {increases k by 1}
Witeln(k); {wites 2}
end;
If you define a procedure having the name I ni ti al i ze, it is called automatically whenever the
program is added to the menu. Withinl ni ti al i ze you may want to initialize any variables or print
some information into the Results window. Hereis an example:
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pr ogram DoMy St uf f;
var i nput Col um: i nt eger;
{where our data cones front

procedure Initialize;

{prints a description of the program and }
{sets the default value of inputColum }

begi n

Witeln(' This programconverts a data colum');
Witeln('into normalized units.');

i nput Col um: =3; {inititialization}
end; {of initialize}

begin {main part of progrant

{ask for an input columm, default is the one}
{that was set in initialize}
I nput (" whi ch col um?' , i nput Col um) ;

{transform dat a}

end; {of main part}
The above program uses the predefined function W i t el n to output text to the results window and the

function | nput to ask the user for a column number. All predefined functions are described in
Appendix A.

Example
Let uslook at an example of afully functiona program:

Y ou have a data window that contains data in the first two columns. The first column contains positive
and negative numbers. Y ou are only interested in the positive numbers and you want to delete all rows
which have a negative number in the first column.

Here isthe program:
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program El i mi nat eNegati ves;
var i:integer;

procedure Del eteRow(r:integer);
{del etes the rowr and shifts up}
{all follow ng rows}
var mn:integer;
begi n
for ni=1to 2 do
begi n
for m=r to nrRows-1 do
i f DataOK(mtl, n) then
data[ mn] := data[ mtl, n]
el se ClearData(mn);
Cl ear Dat a( nr Rows, n) ; {clear last row}
end; {of for |oop}
end; {of del et eRow}

begin {main part of progrant
i:=1;
while i <= nrRows do
begi n
if DataOK(i,1l) then
if data[i,1] < O then begin
Del eteRow(i); i:=i-1
end;
i:=i+1;
end; {of while | oop}
end; {of main part}

This program tests al numerical valuesin column 1. Thisisdone in awhileloop. A while loop has the
g e n e r a | f o r m
whi | e condition do statement;

Its statement is executed aslong as its condition istrue. If you have more than one statement in awhile-
loop, they must be enclosed by begi n and end.

Our example program executes the while-loop for all rows in the data window (while 1 <=
nr Rows). If adatacell in column 1 and row i contains a negative number, the procedure Del et eRowis
caled, which deletestherow i by shifting all following rows up.

The procedure Del et eRow calls Cl ear Dat a(r, ¢), which is a built-in procedure of proFit.
C ear Dat a(r, ¢) removesany number from the cell in columnc androw r .

In the examples above, we have used the ‘for’ loop and the ‘while’ loop. Let us summarize their use and
introduce the third kind of loop (the ‘repeat’ loop):
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L oops

pro Fit supports three kind of loops, two of which we have aready seen (for-loops and while-loops). The
third oneis the repeat-loop. The loop statements are:

The while-loop
whi | e condition do statement;

The statement of the while-loop is executed as long as the expression in condition returns true. If more
than one statement should be executed in the loop, the statements must be enclosed by begi n and end.

The for-loop

f or loopVariable: = startValuet o endValuedo
statement;

A for-loop executes its statement for all integer values of its variable between startValue and endValue. If
startVaue equals endValue, the for-loop is executed only once. If the startValue is larger than the
endValue, the for-loop is never executed. If more than one statement should be run in the loop, the sta-
tements must be enclosed by begi n and end.

An dternative form of thefor-loop is

f or loopVariable: = startValue downt o endValue do
statement;

In this for-loop the value of the loop variable is decreased by one after each execution of the loop
statement. The loop is terminated as soon as loopVariable < endVa ue.

The repeat-loop
Thelast kind of loop is the repeat-loop. Its genera formis
r epeat statementunti | condition;

In contrast to the while-loop, the statement of a repeat loop is aways executed at least once. After the
execution of the statement, the condition is tested. If the condition istrue, the loop is terminated, €l se the
loop statement is executed again until the condition becomes true.

L oop control statements:. cycle and leave

Y ou can place the keyword | eave into afor-, while- or repeat-loop to exit the loop even if its end-
condition is not yet reached. Example:
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for i := 1 to NrRows do

begi n

if not DataOK(i,1l) then

begi n
Witeln('Enpty cell - |oop aborted');
| eave; { exits the for-loop }

end;

end;

The above example loops through the first column of a data window and does some calculations
(indicated by *. . . . ). If, however, an empty cell isfound, the loop is aborted.

Y ou can place the keyword cycl e into afor-, while- or repeat-loop to immediately start anew iteration
of the loop. Example:

for i := 1 to NrRows do
begi n
if not DataOK(i,1l) then
begi n
Witeln(' Enpty cell skipped');
cycl e; { goes to next value of i }
end;
end;

The above example loops through the first column of a data window and does some calculations
(indicated by ". . . . "). If an empty cell is found, the calculations are skipped and the loop is continued
with the next valueof i .

Optional parameter lists

Usually, you pass parameters to procedures and functions using the standard Pascal syntax. For
example, you write

Dr awRect (10, 10, 50, 100);
In other words, you pass avalue for each parameter and separate the parameters by commeas.

However, some of pro Fit's predefined procedures use an “optional parameter list” for passing values,
for instance

O oseW ndow(wi ndow 'Data 1', saveOption dont Save);

In the above example, “window” and “saveOption” are the names and 'Data 1' and dontSave the values
of the parameters that are passed to the procedure CloseéWindow. In other words, each parameter has a
name that must be passed in front of itsvalue.

The advantage of this calling convention is that you can omit some parameters (if you want to use their
default values). For example, you can call
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Cl oseW ndow saveOpti on ask);

In this example, we have omitted the parameter “window” and use its default value (the front window)
instead.

The pro Fit Programming Guide and Appendix A of this manual state which of pro Fit's predefined
procedures use optional parameter lists.

Aborting procedures, functions and programs

Use the keyword Hal t to immediately end the execution of a function or program. Use the keyword
Exi t for exiting from aloca function or procedure to the caller.

The following is an example of a program calculating the sum of the presently selected cellsin a data
window. The program aborts when the selection contains empty data cells. (Note that it uses the
predefined variables sel ect Left, sel ect Right, sel ectTop, sel ectBottom which
return the enclosing rectangle of the currently selected data cells.)

pr ogram Cal cSum

var row, col: integer; sum real;
begi n
sum : = 0;
for col := selectLeft to selectRight do
for row := selectTop to sel ect Bott om do
begi n

i f not DataOK(row,col) then Halt;
sum : = sunmtdat a[ row, col | ;
end;
witeln(sum;
end;

The following program does basically the same as the one above, but the sum is calculated in alocal
function, which is aborted by Exi t :
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pr ogram Cal cSum

function Suntel ection:real;
{suns the selected data, returns}
{-1if a selected cell is enpty}

var row, col: integer; sum real
begi n
sum: = 0;
for col := selectLeft to selectRi ght do
for row := selectTop to sel ect Bottom do
begi n
i f not DataOK(row, col) then begin
Suntel ection : = -1;
Exit;
end;
sum : = sunmtdat a[ row, col ] ;
end;
SuntSel ection : = sum
end;
begi n
Witel n(Suntel ection);
end;

Note: Calling Exi t from the main body of afunction or program has the same effect ascalling Hal t .

Predefined constants, functions, procedures, and operators

This section lists the operators and the most important predefined constants that are available in the
definition syntax. An aphabetical list of all predefined functions, procedures and constantsis found in
Appendix A.

The following are the most important predefined constants:

Tt (or pi ) = 3.141592..

true =1

fal se =0

I NF infinity (1/1NF=0)

The operators are identical to those that are defined in standard Pascal. In addition, the power operator
(** or ) has been added. The operators —in ascending order of precedence— are:
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= <> =< > >= comparison, returning true (1) or false (0)

+-oor add, subtract, logical ‘or’

* [ and multiply, divide, logical ‘and’

N power (x ** y = xAy =xY)
not logical ‘not’

Y ou can change the order of precedence of the operatorsin the above list by using brackets: ‘(" and *)'.

Note that there are two ways for using the power operator (x**y and x"y). They are equivalent. Use
whichever you prefer.

On some machines, x**y = x”"y iscaculated as exp(y In(x)). As a consequence of
this, the x*y may not work for negative x and may be slow. Therefore, you should not use
this notation for calculating small integer powers (for example: use sqr ( x) instead of
X**2).

[

Note for Pascal programmers: ” is used for the power operator. proFit does not know anything about
pointers and ~ is not used for dereferencing.

The order of precedence for the operators is the same as in standard Pascal. But since the
pro Fit definition language does not distinguish between boolean and real expressions
(refer to the next chapter), this order of precedence provides a dangerous pitfall

[ ) a>x and b>y will becompiledas (a > (x and b)) >y !l
Use brackets to clarify what you want:
(a>x) and (b>y)

Note: In contrast to some other programming languages, all the expressions in a composite logical
expression of the form

(condition1) and (condition2) and ( condition 3)
will be evaluated, even if condition 1 returnsfalse.

Function definition syntax

If you want to define a function of your own to use it for fitting or plotting, you must write afunction
definition. The structure of afunction definition is the same as the structure of a program definition, but
it can optionally contain additional information about the parameters and the contents of the parameters
window. This additional information is placed right at the beginning of the function definition.

A function definition starts with the keyword f unct i on instead of pr ogr am Then follows (optional)
information on the parameters and the parameters window:
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the name of the function, myFunc, will appear in the Func-

function Func;
i menu.

function myFunc(ampl , freq: real); optional, definition of parameter names that will be used to
access parameters in the function code and as a default
parameter name in the parameters window.

optional, these two strings will appear in the parameters

description -
P window.

"textl','text2';

paraneters 4: optional, the number of parameters (max. 64)

optional, the default values for the parameters, their default

defaul ts i L

, mode, parameter-window name, lower and upper limit (see
a[1] : =1. 2, acti ve; the Chapter 8,Fitting ). If you do not define the defaults for
a[2]:=3.0,inactive, ' nanme'; a parameter it will be 0, inactive and limited by -INF and

INF. If you do not define a parameter-window name for a
. . parameter its default name will be used.

a[4]:=1, active,"i",0, I NF The default name is either the name you define in the
function header (e.g. ‘ampl’) or ‘ali]'.

a[ 3]:=2.0, constant;

defaults

anpl : =1. 2, acti ve;

freq: =3. 0, const ant ;

const optional, the definition of constants as in standard Pascal.
c = 2.997ES8;

var optional, variable declarations as in standard Pascal.

tenp: extended;

nmyVar,t: integer;

After this, you can (optionally) define your own local procedures and functions.

Then follows the “body” of the function definition between begi n and end. In this body, you must
calculate the function’s y-value from its x-value and its parameters. For this, you can use the following
variables.

The input variable, the independent
variable of the function

The output variable, the function’s return
value. It must be set by your function.

a[ 1] a[ n] The parameters of the function. Up to 64
o parameters can be used.

It is possible to define your own parameter names in the function header and to use your own names

instead of thea[ 1] . . . a[ n] :
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function foo(anpl, freq, phase: real);
begi n

y .= anpl *cos(freq * x +phase);
end;

If you do this, parameters retain their numbering, defined by their sequence when you define them
(ampl, freq, phase). Theali] remainavailableassynonims(a[ 1] =anpl, a[ 2] =freq,
a[ 3] =phase) and the parameter numbers can still be used in predefined function such as
Set Par anNane.

Example 1:

Y ou want to define the function:
y =at In(a2 x?)

Y our definition looks like this:

function | ogSquare(K, Q real);
begi n

y = Ksqgrt(Qcosh(x));
end;

Thisisafunction in its most simple form. If you work with it often, you may want to assign default
valuesto the parameters. Y ou will also seethat Q should not be negative. Y ou might therefore improve
the above definition asfollows:

function | ogSquare(K, Q real);
defaul ts
K:=1, active, 'K (anmplitude)’;
Q:=1, active, "Q (nultiplier of cosh)', 0, INF
begi n
y = Kfsqgrt(Qcosh(x));
end;

Thefirst line after the keyword def aul t s definesthe default value, default mode (active means that it
will be varied in afit) and the name of K that will appear in the parameter window. The second lines
defines the default value, mode and name as well asthe lower and upper limit of Q .

Example 2:

Y ou want to define the function 1.00 - 7
y = a1 sinc(x—x1) + a2 sinc(x-x2) , 0.00 JW\#
with sinc(x) = sin(x)/x . I R

-20 0 20

The value of the function sinc is not defined for x=0, but it convergesto 1 for x - 0. When
calculating sinc, we must test if its argument is 0 to handle this special case.

Since the sinc function is used twice in our example, it makes senseto put it into alocal function.
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functi on Doubl eSi nc;

defaul ts a[1] 1, active,'al';

a[2] := -20,active,'x1";
a[3] := 1,active, ' a2";
a[4] := 20,active,'x2";
function Sinc(u:real):real; { sin(u)/u}
begi n
if u=0 then sinc:=1 {0/0 is illegal}
el se sinc:=sin(u)/u;
end;

begin {“body”}
y := a[1]*sinc(x-a[2]) + a[3]*sinc(x-a[4]);
end;

Alternative function syntax

pro Fit provides an alternative method for defining the parameters of a function that alows you to use
any desired (legal) name for your parameters. In this syntax, an example of which has aloready been
shown above, you add the parameters in parenthesis after the name of the function. Example:

function MySi ne(anplitdue, frequency);
begi n

y := anplitdue*sin(frequency*x);
end;

Thefirst parameter in the list will correspond to parameter a[ 1] , the second oneto a[ 2] , etc. You can
then refer to each parameter either by using itsname (anpl i t ude, frequency)orbyusngali],
wherei isitsnumber inthe parameter list (i.e.a[ 1] for anplitude, a[ 2] for frequency).

Special proceduresin a function definition

Asin aprogram, the procedures that you define within a function definition can have any valid name you
want. However, there are some reserved names for special procedures(l niti al i ze, Check, Fi rst,
Derivati ves, Last) that you can define to customize and optimize your function definition. These
procedures are called to perform specia actions. For example, one of them (Der i vat i ves) iscalledto
calculate your function’s partia derivatives. Another (Check) can check avalue that was entered into the
parameters window.

The following describes these special procedures. A summary is provided at the end of the section.

Function Check

This procedure is only used to include some advanced features in your function. It can make function
definitions more user-friendly. Check iscalled each time the user changes a parameter in the parameters
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window. It can check the parameter that was changed and act accordingly. For example, it can refuse a
parameter if its value is not acceptable. It can also recalculate some other parameters and cause the
parameters window to be redrawn. Check can use the following predefined variables and constants:

pNunber The number of the modified parameter

a[l1l] .. a[n] The parameters as they appear in the parameters window.
They can be checked and/or changed.

node[ 1] .. The mode of each parameter, which can be act i ve,
node[ n] i nacti ve or const ant. You can check and/or change

the modes.

active, inactive, These three constants can be used to be compared to or

const ant assigned to node[i] .

check The function must store its return value in this variable.

ok, bad, update One of these three constants must be returned in the vari-
able check.

Check must return one of the values ok, bad or updat e in the variable check to tell proFit if it
should accept the new parameter and what it should do with the parameters window:

 |f check=0k, proFit acceptsthe new parameter.

» If check=bad, proFit refuses the new parameter and shows the old one in the parameters window.

» If check=updat e, proFit accepts the new parameter and redraws (updates) the whole parameters
window. Use this feature whenever you have changed a parameter other than a[ PNunber ] inthe
function check, so that the user can see these changes.

For example your function can have two parameters that represent the same value in two different units of
measurement. Check can be used to update the value of one parameter when the other parameter is
changed.

Note for advanced users. Check isnot called during fitting. It is called once when fitting is

complete. Don’'t use Check for calculating intermediate results for later use in the

evaluation of the function. Y ou won't notice anything wrong as long as you modify the pa-

rameters in the results window, but your function will not work when fitting. Always use
o the procedure Fi r st (see below) for calculating intermediate results.

Procedure Initialize

This procedure is used for advanced programming. It is called exactly once after compilation of your
function or program. Y ou can use this procedure to initialize the value of variables or to write somein-
structions into the Results window.

Procedure Derivatives

This procedure is optional. If defined, it is used during fitting with the Levenberg-Marquardt algorithm.
This agorithm uses the partia derivatives of the function with respect to its parameters. If you do not
define the procedure Der i vat i ves, the derivatives are calculated numericaly, but this ows down the
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fitting process considerably. If you notice that fitting is particularly slow, you should define this function
and at least calculate some derivatives (proFit will still calculate numerically any derivative you don’t
define). The procedure derivatives can use the following predefined variables:

X The x-variable, the function’s x-value
a[l1l] .. a[n] The parameters of the function.
dyda[ 1] .. dyda[ n] The partial derivatives. Must be set to dydali] := of(x)/dal[i]

for all parameters that are not declared as constant.

Deri vati ves can set thevaluesdyda[ i ] for someor all of your function's parameters. If you don't
set avalue, it will be caculated numericaly.

Whenever afunction is used by proFit, acall to the procedure Der i vat i ves isaways preceded by a
call to the main part of the function. Therefore you may use temporary results from the main part of the
function by storing them into global variables. This decreases the number of calculations your function
must perform and makesfitting faster.

Example: Y ou want to fit the function y = aj-sinh(x), the partial derivative of which isdy/dag = sinh(x).
Calculating sinh(x) can take alot of time, especialy when you are working on aslow computer. To avoid
calculating expressions twice, you can save temporary resultsin the main part of the function to use them
later in the procedure Der i vat i ves:

function M/Si nh;
var t: real;

procedure Derivatives;

begi n
dyda[ 1] :=t;{ use t calculated in body}
end;
begi n {the function’s body}
t := sinh(x); {save sinh for derivatives}
y 1= a[1]* t;
end;

Procedure First

This procedure is used for advanced programming. It is called whenever the parameters of a function
have been changed — before the body (main part) of the function is called. The body of a function will
never be called without f i r st having been called beforehand.

The proceduref i r st can use the following variables:
a[l1l] .. a[n] The parameters of the function.

The procedure Fi r st ismainly used for accelerating calculations that do not depend on the input value
X. This can make afit considerably faster. Fi r st should calculate all expressions that appear in a
function but that do not depend on x:
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To caculate the mean deviation xg during fitting, proFit calculates the function for each data point
(Xi, Yi)- Thismay involve up to several thousand executions of the body of the function definition. If
your function definition contains expressions that do not depend on the value of x (such as sin(g[2]—
a3])), they will still be recalculated for each new value of x, wasting alot of time. Y ou can evaluate
these expressionsin the procedure Fi r st and store their valuesin variables used by the main part of
the function.

Another use of the procedure Fi r st isto perform some task before proFit starts to use afunction. This
is less common for functions defined inside proFit but it is often used when defining external modules
(see Chapter 10) that need to alocate and deallocate memory only used while afunction is running. The
following isasmall example of this particular use of Fi r st that also demonstrates a possible use of the
procedurel ast :

function Foo;

var firstTinme: bool ean;
dat all: ext ended;
sinDiff: ext ended;

mul tiplier: extended;
procedure Initialize;
begi n
firstTime:=true; {initialize to true}
end;

procedure First;
begi n
if firstTine then
begin {the statenents in this block are }
{executed only once, before any other}
{function call.}
firstTi me: =fal se
datall: =data[ 1, 1];
{perform here other cal culations that}
{do not depend on paraneter val ues}
{and do not depend on x}
end;
sinDiff:=sin(a[2]-a[3]);
mul tiplier:=datall*a[1];
{perform here other calculations that do not}
{depend on x but depend on the paraneter}
{val ues.}
end;

procedure Last;

begi n {finished using function.}
firstTime:=true; {reset firstTime to true }
end;
begin {the main part of the function.}
y ;= multiplier * sin(x)/sinbDiff;
end;

150  Defining functions and programs



The above example uses the procedure Last :

Procedure Last

Thisisaso aprocedure used for advanced programming. It is called when al calculations, fitting, etc. are
completed. It is the last piece of function code called by proFit before returning control to the user.
Last can be used to clean up, to makefinal calculations, or to re-initialize some variablesto their starting
values, asis shown in the example above. Last can also be used to print some special messages or results
in the results window or to alert the user of some event. For example, you can let your machine beep

when fitting is finished:
procedure Last;

begi n
beep;
end;

Summary

The following table summarizes the special procedures listed above:

name called when predefined variables and constants
Check whenever parameters are pNunber
changed by user a[1] .. a[n]
nmode[ 1] .. node[ n]
active. inactive, constant
check, ok, bad, update
Initialize once after compilation a[1] .. a[n]
First whenever parameters are a[1] .. a[n]
changed (e. g. during
calculations)
Derivatives during fitting, after calling x, a[1] .. a[n]
the function’s main part dyda[ 1] .. dyda[n]
Last when calculations are a[1] .. a[n]
through
function’s main during fitting and other x, y, a[1] .. a[n]

part

calculations

Note that in addition to the specially predefined variables and constants, all procedures (as well as the
function’s main part) can use the general predefined variables, constants, functions and procedures listed

in Appendix A.

General comments about programming

Types

The proFit definition language supports the following types for variables:
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1. Smple numeric types.

real, extended, integer, longint, or boolean. These types are not distinguished by pro Fit and are
implemented as floating point numbers.

The boolean value true is represented by the real value 1.0 and false by 0.0. All non-zero values are
interpreted as true in a boolean expression.

Most Pascal compilers on the Macintosh distinguish between the floating point types extended, double
and real, which have different accuracy. All smple number types of the proFit definition language have
extended accuracy. The accuracy and range of numerical valuesin proFit isgiven in Appendix C.

2. Complex type:

The Complex datatype is used to represent complex floating point values having areal and an imaginary
part. Example:

pr ogr am Conpl exTest ;
var c: Conpl ex;

begi n
c:= -1
witeln(sqgrt(c));
end;

The above program recognizes that sgrt is called with acomplex argument. Therefore, a complex version
of the square root function is used, which can handle sgrt(-1). The output of the above programiis:

0.000 + i * 1.000

Type conversion from real (or other simple numeric types) to complex is automatic. For converting
complex numbersto real, use one of pro Fit's predefined functions, such asabs, phase, re, im
(see Appendix A). To define complex numbers, use the predefined function conpl or the predifined
congtanti i , which fulfillssqr (i) =- 1.

All predefined functionsin pro Fit, suchassi n, cos, gamm, erf, etc. automatically become
complex valued functions if they notice that their argument is a complex number, and return complex
numbers as a resullt.

2. Matrix and Vector types.

TheMatrix and Vector datatypes are used to represent 2 dimensional and 1 dimensional arrangements
of complex floating point values.

program Matri xTest ;
var m matrix[2];

begi n
m:=nmatr2(1,2,ii,-ii);
witeln(sqgr(m);

end;

The above program recognizes that sgr is called with a matrix argument. Therefore, a matrix version of
the square function is used. The output of the above programiis:
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{{1.00 + i * 2.00,2.00 - i * 2.00},{1.00 + i * 1.00,-1.00 + i * 2.00}}

Type conversion from real or complex to matrix or vector. To define matrices, use the predefined
functionmatr2, matr3, matr 4.

All mathematical calculations will autmoatically recognize matrix and vector types, and interpret them
correctly when it makes sense.

4. Sring and char types:

Use the type Char for representing simple characters, String for representing strings of up to 255
characters. Example:

program Stri ngAndChar Test ;
var c: Char;

s: String;
begi n
c:="'x",;
s :="hi there';

witeln(c); {wites "c"}
witeln(s); {wites "hi there"}

s:=s + "', Joe'; {s nowis "hi there, Joe"}
c :=5s[2]; {cnowis "i"}
end;

Conversion between Strings and Chars is automatic. For conversion between Char (ASCII values) and
Integer use the functions Or d and Chr . For conversions between Strings and numbers, use
Nunber ToSt ri ng and St ri ngToNunber .

To access the n-th character inastring s, use s[ n] . In other words, strings are arrays of type char.
Thefollowingisalist of the most important functions for working with strings:

Lengt h Returns the length of a string.
Pos, Delete Find/ delete a sub-pattern in a string
Upper Stri ng, Convert between upper and lower case strings.

Lower String
See Appendix A for acomplete list.

Arrays
pro Fit allows the definition of one-dimensional arrays. The following syntax is used:
var name: array[ minindex.maxindex] of type;

Where name is the name of the array, minindex is its minimum index, maxindex is its maximum index,
typeitstype. Since types areignored by pro Fit, you can omit "of type" in the declaration.

To access an array, use the syntax:

name| index]
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Example:

var arrl: array[1l..10] of real;
arr2: array[0..100];
[

for i :=1to 10 do arr1[i] := O;
arr2[33] := 22.1;
Note: the maximum size of all variablesin avariable list islimited to 32 kBytes. Thislimitsthe size of an

array to about 2700 entries for the FPU version of pro Fit, to about 3200 entries for the non-FPU
version, and to about 4000 entries for the Power Macintosh version.

Multi-dimensional arrays are not supported.

Note that arrays are a general purpose object, and should not be confused with the built-in vector types
that only support vectors of length 2, 3, and 4, and that are mainly used in conjuction with the matrix
types to perform matrix and vector operations.

The compiler

When adding a definition to the list of functions or programs of proFit, the definition text is translated
into machine code that can be executed by your computer. This resultsin avery fast execution speed of
programs and functions.

D D
functions programs
y := a[1]*sin(x) for i:=1 to 10 do

data[i,1] := 0;
compiler
code
00FA 20C3
3008 299S
8001 FF29

The trandation of your definitions into machine code is carried out when you choose Add to Menu from
the Prog menu or if you click the button "Add" in the toolbox of the function window.

Any changes that you make to your definition after compilation will not affect the function or program as
it was added to proFit’s menus. To update your changes, you must choose Add to Menu again.
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Comparison to standard Pascal

The programming language used to define functions and programs in proFit is closely related to the
Pascal programming language. However, to keep it ssimple and to allow the generation of fast code, some
restrictions are present. However, there are also some extensions with respect to standard Pasca. The
most important differences to standard Pascal are:

* You cannot define your own data types.

* All numeric types (except complex) are interpreted as floating point numbers. Boolean expressions
are evaluated as floating point numbers (a 0.0 representing f al se, any non-zero value representing
t rue). No records, structures, or pointer s are supported.

Arraysare one dimensional.

Case statements are not supported.

Nested declarations of functions or procedures are not supported.
Optiona parameter predefined procedures and functions are supported.
A genera purpose complex type is supported.

General purpose matrix and vector types are supported.

External functions and programs

Even though proFit’s definition language is very powerful, it does not offer the full versatility of a
special purpose programming language. It only supports one dimensional arrays(except dat af i, ]),
records, pointers, etc. In addition, it does not support access to the Macintosh toolbox routines. If you do
need any of these features or if you want to write alarge program or function for pro Fit where execution
speed is crucial, you should write your definition in any compiler of your choice and add the generated
code to proFit. This process is called ‘writing an external module’. See Chapter 10, “Working with
external modules’ for details.

Debugging Window

pro Fit provides a powerful debugging environment for the development of your programs and functions.
For using this environment, check the option "Debug" at the top of its window. When you run the
program or function, its debug window will show up:
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Oebugging Window

[(Step Into | [Step Over | [ Stepout J [ Run | [ kin__J |2

Calling sequence ¥ariables

prime : Main R L s e
[+ global Data I
g by ‘clicked'
shape "
M | i 0
— i 0
E-E 0

Source Program of Factorize

- if i»1 then Factorize_Deep(i, i);
- wWriteln;

- end;

- end;

procedure Initialize;
- begin
- AddCornmand{command ‘Factorize') ;
- end;

— |4 begin
- GetTaq( program ', tag ‘msgwhy’, stringvalue magwhy);  {why this program was calle
] GetTag) program ', tag ‘msg0wnery indow, walue myw'indow ) ;{the window the program
- it mag by = ‘opened’ then {if the file has been opened}

beqgin
- Set'windowPropertiestwindow mywindow , visible false); {do not show the window on
- dddCommand{command ‘Factorize') ;
- writelni ‘Choose “Factorize” from the Prog menu.'y;
- end =
- elze if msgwhy = ‘command’ then {the comrmand has been chosen from the |«

M | [ 4]

Now, you can step through your program, view and modify its variables, set breakpoints, etc.

Initially the program stops at the first line of code that is executed. (Note: Some parts of your program
may already be called right after compilation, such as the procedure | ni ti al i ze. In this case, the
debugging window will come up right after compilation to let you debug these parts of your code.)

The debug window has four parts:

- At the very top, there's a button bar. The significance of each button is explained below.

- At thetop left, the “ Calling sequence” is shown. It shows through what chain of procedures and
functions pro Fit went in order to reach this particular point in your code. Note that you may step
through more than one of your programs and/or functions, in the case they call each other.

- At thetop right, the variables that are valid at this point are displayed. Y ou can watch and modify their

values. Just double-click avalueto changeit. Clicking onto the small triangles lets you view the
elements of arrays and matrices.

156  Defining functions and programs



- At the bottom, the source of the program or function is displayed, with an arrow showing the current
location.

The buttons at the very top let you control operation of the prosecution of your code:

- Click Step Into or Step Over for advancing one step in your code. When you click Step Into and
the next step isalocal function or a procedure, pro Fit steps into this procedure and stops at the first
instruction there. If you click Step Over and the next step is afunction or procedure, pro Fit will
execute it and stop again right after. If the next step is not afunction or procedure, Step Into and Step
Over just advance by one step.

- Click Step Out if you arein the midst of alocal function or procedure and you want pro Fit to stop
when execution returns from this function or procedure, i.e. you do not want to stop again until the
function or procedure is terminated.

- Click Run to continue operation to the next breakpoint or (if there is no more breakpoint) to the end
of your code.

- Click Kill to abort execution of your function or program.

Y ou can set “breakpoints’ by clicking into the left margin of the source code in the debug window. Red
dots mark the breakpoints. To remove a breakpoint, click it again. When you run a program or function
and pro Fit encounters such a breakpoint, execution is interrupted and the debug window comes

Using pro Fit Modules

After you have added a function or program to the menus, you can save its compiled code as a separate
file for later use. Thisfile is called a module because it is a self-contained unit that can be used to
customize proFit’s menus.

Y ou can a so create modulesin an external compiler. These modules are called external modules. proFit
comes with a set of external modules for different tasks. Y ou can use them to add functionality to your
copy of proFit according to your needs. See Chapter 10, “Working with external modules” for an
explanation on how to build external modules.

This section explains how to use such modules.

) _ Lininterpol..
Saving functions and programs

Slow...
To save a function or program as a module, choose Save User Function...
M odule from the Customize menu to see a submenu with all
the functions and programs that can be saved as modules. test..

User_Program...

This sub-menu has two sections divided by a horizontal line. The first section lists the functions, the
second section the programs. Choose the function or program you want to save as amodule, and proFit
will ask you where you want to save it. Note that you can only save functions and programs that you
compiled in pro Fit — you cannot save built-in functions or external modules.

The resulting file is a proFit document. You can load it by using the Load Module command or by
double clicking it from the Finder.

L oading functions and programs

Choose “Load Module...” from the Customize menu to load a module. You are asked to locate the
module.
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The command “Load Module...” can also be used to load compiled Apple Scripts. See Chapter 11,
“Apple Script” for details.

Removing functions and programs from the menus

To remove afunction or a program (or an Apple Script) from pro Fit's menus, choose “Remove from
Menu” from the Customize menu. A submenu lists all the functions and programs that can be removed
from the menus. Select the name of the function or of the program you want to remove.

Note: you cannot remove any of proFit’s built-in functions (Spline, Polynom, etc.).

L oading modules automatically on startup

Imagine you have one or more modules or Apple Scripts that you use often. Y ou can make them available
automatically whenever you start proFit.

Put the modules you want to add permanently to proFit into a folder named “pro Fit Modules’. This
folder must be located in the same folder as proFit’ s or in the Preferences folder of your System Folder.
(When you create the folder “pro Fit Modules’, type the name exactly as given here, otherwise proFit
will not find it.)

Whenever proFit starts up, it checksif afolder named “pro Fit Modules” islocated in the same folder
as the application itself and tries to load all modules it finds there. Then proFit looks for afolder “pro
Fit Modules™ in the Preferences folder of the System folder and again tries to load all modulesit finds
there.

If you are running proFit directly from a server, the modules found in the “pro Fit Modules’ folder in
the application folder on the server will be available to all users, the modulesin the “pro Fit Modules”
folder of your system’s Preferences folder will only be available to you.

L oading a set of modules together with a new preferencesfile

In multi-user environments different users might want to use the multi-preferences-file mechanism
provided by proFit.

The proFit preferences file holds the default settings and other information for many proFit’s options.
Different users may want to use different preferences files. proFit normally uses the preferences file
found in the Preferences folder inside your System folder. It is possible, however, to start proFit by
double clicking another preferencesfile, or to switch to anew preferences file while proFit isin use by
choosing Pr efer ences... from the File menu. This allows each user to use his own set of preferences. See
Chapter 13, “Preferences’ to learn how to use preferencesfiles.

pro Fit provides a mechanism that allows users to load their favorite modules together with their
preferences file: whenever a preferences file is opened, proFit looks for a folder named “pro Fit
modules’ in the same folder as the preferencesfile and loads all the modulesit contains.

To take advantage of this mechanism, smply put your preferences file and pro Fit Modules folder inside
acommon folder.
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Whenever proFit opens the preferencesfile, it also loads al the modules found in the “pro Fit modules”
folder.

Attaching programs

Programs can be attached to drawing windows. Such programs are called whenever there is a user-
interaction with drawing windows, e.g. when they are clicked, opened, closed, etc. Thisfeatureis useful
when using the drawing window to design an interface for a program. The attached program can then
read the actions of a user, and interpret them.

To attach a program to a drawing window or to modify an attached program, bring the drawing window
to front, choose Getlnfo from the File menu and check “Show program window”. Then click OK.
Alternatively click into the drawing window while holding down the control key and choose “ Show
program window” from the contextual menu. A window with the source of the attached program

appears.

Once you have defined the program, choose “Compile” from the Customize menu. The program is
compiled and its code is attached to the window.

A program attached to a window (an “attached program”) communicates with pro Fit using tags (see
below). An attached program should always check itstag nsgWhy to find out why it was called. If this
tag contains an unknown stringValue, the program should do nothing. Otherwise, it should take some
action according to its needs.

The following code-snippet retrieves the “nmsgWhy” tag:
var nmsgWhy: String;

Get Tag(program'', tag 'msgWhy', stringVal ue nmsgWy);
Thetag nsgWy can currently have the following stringValues:

"clicked : The drawing window was clicked. In this case the tag
“msgShape” will haveast ri ngVal ue set to the name of the
clicked shape (if a shape was clicked) or will have an empty
stringValue if no shape was clicked. Thetags' nsgCl i ckedX
and' nsgd i ckedY' contain the clicked coordinates.

‘control clicked : A control shape was clicked successfully. In this case, the tag
'msgShape’ has astringVaue set to the name of the clicked shape,
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‘control keydown start':

‘control keydown end':

' opened' :
'save':
"cl ose':

" comand' :

"idle':

Thetags' nsgCl i ckedX and' nsgCl i ckedY' containthe
clicked coordinates.

A control receives keyboard input. This tag message is sent before
the key is processed. In this case, thetag ' msgShape' hasa
stringValue set to the name of the shape, The tag
" megChar Code' hasastringValue of length 1 giving the char
code of the pressed key. (For easier comparison there are the
following charCodes constants predefined: char Home,
char Enter, charEnd, charBackspace, char Tab,
charLf, charPageUp, charPageDown, charCr,
charEsc, charArrowLeft, charArrowRi ght,
char ArrowUp, char ArrowbDown, char Del et e. Thetag
' msgKeyCode' has astringValue of length 1 giving the key
code of the pressed key. Thetag' msgModi fi ers' hasavalue
set to the keyboard modifiers (it tells, e.g. if the option-key was
pressed). Y ou can change the nsgChar Code, nsgKey Code and
nmsgModi f i er s tag to change the keyboard event before it is
processed. (For easier comparison there are the following
modifier codes predefined: modButt onSt at e,
mod Command, modShi ft, modAl phalLock,
nodQOpt i on, nodContr ol .) You can set nsgChar Code to
an empty string to suppress the event.

A control has received keyboard input. Called after the key is
processed. Same parameter as for message “cont r ol
keydown start”.

The drawing window was opened.
The drawing window will be saved.
The drawing window will be closed.

A command added by the procedure AddCommand has been
caled. The tag “nsgCommand” contains the name of the
command.

The program is being called because the value in its property
"idleCall Ti me' corresponds to the present value of
TickCount.

In addition to the tag “ns gWhy ", attached programs can always rely on the presence of the
" msgOaner W ndow : Thevaue of thistag isthe ID of the window to which the program is attached.

An attached program should therefore look like this:

program att ached;

var nsgWiy: String;

begi n

Get Tag( program '

if msgWy = ...

end;

t hen

, tag 'msgWhy', stringVal ue nmsgWy);

check here for known tags
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It is aso possible to attach a program from another program using the call At t achPr ogr am

Working with control shapes

As explained in Chapter 7, drawing windows can contain “control shapes’, such as buttons or
checkboxes. The following isalist of all control shapes and of the most important properties they have.
These properties can be read by calling Get ShapeProperty and modified through

Set ShapePr operti es.

[ ]Checkbos

i3 Radio button

Text field

Static text field

Buttons: These are simple objects that hilite when clicked.
Properties:
acti ve: Settotrueif the button can be clicked. Set to falseif itis
grayed and cannot be clicked.
val ue: Usualy 0. Set to 1 for hiliting the button.

t ext : Thetext that appears in the button.

Checkboxes: They automatically change their state when they are
clicked. Properties:
act i ve: Settotrueif the checkbox can be clicked. Set to false if it
is grayed and cannot be clicked.
val ue: 0if not checked, 1 if checked.
t ext : Thetext that appears beside the checkbox.

Radio buttons: They are checked when they are clicked. They
usually come in groups. The program that manages the radio buttons
isresponsible for unchecking all other radio buttons when one radio
button is clicked. Properties:

act i ve: Settotrueif the checkbox can be clicked. Set to false if it

is grayed and cannot be clicked.
val ue: Oif not checked, 1 if checked.
t ext : Thetext that appears beside the radio button.

Text fields: These are shapes that contain editable text. Generally,
text fields can be edited.
acti ve: Settotrueif thefield can be edited. Set to faseif it
cannot be edited.

val ue: The numeric equivalent of the text appearing in the field.
Usethefunction | nval i d to check if the text correspondsto a
value number.

t ext : Thetext that appearsin the edit field.

Static text fields. These are shapes that contain non-editable text.
Properties. same asfor text fields, except that active has no influence
on the shape’ s editability.
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- = Popup menus. Popup menu shape have severa “values’ which can
Popup | item 1 o be selected by choosing them from a pop-up menu. Properties:

acti ve: Setto trueif the pop-up can be clicked. Set to faseif it
cannot be clicked and is grayed.

val ue: The currently selected item in the pop-up menu. 1 isthe
first item, 2 the second item, etc.

t ext : Thetext that appearsto the left of the pop-up.
nmenul t ens: The menu items, separated by semicolons.

Wells: These shapes are usually used as background for other
objects, e.g. agraph. They consist of awhite rectangle.

For further properties that you can use for controlling these shapes, see the description of
Get ShapePr operty and Set ShapePr operti es in Appendix A.

To use control shapes, you first must draw them in a drawing window. Then you write a program that
manages them and attach it to the window. Finally, you must switch the window to “dialog mode”. The
following is a simple example that shows this procedure.

1. Open a new drawing window and create a button named “ Multiply”

To do this, choose the button tool from the windows toolbox. Then
click into the drawing window. A dialog box appears where you can
define the text that appears on the button. Y ou can also define a name
for the button, that we will later use for accessing the button from a
program. In this example, set the button text to “Multiply by 2" and its
name to “Button”. Button tool

.

A
p
o

*

% O 0

-8,

Control Shape 5Settings

Shape name !Buttun

Title |Multiply by 2

] Default button

| Cancel I

Click OK, and the button will appear in the drawing window.

I Multiply by 2 I

2. Create an edit field named “Number”
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Now, click the button tool again and hold the mouse down ~ Button
until a poup menu appears. Choose “Text Field”. Now, click Checkb
into the drawing window and enter “Number” for the shape's EF o
name. Then click OK. Radio Button
Y ou now should have a drawing window with an edit field and ;I:Htt- Flfmt Field
abutton. Arrange these items as you wish, then save thefile, atic 1ext rie

_ _ _ - Popup Menu
The window might e.g. look like this: Well

# Simple button example = H B

[ Multiply by 2

S

¥:5.821 ey 5009 em [ [ 4 | ]

3. Switch the window to dialog mode

To do this, hold down the control key while clicking Help
anywhere into the window and choose “Display As -
Dialog”. Alternatively, choose “Get Info...” from the Close Window

File menu and check the option “Display AsDialog”. Display As Dialog
‘ Show Program Window

The window now looks like adialog box.

O

B

| Simple button example

| Multiply by 2 |

4. Attach the program
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To attach the program, again hold down the control key while clicking anywhere into the window and
choose “ Show Program Window”. Then, enter the following program:
program att ached,;
var nmsgWhy: String;
msgShape: String;
x: real
begi n
Get Tag(program'', tag 'msgWhy', stringVal ue nsgWy);
if msgWiy = 'control clicked then

begi n
CGet Tag(program'', tag 'msgShape', stringVal ue nsgShape);
i f megShape = 'Button' then
begi n

X := CGet ShapeProperty(' Nunber', val ue);
if not Invalid(x) then {if valid nunber}
Set ShapeProperties(shape ' Nunber', val ue x*2);
end;
end;
end;

Hit Command-L to add the program to the window.
Now, your “dialog box” isready to use. Enter anumber in the edit field, then hit “Multiply by 2”.

Notes:
- If you want to modify the items in the dialog window, switch it back into drawing mode. To do this,
hold down the control key and choose “Display As Drawing”. For changing the text of a shape or
its name, double-click it. Alternatively, select it and choose “ Shape Settings...” from the Draw menu.

- Asashortcut, you can change some properties of the items when the window is till in dialog mode.
To do so, hold down the command key and double-click the item you want to modify.
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10 Working with external modules

This chapter explains how to add external modules to proFit. External modules are documents
containing the computer code for afunction or program.

pro Fit comes with a number of ready-to-run external modules containing useful functions or programs.
The next section tells you how you add them to proFit.

See the sections “Creating an external module” and “Writing an external module” for a detailed
explanation of how to create your own external module.

Loading an external module

To add an external module to proFit:

1. Select Load Module from the Customize menu.
Y ou are asked to locate your module:

2. Choose the external module you want to load and click “Open”.

proFit checksif an external module can be found in the file you have selected. If yes, it isloaded. If
the moduleisafunction, it is added to the Func menu. If it isaprogram, it is added to the Prog menu.

Instead of loading a module by choosing Load Module, you can double-click itsfile. (For this, the ‘file
type’ and ‘creator’ of thefile must be *ftCD’ and *NLft’, respectively).

An important note for Power Macintosh users.
If you have loaded a module and you subsequently change it (e.g. by recompiling it) you
must remove the loaded module from proFit before loading its new version.

To load your modules automatically at start-up, put them into afolder called “pro Fit Modules’ located
in the same folder as the application itself or in the Preferences folder of the System folder. See the end
of Chapter 9, “Defining functions and programs’, for a more detailed discussion of how to work with
pro Fit modules.

Therest of this chapter explains how you can write external modules using your own compiler.

Creating an external module

Y ou need the following to write an external module:
* Some experience in programming.
e A compiler (such as Metrowerks® Pascal, Metrowerks® C/C++, or the Macintosh Programmer
Workshop™ (MPW)). Y our compiler must support the generation of shared libraries.

To create an external module, proceed asfollows:

1. Choose a stationery file to start from and save it under a name of your choice
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In your proFit distribution package, you will find a number of stationery (template) files that contain
“empty” functions or programs:

Pr ograniTenpl ate. c for creating an external program in C
Functi onTenpl ate. c for creating an external function in C
Pr ogr anTenpl ate. p for creating an external program in Pascal
FunctionTenpl ate. p for creating an external function in Pascal

Open the stationery from your programming environment and save it under a name of your own (e.g.
“Xxx.c”).

Note: you should never modify the files ProgramTemplate.c/p or FunctionTemplate.c/p directly —
awayswork on acopy.

. Complete the code

Since the stationery files only contain empty routines, you must fill in your code. The following
section “Writing external modules’ tells you how to do this.

. Build your code

Note that in addition to the code defined in your file, you must also compile the file
“proFit_interface.c” or “proFit_interface.p”, respectively, which contains glue code for calling
proFit’s routines.

If you are using C, please note that “proFit_interface.c’ as well as your own source file xxx.c
#include the files “proFit_interface.n” and “proFit_paramBIk.h”. Therefore, these files must be in
the “ search path” of your compiler (they could e.g. reside in the same folder asthe ...c files).

If you are using Pascal, note that your own source file “uses’ the unit proFit_interface defined in
proFit_interface .p.

. Build the module

The module should be created in afile having the type “ftCD” and the creator “NLft”.

Set your compiler/linker to build a “shared library” or “import library”. The entry point of your
module is the function “main”, which must be exported from your library. Consult your compiler’s
manual on how to export symbols from alibrary. (The example source files contain compiler options
for exporting “main” in one of Metrowerks compilers. Note that these compiler options may not
work correctly with other compilers.)

. Link the module to pro Fit

To do this, either double-click the file you have built or load it from proFit by choosing Load
Module... from the Customize menu.

The following gives some hints for creating modules with some of the most common compilers. Note
that there are sample “ project” and “make” included with the pro Fit package.

M etrowerks Code Warrior Profor Power Macintosh

If you are using Metrowerks Code Warrior Pro or the Power Macintosh, create a project with the files:

Mat hLi b Mathematical routines
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MSL RuntimePPC. lib runtime library for Metrowerks projects

InterfaceLib system routines
proFit_interface.c glue for interfacing with pro Fit
XXX. C Declaration needed to define a pro Fit function

MathLib, MSL RuntimePPC.lib and Interface.lib came with your copy of the Metrowerks C/C++
compiler, proFit_interface.c can be found in your distribution package. “xxx.c” is your source code
created from “ProgramTemplate.c” or “FunctionTemplate.c”.

Make sure that the files “proFit_interface.h” and “proFit_paramBlk.h” reside in the same folder as
your project.

Many mathematical functions (such assin(), log()) are not part of the standard C function set. In order to
use them, use <fp.h> and <fenv.h> (the header files for the Power Macintosh numerics environment).

MPW C/C++ for Power Macintosh

If you are using the MPW compiler for the Power Macintosh, you will find an example for a “make”
file on your distribution disks.

Writing an external module

Note once again that the size of the floating point type ‘ extended’ (or double in C) must be
the correct one for the version of proFit you are working with. For the FPU versionitis 12
bytes, for the non-FPU version 10 bytes, and for the Power Macintosh version 8 bytes.

To write your external modules, start from a stationery file (ProgramTemplate or FunctionTemplate) as
shown above. These files contain some routines that you will have to modify.

Routines to be modified

The following table lists the routines defined in ProgramTemplate.c/p and FunctionTemplate.c/p that can
or should be modified by the user. Functions or procedures that are only used by advanced programmers
are marked with a T

function nane modify if defining a
Set Up program or function
d eanUp T program or function
InitializeProg T program
Run program
InitializeFunc T function
Func function
Derivatives function
First T function
Check T function
Last T function
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In the following section, we will first describe the routines Set Up and Cl eanUp that are used for both
types of modules. Then we discuss the routines only used in external programs, then the routines only
used in external functions.

Note for Pascal programmers:
In ProgramTemplate.p and FunctionTemplate.p you will find a procedure with the name nai n.
L eave this procedure unchanged — it provides the glue between proFit and your routines.

Note for C programmers:
The following function definitions are given in Pascal. If you are programming in C, you should
keep in mind that wherever avar parameter is passed in Pascal, the corresponding pointer is passed
in C. If the description text e.g. saysthat “avalue of 1.0 must be returned in the variabley”, the C
code should assign 1.0to*y, i.e. *y = 1. 0. Further differences between the definitionsin C and
Pascal will be highlighted along the way.

All the following routines have a parameter called pb. It is a pointer to a record (struct in C) of type
Ext Modul esPar amBl ock. Most users won't need the information stored in it. Advanced
programmers can refer to the section “ Global variables’ for more information about data to be accessed
through pb.

Routines to be defined in functions and programs

Set Up procedure SetUp(var nodul eKi nd:integer; var nane: Str255;
var requiredd obals: |ongint; pb: ExtMdul esParanBl ockPtr);

Thisroutineis called when your moduleis linked to proFit. It must return the following values:

* nmodul eKi nd must be set to the constant i sPr ogr amif your module is an external program, and
toi sFunct i on if your moduleisan external function.

* nanme must be set to the name of your module. If you are programming in Pascal, you can simply
assign astring to it:
nane : = 'nyNane'

If you are programming in C, you must make sure that you return a Pascal string. For this purpose,

you can use the function Set Pascal Str that is defined in proFit_interface.c:
Set Pascal Str( nane, "\ pnyNane", 255) ;

(The last parameter is the maximum length of the resulting string.)

* requi redd obal s should usually be set to 0. Advanced programmers can set it to the size (in
bytes) of aglobal data buffer they want to have allocated. If r equi r edd obal s isreturned with a
value > 0, proFit allocates a block with the corresponding number of bytes and stores a pointer to it
in pb”. gl obal s (inC: pb->gl obal s). pb is a pointer to a record called
Ext Modul esPar anBl ock and is passed to al routines called by proFit.

Note that memory allocated in this way is deallocated automatically when your module is unlinked
from proFit —you must not deallocate this memory yourself!

Cl eanUp procedure Cl eanUp(pb: ExtMdul esParanBl ockPtr);

CleanUp is called when proFit is quitting or when your module is removed from proFit. In most cases,
you won't have to do anything here. Advanced programmers may wish to deallocate some special
memory, to close a port or to clean up other stuff here.

Routines to be modified in external programs only
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InitializeProg procedure InitializeProg(pb: ExtMdul esParanBl ockPtr)

Thisroutineis called before a program is run for the first time. Most users can leave it empty. Advanced
programmers may wish to alocate some memory, open aport, initialize global (static) variables, etc. here.

Run procedure Run (pb: Ext Modul esParanBl ockPtr)

Thisroutineis called when your program is executed. It should hold your program’s main code.

Routines to be modified in external functions only

An important note about parameter indices. When accessing arrays that hold values, names,
etc. of the parameters, suchasali], a0.nanes”[i], node[i], dydalil],the
index i rangesfrom 1to 64 in Pascal, but from0to 63in C

InitializeFunc procedure InitializeFunc(var hasDerivatives: bool ean;
var descr 1stLine, descr2ndLi ne: Str255;
var nunber Of Parans: integer; var a0O: DefaultParamn nfo;
pb: Ext Modul esPar anBl ockPtr);

This routine is called once after your external function has been linked to proFit. It must return some
default values and information about the function. Advanced programmers may also use it for
initidization of global (static) variables, memory allocation, etc.

I nitializeFunc should return the following datain its parameters:

* hasDeri vat es mustbesettot r ue if you want to calculate some derivatives of your function
with respect to its parameters yourself (in the function Der i vat i ves described below). Any
derivative you don't calculate will have to be calculated numerically by proFit. If you set
hasDeri vates tof al se, al derivatives will be calculated numerically and the function
Deri vat i ves will beignored. (The derivatives are used for nonlinear fitting.)

e descrlstLine, descr2ndLi ne: Thesetwo strings are displayed in the parameters window
and should give a short description of your function. (C programmers should use the function
Set Pascal Str described under Set Up, above, for setting these strings.)

e nunber O Par ans: Here you should return the number of parameters of your function (up to 64).

» a0: Thisisarecord (in C: a pointer to a struct) that defines the default values, modes, names and
limits of your parameters. Y ou can leave this record unchanged if you want to use the default values.
The following table lists the values that can be set in a0 for each parameter i:
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Pascal notation 1) C notation 2) contains

a0. val ue”[i] (*a0->value)[i] Default value

a0. node”[i] (*a0->node) [i] Default mode, setto act i ve (varied during
fitting), i nact i ve (not varied during fitting), or
const ant (cannot be fitted)

a0. nanme”[i] (*a0->nanme) [i] Parameter name, a Pascal string of length
maxPar am_engt h. 3)

a0. | owest [ ] (*a0->l owest)[i] The lower limit for a parameter. By default, this
value is -INF.

a0. hi ghest[i] (*a0->hi ghest)[i] The upper limit for a parameter. By default, this
value is INF.

1) In Pascal, indices for these arrays run from 1 to 64
2)  InC, indices for these arrays run from 0 to 63

9 ¢ programmers should set the name by calling the function Set Pascal St r with a maximum string
length of maxPar anlengt h. Example:
Set Pascal Str((*a0->nane)[0], "\ pname", naxParanNanelLength);

Func procedure .i.Func; (x:extended; a:ParanArray;
var y:extended; phb: ExtMdul esParanBl ockPtr);

This procedureis called to calculate the return value of your function. It has the following parameters:
» X: Thefunction’sindependent variable.
e a: Thefunction’s parametersal i | . Notethat theindex i rangesfrom 1in Pascal but from0in C.
* y: Thefunction’'s return value to be calculated from x and a.

Derivatives procedure Derivatives (x: extended; a: ParamArray; var
dyda: ParamArray; pb: ExtMdul esParanBl ockPtr);

This routine calculates the partial derivatives of your function with respect to its parameters. Y ou can
leave this routine empty if you don’'t need it, or you can calculate only some derivatives. Y ou don't need
to calculate al of them. proFit will check if you did not calculate a derivative and will calculate it numeri-
caly. SethasDeri vati vestofaseinl nitial i zeFunc if you are sure that you will never want to
calculate any derivatives yourself. (Note that acall of Der i vat i ves with agiven x-value is always
preceded by acall of Func with the same x-value — therefore, you might save atemporary result in Func
for later usein Der i vat i ves. See also Chapter 9, “ Defining functions and Programs’.)

Parameters:
» X: Thefunction’sindependent variable.
e a: Thefunction’s parametersal i | . Notethat theindex i rangesfrom 1in Pascal but from0in C.
e dyda[i]: Thepartid derivativesto be returned.

First procedure First (a: ParamArray; pb: Ext Modul esParanBl ockPtr);

Thisroutineis called whenever the parameters a have changed before Func is called. In most cases, you
can leave it empty. Advanced programmers can use Fi r st for speeding up your function by evaluating
temporary results that only depend on your function’s parameters but not on its x-value (for more
information: see the description of First in Chapter 9, “Defining functions and Programs”).
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Parameters:

» a: Thefunction’s parametersa[ i ] . Notethat theindex i rangesfrom 1in Pascal but fromQ0in C.
Check function Check (ParamNo: integer; var a0O: DefaultParani nfo;
pb: Ext Mbdul esPar anBl ockPtr): CheckPAnswer ;

Check is called whenever the user has entered a value in the Parameters window. In most cases, you can
leave Check empty, returning the value good. Advanced programmers can use it for improving the
parameters window’s user interface. Applications of Check are described in Chapter 9, “Defining
functions and Programs”).

Parameters:

» par anmNo: Thisistheindex of the parameter that the user has changed (1..64 in Pascal, 0..63in C).

* a0: Thisisarecord (in C: a pointer to a struct) that defines the default values, modes, names and
limits of your parameters as they appear in the parameters window. The values that you can access or
change in this data structure are listed under theroutinel ni ti al i zeFunc above.

Check should return one of the following values:

- good if the new parameter isto be accepted

- updat e if the new parameter is to be accepted but the parameters window must be redrawn (because
Check changed some valuesin a0)

- bad if the new parameter cannot be accepted.

Last procedure Last (pb: Ext Modul esParanBl ockPtr);

Thisroutine is called whenever an operation that has used your function (such as a command for fitting)

isdone. In most cases, you can leave this procedure empty. Applications of Last are given in Chapter 9,
“Defining functions and Programs”’.

Predefined constants and types

When writing an external module, you can (and must) use several predefined constants, types and
procedures (or functions). In Pascal, they are defined in the interface of the file proFit_interface.p. In C,

they are defined in proFit_interface.h and proFit_paramBIk.h. This section describes some of the most
important things defined in these files.

The definitions in these files should not be changed. Doing so might cause
incompatibilities with the present or future versions of proFit.

Genera remarks:

» Srings passed between proFit and an external module are always Pascal strings (and not C strings).
If you are programming in Pascal, you won’t have any problems with this. If you are programming
in C, you must remember that a Pascal string must be introduced by "\ p" (example:

"\ pMyString"). For assignments, you can use the function Set Pascal St ri ng described
earlier in this chapter.
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» Records (structs) passed between proFit and an external module always use “68k-alignment”.
Therefore, for compatibility with Power Macintosh compilers, definitions for C structs are always
preceded by

#i f defined(powerc) || defined (__powerc)
#pragma options align=mac68k
#endi f

and followed by
#i f defined(powerc) || defined (__powerc)
#pragma options align=reset
#endi f

» Parameter indices under Pascal always run from 1 to maxNr Par ans, in C they run from O to
maxNr Par ans—1.

The following lists the most important constants and types.

(The numbersin curly brackets give the offset and size of some records and their components. Pascal or
C programmers won't need this information. It is provided for porting the records to another
programming language.

const
ver si onNunmber = 1;
maxNr Par ans = 64;
maxPar amNaneLength = 31,
maxNr | nput Val ues = 6;
i sFunction = 1;
i sProgram = 2;
type
i nput Rec = packed array[1l..mxNrl nput Val ues] {size 48}
of record
X: "extended; {offset 0, size 4}
s: “str255; {offset 4, size 4}
end; {field size 8, offset 8, #fields 6}
checkPAnswer = (update, good, bad); {size 1}
{update=0, ok=1, bad=2}
ModeType = (active, inactive, constant); {size 1}
{active=0, inactive=1, constant=2}
ParamNane = string[ maxParamNanmelLengt h]; {size 32}
ParamArray = array[l..maxNrParans] of extended; {size 512}
{field size 8}
{offset 8}
{#fields 64}

Par amNanmeAr r ay array[ 1..maxNr Paranms] of ParanName;
{size 2048}
{field size 32, offset 32, #fields 64}

Par amvVodeAr r ay array[ 1. . maxNr Paranms] of ModeType;

{size 64}
{field size 1, offset 1, #fields 64}
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Defaul t Param nfo = record {size 58}

val ue: ~ParanmArray; {offset 0, size 4}
| owest: ~ParamArray; {offset 4, size 4}
hi ghest: ~ParamArray; {offset 8, size 4}
node: ~ParanmvbdeArr ay; {offset 12, size 4}
name: “~ParamNanmeArray; {offset 16, size 4}

end;

Def aul t Paranml nfoPtr = 2Def aul t Par aml nf o; {size 4}

type

{paraneters for all functions calling pro Fit}

Ext Modul esPar anBl ock = record {size 4}
RunTi meProcPtr: Ptr; {offset 0, size 4}
gl obal s: Ptr; {offset 4, size 4}
ver si onNumber: i nteger; {offset 8, size 2}
nodul eKi nd: i nteger; {offset 10, size 2}
codeType: integer; {offset 12, size 2}

nane: Str 255; {offset 14, size 256}
requi redd obal s: | ongint;
{offset 270, size 4}

v: array[1l..30] of extended,; {offset 274,size 240}
dummy: Bool ean; {size 1}
hasDeri vati ves: Bool ean; {size 1}
descrl, descr2: Str255; {size 512}
number Of Par ans: i nteger; {size 2}
a0: Defaul t Param nf o; {size 58}
paramNo: i nteger; {size 2}
answer: integer; {size 2}
X, Yy: ”“extended; {size 8}
a: "ParamArray; {size 4}
dyda: ~ParamArray; {size 4}
gl obal Scratch: d obal ScratchPtr; {size 4}
modul eFi |l e: FSSpec; {size 70}
end;

Ext Modul esPar anBl ockPtr = ~Ext Modul esPar anBl ock; {size 4}

Ext Modul esPar anBl ockH = ~Ext Mbdul esPar anBl ockPtr ; {size 4}

The most important constants and types are the following:

ver si onNunber isthe current version of the proFit interface.

maxNr Par ans isthe maximum allowed number of parameters, maxPar anNaneLengt h isthe

maximum length of a parameter name for afunction.

i sFuncti on, i sProgramarepossibletypesof amoduleto bereturned by Set Up described

above.

maxNr | nput Val ues isthe maximum number of input variables for the function | nput Box

described below.
I nput Rec isthe parameter to the function | nput Box described below.
checkPAnswer isthetype of the return value of the function check described above.
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* ModeType describes the mode of a parameter, as explained in Chapter 9, “ Defining functions and
programs’.

« Par amNane holds the name of a parameter asit gppearsin the parameters window.

e Par anArr ay, Par amvbdeAr r ay and Par amNaneAr r ay are the arrays with the parameters
values, modes and names.

» Def aul t Par am nf o contains al the arrays with theinitia values, limits, modes, and names of the
parameters.

» Ext Modul esPar anBl ock: Thisrecord contains low-level parameters to be passed between an
external module and proFit. In most cases, you will not need the information stored here. There are
only two fields that you might find useful: v and gl obal s. These are described in the following
section “Global variables’.

* gl obal Scr at ch: A pointer to a data area shared by al modules, internally defined functions and
programs, aswell as external modules. From programs and functions defined within pro Fit, you can
access this area through the predefined array gl obal Dat a[ 0. . 99] .

* nodul eFi | e: A file specifier for the file that the module isin. You can e.g. use this specifier for
accessing aresource stored in your module.

Global variables

Global variables (or static variables, as they are often called by C programmers) are variables that remain
statically in memory. Their values are preserved between individual calls to your module.

If you are programming for the Power Macintosh, you can define global variables in the way you are
used to: In Pascal, you declare them globally within your unit —in C, you declare them outside your
functions or, if you declare them inside afunction, you declarethem asst at i c.

Therecord Ext Modul esPar anBl ock provides a method for storing global, static data that works on
al compilers:

Each externa module has its own record (struct) of type Ext Modul esPar anBl ock. A pointer to this
record is passed to your procedures and functions in the parameter pb. There are some fields in this
record that you can use for your own purposes. Data stored there is preserved between individual callsto
your functions:

» Oneof thesefieldsisthe array of ext ended valuespb”. v[ 1. . 30] (under C, thisisan array of
doubl e values, pb- >v[ 0. . 29] ). You can use this array for your own purposes—it is not used by
proFit.

» The second such field isthe pointer pb”. gl obal s (under C, pb- >gl obal s). If your procedure
Set Up returns a non-zero value in the parameter r equi r edd obal s, proFit will initialize
pb”. gl obal s to point to amemory block of corresponding block size (for more information, see
the description of the procedure Set Up given above). You heedto set r equi r edd obal s if you
want to usethe pb- >gl obal s poi nter.

For examples on how to use global or static data, please refer to the sample code provided on your
distribution disks.

Procedures provided by proFit

proFit offers alist of functions and procedures that can be called by your external modules. If you are
programming in Pascal, they are defined in the interface of the file proFit_interface.p. If you are
programming in C, they are defined in the header file pro Fit_interface.h. Their implementation can be
found in thefiles pro Fit_interface.p or proFit_interface.c, respectively.
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Most of the functions and procedures provided by proFit for external modules are the 1:1 equivalents of
the ones that can be used when defining a function or program with proFit’s definition language. Refer
to Appendix A, “Predefined Functions, Procedures and Arrays’ for more information on the individual

routines.
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11 Apple Script

I ntroduction

Apple Script is alanguage for scripting applications on the Macintosh. It provides acommon technique
for automating tasks, exchanging data, and process remote control.

Y ou can use Apple Script with pro Fit. Note, however, that pro Fit cannot create (i.e. compile) an Apple
Script. To use Apple Script with pro Fit, you need an Apple Script compiler, such as Apple's Script
Editor (installed together with your system software). Y ou enter the script in the script editor and compile
it there.

Once the script is compiled, you can either run it from your script editor, or you can
save it in its compiled form. (When using Apple's Script Editor, choose “Save @
As...” from the “File” menu, choose the type “Compiled script” and save the
script.) Such a compiled script can be loaded into pro Fit: Choose “Load
Module...” from the Customize menu and select the compiled script. It is added to
the Prog menu.

carmnpiled script

In the following, we give some examples for scripting pro Fit through Apple Script. Then we discuss the
differences between programs and scripts.

For alist of al Apple Script classes and methods supported by pro Fit, read pro Fit’'s dictionary from
your Apple Script compiler, e.g. by choosing “Open Dictionary...” from the File menu of Apple’'s
Script Editor.

There is an Apple Script equivaents for most commands of pro Fit’s built-in compiler. Appendix D of
this manual provides a cross reference between the commands of pro Fit's compiler and the
corresponding operations in Apple Script.

Apple Script is avery powerful programming language. However, it may be confusing for
the beginner. The easiest way to get started is using Apple Script's “recording”
capabilities. Just open the Script Editor and click the Record button. Now go into pro Fit
and do (by hand) what your script is supposed to do. Script Editor records al your actions

o as Apple Script commands. Once you are through, go back to Script Editor and click the
Stop button. Y our script is now complete.

Note that this chapter is not intended to give a beginner’ sintroduction to the Apple Script language. We
will, however, explain some its aspects as we use them. To learn more about Apple Script, consult the
dedicated literature, such asthe “Apple Script Language Guide” distributed by Apple.

Examples

Opening and closing a single file
Thefollowing isavery smple Apple Script for opening and closing asinglefile:

tell application "pro Fit"
open file "measured data" -- open a file
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run program "Analyze" -- analyze it
close window "measured data" -- close it
end tell

The script starts with the statement tell application "pro Fit" which indicates that all subsequent
statements (until end tell) are to be sent to pro Fit. The following lines tell pro Fit to open afile called
“measured data’, run the program “Anayze” from the Prog menu, and then close the file again.

To use this script, you must enter it in a script editor, such as Applée' s Script Editor:

[}‘- Description...
Lo | [ ] ]
Fecord  Stop Fun Check Syntax
tell application "pro Fit 5.5.[1"
open file "measured data” - - ooen s File
Fun program "&nalyze” - - snalvze i
cloze window "measured data™ - - close i
end tell
N
[+ |
hppleSeript M | 4 | k|

When you click Run, the script is compiled and then executed. When compiling the script, the statements
are converted into Apple Events, data packets that can be exchanged between applications. When running
the script, they are sent to pro Fit.

As mentioned above, you can save the script as a“ Compiled Script” and then load the compiled script
from pro Fit by choosing “Load Module...” from the “Customize” menu. The script is added to the
Prog menu from where it can be run.

Batch processing

Imagine you have alarge number of datafilesin afolder. Y ou want to open each of these files from pro
Fit and analyze its data. Without scripting, you would have to open each file by hand, run your analysis,
then close it again — boring work if you haveto do it often. The following script doesit al for you:

-- bring up a dialog for selecting the folder of the files to analyze
set myFolder to choose folder with prompt "Choose a folder with data files:"

-- create a list with all files in the folder
set myFiles to list folder myFolder -- a list of files in myFolder
set myFileCount to count myFiles -- the number of files in myFolder

-- now start working with pro Fit

tell application "pro Fit"
set oldErrorAlerts to error alerts -- save error alert status
set error alerts to false -- pro Fit should not show alerts
activate -- bring pro Fit to front

repeat with ifrom 1to myFileCount -- go through all files
set theFile to item i of myFiles -- get the i-th file
try
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-- open the file for processing as data file:
open file ((myFolder as string) & theFile) as table
write line "found: " & theFile -- write comment to Results window
close window theFile saving no -- close without saving
on error errText
write line "cannot open: " & theFile & " (" & errText & ")"
end try
end repeat
set error alerts to oldErrorAlerts -- restore
end tell

This script first brings up adialog box for selecting afolder by using the Apple Script extension choose
folder with prompt. Then it goes through all the files in this folder and uses the command open file
name as table for opening the file as a data window. It also uses the command write line text for
writing atext into the resultswindow. Then it closesthefile.

The open file and close window commands are enclosed by the statements try and on error. If any of
these commands fails and returns an error, the write line statement between on error and end try is
executed.

Note that we are setting a property called error alert to false before opening the files. Thistells pro Fit
that it should not show any error aerts of its own when it cannot open afile.

The above example simply opens each filein the folder and closesit again. In practice, you may e.g. want
to run a program on each opened file. For this purpose, smply insert

run program "MyProg" -- analyze it
after the command open file, where “MyProg” is the name of the program you want to run.

The following is amore complete version of the above script. It not only runs a program on each opened
file, it also defines the program, adds it to pro Fit's Prog menu, and then exchanges data with it:

-- the following defines the pro Fit program run for each data file:
set scriptProgram to -

program ScriptProgram;

var sum, i;
begin
sum := 0;
fori:= 1 to nrRows do
if DataOK(i,1) then sum := sum+datali,1];
globalData[1] := sum; { store result }

end;

-- bring up a dialog for selecting the folder of the files to analyze
set myFolder to choose folder with prompt "Choose a folder with data files:"

-- create a list with all files in the folder
set myFiles to list folder myFolder -- a list of files in myFolder
set myFileCount to count myFiles -- the number of files in myFolder

-- now start working with pro Fit

tell application "pro Fit (ppc)"
set oldErrorAlerts to error alerts -- save error alert status
set error alerts to false -- pro Fit should not show alerts
activate -- bring pro Fit to front
compile scriptProgram -- add the above program to Prog menu
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set myTable to make new table -- open new data window
set kto 1 -- a counter for opened files
repeat with ifrom 1to myFileCount

set theFile to item i of myFiles -- get the i-th file

try
open file ((myFolder as string) & theFile) as table -- open the file
write line "processing: " & theFile
run program "ScriptProgram” -- run the program in pro Fit
close window theFile saving no -- close without saving
set sum to globalData 1 -- get result
set cell k of column 1 of myTable to sum -- store it in the table
setktok+1
on error errText
write line "cannot process: " & theFile & " (" & errText & ")"
end try
end repeat
delete program "ScriptProgram™” -- remove the program from Prog menu
set error alerts to oldErrorAlerts -- restore
end tell

The above script starts with the definition of the program to be run by pro Fit. Then it opens a new data
window and stores its reference in “myTable’. Now it opens each data file in the designated folder,
calculates the sum of the valuesin its column 1 and stores these sums in column 1 of the data window
myTable.

The script starts with
set scriptProgram to -

This statement sets the symbol scriptProgram to the text following it. The symbol - at the end of the
line tells the script editor that more lines follow (to generate this symbol, type the return key while
holding the shift key down).

The statement
compile scriptProgram -- add the above program to Prog menu

sendsthistext to pro Fit and tells pro Fit to compileit, i.e. to add it to the Prog menu.

Then, the script creates a new data window using the command
set myTable to make new table -- open new data window

The symbol myTable becomes areference to the new data window.

Now, thefiles of the designated folder are opened one by one. After afileis opened, the Scri pt Progr am
is run and the file is closed again. Then the script retrieves the result of the program from
gl obal Dat a[ 1] . The valuesin the array gl obal Dat a can be accessed from scripts by using the object
globalData and an index, such as

set sum to globalData 1 -- get result

The result retrieved in thisway is transferred to the k-th row of column 1 of the datawindow myTable:

set cell k of column 1 of myTable to sum -- store it in the table

Asyou can see, scripts can exchange data with pro Fit, either through globalData or by accessing values
in adatawindow.

There are other ways of interaction between scripts and pro Fit. They are explained in the last section of
this chapter, which lists al Apple Script commands and objects supported by pro Fit.
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When to program, when to script

Asyou may have realized, there are various things you can do through Apple Scripts as well as from a
program defined within pro Fit. For example, you could define the following program for writing the
sum of thetwo first cells of adatawindow into the results window:
program Sum
begi n
Witeln(data[ 1, 1] +data[ 1, 2]);
end;

Alternatively, you could do the same from an Apple Script:
tell application "pro Fit"
set sum to value of cell 1 of column 1 + value of cell 1 of column 2
write line sum
end tell

Even though the above examples do the same, you will prefer the program, because defining programsis
usually more convenient and faster.

In practice, you probably use programs more often than Apple Scripts. Programs can be defined within
pro Fit, they are much faster, and they are better suited for numerical applications. However, there are
some things that you simply cannot do from a program, such as exchanging data with other applications,
communicating with the Finder, batch processing a large number of files, etc. For these tasks, you can
use Apple Scripts.

Y ou can combine the advantages of Apple Scripts and programs: To call an Apple Script from a program,
first add it to the Prog menu (choose Load Module... from the Customize menu), then call it with
CalProgram( ..) . To cal aprogram from an Apple Script, compile it and use the command run program.

Apple Script methods and classes

The following describes some applications of the most important Apple Script methods and classes
supported by pro Fit. For acomplete overview, check pro Fit’s dictionary and have alook at Appendix D
of this handbook.

Some methods

open: Open the specified object(s)
open file -- list of objectsto open
[as data window/drawing window/funcProg window/text window]

If thefileisafile of type text, you can indicateif it isto be opened as text (i. e. in anew function
window) or as table (i. e. in anew data window).

Examples:

open file "HD:myData" -- opens the file "myData” on the disk HD

open file "data" as data window -- opens the (text) file “data” as data window
open file "Drawingl" -- opens the file called “Drawing” in pro Fit folder

calculate statistics: performs statistical cal culations on the given window
caculate statistics reference -- the datawindow for the statistical analysis
[column integer] -- the column for the statistical analysis. 0 to use all columns.
median boolean -- set to true to calculate median, minimum, maximum.
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basic boolean -- set to true to calculate basic statistical information.
skewness boolean -- set to true to calculate Skewness and Kurtosis.
[selected cells boolean] -- trueif statistical analysis of the current selection
[selected rows boolean] -- trueif statistical analysis must be applied

-- only to the data contained in the selected rows.

To retrieve theresults, use e.g.
get statMean of results -- returns the mean value
(Available selectors of results are listed for class " calculation results' below)

capture: Switches capturing on and off
capture constant -- to file | enabled | disabled | done
[to dias] --thefileto capture into (not used for options on | off | done)
Example:
tell application "pro Fit PPC"
capture to file "HD:logFile" -- start capturing to logFile
write line "hi there" -- will be captured
capture disabled -- disable capturing temporarily
write line "some text" -- will not be captured
capture enabled -- enable capturing
write line "add this to log file" -- will be captured
capture done -- close the capture file
end tell

close; Close awindow
close reference -- the window to close
[saving yes/no/ask] -- Specifies whether or not changes should be saved

Windows can be specified by name or index (1 is the frontmost window, 2 is the window behind the
frontmost window).

If you append the specification saving yes then al changes are saved — if the window has not yet
been saved to afile, you are asked to specify where you want to save the changes. If you append
saving no, changes are not saved. If you append saving ask or if you do not append a saving
specification and the window contains unsaved changes, pro Fit will ask if you want to save the
changes.

Examples.
close front window -- prompts for saving unsaved changes
close window "Tablel" saving no -- closes the window without saving

compile: Compile afunction or program written in pro Fit's definition language.
compile reference -- text or fileto compile

Examples:
compile file "HD:myProg" -- compiles the given file
compile "function lin; begin y:=a[l]*x; end;" -- compiles a text

the following isamore reaistic way to define and compile alarger program from a script: (note that
you can create the character "=" by hitting option-return — this character specifies that the lineis

continued on the next one):
set myProg to -
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program test;

var i, sum;
begin
sum := 0;
for i := 1 to nrRows do

if dataOK(i, 1) then sum := sum + datali,1];
writeln(‘'sum of col 1: ', sum);
end; "

tell application "pro Fit"

compile myProg -- compiles the above definition
run program "test" -- and runs it
end tell

delete: Removes a function or program from pro Fit's menus

delete reference -- The function or program to delete
delete program "FitFrontWindow" -- deletes the specified program
delete function "linear" -- deletes the specified function

do script: Compile and execute one or more Pascal statements
do script reference -- the window or the statements to execute

Examples:
do script "Writeln(‘"Hello world");" -- executes the pascal statement

make: Make a new window or shape.
make
new: typeclass -- the class of the new element: ‘table, ‘drawingWindow’,
-- 'textWindow'
[with properties: record] -- theinitial valuesfor the properties of the element
Result: reference -- to the new object(s)

The keyword “new” isoptional in Apple Script.

what specifies the type of window to be opened. Specify table for a data window,
drawingWindow for a drawing window, textWindow for a function window.

The with properties parameter specifies the properties of the window in an Apple Script record.
All types of pro Fit windows have the property name holding the name of the window as a string.
In addition to this, data windows have the properties nrRows and nrCols with the numbers of
rows and columns.

Examples:
make table with properties {name:"myTable"}
-- creates a new data window having the name "myTable"
make drawingWindow with properties {name: "lookatthis"}
-- creates a new drawing window having the name lookatthis
make textWindow -- creates a new function window
make table with properties {name:"small", nrCols:10, nrRows:20}
-- creates a data window with name "small", 10 columns and
-- 20 rows

-- the following creates a new data window and then closes it using a
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-- temporary reference to the window
set myRef to make new table
close myRef

save: Save awindow

save reference -- the window to save

[in diag] --thefilein which to save the object

[as datafile/drawing file/EPS file/function file/PICT file/text file]

-- file type for data export

Windows can be specified by name or index (1 is the frontmost window, 2 isthe window behind it,
etc). Note that Apple Script allows you to specify indexed objects in various ways (such as
window 1, front window, 3rd window, last window)

Optionally, you can specify the file where the window is to by saved after in. If you do not specify
the file where to save the window and the window has never been saved before, you are prompted to
enter afile name. If you don’t specify the file where to save the window and the window has been
saved before, the window is saved to the same file as before.

If the specified window is a data window, it is saved as aregular pro Fit file by default (thisis
equivalent to specifying “as table”). If you want the data window to be saved as text file for
exporting it, specify “as text”.

Examples:
save window 1 to file "HD:data" -- saves front window to file
save window "data" to file "data.txt" as text -- saves as a text file
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12 Printing

Thereisawide range of different printers that can be connected to a Mac OS machine, and each of these
printers have different capabilities, resolutions and command languages. pro Fit allows you to get the best
out of most of the commonly used printersif you follow the guidelines described in this chapter.

Basically, there are two possibilities for printing proFit drawings. Y ou can print from proFit directly
(using the Print command from the File menu) or you can export a drawing to another application, such
asaword processor (using the Copy or the Create Publisher commands or by dragging it to the other
application), and print it from there. The next two sections discuss these two possibilities separately.

Printing from pro Fit

Before printing, you should choose Page Setup from the File menu.
Y ou can print the active window by selecting the Print command from the File menu.

proFit offers two different modes of printing: printing with PostScript and printing at the printer’s
resolution. Y ou can select the desired method by choosing Preferences... from the File menu. In the
dialog box that comes up, click the icon “Printing” in the list at the left. The dialog box now looks as
follows:

Preferences

[+« Print drawings using PostScript

. [+ Use Quickdraw for text

LAl 2] (cenee]

If you check Print drawings using PostScript, proFit sends PostScript commands to the printer
together with a ssimple picture describing your drawing. Y ou should check this option if you are printing
to a PostScript printer. When you check “Print drawings using PostScript”, you should also check
“Use QuickDraw for text”. More information on this option is given below.
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If ‘Print drawings using PostScript’ is not checked, proFit prints the drawing “at the printer’s
resolution”. No PostScript commands are sent in this case. You should use this setting if you are
printing to a non-PostScript printer.

The default setting on a“fresh” installation of pro Fit isthe last one. |.e. no PostScript is
sent to the printer. The reason for thisis that this default setting gives good results on most
printers, PostScript or not PostScript.

[ If you have a PostScript printer, you will get better results if you check the “Print
Drawings using PostScript” option.|

Printing with PostScript

PostScript® is alanguage for defining graphical objects. It is used by many high quality printers. When
an application prints to such a printer, it can use the built-in graphics language of the Macintosh
(QuickDraw), which is automatically trandated to PostScript by the printer driver beforeit is sent to the
printer. However, some information may be lost during this translation. To get better results, an
application can generate the PostScript directly and send it to the printer, obviating the need for any
trandation.

Check ‘Print drawings using PostScript’ after choosing the “Printing” panel of the preferences dialog
box, to let proFit generate PostScript during printing.

When printing with PostScript, you should usually check the option “Use QuickDraw for text” for best
compatibility with most printer drivers and printers. If “Use QuickDraw for text” is checked, proFit
first creates PostScript code for all items of the drawing window except text items and sends this code to
the printer. Then it draws the texts — without using PostScript. This ensures the correct setting of the
font and supports al text styles. If you uncheck ‘Use QuickDraw for text’, text will be sent as PostScript
code —this option is not recommended asit can lead to compatibility problems with some printer drivers.

Not all printers support PostScript. Don’t use the ‘Print drawings using PostScript’
option on non-PostScript printers. A non-PostScript printer will ignore the PostScript
commands and will print anon-optimized picture (with the resolution of the screen).

Switch off the option ‘ Print drawings using PostScript’ to get optimal results on a non-PostScript printer
(seethe next section, below).

Drawings will generally look better when printed with PostScript than when they are printed at the
printer’ s resolution. However, there are some minor problems when using specia patterns or characters:
* When using patterns, only the gray patterns will print. All other patterns will be replaced by a 50%
gray pattern.
e |If “Use QuickDraw for text” is not checked, outlined, shadowed and underlined fonts are not
supported.
» If “Use QuickDraw for text” is checked, text is printed above al other itemsin a drawing.

Printing at full printer resolution

If your printer does not support PostScript, do not check ‘ Print drawings using PostScript’. In this case,
pro Fit determines the resolution (the number of distinguishable dots per inch that can be printed) of your
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printer when it is printing a drawing window. Using this information, proFit can optimize the picture it
sends to the printer in order to take full advantage of the resolution available on your printer.

Printing a pro Fit drawing from another application

When you copy or drag a drawing into another application (or when you create a Publisher that you
subscribe to from another application), proFit creates a picture (often called PICT) that contains all the
information required for drawing the copied objects on the screen. However, when it comes to printing on
ahigh quality printer (with better resolution than the screen), more information is needed. This additional
information must be packed into the picture. Since there is no standard method of doing thisin away that
works for all printers, you should give proFit some information about your printer before creating a
picture.

You can give this information by choosing Preferences from the File menu and selecting “PICT
Options’ from thelist of iconsto the left. This brings up the following dialog box:

Preferences
B (3 Normal PICT (3 Enlarged PICT
G |
i @ Embedded PostScript () Bitmap
Q {_» High resolution PICT
Frinting =
|=-||::'T Dpt;-:uns [ Use Quickdraw for Text
AR
L™ | Standards... |
D awing
Plotting
.-+-l u - "}
F_[rwiew — 2| | cancel I | DK I

Y ou can choose between six picture formats:

* Normal PICT: Use this option when you don’t plan to print your pictures at a high quality. Pictures
generated with this option look fine on the screen and use a minimum amount of memory.

* Embedded PostScript: Use this option when you are planning to print your pictures on a printer
that understands PostScript, such as a printer of the LaserWriter® family. The pictures generated
with this option till look nice on screen, but they also have PostScript information included.

When you select “ Embedded PostScript”, you can specify if you want to “Use QuickDraw for
Text”. For best compatibility with the widest range of printers and printer drivers, “Use QuickDraw
for Text” should be checked.
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For more information on printing with PostScript, see the section ‘ Printing with PostScript’ earlier in
this chapter.

» High resolution PICT: This option generates pictures that print well on most printersif the printing
application supports “printing at the printer’ s resolution” and does not change any information in
the pictures it imports. However, few applications presently support these features. When generating
a high resolution picture, you must enter the desired resolution in atext field appearing at the bottom
of the dialog box.

High resolution pictures may not ook perfect on screen but they use a minimum amount of memory.

« Enlarged PICT: Pictures generated under this option are enlarged by a zoom factor z given by the
specified resolution r. Y ou can enter the resolution r in an edit field appearing at the bottom of the
dialog box. The zoom factor is given by the formulaz=r / 72 dots per inch.

Y ou can obtain high quality prints of an enlarged picture on many printers by choosing areduction
factor 1/z in the Page Setup dialog box before printing.

» Bitmap: Thisis presently the recommended picture format for printing on any high resolution
printer that does not support PostScript. In abitmap every pixel of the pictureis stored at the
printer’ s resolution. Y ou can enter the desired resolution in atext field appearing at the bottom of the
dialog box.

Bitmaps print well on most high resolution printers. However, a bitmap uses a large amount of
memory and often looks unsatisfactory on screen. Also, printing a bitmap can be very slow,
especialy when printing to a PostScript device.

When you select ‘Bitmap’, you can specify if your bitmap should be black and white or if it should
contain color information. Don’'t check ‘with Color’ unless you really need a color bitmap — black
and white bitmaps use considerably less memory.

At the bottom of the “Printing” panel in the Preferences dialog box, there is a button called
“Standards”:

[ Standards... ]

Clicking this button brings up another dialog box that lets you store your settings in the preferencesfile
or load previoudly stored settings:

Saved PICT styles:

Laser Writer 320 -
Mormal

Save PICT style as:

PICT Settings

| Delete | [2] [ cancel |
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The upper part of the box lists al styles saved in the preferences file. To load a style, double-click its

name. To delete one or more styles, select their names (shift click for multiple selections) and click
Delete.

To save your current picture settingsas aPICT style, type anamein the edit item and click Save.

If you save a style with the name Nor mal, it becomes the default style and it is loaded whenever you
start proFit.
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13 Preferences

proFit offers many possibilities to customize its features. Y ou can choose the format for exporting
pictures, the preferred method for printing, you can save your preferred user interface options, etc. All of
these settings are saved in proFit's preferences file. During start-up pro Fit looks in the Preferences fol -
der of the System folder for its preferencesfile. If thefileisthere, proFit reads its standard settings from
it. If thefileis not there, proFit creates a new preferencesfile. You can switch to another preferencesfile
or create anew preferencesfile anytime later.

If you do not want to load the standard preferences file in the system folder, hold down the option and
the shift key while starting up proFit.

Most of proFit’s settings are controlled by choosing Preferences... from the File menu. Doing so brings
up adialog box with several panels. Each panel controls a set of options. To choose a panel, select its
icon from thelist in the left of the dialog box.

The panels Printing and PICT Options are discussed in Chapter 12, “Printing”. In the following, we
discuss the panels General, Drawing, Preview, Interface and Prefs File.

Panel “ General”

This panel controls some genera options for output, scrolling and data windows.

Preferences

- + # digits after the decimal point

= in numerical results: 4
eneral

Q ] Results Window to front after output
Printing = + Default data window range:

E@f‘ {3 =1e30..1e30 @ -1e300... 1e300

F'IEEI' Elpt?n:nns + Help:
-

M [+ Show hints
Crawing
Flatting

LAl 2] (canes]

Thefirst itemin this panel definesthe # digits after the decimal point used when displaying numerical
results. Enter a negative number if you want to set the total number of digits, a positive number for setting
the number of digits after the decimal points.
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The radio buttons under the title Default data window range control the default range and precision of
the numeric columns in new data windows. See the section “Data Types’ of Chapter 4 for details.

Show hints controls if pro Fit should show some hints to guide an unexperienced user. Uncheck this
option if you don't want any hints to be shown.

Note that each hint also has an individual checkbox that can be used to diableit. If you uncheck and later
check again “Show hints’ in the Preferences dialog, all hints (also those that have been disabled
individually) will be shown again.

Panel “Printing”
This panel is discussed in Chapter 12, “Printing”

Panel “PICT Options’
This panel is discussed in Chapter 12, “Printing”

Panel “ Drawing”
This panel controls some options used by the drawing window:

Preferences

+ Default units | cm :I

[] Always use floating toolbox

-
=
3
=
3

Ir=!
il

'
H]
Y-Axiz

Flotting
|._-'_L_‘1’_E F | I [ I

) I.. . l-?‘ EH"EEI
Preview - :

Default units controls the default units used for measuring and entering distances in the drawing
window and the Drawing Info window.

Check Always use floating toolbox if you never want the drawing tools to appear inside the drawing
window.
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Panel “Plotting”
This panel controls some options for the preview window:

Preferences

+ Format of labels in graph axes
[ Typographical minus
] Comma instead of decimal point
Exponentials: @ 810% (O Bx10¥ ) BEQ

+ [+{ Automatic grouping of new graphs

# 5Store data | function points with coordinates
outside the graph ranges, if they exceed the

graph x-range by less than 0 .

and the y-range by less than [ INF .

ey - [ I
Preview - |£I EanEES

Check Typographical minusif you want to use alonger dash (-) instead of the hyphen (-) asaminus
sign for numbersin the labels of a graph. Note that the typographical minus may not be available on non-
roman fonts.

Check Comma instead of decimal point to use a comma as the decimal marker (12,345) instead of a
point (12.345).

Exponentials controls the style for drawing exponential |abels.

Note that changing the settings under “Format of labels in graph axes’ does not affect the labels of
existing graphs. When you have changed the settings and want to use them for an existing graph, redraw
the axis, e.g. by double-clicking it and clicking the button “ Apply”.

Check Automatic grouping of new graphs, if you want to automatically group a graph, the names of
its axes, and its legend when it is created. Uncheck this option if these items should not be grouped.

The edit boxes at the bottom let you enter x- and y-ranges for storing data points during plotting. When
you plot a data set or afunction, pro Fit stores the corresponding data with the graph. However, it clips
data that lie far outside the graph. When you expand the graph later on, clipped data points will not
appear. If you want pro Fit to store data points that lie outside the graph, enter values > 100 in these
fields.
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Panel “Preview”
This panel controls some options for the preview window:

Preferences

+ [Data points Color [E Selection [E

+ Markers Color |l % | Reference |l %

+ Function Color | #| Thick |1 =

#+ Coordinate lines ¥4 a

H:H

[+ Allow dragging of data points

| Cancel I

The pop-up menus under Data points, Markers and Function let you set the appearance of these
items.markers (For more information on markers, see Chapter 6).

The Coordinate Lines are drawn in alight grey color in the preview window, behind the data points and
the function curve. They are two perpendicular lines that cross the x- and y- coordinate axes of the
preview at the coordinates given in the two edit fields.

Check the option Allow dragging of data pointsif you want to be able to change coordinates in a data
window by dragging the corresponding data points in the preview window. Uncheck this option to
disable this potentially dangerous option.
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Panel “Date & Time’
Using this panel you can control some aspects of pro Fit's user interface.

Preferences
—

i + Date & Time format:

Flatting [ System defined [ Custom = ]

p|,,w,w + Relative Time format:

. F days per year [ 365.24219878 = I

Date & Time # days per month [}"Eﬂl‘.-"' 12 ¥ I

® DK

M |= Format for hours, . =

Interface minutes, seconds [ 04:25:03 a

W

File Export

L,
=] )
= il

Frefz File |[™

2] [ cancel |

Date and time can be displayed in various formats, e.g ‘ 18. Jan. 2000 or *1/18/00’. pro Fit allows you
to define the format that you prefer. You can either use the system’s default format (check System
defined) or you can use a custom format (uncheck System defined).

Relative time expresses the duration between two momentsin time. pro Fit allows you to display relative
time, inter alia, in months and years. To do this, you must define the length of these units. This can be
done with the pop-up menus under Relative time for mat.

Additionally, you can select between two formats of displaying hours, minutes, and seconds: Either these
numbers are delimited with acolon, or each unit is separately written, e.g. '4h 25m 3s.
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Pand “Interface”
Using this panel you can control some aspects of pro Fit's user interface.

Preferences

=AXIT

: + Enable dynamic scrolling for:
Plotting [+ Data windows [+ Drawing windows

| ;\g—F [+ Text windows

Prewview

Date & Tirme

Interface

W

File Export

L,
=] )
= il

Frefz File |[™

2] [ cancel |

The check boxes under Enable dynamic scrolling for control what happens if you click and drag the
indicator of ascroll bar. If the corresponding checkbox is checked, the contents of the window will be
scrolled while you drag the scroll bar. This provides a more accurate control of scrolling, but may be

sluggish on slower computers.
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Panel “File Export”

Using this panel you can define the file creators that pro Fit uses when generating files that are exported,
e.g. TEXT files or various image formats:

— PrefereniesS=————————
|
‘ZM + Creator codes for the different file types:
Flotting ; .
|j7\>F Text: |titxt (saving data windows)
. . Text: |tixt (other text windows)
ey ey
EPS: |vgrd
Date & Time PICT: txt
®
M [= GIF: ogle
Interface
.i IPG: ogle
File Export
Prefs File |[= |g| [ﬂ]

The Creator codes are the file creators of the exported files that pro Fit creates. Note that the creator
code defines which application is opened when you double-click afile from the Finder.

The first two are files of type TEXT (ASCII text), one for saving data files as text, and one for all the
other cases where text files are generated. The lower 4 creators are used for the drawing or image files
that pro Fit can export: EPS for Encapsulated PostScript files, PICT for Apple Picture files, GIF and
JPG for the well-known image files with format GIF or JPEG.
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Panel “ Prefsfile”
Using this panel you can switch between preferences files or create a new preferencesfile:

Preferences

=HXIT

# Y=RxIZ

Flotting

Preview

Cate & Time

Interface

Mo

| New Preferences file...

| Use Preferences file...

File Export
B
Prefz File |™

| Cancel |

Click New Preferencesfile to create anew preferencesfile. All the settings and extensions stored in the
current preferences file are copied to the new preferencesfile.
Click Use Preferences file to switch to another existing preferencesfile. proFit will scan the folder of

the selected preferencesfile for afolder called “pro Fit modules’. If it finds such a folder, any modules
stored in this folder are loaded into proFit. (For a more complete discussion of the proFit modules

folder, see Chapter 5, “Working with Functions’).
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14 General features

Getting help

proFit offers a powerful on-line help based on Apple Guide. The proFit Guide can be accessed by
choosing proFit Guide from the help menu, or by clicking one of the question marks that are present
everywhere in pro Fit windows and dialog boxes. Balloon help is a so supported.

When defining functions and programs there is a special feature based on a dedicated help menu which
isaways present in the header of function windows. See chapter 9, “Defining functions and programs”,
for more information on this help menu.

The proFit Guide

The proFit on-line help system comes in a separate files called proFit Guide and proFit
Programming. These files are found on your distribution disks and must reside in the same folder as
proFit. If proFit cannot find one of thesefile, then the corresponding on-line help is not available.

The main proFit Guide can be accessed using the Help menu to the right of the menu bar.

As an alternative to this, there are lots of question marks everywhere in proFit dialog boxes and
windows. Click any of these question marks if you need help in a particular situation. proFit will
immediately display afloating window that can guide you through the operation at hand.

The proFit Programming guide provides help on all features of proFit's function and program
definition language. This Guide contains a detailed description of every predefined function or keyword.
The programming Guide can be opened directly at the page describing a given keyword, by selecting that
keyword in the function window Help menu, or by option-double-clicking a keyword in the text of a
function definition.

Help balloons
Switch on balloon help by choosing the Show Balloons command from the Help menu.

Once you have switched on balloon help, helpful comments show up whenever you move the mouse over
some interesting item. Choose Hide Balloons from the Help menu to switch balloon help off.

Help Balloons can be switched on locally for the Help menus in function windows. They show helpful
information on the keyword currently selected in the menu.

On-line evaluation of mathematical expressions

Wherever proFit expects a numerical input, such as in spreadsheets or dialog boxes, you can enter a
mathematical expression. For example, instead of typing a number directly, you can use a mathematical
expression like “exp(1)” or “6+sin(pi/4)”. proFit reads the mathematical expression you typed or
pasted and cal culates the numerical result.
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Text windows, such as the result window, can be used as a calculator by typing an expression on a new
line, positioning the insertion point on that line, and hitting the Enter key. The result is displayed on the
next line.

[0 =—Results =—H H
1/=qrti2s -
0.70M 1
=+ 100
TO.71a07

[ |
T

Y ou can aso use mathematical expressionsin al proFit dialog boxes. As an example, if you want to
tabulate a function between 0 and two times pi at intervals of pi / 5, type command-T and enter the
following:

Table of Polynomi{x)

Tabulate by varying | x % |
Min: |0 Max: | 2*pi
Atep: I m/a I (0.9, ‘auto’, ‘points")

[ ] Use fitted parameters

4 [ Cancel I

When typing a mathematical expression, you use the same syntax elements that are available when
writing a function definition. In on-line mathematical expressions, x is equal to the last result that was
evaluated, and a[ i ] isequal to the parameter values shown in the current parameters window. Y ou can
use al the predefined functions available when writing the definition of afunction. As an example, after a
successful fit you can type 'ChiSquared' in a data window cell. Thistells proFit to set the value of that
cell to the mean deviation obtained in the last fit (see Chapters 9 and 10, together with Appendix A, for
more information on predefined functions).

Let’slook at asimple example that illustrates how you can use proFit’s understanding of mathematical
expressions when you are pasting into a data window. Write the following text and copy it to the
clipboard:

2] - fittedParams(2) — &[2] —fittedParams(2) — paramSD(2)
a[3] - fittedParams(3) — a[3] — fittedParams(3) — paramSD(3)
a[4] — fittedParams(4) — a[4] —fittedParams(4) — paramSD(4)
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Wherethe -’ stands for atabulator character and each line is terminated with a carriage return (). If
you paste the above text into a data window after a successful fit, you automatically obtain a table
containing the parameter values before the fit, the values after the fit, their difference, and the resulting
standard deviations.

File info

proFit lets you save a comment with every one of itsfiles. You can edit this comment with the Get Info
command from the File menu. Choosing Get Info presents a dialog box with a large field for editing
text.

Infos about "Data 122"

Theze points were recorded using Finac's correction
Colurnns 3 and 4 give the temperatures at the end points.

TSS6 KS

| Cancel I

Y ou can add an info comment to data windows, drawing windows and functions or programs.

The data windows let you view and edit this information directly, without using the Get Info command.
For this you drag down the info hook (a black area on top of the right scroll bar) of a data window to
create an info field of the desired size. See Chapter 4, “Working with data’ for more information on
datawindows.

D %@ Data ]EEEE
Theze points were recorded using Finac's correction
Colurnns 5 and 4 give the temperatures at the end points=.
/S92 KS
F. | = T 1 =1 o i Il % E
Index Timne [5] at T1
= 1 1.200 012150 20
= 2 1.400 052120 55.13
= ] 1.600 1.00122 4523 |
= 4 1.200 1.21520 E 1= B
= 5 22320 1912324 55.00 -
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Note that the info comments are in general only saved in files that have proFit’s standard formats. If you
save a function definition as normal text files (TEXT format) or if you save a drawing window as a
picture or EPSfile (PICT format, EPSF format), the info comments are not saved. If you save adatafile
as TEXT, you have the option of placing the info comments right at the beginning of the text file, as a
header. To set this option, you have to choose “ Custom format” in the dialog box that comes up when
saving text files.

Find and Replace

proFit provides Find & Replace features to help you navigate through text. Thisfeature is available for
the results window and all function windows. Y ou will find it most useful when you are editing the
definition of afunction or a program inside a function window.

The Find & Replace commands are found in the Edit menu:

Find... O HF
Find Again S HEO
Enter Selection O ®E
Replace £ ¥#ER
Replace & Find Again <%3H
Replace All

When you choose Find... the Find/Replace dialog box appears:

Find / Replace

Find a[3]

Replace Ia[l] I
[+ lgnore case i#® Forward
] Whole words only i) Backward

Replace All | | Done | 121 _Cancel |

Type the text you are searching for and the replacement text in the Find and Replace edit fields. Use the
radio buttons Forwar d/Backwar d to start the search by moving down from the current insertion point
towards the end of your text, or up towards the beginning. Click the Find button to start a search, click
Doneif you don’t want to start a search yet. Click Replace All to replace al the occurrences of the text
appearing in the Find item with the text appearing in the Replace item.

Use the menu command Enter Selection to enter the currently selected text in the Find field of the
Find& Replace dialog box. Choose Find Again to restart a search (the fastest way to find all
occurrences of atext isto select it and choose Enter Selection and Find Again in rapid succession). Use
Replace to replace the current selection with the text in the Replace field of the Find& Replace dialog

200 General features



box. Replace and Find Again combines the last two commands. Replace All is equivalent to the
Replace All button in the Find dialog box.

Note that by using the Enter Selection command, or by copying some text and pasting it into the Find
and the Replace field, you can enter text that you cannot enter by typing in the dialog box, such as
carriage returns () and tabs (- ).

These commands can be accessed by using the following key combinations:

Find... shift + command + F
Find Again shift + command + G
Enter Selection shift + command + E
Replace shift + command + R
Replace & Find Again shift + command + H

These command key equivalents are displayed in the Help Balloons for the corresponding menu items.

Contextual menus

Some of pro Fit’s windows allow you to use “contextual menus’. To invoke a contextual menu, click on
adesired part of pro Fit while holding down the control key.

O | Untitled Drawing 2

=]

Help

Close Window
Group
Ungroup
Send

Rotate

Flip

Align

]

wvwvw

Display As Dialog
Show Frugram Window
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Shortcuts and other options

Although most of proFit’s features and commands are readily accessed through its menus, there are
some more advanced or rarely used features that require the use of modifier keyslike the option key, the
command key, or the shift key.

Thisisashort list of these features;

action modifier keys
* Pressing ‘F shift & command
to select ‘Find..." from the Edit menu.
e Pressing ‘G’ shift & command
to select ‘Find Again’ from the Edit menu.
e Pressing ‘E’ shift & command
to select * Enter Selection’ from the Edit menu.
* Pressing ‘R’ shift & command
to select ‘Replace’ from the Edit menu.
* Pressing ‘H’ shift & command
to select ‘Replace & Find Again’ from the Edit menu.
* Pressing ‘D’ command

to dismiss the “Do you want to save changesto...” dialog box.
Keyboard equivalent of typing the“Don’t Save” button.

» Sdecting atool inthetools option
palette of drawing windows to keep the tool selected after drawing the corresponding object.
» Dragging objectsin drawing command
windows to constrain the movement along 45° lines.
shift
to constrain the movement to horizontal and vertical directions.
option
to duplicate an object instead of simply moving it.
» Drawings objectsin drawing option or shift

windows to get a square bounding box.
» Drawinglinesin drawing shift
windows to make the line horizontal, vertical or diagonal (at 45°)
option

to make adiagonal line
» Drawing polygonsindrawing  option, shift
windows same asfor lines
command double-click
to produce a corner that remains a corner even when the polygon
is smoothed.
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Resizing objects in drawing
windows

Resizing linesin drawing
windows

Clicking objectsin drawing
windows

Clicking graphsin drawing
windows

Clicking nothing in drawing
windows

Using the line style pop-up
menu in adrawing window to
changethelinestylesina
legend

Using the point style pop-up
menu in adrawing window to
change the point stylesina
legend

Clicking acell in adatawindow

Clicking the column number
cdl in adatawindow

option

to keep the bounding box of the object square (height=width).
shift

to maintain the horizontal and vertical proportions of the object, its
height, or itswidth.

command

to resize the size of textsin agroup.

option

to get aline constrained to 45° directions.

shift

to maintain the direction of the origina line, or to maketheline
vertical or horizontal

shift
to select an object without de-selecting other already selected
objects.

option & command + click

to see the plot coordinates of the point you are indicating with the
Cursor.

option & command click, and then press shift

to select an area of the graph to be enlarged.

command double-click

to make a graph the * current graph’.

command & shift double-click

to remove the ‘current graph’ setting.

command + click

to zoom in, centering the clicked point in the new view.
option & command click,

to zoom out.

shift

to change the line styles of dl the linesin the legend.

option

to change the line style and set the attribute ‘ points connected’ for
the data plot in the first row of the legend.

shift & option

to change the line styles of dl the linesin the legend and set
‘points connected’ for al data plots.

shift
to change the point style of all the data plotsin the legend.

option

to sdlect the whole column above the clicked cdll.
shift

to enlarge a selection.

command
to set the default columns (X, y, Ax, Ay) using a pop-up menul.
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» Clicking onthe ‘larger font option
Size' controlsin the text-edit to increase the font sizeby 1 pt only .
diaog box
» Clicking onthe option
“subscript/superscript position’”  to change the vertical position of the selected text by 1 pt only.
controlsin the text-edit dialog

box
» Choosing ‘New Function’ option
from the file menu to open anew definition window containing a sample function
definition.
option/shift
to open anew definition window containing a sample program
definition.
* Importing text files option

to tell proFit not to ask for information and to open the text files
as datafiles using the current settings.

» Saving adrawing asan EPS option

file. to create a TEXT file containing the PostScript information.
» Using listsin diaog boxes (e.g. shift click, shift and drag

the y-column list in the plot to select more than one item.

data dialog box). shift click

to de-salect an item.

» Clicking with thelenstool in command to drag a selection rectangle specifying the region to
the Preview Window enlarge.
option to zoom out instead of zooming in

» Sdecting anitem fromthe Help option

menu in a Function window to paste the template with a';' and a carriage return
command
to enable pasting templates and disable help panels
shift
to enable help panels and disable pasting templates
» Clicking amarker inthe option
Preview window to transform the clicked marker into the reference marker
* Moving amarker with the option
arrow keysin the Preview to let the marker go outside the ranges of the preview.
window
» Usingtheleftandright arrow  option
keysin adata window to move the insertion point by one character within the active data
cel.
 Clicking in the data window command
to create a discontinuous selection
o Starting proFit option and shift

in order not to load the standard preferencesfile
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Another commonly used shortcut is typing aperiod (*.”) while holding down the command key. Thisis
equivaent to typing the escape key and it interrupts most of the calculations. Use it to stop the plotting of
afunction, to stop fitting, to cancel printing, or to interrupt lengthy calculations.

The combination Command-key/period is also interpreted as typing ‘Cancel’ in dialog boxes. The
escape character is also interpreted as ‘ Cancel’. Return or Enter are always interpreted as clicking the
outlined button.
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Appendix A: Programming reference

When programming in proFit, you can use alarge number of predefined functions and procedures. The
first part of this appendix gives a short list of these functions and procedures ordered in functional
groups. The second part of this appendix provides a full description of each function or procedurein
alphabeticd order.

Note that the pro Fit compiler ignores upper/lower case, i.e. Set Col utmNanme is identical to
set col utMmnanE. An exception to the above rule applies when you call other functions or want to
execute menu commands. In that case the strings you specify for the names of the functions or menu
commands are case-sengitive.

All the predefined functions and procedures described here are also available to external modules unless
they work with special pro Fit types, likeconpl ex, mat ri x, or vect or. In some cases, to avoid
conflicts with the names of Mac OS routines, the names used in the external modules interface files
(proFit _interface.h and proFit _interface. p)canbedightly different from the names
used in pro Fit’s function windows. Unless the difference between the names is very small and obvious,
external modules names are also found in the alphabetical listing at the end of this chapter.

Some predefined functions provide advanced features and are only available for external modules.

Routines only available for external modules are marked with a ™' in the following functional groups
descriptions.

To get afast look at what you can do in aproFit program, go through the following functional group
descriptions. To get details on a certain function, see the alphabetical list which follows.
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Types

Internal functions and programs

For user-defined functions and programs, the following basic types are supported:

r eal

i nt eger

string
char
bool ean

conpl ex

vector[n]

mat ri x[ n]

real is the standard type for floating point numbers. It has at least 64Bit accuracy.
(optional, but equivalent type: extended)

integer is the standard type for integer numbers. It has at least 32Bit accuracy. (optional,
but equivalent type: longint)

string is the type for strings. It is at maximum 255 Bytes long.
char is the type for single characters.
boolean is the type for booleans. It takes the values t r ue or f al se.

complex is the type for complex numbers. It consists of two real values, the real and the
imaginary part.
vectorn] is the type for a vector with n complex elements. 2<n <4,

The i-th element of a vector v can be accessed using V[i]

matrix[n] is the type for matrices with nxn complex elements. 2 <n < 4.
The element in the i-th row and the j-th column of a matrix m can be accessed using m[i,j]

See appendix B of this manual for number accuracies.

Note that for the real column type of data windows you can choose between single or double accuracy.

External functions and programs

External functions and programs are written in the programming language of an external compiler, and
therefore cannot use pro Fit’'s basic types. For data transfer between externally defined functions and
programs, the interfaces for the pro Fit functions and procedures specify the correct types that must be

used.
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Functional groups
Operators

+ - F /

= <> >= >

<= <

nod, div

and, or

not

addition, subtraction, multiplication, division
power

equal, not equal, larger or equal, larger, smaller or equal, smaller

integer modulo and integer division
logical and, logical or

logical not

Note that the power operator ‘**’ (*A’ isasynonym) is evaluated as

X**y

Whenusingx ** vy,

:X/\y:

exp(y*In(x))

X must be positive.

The evaluation of this expression can be rather slow. If you want to calculate ssimple
integer powers, e.g. X2 or x3, use expressions such assqr ( x) or sqr ( x) *x.

M athematical functions and constants

sin, cos, tan,

arcsin, arccos, arctan
si nh, cosh,

ar si nh,

t anh,
arcosh, artanh

erf, erfc

In

| og
exp
tento
sqr, sqgrt

Gammma, Ganmal ,
GammaP

T (or pi),
I NF, -INF

Gamaln,
true,

fal se,

i nval i dNum

Even, dd

trigonometric functions, (arguments or results in rad)

hyperbolic functions

error function
er f ¢ is the complementary error function: er f ¢ =1-er f

natural logarithm

base 10 logarithm
exponential function, eX
power of ten, 10X

square, square root (x2. VX)

Gamma function and incomplete gamma function
constants

an invalid number. Used to mark empty data cells in a data window.

test for integer numbers, is true if the number is even or odd,
respectively
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Special Mathematical Functions used with complex numbers

pro Fit expressions of the conpl ex type can be used with all mathematical operators and with all
mathematical functions. When the type of a parameter isconpl ex, the function will recognize it and
return an appropriate complex or real result. The following are the few special functions that only make
sense for complex numbers.

conj returns the complex conjugate of a complex number

Re, Im return the real and imaginary part, respectively, of a complex number
phase returns the phase @ of a complex number r ei®

abs returns the absolute value rof a complex number r ei®

conpl used to define a complex number. compl(x,y) =x +iy

Special Mathematical Functions used with matrices and vectors

det er mi nant returns the determinant of a matrix

transp returns the transposed matrix

adj oi nt returns the adjoint matrix

out er returns the matrix defined as the outer product of two vectors.
matr2, matr3, matr 4 used to define a matrix, these routines take 4,9, or 16 complex

parameters, respectively.

vect 2, vect 3, vect 4 used to define a vector, these routines take 2,3, or 4 complex
parameters, respectively.
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Interpretation of matrix and vector typesin mathematical expressions

pro Fit expressions of themat ri x or vect or type can be used with norma mathematical operators and
functions when it makes sense. Mathematical operations between matrices and matrices, matrices and
vectors, vectors and vectors, and matrices/vectors with numbers do the expected thing. In the table below,
"m' standsfor any mat ri x[ n] type, "v" for any vect or [ n] type, and "c" standsfor any conpl ex
or r eal number.

mm matrix multiplication, result is a matrix.

ntv matrix times vector, both must have the same dimension, result is a vector
ntc, v*c multiplication by a scalar. Every matrix or vector element is multiplied by c.

1/m this is the inverse of the matrix m Produces a run-time error if the matrix cannot

be inverted. 1/ m = adj oi nt (n)/ det er m nant (n)

i/ @ matrix division. ml is multiplied with the inverse of n.
v1i*v2 scalar product between two vectors. The result is a number.
abs(v) the absolut value of a vector. The result is a real number.
sqgr(v),sqr(m translates to v*v, and m*m, respectively

conj (v), conj(m the complex conjugate is obtained by taking the complex conjugate of each
individual element.

conpl used to define a complex number. compl(x,y) =x +iy

Thefollowing is an example of a program doing some matrix and vector calculations:

pr ogram SoneMat r i xAndVect or Cal cul ati ons;

var nl,n2: matrix[2]; {two 2x2 matrices}
mm mP: matrix[3]; {two 3x3 matrices}
vl,v2: vector[2]; {two vectors of length 2}
C: compl ex; {a complex number}
begi n
mil: =matr 3(1+ii*2,2*ii,3,4,5,6,7,8,9); {define the elements of the 3x3 matrix mm1}
mR2: =1/ m; {mm2 is now the inverse of mm1}
ml: =matr1(1, 2, 3, 4); {define the 2x2 matrix m1}
n2: =sqr (m*4. 2) +3. 3; {m2 is calculated from m1}
vl:=vect2(1, 2+ii); {define the vector v1}
v2: =nR*v1l,; {matrix multiplication of v1 gives v2}
c:=vl*v2; {c is the scalar (dot) product of v1 and v2}
end;

Bit operations

BitAnd, BitOr, BitXor, logical bitwise operations: and, or, exclusive or, not
Bi t Not

BitShift, Bitdr, BitSet, functionstohandle bit-arrays

Bit Tst
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Data processing
Statistics run statistical analysis, get results

Sort, ReduceData, BinData SO, smooth or reduce data or prepare data for histograms

FFT, |nverseFFT FFT and inverse FFT
Dat aTr ansf or m general data transfomations
Tr anspose transposing rows and columns
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Accessing the data window

data[i,j],

Dat aCX,

C ear Dat a,

Test Dat a*, Set Dat a*,
Get Dat a”

GetCell, SetcCell

Set Def aul t Col s,
Set Dat aW ndowPr operti es,
Get Dat aW ndowPr operty

xCol um, yCol umm,
XErr Col um, yErr Col um

Nr Col s, Nr Rows,

Sel ect Left, Sel ect Top,
Sel ect Ri ght,

Sel ect Bott om

Get Sel ection”

Sel ect Cel |, Sel ect Row,
Sel ect Col umm,
RowSel ect ed, Cel |l Sel ect ed

Set Col ummPr operti es,
Get Col ummPr operty,

Get Col Name, Set Col Nane,
Get Col Type, Set Col Type,
Set Col Wdt h, Col Enpty

Cet Def aul t Dat a*,
Get Col Handl e”,
Set Col Handl e”

an array and some routines for accessing the data in the current data
window

setting and reading cell contents, including text-cells.

set the default x, y, Ax, and Ay columns and the number of columns
and rows in the current drawing window.

the column numbers of the x, y, Ax, and Ay columns in the current
data window

information on the selection area and the size of the current data
window

set the selection and check if a single cell or a row is part of a
(possibly discontinuous) selection.

obtain and write titles of single columns and other column
characteristics.

obtain column data in a single step from external modules.

All the above calls access the current data window. By default, the current data window is the frontmost
data window. You can make another data window the current data window by calling
Set Current W ndow( wi ndowl D) with wi ndowl D being the window ID of the desired data
window.

Input and output

| nput, SetBoxTitle
Ask, Alert
Wite, Witeln

CreateTextFil e,
Cl oseText Fi |l e,
WiteToTextFile

displays a dialog for entering numerical values
show alert boxes
these procedures write into the results window

open and close text files, and redirect the output of the write, writeln
functions to a text file.
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Drawing

Set Li neStyl e, set the style of future drawing calls

Set Li neCol or,
SetFi |l | Col or,
SetFill Pattern,

Set Dat aPoi nt St yl e,
Set BGDat aPoi nt St yl e
Set ArrowsSt yl e,

Set Text Styl e

MoveTo, LineTo, Mve, produce line drawings in the drawing window.

Li ne, DrawlLine

OpenPol y, O osePol y collect line-drawing calls to define a polygon

Dr awLi ne, Dr awDat aPoi nt , create single drawing objects in the current drawing window.

DrawPl CT", DrawRect,
Drawkl | i pse, DrawArc,
Dr awText, DrawNumber

G oupBegi n, G oupEnd group drawing objects.

Di sabl eDr awi ngUpdat es inhibit updates in the current drawing window until a program is
finished.

Cet Sel ect i onBounds find the rectangle corresponding to the boundaries of the current

selection in the current drawing window

Cetd i ckedCoord find the last clicked point in the current drawing window.
NewShape, Del et eShape, generic routines for creating, checking, changing and deleting any
Set ShapePr oper ti es, type of shape in a drawing window. (Every object in a drawing

Get ShapePr operty window, e.g. rectangles, groups, graphs, legends, etc, is a shape.)

Unless explicitly mentioned in the definition, all the above calls access the current drawing window. By
default, the current drawing window is the frontmost drawing window. Y ou can make another drawing
window the current drawing window by calling Set Cur r ent W ndow( wi ndowl D) withwi ndowi D
being the window ID of the desired drawing window.

The drawing routines work on a coordinate system that has its origin on the top left of the paper. Units
are points (1/72 of an inch).
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The following program creates a“ bull's eye” at the point where you last clicked
in the drawing window:

program Bul | sEye;
const radius = 40; step = 8;
var x0, yO0, t:real;

begin
Get d i ckedCoor d(x0, yO0);
G oupBegi n;
t .= step;
whi | e t<=radi us do
begi n
Drawkl |i pse(x0-t,y0-t, x0+t, yO+t);
t 1= t+step;

end;
MoveTo( x0-radi us*1.1, y0);
Li neTo(x0+radi us*1.1, y0);
MoveTo(x0, yO-radius*l.1);
Li neTo(x0, yO+radius*1.1);
Gr oupEnd;

end;

The drawing routines accept floating point numbers as parameters. pro Fit uses a precise floating point
coordinate system for drawings, and drawings created from aprogram will print at the highest resolution
on al output devices.
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Plotting in a graph

Pl ot Dat a, Pl ot Function plot a data set or a function.

Set Li neStyl e, set the line style (line thickness, color...) of future line-plots and the
Set Li neCol or, style of future data points.

Set Fi |l | Col or,

SetFill Pattern,
Set Dat aPoi nt St yl e,
Set BGDat aPoi nt St yl e

Set CurveFi | I, set the filling options of plots and the appearance of error bars for
Set EBar Styl e the next curve or data set added to the current graph.
OpenCur ve, start/end the definition of curves or data sets for the current graph

G oseCurve, OpenDat aSet,
Cl oseDat aSet

AddDat aPoi nt , add a data point (possibly including error bars) to the current data
Dr awDat aPoi nt set.

MoveTo, LineTo, Move, define a curve in the current graph.

Li ne

All the above calls access the current graph. To make a graph the current graph, double-click it while
holding the command key down. From a program, you can usethe call Set Cur r ent G- aph to make a
graph the current graph.
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Thefollowing isasmall example program drawing a Lissgjous figure in the drawing window:
program Li ssaj ous;
var xmn, xmax, ymn, ymax;
centerH, centerV, {center of the figure}
radi usH, radiusV, {and its radius}
angl e;
begi n
xm n: =1; xmax: =3;
ym n: =2; ymax: =5;
Cr eat eNewG aph(xm n, xmax, ym n,ymax, false,false);

centerH : = (xm n+xmax) / 2; 50

centerV := (ymin+ymax) / 2; ' e,
radi usH : = (xmax-xmin) * 0. 4; i '. e
radiusV : = (ymax-ymn) * 0.4; a0k mel

Set Li neStyl e(1,2); .................
OpenCurve(' Circle'); 3.0 - """"""

MoveTo(radi usHtcenterH, centerV); L T
angle := 0; 2.0 C |. ) 1 L 1 L

-~

while (angle <= 2*pi) do 1.00 150 2.00 250
begi n
Li neTo(radi usH*cos(3*angl e) +centerH, radi usV*si n(2*angl e) +centerV);
angle : = angle + pi/40;
end;
Cl oseCurve;

SetLi neStyle(1,1);
end;

Creating and accessing graphs

Set NewGr aphRect sets the default size and position of graphs created with
CreateNewGraph.

Cr eat eNewGr aph creates a new graph in a drawing window.

Get Cur r ent G aph, obtain a unique identification number for a graph and use it to

Set Cur r ent G aph, access different graphs.

Get Next Gr aph
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Editing the current graph

Set GraphAt tri but es set various options that determine the appearance of the current
graph.

Set LegendPr oper ti es set visibility, position and size of the legend of the current graph.

Get G aphFr ane, get/set the position and size of the current graph.

Set Gr aphFr ane

Get G aphCoor di nat es returns the ranges of the main axes in the current graph

Set Range, MakeTi cks, change the range, ticks, position, labels format, and various drawing

Set Label sFor mat , options for the current axis.

Set Axi sPosi ti on,
Set Axi sSAttri butes

Mak eNewAXxi s, create/kill coordinate axes in the current graph and change the
GetCurrent Axi s, current axis used to define a new curve or data set.

Set Current AXi s,

Del et eAxi s

ClearTicks, O earlables, definea custom listof tick marks and/or labels.

AddTi ck, SetLabel,
Set Label Text

All the above calls access the current graph. To make a graph the current graph, double-click it while
holding the command key down. From a program, you can usethe call Set Cur r ent G- aph to make a
graph the current graph.

Some of the above routines use or change the axes of a graph. They access the current x-axis or the
current y-axis. To make an axisthe current x-axis, call Set Cur r ent Axi s( XAxi s, i),wherei isthe
number of the axis (Set Cur r ent Axi s( XAXi s, 2) setsthe current x-axisto X2). To make an axisthe
current y-axis, call Set Current Axi s(yAXi s,i).

Cdllsthat work on the current axes are Set Axi sPosi ti on, Set Label sFor mat , etc. The following
code changes the position of the X2 axis of the current graph:

Set Cur rent Axi s(xXAXi s, 2); {2nd x-axi s}
Set Axi sPosi tion(xAxi s, 0.5);

Setting default parameters

Set Par anet er Properti es, Set and retrieve the value, name, limit and mode of a parameter
Cet Par anet er Property

Thisroutineisusually called in the procedure | ni ti al i ze of afunction. It allows to set the settings of
aparameter that are given in the Parameter window.

Example: Set Par anet er Properti es provides an alternative to the def aul t s statements (for
external modules, it provides an alternative to setting the various default values and names by hand).
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function foo;
procedure Initialize;
begin {initialization of param values, etc. }
Set Par anet er Properti es(param 1,
val ue sin(pi/4), node paranmictive,
nane 'pi',mn 0, max inf);
end;
begin {function definition}
y:=a[ 1] - si n(x);
end;

Using other functions or programs

Cal | Functi on, call a function or execute a program.
Cal | Program
Set Funct i onPar am access other functions’ parameters.

Get Funct i onPar am

Get Funct i onPar anivbde,

Get Funct i onPar anmNarne

Get NunFunct i onPar ans

Set Funct i onProperit es get and set function and program options, hide/show function in
Get Funct i onProperty preview window

Set Progr anProperti es,

Cet Progr anPr operty

Get Funct i onNane get name of current function

Sel ect Funct i on, select or delete a function or program

Del et eFuncti on,
Del et ePr ogr am

Get d obal Dat a, passing data between programs and/or functions
Set G obal Dat a
LoadPar anet er Set , controlling the parameter set menu

SavePar anet er Set ,

UsePar anet er Set ,

Del et ePar anet er Set ,

AddPar anet er Set

AddConmand add a command to the Prog menu

At t achPr ogr am attach a program to a drawing window

The following example program copies the active parameters of the current function to the first column of
the current datawindow. It aso calls afunction called ChangeUni t to calculate new parameter values
that it stores in the second column. Before using ChangeUni t , it setsthe value of itsfirst parameter to
zero.
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pr ogr am CopyPar ans;

var i:integer;
pa: real;

begi n

Set Funct i onPar an{' changeUnit', 1, 0.0);

for i:=1 to GetNunfFunctionParanms('') do
i f Get FunctionParamnibde('',i)=active then
begi n

pa: =CGet Functi onParan('"',i);
data[i, 1] : =pa;
data[i, 2]:=Call Function(' ChangeUnit', pa);
end;
end;

Numerics on functions

I nt egr at e, calculate the integral and the derivative of a function
Tabul at el nt egral,
Derivative

Root s, Tabul at eRoot s calculate roots
Fit set fitting, below.
Optim ze, Extrens, find extrema of a function by varying its x-value and/or its parameters
Tabul at eExt r ema
Tabul at e tabulate functions
Fitting
Fit runs a fit.
Cet Resul t retrieves the results.
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Thefollowing example runs afit and prints some of the results:

program DoFi t;
var i, nrParans:integer;

begi n

Fit(function Sin,

yCol um 2);
Witeln(' chi

squar ed:

al gorithm | evenberg,

xCol um 1,

CGet Resul t (chi Squared));

nr Parans : = GetResul t (chi Squared);

Witel n(' nunber of paraneters: ', nrParans);
for i := 1 to nrParanms do
witeln(' ', CetResult(fittedParaneter, i));
end;

Using Windows and Documents

NewDat aW ndow,
NewFunct i onW ndow,
NewDr awi ngW ndow

Get W ndowl D

Fr ont W ndow,
Fr ont nrost W ndow

Get W ndowType,

Set Cur r ent W ndow,
Cet Cur r ent W ndow,
Next W ndow

Get W ndowTi tl e,
Sel ect W ndow
OpenFil e

SaveW ndow

GetFileDirectory
Sel ectDirectory
Set Def aul t Di rectory

Cl oseW ndow

Dat al nport Opt i ons,
Dat aExport Opti ons

Set W ndowPr operti es,
Get W ndowPr operty

open a new data, function, or drawing window

obtain a unique identification number for a window from its title

obtain the ID of the document window in front of all others

check if a window is a drawing window, a data window, or a function
window.

change the window currently used for program input/output.

access the title of a window.
Bring window in front of all other windows
open a document and put it inside a new window

save a window's contents into an existing or a new pro Fit
document

Get the directory where a given file resides.
Select a directory from a dialog box.
Set the default directory used to save files without a full path name.

close a window.

set the format for loading and exporting text files

set or retrieve the info-text, size, title, position, etc. of a window.
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Conpi | e, Conpi | eText, compile the definition of a function or program

DoScri pt
PageSet up, Print specify document format and print

Note: Windows are usually accessed by window ID. A window ID is a unique long integer number
assigned to each window. Y ou can obtain awindow ID by caling Get W ndowl D, Fr ont W ndow,
Fr ont nost W ndow, GCet Current W ndow. The following example sets the name of the frontmost
data window to “favourite data’:

pr ogr am Set W ndowNane;
var w ndow D: i nt eger;
begi n
wi ndowl D : = Front nost W ndow( dat aType) ;
Set W ndowPr operti es(wi ndow wi ndow D, name
'favourite data');
end;

Note: The Results, Parameter and Preview windows aways have the same window ID:

Results: window ID =-1
Parameters: window ID =2
Preview: window ID =4

Thewindow IDs of data, text and drawing windows are dways larger than O.

String and character manipulation

Od, Chr convert between (real) ASCII codes and characters.
Length returns the length of a string.

Del et e deletes parts of a string.

Pos finds a pattern in a string.

InsertString inserts a string into another at a selectable position
CopyString copies a substring from a given string

Upper String, LowerString converts between upper- and lower case strings.

Nunber ToSt ri ng, convert between numbers and strings.
StringToNunber

Tags

Tags are pieces of datathat can be attached to awindow, a program or pro Fit itself. A tag isidentified by
its name and its value can either be a string or a number. Tags are primarily used for passing data to or
between programs/functions, for attaching custom data to windows or to pro Fit. Tags are identified by
the object they belong to (a program, function, window, or pro Fit itself) aswell as by their name.

Get Tag, Set Tag get and set individual tags.

Del et eTag deletes a tag.
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Example:
Set Tag(wi ndow ' nyWndow , tag 'tag 1', value 13); {saves the tag}
Get Tag(wi ndow ' myW ndow , tag 'tag 1', value x); {reads the tag to x}

From Apple script, you can use
get value of tag "tag 1" of w ndow "nmyW ndow"

Getting and Setting " Properties’ of various pro Fit objects

pro Fit 5.5 supports a general mechanism to retrieve or set various properties of various objects, such as
the coordinates of shapesin adrawing window, thetitle or size of awindow, etc. The following routines
provide access to the properties of drawing shapes, windows, function and programs, and pro Fit itself.

g: gﬂapegr oper: ies, generic routines for checking, and changing any type of shape in a
aperroperty drawing window. (Every object in a drawing window, e.g. rectangles,
groups, graphs, legends, etc, is a shape.)

Set W ndowPr oper ti es, set or retrieve the info-text, size, title, position, etc. of a window.
Get W ndowPr operty
Set Dat aW ndowPr oper ti es, get and set the number of columns and rows in the current drawing
Cet Dat aW ndowPr operty .

window.
Set Functi onProperties get and set function and program options, hide/show function in

Get Funct i onProperty
Set Progr anProperti es,
Cet Progr anPr operty

preview window

Set Opt i ons set and retrieve various options of pro Fit.
Cet Opti on
Set Par amet er Properti es set and retrieve the value, name, limit and mode of a parameter.

Cet Par anet er Property
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Miscellaneous auxiliary routines

Random
Invalid
Ti ckCount

Cet Dat eTi e,

DateString, TimeString

NunifoDat eTi neSt r,
Dat eTi meSt r ToNum

NuniToRel Ti meStr,
Rel Ti meSt r ToNum
Beep
SpeakString

Butt on, KeyPressed
Get d i ckedCoord

Mar kedX, Mar kedY,
Cet Mar kedCoor d

Undo, Cut, Copy, Paste,
Clear, SelectAll

DoMenu

Capture

SetWaitTitle, SetWiitText
Set Options, GetOption

Nunber ToSt r 255",
St r255ToNunber *

Get Modul eFi | e*

Deact i vat ePr oFi t W ndows*
Act i vat ePr oFi t W ndows”
Get Def aul t Dat a”

Get Col Handl e”,

Set Col Handl e*

Handl eEvent *,
Cancel Event *

returns a random number between 0 and 1.
checks if the result of a calculation is a valid number.
return the number of ticks (1/60 seconds) since start-up.

return today's date and time, either as a number of seconds since
1.1.1904 or as strings.

convert data & time numbers (seconds since 1.1.1904) into data &
time strings and vice versa.

convert relative times (seconds) into relative time strings and vice
versa. A relative time can be the difference of two dates.

lets your computer emit an alert sound.

lets your computer speak out loud a text string.

check the mouse button and the keyboard

find the last clicked point in the current drawing window.

find the position of coordinate markers in the preview window

execute edit menus

execute a menu command
redirect output of results window to file

set the text displayed in pro Flt's progress window, shown during
lengthy operations.

set and retrieve various options of pro Fit.

Advanced routines for external modules only

conversion

find a module's file

tell pro Fit that a module is opening a window of its own.

Get the current x- and y- data

Get and set in one step all the data contained in a column

event processing
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Alphabetical list

Abs
function Abs(x:real orconpl ex orvector):real;

Returns the absolute val ue of x.

ActivateProFitWindows
procedure ActivateProFi t Wndows;
External modules only. Activates pro Fit’'s frontmost window and enables the menus. Call this routine

after closing a window or a dialog that you created from an external module. Each call to
Act i vat ePr oFi t W ndows must be preceded by acall to Dect i vat ePr oFi t W ndows.

AddCommand
procedur e AddCommand(opti onal paraneter |ist);
Adds acommand to the Prog menu. Parameters:
command (string) The name of the command asit will appear in the menu.
program (string) The program the command belongs to. Omit if the command isto

belong to the currently running program.
When the user choses the new command in the Prog menu, the program the command belongs to is
called. Before calling the program, its tag 'msgWhy' is set to ‘command’ and its tag 'msgCommand’ set to
the name of the command.
To remove acommand added in thisway, call Del et ePr ogr am
When the program the command belongsto is removed from the menu, the command is deleted as well.

AddDataPoint
procedure AddDat aPoi nt (x,y, xErr1, yErrl, xErr2, yErr2:real);

Adds a new data point to the current data set in the current graph. x and y are the coordinates of the new
data point, xErr1 and yErr1, (xErr2 andyErr2) the lengths of the (asymmetric) error bars.
Depending on the parameters passed to OpenDat aSet , the parameters xEr r 1 through yEr r 2 may be
ignored.

Call openDat aSet before calling AddDat aPoi nt . The style and size of the data points can be set using
the routine Set Poi nt Styl e.

See aso Dr awbat aPoi nt .

AddParameter Set
procedur e AddPar anet er Set (opti onal paraneter list);

Adds the parameters that currently appear in the Parameter window to the parameter set menu.
Parameters:
set (string) The name of the set.
for All (boolean)Trueif the parameter set isto be available for al functions, falseif the parameter set is
only to be available for the current function. (Default: false)
per manent (boolean)true if the parameter set must be added permanently to the menu, i.e. if it will be
till available after aquit and restart. (Default: true)
See dso: UseParameterSet, SaveParameterSet, L oadParameter Set, Del eteParameter Set
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AddTick
function AddTi ck(whi chAxi s:integer; tickPos:real;
I sMaj or : bool ean) : i nt eger;
Adds a tick at the position t i ckPos to the current axis, makes it a mgjor tick if i sMaj or is true.
whi chAxi s iseither xAxi s Or yAxi s.

Adjoint
function Adjoint(mmatrix):matrix;
Returns the adjoint matrix of the matrix m
Alert
procedure Al ert(s:string);
Presents a dialog box displaying the string s.
Example: Caling Al ert (' I nconpl ete data.') opensthe following window:
Incomplete data.
(i
If you click ‘OK’ the program continues, if you click ‘Stop’ the program will be stopped.
In external modules, thisroutineiscalled Al er t Box.
AlertBox

function Al ertBox(s: Str255): bool ean;

External module name. See Al ert. In external modules Al ert Box isafunction, and it returnstr ue if
the Stop button was clicked.

ar ccos
function arccos(x:real):real;
ar ccos returnsthe arcus cosine (the inverse cosine) of x. Causes arun-time error if [x| > 1

arcsin
function arcsin(x:real):real;
ar csi n returnsthe arcus sine (the inverse sine) of x. Causes arun-time error if [x| > 1

arctan
function arctan(x:real):real;
ar ct an returns the arcus tangent of x

arcosh

function arcosh(x:real):real;
ar cosh returns the inverse of the hyperbolic cosine of x. Causes arun-time error if |x| < 1. arcosh is

defined by
arcosh(x) = In(x +1/x2 —1).
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arsinh
function arsinh(x:real):real;

ar si nh returnsthe inverse of the hyperbolic sine of x. arsinh is defined by
arsinh(x) = In(x+\x2 +1).

artanh
function artanh(x:real):real;
ar t anh returns the inverse of the hyperbolic tangent function of x. Causes a run-time error if [x| > 1.
artanh is defined by
0 /x+10
artanh(x) = In%\s‘—g
C x1

Ask
function Ask(s:string):bool ean;

Presents adialog box displaying the string s. The box hasa 'Y es and a No button. If the user clicks Y es,
ask returnstrue, if he clicks No, ask returns false.
Example: Calling Ask('Continue transformation ?) displays the following window:

i"_\ Continue transformation ?

| 1] I Yes

In external modules, thisroutine is called AskBox.

AskBox
function AskBox(var retval:integer; s:Str255): bool ean;
External Module name. See Ask. The return values depend on the button that was clicked:
* Yesbutton: retval island AskBox returnsf al se.
* No button: retval isOand AskBox returnst al se.
o Stop button:  r et val isundefined and AskBox returnst r ue.
If AskBox returnstrue, you should stop executing your function or program.
AttachProgram
procedure AttachProgran{optional paraneter |ist);
Attaches a program to adrawing window. Parameters:
program (string): The program (source) to attach. To add a long string, you can
repeat this parameter. Y ou can repeat this parameter if you have a long
program.
window (string or integer) The window's name or reference ID. Omit for front
window.

Example:
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At t achPr ogranm(program ' program attached; '
program ' begi n Beep; end;');

Beep
procedur e Beep;

produces an alert sound.

BinData
procedure Bi nData(optional parameter list);
Bins a given data set. "Binning" is the process of putting data into bins, i.e. consecutive intervals. For

each datavalue, the bin or interva it belongs to is determined and the size of the bin isincreased by 1. In
other words, the number of valuesin each bin are counted. Parameters:

window (integer or string) The name or window ID of the window of the input
data. Default: Front window

column (integer) The input column (omit for using the currently selected data).

selectedRowsOnly (Boolean) Set to true if you only want to bin the selected rowsin the given
column. Default: false

from (real) The start of the bins, i.e. the left border of thefirst bin.

to (real) The end of the bins, i.e. the right border of the last bin.

nrBins (integer) The number of bins.

scaling (i nScaling, |ogScaling, recScaling, probScaling):
the scaling used for distributing the bins. Default: | i nScal i ng.

outputWindow (name or windowI D) The window to hold the resulting data. If no window

with the given name exists, a new window with this name is generated.
Omit for creating a new window with default name.

binCenter Column (integer) The column for storing the centers of the bins. Set to O if you
don't want this column. Default: 1.
binSizeColumn (integer) The column for storing the sizes of the bins. Set to 0 if you don't

want this column. Default: 2

BitAnd
function BitAnd(il,i2:integer):integer;

BitAnd applies the bitwise 'and'-operation on two integer numbers and returns the result as an integer
number. Note that the arguments are rounded to (long) integersfirst.

BitClIr
procedure Bitdr(i,offset:integer);

BitClr setsthe bit at this offset in an integer number to '0'. Note that the arguments are rounded to (long)
integersfirst.

BitNot
function BitNot(i:integer):integer;

BitNot applies the bitwise 'not’-operation on an integer number and returns the result as an integer
number. Note that the argument is rounded to a (long) integer first.

BitOr
function BitOr(il,i2:integer):integer;

BitOr applies the bitwise 'or'-operation on two integer numbers and returns the result as an integer
number. Note that the arguments are rounded to (long) integersfirst.
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BitSet
procedure BitSet(i,offset:integer);

BitSet setsthe bit at this offset in an integer number to '1'. Note that the arguments are rounded to (long)
integersfirst.

BitShift
function BitShift(i,offset:integer):integer;

BitShift shifts the bits of the integer number by offset and returns the result as an integer number. Note
that the arguments are rounded to (long) integersfirst.

BitTst
function BitTst(i,offset:integer):bool ean;

BitTst returnstrue if the bit at this offset in an integer number is'1'. Note that the arguments are rounded
to (long) integersfirst.

BitXOr
function BitXOr(il,i2:integer):integer;

BitXOr applies the bitwise "Xor'-operation on two integer numbers and returns the result as an integer
number. Note that the arguments are rounded to (long) integersfirst.

BringWindowT oFront
procedur e Bri ngW ndowToFront (W ndow D: i nt eger);
Obsolete. UseSelectWindow instead.

Moves the specified window in front of all other windows. windowID isawindow id, such asitise.g.
returned by Get W ndowl D Or Get Cur r ent W ndow.

Button
functi on Button: bool ean;

Returnstrue if the mouse button is pressed.

CalcStat
function Cal cStat (col um:integer;
sel RowsOnl y, wi t hBasi cs, wi t hSkewAndKur t ,
wi t hMedi an: bool ean) : bool ean;

Obsolete. Use Statistics instead.

Runs a statistical analysis on the numbers in the current data window. The results of the calculations can
be accessed using the routines GetBasics, GetMedian, and GetSkew.

CalcStat returnsfalse if an error occurred, true if the calculation completed correctly. Set column to O to
include all columns, set it to -1 to use the current selection. Set selRowsOnly to true if you only want to
analyze the currently selected rows.

If you consequently want to use the results of GetBasics, set withBasics to true. If you want to use the
results of GetMedian, set withMedian to true. If you want to use the results of GetSkew, set
withSkewAndKurt to true.

CallFunction
function Call Function(name:string; x:real):real;

Calls afunction from the Func menu. nane is the name of the function as it appears in the menu. This
parameter is case sensitive. Pass an empty string (' * ) to call the currently selected function. x is the x-
value passed to the function.

Cal | Functi on causesarun-time error if the specified function does not exist.

Example:
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k: =Cal | Function(' Pol ynom , 1.23)

m =Cal | Function('"',0);
k is set to the value of the built-in function Polynom at x=1. 23, using the parameters as given in
Polynom’ s parameters window. mis set to the value returned by the currently selected functions at x=0.
If you want to set a parameter of the function before calling it, use SetFunctionParam.
In external modules, after you call Cal | Functi on you should call Test St op to check if the called
function has interrupted execution.

CallProgram
procedure Cal | Progran(nane: string);

Calls a program, module or AppleScript. name is its name as it appears in the Prog menu. .i.programs
;.1.macros ;.i.scripts,

causes arun-time error if the specified program or script does not exist. Note that nane is case-sensitive.
In external modules, after calling Cal | Progr am you should call Test St op to check if the called program
has interrupted execution.

CancelEvent
function Cancel Event (var theEvent: Event Record): bool ean;

External modules only. For advanced programming. Returnst r ue if the given event is a key down event
for the escape-key or for command and ‘.’

Capture
procedure Capture(optional paraneter list);
Controls redirection of results window to atext file. Parameters:
file (string) The file to capture the window into. Use a simple name or afile
path. If you pass this parameter, a new capturefile is opened and capturing
starts. Omit this parameter when passing the parameter ‘option’.
option (integer) capt ur eOn (= start capturing into thefile) , capt ureof f (= stop
capturing but leave capture file open) , capt ur e ose (= stop capturing
and close capture file) . Omit this parameter when passing the parameter
‘file’.
Example:
Capture(file "nyFile');
now, output isredirced to the givenfile
Capt ure(option captureOrf);
now, output to the file is temporarily suspended
Capt ure(option captureQOn);
now, output to thefileis again turned on
Capt ure(option captured ose);
now, output to the fileis turned off and thefileis closed

CellSelected
function Cel | Sel ected(row, col um: i nteger): bool ean;

Returnst r ue if the given cdl in the current datawindow is selected

ChiSquared
function Chi Squar ed: real ;

Returns the yalue of the mean deviation function xR obtained in the last fit. X is the mean square
deviation x < if the last fit was performed using Gaussian distributed errors. Otherwise it is the value
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obtained by applying whatever deviation function must be applied for the given error specifications. See
chapter 8, “Fitting”, for more details.

Causes arun-time error if the last fit was not successful. Y ou can check if the last fit was good using the
function nunFi t Par ans.

Chr
function Chr(i:integer):char;
Convertsthe given (real) ASCII codei to acharacter.
Clear
procedure d ear;
Equivalent to selecting “Clear” from the “Edit” menu.
ClearData

procedure d earData(row, col:integer);

Removes any numerical value in the given cell (row/column) of the current data window and leaves an
empty cell.
Causes arun-time error if no datawindow is open or if the given cell lies outside the bounds of the list.

ClearLabels
procedure d earLabel s(whi chAxi s:integer);

Killsal labelsin the current axis. whi chAxi s iSeither xAxi s or yAxi s.

ClearTicks
procedure d ear Ti cks(whi chAXxi s: i nteger);

Killsal ticksin the current axis. Call before using AddTi ck. whi chAxi s iSeither xAxi s OF yAxi s.

CloseCurve
procedure O oseCurve;
Stops data collection for the current curve.
CloseDataSet
procedure d oseDat aSet ;
Stops data collection for the current data set.
ClosePoly

procedure O osePol y;
Stops data collection for the current polygon, opened by calling GpenPol y

CloseTextFile
procedure O oseTextFil e(fil eRef Nunber:integer);

Closesthe given text file. f i | eRef Nunber isthe reference number returned by Cr eat eText Fi | e.

CloseWindow
procedure O oseW ndow( optional paraneter list);

Closes awindow. Parameters:

window (integer or string) The name or window 1D of the window.
Default: Front window
saveOption (integer) saveToFi | e (= always save into its file), dont Save (= never

save), askUser (= if window has been changed, ask user if it should be
saved). Default isaskUser .
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There is also an obsolete version of CloseWindow, which is supported for compatibility with older
versions. Do not useit in new programs:

CloseWindow
procedure C oseW ndow(w ndow D: i nteger; savelt: bool ean);

Set savelt tof al se if you do not want to save the window, even if it was changed. wi ndowi D specifies
the window.
This procedure cannot be called while afunction is running.

ColEmpty
function Col Enpt y(col umNunber : i nt eger) : bool ean;

Returnstrueif the given column of the current data window doesn’t contain any data.

Compile
procedure Conpil e(w ndow D: i nteger);

Compiles the given text window. Equivalent to choosing “Add to Menu” from the Customize menu.
Generates arun time error if wi ndowt D does not belong to a function window, or if asyntax error occurs.
wi ndowt Disawindow id, such asit isreturned by Get W ndow D Or Fr ont W ndow.

See also: Conpi | eText

CompileText
procedure Conpil eText (optional paraneter list);

Compiles a given text. Equivalent to Compile, but the text containing the definition of a program or
function istaken directly from the parameters of CompileText, instead of awindow.
Parameters:

text A text containing the full definition of aprogram or afunction.
This parameter can be repeated many times when calling this function, and the pieces of text will be
automatically concatenated together.
See aso: Conpi | e

Compl
function Conpl (r1,r2:real):conpl ex;

Returns the complex number with rl for real part and r2 for imaginary part.

Confidencel nterval
procedure Confidencelnterval (i:integer;var mn, nax:real);

Returns (in ni n, max) the confidence interval for parameter i asit was calculated in the last fit.

Note that this routine does not return meaningful resultsif the confidence interval for a given value was
not determined, e.g. because the given parameter was not active during afit or because the chosen fitting
agorithm did not calculate confidence intervals.

See aso: Par anSD

Conj
function Conj (z:conpl ex): conpl ex;

Returns the complex conjugate of z.

Copy
procedure Copy;

Equivalent to selecting “ Copy” from the “Edit” menu.
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CopyString
function CopyString(src:string; idx:integer; len:integer):string;
Returns a substring of the string sr c. i dx defines the start of the substring (1 for first character) insrc,

| en itslength in chararcters. If you choose bad values for i dx or | en, CopySt ri ng returns a shorter or
an empty string.

Exanpl es:
CopyString('there is no way', 1, 3) returns 'the'
CopyString('this is good' , 6, 200) returns 'is good'
CopyString('cogito ergo sunm, 8, 4) returns 'ergo'
Ccos
function cos(x:real):real;
Returns the cosine of x.
cosh

function cosh(x:real):real;
Returns the hyperbolic cosine of x. cosh is defined by

cosh(x) = ex+2 .

CovarMatrix
function CovarMatrix(i,j:integer):real;

Returns the values of the covariance matrix obtained in thelast fit. i andj arethe indices corresponding
to the parameter numbers.

Covar Mat ri x returns an invalid number (NAN: Not A Number) if i orj correspondsto a parameter that
was not active during the last fit. Y ou can test the vaidity of the return value using the function | nval i d.
Causes arun-time error if the last fit was not successful or if i ,j are out of range. Y ou can check if the
last fit was successful by using the function NunFi t Par ans.

CreateNewGraph
procedure Cr eat eNewG aph(xm n, xmax, ym n, ynmax: real ;
xScal i ng, yScal i ng: i nt eger);
Creates anew graph in the current drawing window. xmi n, xmax, ymi n, ymax are the ranges of the graph
axes. xScal i ng, yScal i ng must be set to either 0,1,2, or 3 for linear scaling, logarithmic scaling, 1/x
scaling and probability scaling, respectively.
Causes arun-timeif the ranges or axes styles are inconsistent.

CreateTextFile
function CreateTextFile(fileNane:string):integer;

Creates a text file with the given name in the default directory and returns a reference number used to
identify this file. Call witeToTextFil e to redirect the output from callsto wite /Witeln /
Wit eNunber into thisfile and use d oseText Fi | e to close the file when you are through.

If fil eName isof theform' ?' or' 2: nyName' , a save dialog box is displayed. The text file will be
created in the selected directory.

The parameter opt can take the values:

0= new filerequired,

1 =append if existing text file,

2 = overwrite if existing text file,

3 = overwrite any existing file
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Cut
procedure Cut;

Equivalent to selecting “ Cut” from the “ Edit” menu.

data
array data[row, col:integer] of real;

This array holds the data of the current data window. Assigning avalueto dat a[ r ow, col ] setsthevaue
of acell in thiswindow. Reading the cell dat a[ r ow, col ] returns the value of a cell. Causes run-time
errorsif the data cell is not within window, if the cell isempty, if the cell is part of atext column, or if no
datawindow is open. Always call Dat aOK(r ow, col ) beforeusing the value of dat a[ r ow, col ] .

The array dat a does not exist for external modules. External modules must use the routines Set Dat a
and Get Dat a for numeric cellsand Get Cel | and Set Cel | for text cells. In addition to this, the routines
Get Def aul t Dat a, Get Col Handl e and Set Col Handl e provide some fast low-level access.

DataExportOptions
functi on DataExport Qpti ons(optional paranmeter list);

Sets the options for exporting data windows as text files.

Parameters:
mode Specifies the basic format. Pass withTitles (for standard format with
column titles) , withoutTitles (for standard format without column titles) ,
or customFormat (for a customized format as specified in the following
parameters) .
withTitles (boolean)Add the text from the info field to the beginning of thefile.
copylnfo (boolean)Write the text from the info field.
optimize (boolean)Remove leading spaces and trailing zerosin al numbers,
delimiter (string)Column delimiter, at least 1 character. Typical values are:
- \t' which defines a tabulator (decimal 8),
- ""which isasimple space,
-','whichisasimple comma,
- Any combination of charactersand \t'.
Usualy, \n' (line feed) or "\r' (carriage return) should not be used.
terminator (string)Line terminator appended after each row, at least 1 character.

Typica vauesare:
- \r' which defines a carriage return (decimal 13),
- \n" which defines aline feed (decimal 10),
- Any combination of charactersand \r', \n'.
Note that the line terminator must not be equal to the column delimiter.
firstLine (string) A string to be added to thefirst line of the file.
To export datainto atext file, fist call DataExportOptions for setting the desired file format. Then call

SaveWinow and pass textFileType for the parameter
See also: DatalmportOptions

Datal mportOptions
function Datal nport Qptions(optional paraneter list);
Sets the options for importing text files. Parameters:
mode (integer) Specifies the basic format . Pass asFunction (for loading text
files into a text window) , withTitles (for loading text files as data in
standard format with column titles) , withoutTitles (for loading text files as
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data in standard format without column titles) , or customFormat (for
loading text files as datain a customized format as given by the following

parameters)
headerLines (integer) The number of lines to be skipped at the beginning of thefile,
copylnfo (boolean) Copy the header lines (specified with parameter headerLines)
into the info field of the data window.
withTitles (boolean) Read the column titles.
delimiter (string) Column delimiter, at least 1 character. Typical vauesare:

- \t' which defines atabulator (decimal 8)
- ""which isasmple space,
-','whichisasimple comma,
- '\s stands for “1 or more spaces’,
- \w' stands for “1 or more spaces and/or tabulators in any
sequence”’,
- Any combination of characters and "\t'.
terminator (string) Line terminator after each row, with at least 1 character. Typical vaues are:
- \r' which defines a carriage return (decimal 13) ,
- \n' which defines aline feed (decima 13) ,
- Any combination of charactersand '\r', \n'.
Note that the line terminator must not be equal to the column
delimiter.
To import data from atext file, fist call DatalmportOptions for setting the desired file format. Then call

OpenFile and passtextType (for loading the file into a function window) or dataType (for loading the file
into adatawindow) for the parameter “type”.

DataTransform
procedure DataTransforn{optional paraneter |ist);

Performs various data transformations on a data window. Corresponds to the command “Data
Transform...” of the “Calc” menu.

Parameters:

window (string or integer) The name or window ID of the data window.

operation (integer) The operation to be performed. Use one of the constants: sunp,
mul t Op, subOp, divisionOp, powerOp, DIVOp, MODOp,
i ntegrateQp, derivativeOp, fornulaOp, functionOp, sqrQOp,
sqrtOp, invertOp, absOp, expOp, InOp, tentoOp, | ogOp,
fill_0, fill_1, fill_N, sinOp, arcsinOp, cosOp, arccosOp,
tanQp, arctanOp, sinOp, arcsinQp, cosOp, arccosOp, tanOp,
ar ct anQOp.

selectionOnly (boolean) True if operating on current selection, false if operating on x and
y column.

selRowsOnly (boolean) Trueif operating on the selected rows only.

xColumn (integer) The x-column (omit if you passtrue for selectionOnly)

yColumn (integer) They-column (omit if you pass true for selectionOnly)

function (string) The function to be used if operationisf uncti onQp.

formula (string) Theformulaif operation is set to formula.
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argumentColumn (integer) The column to be used as argument if the operation works on a
column argument.
argumentValue (real) The value to be used if the operation works on a value argument.
To use this command, you best choose “ Start Recording” from the Customize menu, then choose “Data

Transform...” from the Calc menu and set the desired options. Hit ok. The correct call isthen recorded in
your function window.

DataOK
function DataOK(row, col :integer): bool ean;

Returnst r ue if the given cell of the current data window contains a numeric value, returnsf al se if the
cell isempty, if it ispart of atext column, or if it lies outside the data window. Use this function before
reading adata cell.
Example:

if DataOK(i,j) then nyVariable := data[i,j];
Dat aOK causes arun-time error if no data window is open.
The external module name for thisfunction is Test Dat a.

DateString
function DateString(format:integer):string;

Returns a string with today's date. f or mat defines the formatting of the string and can take the following
values: short Dat e ('1/31/92), abbr evDat e ('Fri, Jan 31, 1992, | ongDat e (‘Friday, January 31, 1992").
See dso: TimeString

DateTimeStr ToNum
function DateTi neStrToNun(s:string):real;

Convertsthe string s into anumber of seconds since 1.1.1904.
Use 'BC' placed after the year for dates'Before Christ'.

pro Fit uses system routines to achieve this conversion. Y ou may select the country specific formatting
either through the system control panel or in the pro Fit preferences.

Best results are achieved by strings like
'14.5.1345 12:55:3.40'
(14. May 1345 at 12 o'clock, 55 minutes and 3.4 seconds).

DeactivateProFitWindows
procedure Deacti vat eProFi t Wndows;

External modules only. For advanced programmers only. Deactivates all of pro Fit's windows and
disables all menus. Call this routine before showing a window or creating a dialog. Each call to
Dect i vat ePr oFi t W ndows must be matched with acall to Act i vat ePr oFi t W ndows.

Delete
procedure Del ete(s:string; first, length:integer);

Deletes| engt h charactersin s, starting from character fi r st . To delete all characters until the end of the
string, pass 255 for | engt h.

Example:
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s := 'hi there';
Delete(s, 4, 2);
Witeln(s); {writes "hi ere'}

DeleteAxis
procedure Del et eAxi s(whi chAxi s:integer; axislD: integer);

Deletes the given axis. axislD corresponds to the number used in the axis popup menu in the dialog box
that appears when double clicking an axis, e.g. axisiD=2 for axis X2. whichAxisis either xAxis or yAXis.

DeleteFunction
procedure Del et eFunction(func:string);

Removes the given function from the “Func” menu. func is the name of the function.
See also: DeleteProgram

DeletePar ameter Set
procedur e Del et eParanet er Set (opti onal parameter list);

Deletes a parameter set previoudy saved with SaveParameterSet. Does nothing if the parameter set is not
found. Parameters:

name (string) The name of the set. Omit to delete all the sets belonging to the
given function.
of Function (string) The function the parameter set belongs to. Omit if the parameter
set was availableto all functions.
file (string) The file from which the parameter set must be deleted. Omit to
delete from permanent set.
fromMenu (boolean) True if the param set must be deleted from the parameter set
menu. Default: true)
fromFile (boolean) Trueif the param set must be deleted from thefile.
Default: true.
See ds0: AddParameter Set, UseParameterSet, SaveParameterSet, L oadParameterSet
DeleteProgram
procedure Del et eProgran(prog: string);
Removes the given program, module or script from the “Prog” menu. prog isits name.
See also: DeleteFunction
DeleteShape
procedure Del et eShape(optional paraneters);
Deletes a shape . Parameters.
shape (string) The name of the shape.
window (string or integer): The name or 1D of the window that contains the shape.
Omit for using the current drawing window.
See also: NewShape
DeleteTag

procedure Del et eTag(optional paraneters);

Deletes atag. Parameters:
tag (string) The name of thetag.
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program (string) The name of the program if the tag belongs to a program. Pass an
empty string (' ' ) for the currently running program. Omit if the tag does
not belong to a program.
window (string or integer) The name or id of the window the tag belongs to. Omit
iIf the tag does not belong to awindow.
See also: Get Tag, Set Tag

Derivative
function Derivative(nane:string; x,scale:real):real;

Returnsthe derivative of afunction. nane isthe name of the function asit appears in the Func menu. This
parameter is case sensitive. Use an empty string (' ') for the function that is currently selected in the Func
menu. x is the x-coordinate where the derivative must be calculated. scal e is the length of atypical
interval of x-values over which the function’ s value changes.

For the parameter scal e, arough estimation is good enough. scal e istypically something like the length
of the x-axis when you plot your function. It must not be too small. As an examplg, if your function
describes a 20 nslaser pulse and usestime in seconds asits input, set scale e.g. to 10 (10 ns).

Causes arun time error if the function does not exist.

Deter minant
function Determ nant (m matri x): conpl ex;

Returns the determinant of the matrix m

DisableDrawingUpdates
procedur e Di sabl eDrawi ngUpdat es;

By default, pro Fit draws a shape immediately after a program created it. If you don’t want shapes to be
drawn immediately, call this routine before you start drawing. This can accel erate the execution of your
program.

There isn't any “Enabl eDr awi ngUpdat es” routine. Di sabl eDr awi ngUpdat es inhibits drawing until
your program has finished.

Div
operator il Div i2

This operator calculates the integer division of i 1 andi 2. Note that the arguments are rounded to (long)
integersfirst.

DoCloseWindow
procedure Dod oseW ndow wi ndowl D: i nt eger; savelt: bool ean);

External module name, see d oseW ndow

DoMenu
procedure DoMenu(theMenultem string);

Executes a command appearing in pro Fit's menus. t heMenul t emdefines the command to be executed.
To execute acommand from anormal (not hierarchical) menu, t heMenul t emhas the format:
'menu name:item name'
To execute acommand from a hierarchical menu, t hemenul t emhas the format:
'menu name:submenu name:item name'
Instead of specifying an item name, you can aso specify the number of the item in the menu preceded by
#.
This procedure cannot be called while afunction is running.
Examples:
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DoMenu(' Edi t: Copy');

DoMenu(' Cal c: Nonlinear Fit...");

DoMenu(' Cal c: Fourier Transform FFT...$OK' );

DoMenu(' Draw: Rot ate: #1' ) ;
If the command that you select in thisway brings up adialog box and if you want to automatically click
the OK button of this dialog box, add ' $ok' to the end of the string. Adding ' $OK' to the end of the
string has the same effect asimmediately clicking OK when the dialog box comes up, but the dialog box

will not appear.

DoScript
procedure DoScri pt (wi ndow. i nt eger);

Runs the script in the given window. window isits window ID. Equivalent to selecting “Run” or “Run
Selection” from the menu “ Customize”.

DoNewWindow
procedur e DoNewW ndow( wi ndowType: OSType) ;

External modules name. See NewW ndow.

DrawArc
procedure DrawArc(left,top,right,bottom start,length:real);

Creates an arc inside the specified bounds in the current drawing window. It is a part of an ellipse. The
arc extends from theangle st art to theanglest art +l engt h.

DrawDataPoint
procedure DrawbDat aPoi nt (x,y:real);

Creates a data point at the coordinates x,y in the current drawing window. It uses the point style set by
SetDataPointStyle, SetBGDataPointStyle.

If OpenDataSet has been called before calling DrawDataPoint , then DrawDataPoint creates a new data
point in the current graph instead of drawing in the drawing window. In this case DrawDataPoint adds a
point with zero error bars, a call to DrawDataPoint(x,y) is then equivalent to a call to
AddDataPoint(x,y,0,0,0,0);

DrawEllipse
procedure Drawkl |i pse(left,top,right, bottomreal);

Creates an €llipse inside the specified bounds in the current drawing window.

DrawLine
procedure DrawLi ne(start_h,start_v,end_h, end v:real);

Creates alinein the current drawing window extending between the given start and end pointSst art _h,
start_v, end_h, end_v.

DrawNumber
procedure DrawNunber (theNumreal ; decs:integer; theAngle:real;
docent er : bool ean) ;

Converts t heNumto a string and draws it in the current drawing window. decs defines the number of
digits after the decimal point that must be displayed.

The text appears at the current pen position, set with MoveTo. If doCent er istrue, the number is centered
on the current pen position and the current pen position remains unchanged. If doCent er isfase, the text
starts at the current pen position and the current pen position is offset to the end of the text. t heAngl e
defines the rotation of the text and can take the values 0, 90, 180 and 270.

If doCent er isfalse, the current pen position is offset to the end of the string.
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DrawPICT
procedure DrawPl CT(Il eft,top, right, bottom extended; thePict:PicHandl e);

External modules only. Creates a new picture in the current drawing window using the Mac OS
Pi cHandl e t hePi ct .| eft andt op give left top corner of the picture. ri ght and bot t omare used to
define the size of the pictureif they are larger than left and top, respectively. Otherwise the size is derived
from the information givenint hePi ct .

DrawRect
procedure DrawRect (l eft,top, right,bottomreal);

Creates a new rectangle with the given bordersin the current drawing window.

DrawT ext
procedure DrawTlext (theString:string; theAngle:real; docenter: bool ean);

Draws a text in the current drawing window. The text appears at the current pen position, set with
MoveTo. If doCent er istrue, thetext is centered on the current pen position and the current pen position
remains unchanged. If doCent er isfalse, the text starts at the current pen position and the current pen
position is offset to the end of the text. t heAngl e defines the rotation of the text and can take the values
0, 90, 180 and 270.

If doCent er isfalse, the current pen position is offset to the end of the string.

DrawTextLine
procedure DrawTlextLi ne(theString: Str255; theAngl e: ext ended;
docent er : bool ean) ;

External module name. See Dr awText .

Erf
function Erf(x:real):real;
The error function, defined by
erf(x) = -2 (G
VT4
Erfc

function Erfc(x:real):real;

The complementary error function, erfc(x) = 1-erf(x)
(Erf and Erfc are also available as PEr f and PEr f ¢ for external Pascal modules to avoid ambiguities
when using the unit fp.p, which defineserf anderfc.)

Even
function Even(i:integer): bool ean;

Returnstrueif i isan even number. Note that the argument is rounded to an (long) integer.

Exit
procedure EXit;

Exitsalocal function or procedure. If called in main body of a program or function, exits the program or
function. Seeaso: Hal t .

Exp
function Exp(x:real):real;

The exponential function.
exp(x) = X

Appendix A: Predefined functions, procedures and arrays 239



Extrema
procedure Extrema(optional parameter list);

Finds the minima/maximaof afunction by varying its x-value within agiven interval. Parameters:

function (string) The function to be used. Omit for current function.
xMin (redl) The start of the x-interval to be searched for extrema.
XM ax (real) The end of the x-interva to be searched for extrema.
subintervals (integer) The number of sub-intervals to be searched in the x-interval.

When the function’s derivative changes its sign over a sub-interval, the
sub-interval is searched for a minimum or maximum.

printResults (boolean) Set to true for printing the results to the Results window. Omit
“printResults” or set it to false for suppressing this.

To retrieve the results of acall to procedure Ext r ema, call the function Get Resul t (sel ector...).Use
one of the following selectors:

ext r emaCount : the number of extremafound (< 100)
ext remaxval ue: X-vaue of each extremal point*
ext remaYVal ue: y-value of each extremal point*

ext remaSi gn: specifiesif given point is minimum (extremaSign hasvalue—1) or maximum
(valuel) *
* pass an index (1..extremaCount) as second parameter to GetResult

The following example finds the maxima of the current function between —1 and 1, then prints them:

pr ogram Maxi maFi nder ;
var i, nrPoints:integer;
begi n
Extrema(xM n -1, xMax 1, sublntervals 50);
nr Poi nts: = Get Resul t (ext renmaCount) ;
for i := 1 to nrPoints do
if GetResult(extrenaSign,i) > 0 then {if nmax.}
Witel n(Get Resul t (extremaXVal ue, i));

end;
false
const false = 0;
This constant stands for the logical value of false.
Fit
procedure Fit(optional paraneter |ist);
Runs afit. Parameters:
function (string) Function to be fitted. Omit for current function.
algorithm (integer) Algorithm to be used: levenberg, montecarlo, robust, linear,
polynomid.
window (string or integer) The data window’ s name or window ID. Omit for fitting
the front window.
xColumn,
yColumn (integer) The columns containing the x- and y-data. Pass -99 for using the

row index as x-column.
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XErrKind

XErrColumn
XError

XErrDistribution

yErrKind

yErrColumn
yError
yErrDistribution
autoSearch
selRowsOnly
fullDescription
onlyActiveParams

stopCounter

doErrorAnalysis

confidence

printResults

(integer) Errors of the x-data: i ndi vi dual Error (if the x-errors are
found in a column, passed in parameter “xErrColumn”),
constant Error (if the x-errors are constant, passed in parameter
“xError”), percent Error (if the x-errors are in percent, passed in
parameter “xError”), zeroError (if the x-errors are assumed to be
Zero) .

Omit if x-errors are unknown.

(integer) The column containing the x-errors if “xErrKi nd” is
individua Error.

(real) The x-error if “xErr Ki nd” iSconst ant Error Of percent Error.
(integer) The distribution of the x-errors: gaussianDistribution,
lorentzDistribution, expDistribution, tukeyDistribution,
andrewDistribution.

(integer) Errors of the y-data: i ndi vi dual Error (if the y-errors are found
in a column, passed in parameter “yErr Col um”) , const ant Error (if
the y-errors are constant, passed in parameter “yError ™) , per cent Error
(if the y-errors are in percent, passed in parameter “yError”) ,
unknownEr ror (if the y-errors are unknown)

Omit if the y-errors are unknown.

(integer) The column containing the y-errors if “yErrKi nd” is
individua Error.

(real) They-error if “yErrKi nd” iSconst ant Error Of percent Error.
(integer) The distribution of the y-errors: gaussianDistribution,
lorentzDistribution, expDistribution, tukeyDistribution,
andrewDistribution.

(boolean) Trueif the Monte Carlo fit agorithm should vary the parameters
within floating, i.e. not fixed ranges.

(boolean) True if the fit should take only the selected rows into
consideration.

(boolean) True if a complete protocol of the fit is to be printed in the
results window, falseif a shortened protocol isto be printed.

(boolean) Trueif al parameters are to be printed in the results window,
faseif only the fitted parameters are to be printed.

(integer) Defines the number of iterations if algorithm is montecarlo. Set
to 0 if you want the fit to continue until it isinterrupted manually. Omit for
al other fitting algorithms.

(boolean) True for running a statistical error analysis after the fit (slow) ,
falseif errors are to be derived from the covariance matrix (Levenberg-
Marquardt algorithm only) . Default: false

(real) The desired confidence interval for statistical error analysis. Omit if
doErrorAnaysisisfase.

(boolean) Set to true for printing the results to the Results window. Omit
“printResults” or set it to false for suppressing this.

To retrieve the results of the fit, use the function Get Resul t (sel ector. . . ). Use one of the following
selectors:

Appendix A: Predefined functions, procedures and arrays 241



chiSquar ed
nrFittedParameters
fittedPar ameter
covariance
confidenceMin,
confidenceM ax
standardDeviation
nrlterations
goodnessOfFit
nrDataPoints
sumOfDeviations
correlation
probCorrelation

chi squared

number of fitted parameters

fitted parameters*

elements of the covariance matrix **.

lower and upper limits of the fitted parameters *

standard deviation of fitted parameters

number of used iterations

goodness of fit

number of fitted data points

sum of deviations (only after robust fit)

linear correlation between x- and y-values (only after linear fit)
significance of linear correlation (only after linear fit)

*  Pass parameter index (1 based) as second argument to GetResult
* x Pass matrix indices (1 based) as second and third arguments to GetResult

Note: The old definition
procedure Fit(funcNane:string; xCol, yCol,
errCol :integer; errVal:real;
sel ecti onOnl y: bool ean
is still supported but obsolete — do not useit in new programs.

FittedParams
function FittedParans(i:integer):real;
Obsolete. Use Get Resul t (fittedParaneters, i) instead.
Returns the parameter values obtained in the last fit. i isthe parameter index.
Causesarun-timeerror if i isout of range or if the last fit was not a successful fit.
FFT

procedure FFT(optional paraneter |ist);

Performs a Fourier transform on a data window. Input is a column of real values in the time domain,
output are two columns of real/imaginary or amplitude/phase in the frequency domain. Parameters:

window (string or integer) Data window, specified by name or window ID.

inputCol (integer) Input column

outputColl (integer) Output column for real part or amplitude in the frequency
domain.

outputCol2 (integer) Output column for imaginary part or phase in the frequency
domain.

outFrequencyCol (integer) Output column to hold the frequency values (Hertz) of the data
in outputCol 1 and outputCol2. Calulated from parameter “timelnterval”.
Omit if no frequency column isto be calculated.

timelnterval (real) Thetimeinterval (Seconds) between consecutive data pointsin the
input column. Used for calculcating the frequency column. Omit if no
frequency column isto be calculated.

reallmaginary (boolean) True if the output columns are to hold the real and imaginary

values in the time domain, false if they are to hold their amplitude and
phase.
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printResults (boolean) True if statistical information on the processed data is to be
printed in the Results window.
Seedso: InverseFFT.

FrontmostWindow
function Front nost Wndow(w ndowType: OSType) : i nt eger;
Returns the ID of the front most window of the given type, returns O if no window of the given type

exists. wi ndowType can either be dat aType, t ext Type Or dr awi ngType for specifying data windows,
function windows and drawing windows, respectively.

FrontWindow
function Front Wndow. i nt eger;

Returns the window ID of the front window. The ID will be valid as long as the window exists. For more
information about window IDs, see the section “Windows and Documents” above.

Gamma
function Ganma(x: real / conpl ex) : real / conpl ex;

Gamma function. x must be larger than O for real valued results. Accuracy of real value > 12 digits.

Gammal
function Gammal (a, x:real/conplex):real/conplex;

Incomplete gamma function. x and amust be larger than O if they are both real-valued. Accuracy of rea
value approximately 8 digits. Accuracy of complex value up to 12 digits.

GammalLn
functi on GammalLn(x: real / conpl ex): real / conpl ex;

Natura logarithm of the gammafunction. Accuracy of red value > 12 digits.

GammaP
functi on GammaP(a, x: real / conpl ex) : real / conpl ex;

Incomplete gamma function “P”.

GanmaP(a, x) = 1 - Ganmal (a, x)/ Gama(a) .
x and amust be larger than 0 when they are both real-valued. Accuracy of real value approximately 8
digits. Accuracy of complex vaue up to 12 digits.

GetAndSetStatus
function Get AndSet St at us(newSt at us: i nteger; var s:Str255):integer;

External modules only. For advanced programming. Returns the present execution status, then setsit to
newSt at us. The status can be O(if normal operation), 1 (if the user interrupted operation), 2 (if awarning
has been posted), 3 (if arun-time error has been posted).

Set newst at us to - 1 if you don't want to change the current status. If you set a status 2 or 3, pass a
suitable error or warning messagein s, it will be shown once your module is finished. On return, s holds
the current message (if statuswas 2 or 3).

Note: Calling St opExecut i on isequivalent to setting error status to 1 and Test St op returns true if error
statusis1or 3.

GetBasics
procedure CetBasics(var count:integer;
var sum mean, vari ance, st dDev, neanAbsDev:real);

Obsolete. Use Statistics and GetResult instead.
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Returns some of the results obtained in the last statistics evaluation performed with the routine Cal cSt at .
Cal cStat must have been called with the wi t hBasi cs parameter set to trueif Get Basi c¢s isto be useed
be used.

GetCell
procedure CGetCell (var s:string; row, colum:integer);

Returns the string in the given cell of the current data window. If the cell isin a number column, it
converts the number to a string and returns the string.

GetClickedCoord
procedure Getd ickedCoord(var x,y:real);

Returns the window-coordinates where the last mouse click took place in the current drawing window.

GetColHandle
procedure Cet Col Handl e(col : | ongi nt; var col H Handl e;
var |ength:longint; var col Type:|longint;
forWiting: bool ean);

External modules only. For advanced programming.

Thisroutine returns a Mac OS handle to the data of the given column. Y ou can read and/or modify the
datain the handle. Thisis much faster than accessing a column's data through Get Dat a/ Set Dat a and
Get Cel I / Set Cel I .

colH can be ni | if the corresponding column is empty. | engt h is the number of rows held by this
column, presently always equal to nr Rows. f or Wi t i ng must be set to true if you intend to change the
contents of the column, set to false otherwise. If you change the data in the returned handle, you must
subsequently call Set Col Handl e. col Type is the type of the column (t ext Col unm, fI oat Col um,
doubl eCol umm)

Do not cal D sposeHandl e( col Hf — col His alocated and deallocated by pro Fit.

The organization of the datain col H depends on the data type of the column as returned by col Type:

if col Type = fl oat Col umm, col His ahandle of type Fl oat Col umHandl e (handle to an array of 4-
byte floating point values), if col Type = doubl eCol umm, col His of type Doubl eCol utmHandl e (handle
to an array of 8-byte floating point values), if col Type = textColum,col H is of type
Text Col ummHandl e (handle to arecord of type st ri ngDat a).

Note: For columns of typef | oat Col urm and doubl eCol umm, the first entry of the array isreserved. The
value of thefirst cell isfound in the array element having index 1.

Warning 1: Thisroutine should by used by experienced programmers only.

Warning 2: Accessing text columnsin thisway is not recommended. The definition of the data structure
may change in the future.

While you are working on the data in col H, you should not call any other routines accessing the data
window except Get Col utmHandl e and Set Col urmHandl e. When you modify the datain col H, you
should avoid calling any pro Fit routines until you have called Set Col Handl e — if you want to call other
pro Fit routines, first make a copy of the data by using HandToHand; once you have made all
modificationsto the data, call Set Col Handl e.

GetColName
function Get Col Nane(col :integer):string;

Returns the title of the column col .

GetColType
function Get Col Type(col umNunber:integer):integer;

Returns the type of the data of the given column (in the current data window).
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Return values aret ext Col umn (for text columns), f | oat Col unm (for numeric columns having arange of
-1€30 ... 1€30, i.e. 4-byte floating point values) or doubl eCol umm (for numeric columns having arange
of -1e300 ... 1e300, i.e. 8-byte floating point values).

GetColumnProperty
function Get Col utmProperty(colum, property):string or real;

Returns a given column property of the current data window.
column: Theindex of the column.

property: The name of the property. See Set Col unmPr operti es.
See also: See Set Col umPr operti es.

GetCurrentAxis
function Get Current Axi s(whi chAxi s:integer):integer;

returns the ID number of the current X- or y-axis. whi chAxi s iseither xAxi s Or yAxi s.

GetCurrentGraph
function Cet Current G aph:integer;

Returns a unique number identifying the current graph aslong asit exists. Returns O if no current graph
exists.

GetCurrentWindow
function Get Current Wndow wi ndowType: i nt eger) : i nt eger;

Returns the ID of the current window with type wi ndowType. wi ndowType can be dat aType,
dr awi ngType Or t ext Type specifying data windows, drawing windows and function windows.

GetData
function GetData(row, col um: | ongi nt): ext ended,

External modules only. Returns the numerical value of the given cell in the current drawing window.
Cet Dat a replaces the predefined matrix dat a[ i , j ] used from functions within proFit.

GetDataWindowPr operty
function Get Dat aW ndowPr operty(w ndow, property):string or real;

Returns the property of agiven datawindow.
window: The name or ID of the window.
property: The name of the property.
In addition to the properties that you can access through Get W ndowPr operty , you can retrieve the
following properties:
nrRows (integer) The number of rows in the data window
nrCols (integer) The number of columns in the data window
See also: See Get W ndowPr operty.

GetDateTime
function Cet DateTi ne: i nt eger;

This function returns todays date/time as the number of seconds since 1.1.1904.

GetDefaultData
procedure Cet Def aul t Dat a(xCol H, yCol H, xErr Col H,
yEr r Col H Ext endedAr r ayHandl ePtr;
i ndecesH LongArrayHandl ePtr; var arraySi ze:integer;
sel ect edRowsOnl y: bool ean; info: Datal nfoPtr);

type
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Datal nfo = record

XM n, xMax, xPosM n, xNegMax: ext ended;

yM n, yMax, yPosM n, yNegMax: ext ended;

order ed: bool ean;

zeroYErrors,invalidYErrors,

zeroXErrors,invalidXErrors: bool ean;
end;
Dat al nf oPt r = ~Dat al nf o;
This routine provides a copy of the default x-y datain the current data window. It allocates memory for
the x,y arrays, for the x,y-Error arrays, and for the array that gives the corresponding row numbersin the
data window. Then it fills them with the data. It copies only the data where both the x and the y cell
contain valid numbers. The arrays are returned in xCol H*, yCol H*, xErr Col H*, yErr Col H*. Passnil
for one of these arraysif you are not interested in it.
Therecordi nf o holds some more information about the returned data.
The arrays returned by Get Def aul t Dat a contain valid data starting from the element with index 1. The
value of the lement with index 0 is undefined. The last element hasindex arr aySi ze. arraySi ze iS Set
to zero in case of out-of-memory situations or other problems.
Warning: Thisroutine should only be used by advanced programmers.

GetFileDirectory
function GetFileDrectory(ID:integer; var s:string):bool ean;

Returns the directory where the document displayed in the given window is stored.
ID is the windowlID. The path-name of the directory is returned in the string s. This function returns
f al se if the path-name had to be truncated.

GetFrontWindow
function Get Front Wndow: | ongi nt;

External module name. See Fr ont W ndow.

GetFunctionName
function Get Functi onNane: stri ng;

Returns the name of the current function.

GetFunctionParam
function Get Functi onParan(nane: string;i:integer):real;

Returns the default value of a parameter. name is the name of the function. This parameter is case-
sensitive. Use an empty string (' ' ) to specify the function currently selected in the Func menu. i isthe
parameter index.

Example:

GetFunctionParam('Polynom’, 1) returns the degree of the built-in function “Polynom”.

GetFunctionParamM ode
function Get Functi onParanivbde( name: string; i:integer):integer;

Returns the fitting mode (acti ve, i nacti ve, const ant) of a parameter. nanme is the name of the
function. This parameter is case-sensitive. Use an empty string (' ' ) to specify the function currently
selected in the Func menu. i isthe parameter index.

GetFunctionParamName
function Get Functi onParanNanme( name: string; i:integer):integer;

Returns the name of a parameter. nanme is the name of the function the parameter belongs to. This
parameter is case-sensitive. Use an empty string (' ' ) to specify the function currently selected in the
Func menu. i isthe parameter index.
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GetFunctionProperty
function Get Functi onProperty(nane:string; prop):string or real;
Returns a property of the function. func is the name of the function or its index in the Func menu. prop

specifies the desired property. It can be any of the properties that can be used in
Set Funct i onProperti es. In addition to this, it can be:

nrParams (integer) The number of parameters.
name (string) The function's name
See also: SetFunctionProperty

GetGlobalData
function Getd obal Dat a(i ndex: i nteger):real;

Returns the value stored under the given index in aglobal dataarray. This data array is shared between all
functions and programs. It can be used for communication between programs, functions, scripts and
modules.

The index must between 0 and 99.

See also: GetGlobalData

GetGraphCoordinates
procedure Get G aphCoordi nates(var xm n, xmax, ym n, ynmax: real);
Returns the minimum and maximum values of the main x-

and y-coordinate axes of the current graph in xmi n, xnax,
ynmin, ymax. |

1.0 T

If the current graph looks like the one to the right, 0.0 =
Get Gr aphCoor di nat es returns xm n=0, xmax=6, ym n=—

1, ymax=1. /
-1.0 -
0.0 6.0
GetGraphFrame
procedure Cet G aphFranme(var left,top,right,bottomreal);
Returns the enclosing rectangle of the current graph.
GetMarkedCoord

procedure Cet MarkedCoord(i:integer;var x,y:real);

Returns the coordinates of the preview window marker withindexi inx, y. Passi=0 for the reference
marker.

GetMedian
procedure Get Medi an(var count:integer; var

mean, medi an, m ni num maxi num real ) ;
Obsolete. Use Statistics and GetResult instead.

Returns some results of thelast call to Cal cSt at . Cal ¢St at must have been called with the wi t hMedi an
parameter set to true before this function can be used.

GetModuleFile
function Get Modul eFi | e: FSSpecPtr;

External modules only. Returns a pointer to the FSSpec record of the file where the currently running
external module was found. Returnsni | if no such file exists.
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GetNextGraph
function Get Next G aph(graphl D:integer):integer;

Returns the graph following the one with the given ID, returns the first graph if gr aphl D=0. Returns o if
gr aphl D points to the last graph. Returns o if no graph exists with the given ID.

Called repeatedly, Get Next Graph cycles through all graphs and returns their ID. Start with
Get Next G aph(0) to make surethat al graphs are scanned.

GetNumFunctionParams
function Get Nunfuncti onParans(nane: string):integer;

Returns the number of parameters used by afunction. nane isthe name of the function. This parameter is
case senditive. Use an empty string (' ') to specify the function currently selected in the Func menu.

GetOption
function Get Option(option):any type;
Returns some options of pro Fit. The type of the return value depends on the desired option. option can
be any of the options you can set using SetOptions. In addition to this, it can be::
version (redl): pro Fit's version number, e.g. 550 for 5.5.0
numFunctions (integer): The number of functionsin pro Fit's Func menu
See also: Set Opt i ons

GetParameter Property
function Get Paranet er Property(param prop):string or real;

Returns a property of the parameter of the current function having the index specified by param. prop
specifies the desired property. It can be any of the properties that you can set using
Set Par anet er Properti es.

See also: Set Par anet er Properti es

GetProgramProperty
function Get ProgranProperty(prog, prop):string or real;

Returns a property of the program having the given name (if prog is a string) or the given index in the
Prog menu (if prog is a number). prop specifies the desired property. It can take any of the names of the
properties you can set using SetProgramProperty. In addition to this, you can use

name (string) The name of the program
See also: Set Progr anPr operti es

GetResult
function GetResult(selector, [indexl,[index2]]);

This function returns the results of various commands. The desired result is selected by the
resultSelector. If the result isan array or matrix, you have to add one or two indices index1, index2. If the
result is asmple number, omit the indices

These are the commands that GetResult returns results for: Fit, Opti mi ze, Stati stics, Root s,
Extrema, | nt egr al

See the definitions of the respective commands for the selectors to be passed to Get Resul t .

GetSelection
functi on Get Sel ecti on: Rect ;

External modules only. Returns the coordinates of the contiguous selection in the current drawing
window. The rectangle's coordinates correspond to Sel ect Left, Sel ect Top, Sel ect Ri ght,
Sel ect Bott om
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GetSelectionBounds
function Get Sel ecti onBounds(var left, right, top, bottomreal);

Returns the boundaries of the current selection in the current drawing window.

GetShapeProperty
procedur e Cet ShapeProperty(shape, prop);
Gets the properties of a shapein the current drawing window. Parameters:
shape (string) The name of the shape.
xPosition, yPosition (real) The shape's x- and y-positions as they appear in the "Coords'
window.
xSize, ySize (real) Rhe shape's size in x- and y-direction as it appears in the "Coords"
window.
text (string) The shape'stitle or text content (for control shapes and text shapes
only).
value (real) The shape's value (for control shapes only). For text edit fields, this

is the numeric equivalent of the edit field or nan255 (invalid) if the edit
field does not contain a number.

active (boolean): Trueif acontrol shapeisactive, falseif isdisabled (for control
shapes only).

rotAngle (real) Therotation angle of adrawing shape in radiants.

arcStart (real) Applies only to the Oval-shape. The angle in radiants at which the
arc starts.

arcLength (real) Applies only to the Oval-shape. The length of the arc in radiants.

See dlso: Set ShapeProperties, NewShape, Del et eShape

GetSkew
procedure Get Skew(var count:integer; var
nmean, vari ance, skewness, kurtosi s: real );
Obsolete. Use Statistics and GetResult instead.

Returns some results of the last call to Cal cSt at . Cal cSt at must have been called with the
wi t hSkewAndCur t parameter set to true before this function can be used.

GetTag
procedure Cet Tag(optional paraneters);
Get the value of atag. Parameters:
tag (string) The name of thetag.
program (string) The name of the program if the tag belongs to a program. Pass an

empty string (' ') for the currently running program. Omit if the tag does
not belong to a program.

window (string or integer) The name or id of the window the tag belongs to. Omit
iIf the tag does not belong to awindow.

value (var parameter, real) The numeric value of thetag. Invalid if the tag does
not exist.

stringValue (var parameter, string) The string value of the tag. Empty if the tag does
not exist.
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To get aglobal tag (i.e. atag that is attached to pro Fit itself), pass neither the program or window
parameter. To get atag of a program that is attached to a window, pass the program and the window
parameter.

From apple script, you can use
get value of tag "tag 1" of w ndow "nmyW ndow"

See also: Set Tag, Del et eTag

GetWindowlI D
function Get Wndow D(w ndowNane: stri ng):integer;

Returns the window 1D of the window having the given title. Returns O if there is no window with this
title.

GetWindowTitle
procedure Get WndowTitl e(wi ndow D: i nteger; var name:string);

Returns the title of the given window. wi ndowl D is the window ID of the window, such asit is e.g.
returned by Get W ndowi D Or Fr ont W ndow. See also: Get W ndowPr operty

GetWindowProperty

function Get WndowProperty(w ndow, property):string or real;
Returns the given window property.
window: The name or ID of the window.
property: The name of the property.
In addition to the properties that you can change through Set W ndowPr oper ti es , you can retrieve the
following properties:

paper RectL eft,

paper RectTop,

paper RectRight,

paper RectButton (integer) The bounds of the "paper" when the window is printed according

to the settings chosen under Page Setup

pageRectL eft,

pageRectTop,

pageRectRight,

pageRectButton (integer) The bounds of the printable area when the window is printed

according to the settings choosen under Page Setup
Examplefor retrieving the |eft border of awindow:
i = GetWndowProperty('Untitled data', boundsLeft)

See also: See Set W ndowPr operti es.

GetWindowType
function Get WndowType(w ndow D: i nt eger):integer;
Returns the type (dat aType for data windows, t ext Type for function windows, dr awi ngType for

drawing windows) of the given window. Returns o if the given window is of any other type.
wi ndowl Disthewindow ID of the window, such asit isreturned by Get W ndowl D or Fr ont W ndow.

globalData
gl obal Data: array[O0..100] of real;

Obsolete. Not supported in version 5.1 or later. Use GetGlobal Data and SetGlobal Data instead.
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GrLine
procedure G Line(x,y:extended);

External modules name. SeeLi ne.

GrLineTo
procedure G LineTo(x,y: extended);
External modules name. SeeLi neTo.
GrMove
procedure G Mwve(X, y: extended);
External modules name. See Move.
GrMoveTo
procedure G MoveTo( X, y: ext ended);
External modules name. See MoveTo.
GroupBegin
procedure G oupBegi n;
Starts the definition of agroup. All drawing taking place after this call will be part of agroup.
Call & oupEnd when you have finished drawing the parts of the group.
GroupEnd
procedure G oupEnd,
Ends the definition of a group. See G oupBegi n.
Halt
procedure Halt;
Exits the running a program or function. See also: Exi t .
HandleEvent

procedur e Handl eEvent (var theEvent: EventRecord);

External Modules only. For advanced programming. Passest heEvent to pro Fit for handling it. Use this
call to handle update events when creating your own window. t heEvent isa pointer to the Mac OS event
record.

const ii = conpl (0, 1);
The imaginary unit.

Im
function In(z:conplex):real;
Returns the imaginary part of the complex number z. To get the real part, call function Re.

inf
const inf = 1/0;
Aninfinitely large number. Use-i nf for aninfinitely large negative number.

I nput

procedure | nput(sl:string; var vl1; s2:string; var v2; ...);

Brings up adialog box where you can enter new values for v1, v2... | nput can set up to 6 variables of
typereal or string. Each variable can be preceded by a string defining atitle to be shown for the variable.
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If you omit this string, the variable’'s name is used. The title of the dialog box can be set using the
Set BoxTi t | e. Example:

programt est;
var
a:real;
i :integer;
begi n
a:=0.5 i :=10;
Set BoxTitle('starting paraneters');
I nput (' value of a',a,'value of i',i);
end;
This program first assigns default values to the variables a and i . Then it asks the user to change these
variables if she wantsto. The program displays the following dialog box:

starting parameters

value of a ll].S I
value of i |Il] |

The title was set using the routine Set BoxTi t | e. The user can enter new values for the variables. If she
clicks*OK’, the program continues, if she clicks*Stop’, the program is interrupted immediately.
I nput checksif thetitle for a parameter startswith' $' followed by one or more special characters. Use
this option if the corresponding variable isto be entered by means of a pop-up menu or a check box. If
thetitle startswith:

"SW. L apop-up menu with alist of all datawindowsis used. Initialize the variable

for the window to O or the reference ID of a datawindow before passing it
to Input. On return, it contains the reference ID of the selected window.

"$C... " a pop-up menu with alist of acolumnsin a datawindow is used. If there
IS a popup menu with data windows in the same dialog box, then the
columns of the selected data window are shown, otherwise the columns of
the current data window are shown.

' $Pxxxx$. .. " a pop-up menu with user defined items is used. The items are defined by
string xxxx (terminated by ' $' ). xxxx recognizes the metachars defined
for the Mac OS routine AppendMenu, €.g. use semicolons to separate the
itemsin xxxx.

"X L acheck box isused. It isunchecked if the variable is 0, checked otherwise.
The returned value will be O (unchecked) or 1 (checked).

Example:
I nput (" $WM ndow , w, ' $Cdata col um', col, '$Pyes;no;-; maybe$do it?', fuzzy);
brings up the following dialog box:
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window | Data 122 % |

data column [ * Time [s] % |

YES

Limitations:

Y ou can only specify one data window pop-up.

If you have a data window pop-up as well as one or more column pop-up menus, the data window pop-up
must appear before the column pop-up.

I nputBox
function I nputBox(nrArgs:integer; var r:InputRec): bool ean;
External Modules Only. Replaces the routine | nput . The parameter nr Ar gs gives the number of
elements of therecordr. Therecordr hasthetypei nput Rec:
type
Ext endedPtr = “extended;
| nput Rec=
packed array[ 1..maxNr I nput Val ues] of record
x: ExtendedPtr;
s: AStr255;
end;
strings and values are set according to the explanations given for the routine | nput . In addition to the '$..'
meta-commands recognized by | nput , | nput Box also understands the meta command '$S..." which

specifiesthat the parameter is astring pointer.
Thefollowing is an abbreviated example showing how to call | nput Box in Pascal:
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var
dl: extended;
sl, s2: Str255;
r: | nputRec;

Str255:; s;
begi n
dl :=1.1; { default values }
s := "default text';
sl := 'datal'; { and nanes }
s2 := '$Sdata2';

ril].x := @i, { set entries of r }
r[2].x := ExtendedPtr (@) ;

rjl].s := @1,

rj2].s := @2;

if InputBox(2, r) then ...

(If you are programming in C: @is Pascal’s address operator (corresponding to & in C). For C, the
indices of the |l nput Rec rangefrom0t05.)

InsertString
procedure InsertString(src:string; dest:string; idx:integer);

Modifies the string dest by inserting the string sr ¢ at the position defined by i dx. Theindex i dx is
automatically limited to valid values. If the resulting string dest becomes too large, a runtime error
occurs. i dx can take values between 1 (start of string) and Lengt h( dest) .
Exanpl es:
s = 'there'; InsertString('hi ', s, 1)
returns s as 'hi there
s = 'this good'; InsertString(' is', s, 5)
returns s as 'this is good'
s = 'cogito ergo'; InsertString(' sum, s, 255)
returns s as 'cogito ergo sumi

Integral
function Integral (nane:string; mn,max:real; iterations:integer):real;
Obsolete. Use | nt egr at e instead.

Returns the integral of afunction. name is the name of the function asit appears in the Func menu. This
parameter is case-sensitive. Use an empty string (' ' ) to specify the function currently selected in the
Func menu. ni n and max are the lower and upper limits of the integral. i t er at i ons is the number of
iterations for calculating the integral (must be in the range 5..15). A small number of iterations makes

execution faster but decreases accuracy — alarge value dows down execution but yields a more accurate
result.

Integrate
procedure Integrate(optional paraneter |ist);

Calculatesthe integral of afunction over agiven x-range. Parameters:

function (string) The function to be used. Omit for current function.
XMin (real) The start of the x-range.
XM ax (real) The end of the x-range.
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iterations (integer) The number of iterations (5 .. 15) . The more iterations you use,
the more accurate the result becomes.
printResults (boolean) Set to true for printing the results to the Results window. Omit
“printResults’ or set it to false for suppressing this.
To retrieve the results, use the function Get Resul t ( sel ect or) with one of the following selectors:
i nt egr al Val ue: theintegral
i nt egr al Accur acy: the correction in the last iteration
The following piece of code calculates the integral of the current function between -1 and 1, then printsit:

Integrate(xMn -1, xMax 1, iterations 10);
Witel n(Get Result (integral Val ue));

See dso: Tabulatel ntegral

Invalid
function Invalid(val:real):bool ean;

Returnstrueif val isan invalid number (a NAN: Not A Number). Use this function to test the results of
Root , Maxi mumand M ni mum or of other functions that can return aNAN in some cases.

InverseFFT
procedure | nverseFFT(optional paraneter |ist);
Performs an inverse Fourier transform on a data window. Input are two columns of of real/imaginary or

amplitude/phase in the frequency domain. Output is a column of real values in the time domain.
Parameters:

window (string or integer) Data window, specified by name or window ID.

inputColl (integer) Input column for real part or amplitude in the frequency domain.

inputCol2 (integer) Input column for imaginary part or phase in the frequency
domain.

outputCol (integer) Output column

outTimeCol (integer) Output column to hold the time values (Seconds) of the datain

outputCol. Calulated from para—meter “frequencylnterval”. Omit if no
time column isto be calculated.

frequencylnterval (rea) Thefrequency interva (in Hertz) between consecutive data pointsin
the input columns. Used for cal culcating the time column. Omit if no time
column isto be calculated.

reallmaginary (boolean) Trueif the input columns hold the real and imaginary valuesin
the time domain, falseif they hold their amplitude and phase.
printResults (boolean) True if statistical information on the processed data is to be

printed in the Results window.
Seedso: FFT.

invalidNum
const invalidNum = "not a nunber”;

Aninvalid number, aNAN.
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KeyPressed
function KeyPressed(key: i nteger): bool ean;

Returns true if the given key of the keyboard is currently held down. key can be opt i onKey,
conmandKey, shi f t Key, cont r ol Key.

Length
function Ord(s:string):integer;
Returnsthe length of the given string s.

Line
procedure Line(dx,dy:real);

Draws a line from the current pen position X, y to the position x+dx, y+dy. Offsets the current pen
position by dx, dy.

LineTo
procedure LineTo(x,y:real);

Li neTo draws aline from the current pen position to x, y. Setsthe current pen positiontox, y.

Ln
function Ln(x:real):real;

Returns the natural logarithm (base €) of x. Causes arun-time error for x < 0. Returns- | NF for x=0.

L oadPar ameter Set
procedur e LoadPar anet er Set (opti onal paraneter |ist);

Loads a given parameter set previously saved with SaveParameterSet. The loaded parameters appear in
the Parameter window. Parameters:

name (string) The name of the set.

of Function (string) The function the parameter set belongs to. Omit if the parameter
set was availableto al functions.

file (string) The file from where the parameter set must be loaded. Omit to

load from permanent sets.
See also: AddPar anet er Set , UsePar anet er Set , SavePar anet er Set , Del et ePar anet er Set

Log
function Log(x:real):real;

Returns the base 10 logarithm of x. Causes arun-time error for x < 0. Returns -1 NF for x=0.

L ower String
procedure Lower String(var s:string);

Converts all characters of sto lower case. See also Upper St ri ng

MakeNewAXxis

procedur e MakeNewAxi s(whi chAxi s:integer; mn, max:real;
scaling:integer; position:real);

Createsanew X (whi chAxi s = xAxi s) ory (whi chAxi s = yAxi s) axisin the current graph.
The newly created axis becomes the current axis. Use Get Curr ent Axi s to find the ID of the newly
created axis.
posi ti on gives the coordinate of the new axis in the coordinate system of the main axes X1, Y 1.
scal i ng can take the values O (linear scaling), 1 (logarithmic scaling), 2 (1/x-scaling), 3 (probability
scaling).
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MakeTicks
procedure MakeTi cks(whi chAxis:integer; firstMj, distance:real;
nrM nTi cks: i nteger);
Creates anew set of ticksfor the given axis.
whi chAxi s ISxAxi s OF yAxi s. firstMaj anddi st ance give the position of the first major tick and the
distance between major ticks. nr M nTi cks defines the number of minors ticks between consecutive
major ticks.

MarkedX
function MarkedX(i:integer):real;

MarkedY
function MarkedY(i:integer):real;

Return the x-coordinate and y-coordinate of the preview window marker with index i . Passi =0 for the
reference marker. Returns aNaNif no marker withindex i exists.

Matr?2
function Matr2(nll, mi2, nR1, nR2: conpl ex): matri x[ 2] ;

A *“construction function” for the mat ri x[ 2] type. It takes 4 complex (or real) parameters, assignes
them to the elements of a matrix according to their order, and returns the matrix.

Matr3
function Matr3(mll, ml2, nl3, ... ,nB1, nB2, nB3: conpl ex): matri x| 3];
A *“construction function” for the mat ri x[ 3] type. It takes 9 complex (or real) parameters, assignes
them to the elements of amatrix according to their order, and returns the matrix..

Matr4
function Matr4(mll, m2, m3, ... ,nm2, M3, mi4: conpl ex): matri x[ 4];

A “construction function” for the mat ri x[ 4] type. It takes 16 complex (or real) parameters, assignes
them to the elements of amatrix according to their order, and returns the matrix..

Maximize
function Maxi m ze(theFunction:string; precision:real; varyX bool ean;
var X,y:real):bool ean;

Obsolete. Use Optimize instead.

Finds the parameter set that that gives amaximum value for the given function.

t heFuncti on is the name of the function as it appears in the Func menu. This parameter is case-
sensitive. Use an empty string (' ' ) to specify the currently selected function. pr eci si on defines the
accuracy of the calculation — Maxi i ze will run repeated iterations until the function value changes by
lessthan pr eci si on in consecutive iterations. If var yX istrue, Maxi m ze variesthe active parameters as
well as the x-value of the function, if false, only the active parameters are varied and the x-value is not
changed.

Thevariablesx andy return the x- and y-vaues where the maximum is found.

The agorithm used is the Simplex method.

Maximum
function Maxi mun{nane:string; mn,nax:real):real;
Obsolete. Use Extremainstead.

Returns the maximum of afunction, i.e. the x-value where the function's value islargest. nane isthe name
of the function asit appears in the Func menu. This parameter is case-senditive. Use an empty string (' ')
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to specify the currently selected function. m n and max are the boundaries of the interval where the
maximum must be found.

Maxi mumstarts looking for a maximum only if the slope of the function is positive at x=min and negative
at x=max.

If no maximum is found, the function returns NAN (Not A Number). Use the function | nval i d to test if
the result is an NAN.

Minimize
function Mnimze(theFunction:string; precision:real; varyX bool ean;
var X, y:real):bool ean;

Obsolete. Use Optimize instead.

Finds the parameter set that gives aminimum value for the given function.

t heFunct i on is the name of the function as it appears in the Func menu. This parameter is case-
sensitive. Use an empty string (') to specify the currently selected function in the Func menu. precision
defines accuracy of the calculation — M ni mi ze will run repeated iterations until the function's value
changes by less than pr eci si on in consecutive iterations. If var yX istrue, M ni ni ze varies the active
parameters as well as the x-value of the function, if false, only the active parameters are varied and the x-
valueis not changed.

Thevariablesx and y return the x- and y-va ues where the maximum is found.

The agorithm used is the Simplex method.

Minimum
function M nimun(nane:string; mn,nmax:real):real;
Obsolete. Use Extremainstead.
Returns the minimum of afunction, that is the x-value where the function value is the smallest. nane is
the name of the function as it appearsin the Func menu. This parameter is case-sensitive. Use an empty
string (" ') to specify the currently selected function. i is the parameter index. mi n and max are the
boundaries of the interval where the minimum must be found.
This function starts looking for a minimum only if the slope of the function is negative at x=ni n and
positive at Xx=nax.
If no minimum is found the function returns NaN (Not A Number). Use the function i nval i d to test if
theresult is an NAN.

Mod
operator il Mud i2

This operator calculates the integer modulo of i 1 and i 2. Note that the arguments are rounded to (long)
integersfirst.

Move
procedure Myve(dx,dy:real);

Offsets the current pen position from its current position by dx, dy.

MoveTo
procedure MyveTo(Xx,y:real);

Moves the current pen position to x, y without drawing anything.

NewDataWindow
procedur e NewDat aW ndow( opti onal parameter |ist);
Opens anew datawindow. Parameters:
nrRows (integer) The number of rows. Omit for default (200)
nrCols (integer) The number of columns. Omit for default (10)
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name
boundsL eft,
boundsT op,
boundsBottom,
boundsRight

info
fontName
fontSize

(string) The name of the new window. Omit for using a default name.

(integer) The bounds of the window in global screen coordinates, omit for
default position and size.

(string) Theinfo text attributed to the window. Omit for leaving it empty.
(string) The font to be used for the new window.

(integer) The font size to be used for the new window.

NewDrawingWindow

procedur e NewDr awi ngW ndow( opti onal paraneter |ist);
Opens anew drawing window. Parameters:

name
boundsL eft,
boundsT op,
boundsBottom,
boundsRight

info
fontName
fontStyle
fontSize

(string) The name of the new window. Omit for using a default name.

(integer) The bounds of the window in global screen coordinates, omit for
default position and size.

(string) Theinfo text attributed to the window. Omit for leaving it empty.
(string) The font to be used for the new window.

(integer) The font style to be used for the new window (bold, italic, ...)
(integer) The font size to be used for the new window.

NewFunctionWindow

procedur e NewFuncti onW ndow optional paraneter |ist);
Opens a new text window. Parameters:

name
boundsL eft,
boundsT op,
boundsBottom,
boundsRight

info
fontName
fontStyle
fontSize

(string) The name of the new window. Omit for using a default name.

(integer) The bounds of the window in global screen coordinates, omit for
default position and size.

(string) Theinfo text attributed to the window. Omit for leaving it empty.
(string) The font to be used for the new window.

(integer) The font style to be used for the new window (bold, italic, ...)
(integer) The font size to be used for the new window.

procedur e NewShape(optional paraneter |ist);
Creates a new shapein the current drawing window. Parameters:

name
shapeClass

NewShape
(string) The name of the shape.
(integer) The type of the shape. The following are the possible values:
t ext Shape, rectangl eShape, oval Shape, |ineShape,

pol ygonShape, pictureShape, graphShape, |egendShape,
groupShape, poi nt Shape, subscri ber Shape, publi sher Shape,
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but t onShape, checkboxShape, radi obuttonShape,
t ext Cont r ol Shape
xPosition, yPosition (real) The shape's x- and y-positions as they appear in the "Coords"

window.

xSize, ySize (real) The shape's sizein x- and y-direction as it appears in the "Coords"
window.

text (string) The shape'stitle or text content (for control shapes and text shapes
only).

value (real) The shape's value (for control shapes only). For text edit fields, this

Is the numeric equivalent of the edit field or nan255 (invalid) if the edit
field does not contain a number.

active (boolean) Trueif acontrol shapeisactive, faseif isdisabled (for control
shapes only).

rotAngle (real) Therotation angle of adrawing shapein radiants.

arcStart (real) Applies only to the Oval-shape. The angle in radiants at which the
arc dtarts.

arcLength (real) Applies only to the Oval-shape. The length of the arc in radiants.

from (string) Specifiesthe name of a shape that should be used as a "template”

for creating this shape. The template shape specifies the defaults for the
parameters of the new shape. Use this parameter for duplicating a shape.
For example, command "NewShape(from ", name 'newone);" duplicates
the selected shape and gives it the name 'newone’. "NewShape(from
'newone’,xPosition 100)" duplicates the shape "newone" and puts the
newly created shape at x coordinate 100.

See also: Del et eShape, Set ShapeProperties, Get ShapeProperty

NewWindow
procedur e NewW ndow( Wi ndowType: i nt eger);

Obsolete. Use NewDataWindow, NewDrawingWindow or NewFunctionWindow instead.

Creates a new window of the given type. wi ndowType iSdrawi ngType (for drawing windows),
dat aType (for data window) or t ext Type (for function windows). The new window becomes the
“current window” of its type.

This procedure cannot be called while afunction is running.

NextWindow
function Next Wndow(wi ndowl D: i nt eger) : i nt eger;

Returns the window (i.e. the window ID) of the window behind the window having the given wi ndow D.
If wi ndow DisO, it returns the frontmost window. Returns O if no window behind the given window.

The following example tiles al data, text and drawing windows. It first cycles through the windows to
count them. Then it moves them.
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program Ti | eW ndows;
const hTile = 5; {horizontal tiling offset}
vTile = 18; {vertical tiling offset}
var wi ndl D: i nt eger;
nr W ndows: i nt eger ;
left, top:integer;

begin
nrWndows : = 0;
wi ndl D : = Front W ndow;,
while windlD <> 0 do {count the w ndows}
begin
if wwndlD > 0 then {if a data, draw ng}
nrW ndows : = nrW ndows+1; {or text}
wi ndl D : = Next Wndow( wi ndl D) ;
end;
left := nrWndows*hTil e;
top := nrWndows*vTil e;
wi ndl D : = Front W ndow;,
whil e wi ndl D <> 0do {pl ace the w ndows}
begin
if wwndlD > 0 then {if a data, draw ng}
begin {or text}
Pl aceW ndow(wi ndl D, 3+l eft, 30+top, 0, 0);
top :=top-vTile; left :=left-hTile;
end;
wi ndl D : = Next Wndow( wi ndl D) ;
end;
end;

NrCols
function N Col s:integer;

Returns the number of columns (numeric and text columns) of the current data window. Causes a run-
time error if no data window is open.

NrRows
function NrRows: i nteger;

Returns the number of rows of the current data window. Causes a run-time error if no data window is
open.

NumberInvalid
function Nunberlnvalid(val: extended): bool ean;

External modules name. See Invalid.

Number ToStr 255
procedur e Number ToStr 255( x: ext ended; var s: Str255;
format, digits:integer);
External modules only. Converts the number x into a string. f or mat /di gi t s control the conversion
process:
format = O: normal conversion
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If di gi t s>0: the number of digits after the ', if di gi t s<O: the total

number of digits (approx.)

format = 1: optimized conversion, removes
unnecessary trailing zeros after the decimal point, unnecessary ‘+' signs,
decimals points, etc.

digits: the number of digits

Number ToString
procedure NunberToString(x:real; var s:string; mnimze: bool ean;
digits:integer);
Convertsx to astring and returnsitins. If di gi t s ispositive or O, it specifies the number of digits after

the decimal point, otherwise the total number of digits of the resulting string. If mi ni mi ze istrue, trailing
zeroes and any trailing decimal point are/is removed.

NumFitParams
function NunFitParans:integer;
Returns the number of parameters of the last fitted function. This is the total number of parameters,
including constant and inactive parameters.
Returns 0 if the last fit was not successful. Use this function to check the validity of the last fit before
using such functions as Covar Mat ri x Or Par anD.

NumToDateTimeStr

function NumloDat eTi neStr(n:real; sh:integer; df:integer;
secs: bool ean; fstr:string):string;

Converts the date & time number n (seconds since 1.1.1904) into a string.
sh can take the values 1 to generate the date part only, 2 to generate the time part only, and 3 to generate
both, date and time.
df defines the formatting of the date string and can take the following values: shortDate ('1/31/92'),
abbrevDate ('Fri, Jan 31, 1992, longDate ('Friday, January 31, 1992").
Set secs to trueif seconds should be displayed as well.
pro Fit uses system routinesto for this conversion. Y ou may select the country specific formatting either
through the system control panels or in the pro Fit preferences.

If fstr isnot an empty string (" ' ), which implies the default behaviour, it is used as a custom formatting
string with various output options:

"0A : day of week nanme, |ong

"8 : nonth nane, |ong

"oV : nonth

"%J . week of year

"% ' : day of week nane, short

"%': nonth nane, short

"o%d' @ day

"% ' : hour

"% ' : day of year

"% : mnute

"%': second

"o : day of week

"%' . year
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NumToRel TimeStr
function NumloRel TimeStr(n:real; dec:integer; forminteger):string;

Convertsthe relative time n (seconds) into astring.

dec isthe number of digits of the seconds.

f or mlets you select the units to be displayed, O is standard; add 1 for seconds, 2 for minutes, 4 for hours,
8 for days, 16 for weeks, 32 for months, 64 for years and 128 for centuries.

An example of arelative time string may look like: '4c 24y 9M 2w 5d 23h 52m 44s
with 'c’ for centuries, 'y for years, 'M' for months, 'w' for weeks, 'd' for days, 'h’ for hours, 'm' for minutes,
'S for seconds.

Use the pro Fit preferences to adjust the number of days per year and month for this conversion.

Odd
function Qdd(i:integer): bool ean;

Returnstrueif i isan odd number. Note that the argument is rounded to an (long) integer.

OpenCurve
procedure QpenCurve(curveNane: string);

Opens anew curve in the current graph. After having called opencur ve, callsto MoveTo, Li neTo, Move,
Li ne will add segmetsto the curve. cur veNane isthe name of the curvein the legend. Call d oseCurve
when you have completed the curve.

Dr awDat aPoi nt is not affected by this procedure. It will continue drawing point shapes. Don't use
AddDat aPoi nt between OpenCur ve and d oseCur ve.

Note that the parameters to be passed to MoveTo, Li neTo, Move, Li ne arein the coordinates of the current
x- and y-axes. (Use Set Cur r ent Axi s to set these axes before calling OpencCur ve.)

QpenCur ve causes arun-time error if no current graph is available.

OpenData
procedure QpenData(fil eNane:string);

Opensthe given file asadatafile. The file must either be a proFit datafile or atext file with valid data.
The new window becomes the “ current data window”.

If fi 1 eNamre contains asimple file name, the fileisloaded from pro Fit'sfolder. If fi | eName containsa
file path, the file is loaded from the folder defined in the file path. Set fi | eNane to' ?' to bring up a
dialog box prompting the user for the name. A run-time error occursif the file cannot be opened.

This procedure cannot be called while afunction is running.

If you want to open atext file with custom format, use Set Text Fi | eFor mat to Set the format.

OpenDataSet
procedure OpenDat aSet (errors:integer; connected: bool ean; nane: string);

Opens a new data set in the current graph. Once you have called OpenDat aSet , call AddDat aPoi nt or
Dr awDat aPoi nt to add data points. Once you have added all data points, call O oseDat aSet .
Parameters:

errors This parameter is 0O (if the data points should not have error bars) or a sum of the
constants eBar X (symmetric error bars in X), eBar Y (symmetric error bars in y),
asynEBar X (asymmetric error bars in X), asynEBar Y (asymmetric error bars in Y)

connect ed Set this to true if the data points should be connected.
name The name associated with the curve. It appears in the legend of the graph

By passing the appropriate valueiner r or s, you tell proFit if it should allocate space for holding error
values or not. If you want to use error bars, you have to call the routine AddDat aPoi nt to add data points
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and their error bar lengths in the currently open data set. If you are not interested in error bars, smply call
Dr awDat aPoi nt . AddDat aPoi nt ignoresitsxErr parameter if errors iSnoErrorBars Or errorBarsY.
ItignorestheyEr r parameter if errors iSnoErrorBars Or error Bar sX.
OpenDat aSet causes arun-time error if no current graph is available.
Example: The following program draws a graph with all types of data points.

programtest;

var i,j;
begi n
Cr eat eNewG aph(0, 18,0, 3,0, 0);
for i :=1to 17 do
begi n

Set Dat aPoi nt Styl e(i, 9, 0.5);
OpenDat aSet (0, fal se, ' nane');
Dr awbDat aPoi nt (i, 1);

Dr awbDat aPoi nt (i, 2);

Cl oseDat aSet ;

end;
end;
OpenFile

procedure QpenFil e(optional paraneter |ist);
Opens afile. Parameters:

file (string) Thefile to open. Use asimple name or afile path.

type (integer) The type of the window to be opened (t ext Type, dat aType).

Omit for default type.

Use Fr ont W ndowif you need the window ID of the new window.

To import data from text files, call Dat al npor t Opt i ons before calling penFi | e.

See adso GetFileDirectory, SetDefaultDirectory, SaveéWindow.

Thereis also an obsolete definition of OpenFile, supported for compatibility with earlier versions of pro
Fit:

procedure QpenFil e(fileNane:string);

Opens a data, drawing or function filein a new window. The new opened window becomes the “ current
window”. If the given file isatext file, the user will be asked if the file should be loaded into adataor a
function window. To automatically load atext file into a data window, use QpenDat a, to automatically
open atext file into afunction window, use QpenText .

If fi | eName contains asimplefile name, the fileisloaded from the proFit folder. If fi | eName contains a
file path, the fileisloaded from the folder defined in the file path. If you pass' ?' for fi | eNane, the user
will be asked to locate the file.

If the specified fileis apro Fit module or a compiled AppleScript, it is added to the Prog or Func menu.
Causes arun-time error if the file could not be opened

This procedure cannot be called while afunction is running.

264  Appendix A: Predefined functions, procedures and arrays



OpenPoly
procedur e QpenPol y(snoot hi ng: i nteger; cl osed: bool ean);

Starts the creation of a polygon. After having called OpenPol y, use multiple callsto Li ne or Li neTo to
draw it, then call d osePol y when you are through. Set cl osed tot r ue if the polygon should be closed
at theend.

snoot hi ng = 0 of no smoothing, snoot hi ng = 1 for norma smoothing, snoot hi ng = 2 for Bézier
smoothing with the curve going through the polygon definition points.

OpenText
procedure QpenText (fil eNane:string);

Opensthe given file asafunction file. The file must either be a pro Fit function file or atext file. The new
window becomes the “current text window”.

If fi1eNane contains asimplefile name, thefile isloaded from the proFit folder. If fi | eName contains a
file path, the fileisloaded from the folder defined in thefile path. If you pass' ?' for fi | eNane, the user
will be asked to locate thefile.

This procedure cannot be called while afunction is running.

Optimize
procedure Qoptim ze(optional paraneter |ist);
Finds a maximum or minimum of afunction by varying its x-value and/or its parameters. Parameters:

function (string) The function to be used. Omit for current function.

getMinimum (boolean) true if you want to find the function’s minimum, false for its
maximum.

varyParams (boolean) true if you want to vary the function’s parameters to find the
minimum/maximum. Only the active parameters of the function are varied.

varyX (boolean) true if you want to vary the function’'s x-value to find the
minimum/maximum.

xValue (real) If “varyX” isfalse, this parameter gives the value of the function’s
x-vaue. If “varyX” istrue, it givesthe starting value for x.

precision (real) The desired precision. Pass O for best precision, 1e-7 for medium
precision, 1e-2 for low precision.

fullDescription (boolean) true if a complete protocal isto be printed in the results window,
faseif only the resulting parameters, x- and y-values are to be printed.

printResults (boolean) Set to true for printing the results to the Results window.
Default: false.

To retrieve the results of acall to procedure Opt i mi ze, call the function Get Resul t (sel ector...).Use
one of the following selectors:

optimizedX the optimized x-value

optimizedY the optimized x-value

fittedParameter the optimized parameters. Pass parameter index (1 based) as second
argument to GetResult

The following example finds the minimum of the current function by varying its x-value and its active
parameters, then prints the optimized value of the second parameter:
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Optim ze(xValue 0, precision 0, getMninmumtrue, varyParans true,
varyX true);
Witeln(GetResult(fittedParanmeter, 2));

Ord
function Ord(ch:char):integer;

Returnsthe (real) ASCII code of character ch.

Outer
function Quter(vl,v2:vector): matrix;

Returns the the matrix containing the outer product of its two vector parameters (of the same length n).
Returns anxn matrix for two vectors of length n.

PageSetup
procedur e PageSetup(optional paraneter |ist);
Shows the Page Setup diaog box for a given window. Parameters:
window (integer or string) The name or window 1D of the window.
Default: Front window
See also: Print
ParamSD

function ParanBSD(i:integer):real;

Returns the standard deviation calculated for parameter i in the last Levenberg-Marquardt fit.

Returns an invalid number (NAN) if theindex i corresponds to a parameter that was not active during the
last fit. You can test if the return valueisaNAN using the function | nval i d.

Causes a run-time error if the last fit was not successful or if i isout or range. Use NunFi t Par ans to
check if the last fit was successful.

Paste
procedur e Paste;

Equivalent to selecting “Paste” from the “Edit” menu.

Phase
functi on Phase(z: conpl ex):real;

Returns the argument of the complex number z, i.e. the angle between the vector pointing to the complex
point and the positive real axis. The function Abs gives the amplitude of the number.
abs(c)*exp(ii*phase(c)) =c

pi, T

const pi 3. 1415926535897932;
T 3.1415926535897932;

Approximation of the ratio between the circumference and the diameter of acircle:
1=3.1415926535897932384626433832795028841971......

First approximations for this peculiar number were already known by 2000 B.C. the Babylonians found
T = 3+1/8, the Egyptians m = 4(8/9)2. Inthe 5th century A.D. in China, Tsu Chung-Chih and
Tsu Kengh-Chih established 3. 1415926<m<3. 1415927.
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PlaceWindow
procedure Pl aceW ndow(wi ndow D: i nt eger;
left,top, right,bottominteger);

Moves the given window to a new place on screen. | ef t, t op, ri ght and bot t omgive the position of the
margins of the new window in “global coordinates’ (which have their origin at the top left of the main
screen). PlaceWindow does nothing if the new window position would be off screen. If ri ght <= I eft,
the width of the window remains unchanged, if bott om <= t op, the height of the window remains
unchanged.

wi ndowl Disthewindow ID of the window, such asit is returned by Get W ndowl D or Fr ont W ndow. Use
wi ndowt D=0 for the front window.

PlaceWindow
procedure Pl aceW ndow(w ndow D: | ongi nt; w ndowRect: Rect);

External modules only. Same as the internal function but accepts a Rect data structure as a parameter.

PlotData

procedure Pl ot Data(optional paraneter |ist);
Plots adata set into a graph. Parameters:

xColumn, yColumn (integer) The x- and y-columns.

window (integer or string) The window to take the data from. Y ou can either passa
window ID or the window’ s name.
(boolean) True if the limits of the x-axis (y-axis) of the graph are to be
selected automatically to contain all data points, false if explicit limits are
given in parameters xFirst, xLast (yFirst, yLast) . Default isfalse.

autoX, autoY

xFirst, xL ast (real) The start and end of the x-axis. Specify these valuesif you set autoX
to false.

yFirst, yLast (real) The start and end of the y-axis. Specify these valuesif you set autoY
to false.

(integer) The scaling of the x- and y-axes. Values can be | i nScal i ng,
| ogScal i ng, recScl ai ng (for 1/x-scaling) , pr obScal i ng (probability
scaling) . Omit this parameter(s) to use the current default scaling.

xScaling, yScaling

XAXis, YAXis (integer) The axis to be used as x- and y-axis. Omit these parameters to
use the default axes.

newWindow (boolean) True if graph is to appear in a new window, false if it isto
appear in the current drawing window.

newGraph (boolean) Trueif plot isto appear in anew graph, falseif it isto appear in
the current graph.

selRowsOnly (boolean) Trueif only the currently selected rows are to be plotted, falseif
all rows areto be plotted.

drawErrors (boolean) Trueif error bars are to be plotted, false otherwise.

pointType (integer) Index of point type in the point style menu.

pointSize (real) Size of point, between 2 and 128.

pointThickness (real) Thickness of linesfor drawing points: O (auto) , 0.25, 0.5, 1.0.

bgPointType (integer) The same as pointType but for the background part of the point.

bgPointSize (real) The same as pointType but for the background part of the point.

connected (boolean) True if the data points are to be connected by lines, false

otherwise. Default; false.
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curveT hickness
dashPattern:

curveDash

curveRed,
curveGreen,
curveBlue

title
xLabel, yL abel

legendT ext

style

(real) Thickness of the lines connecting the data points. Omit for using
default thickness.
(string) Defines the length of the individual dashes, separated by commas.
For example: '10,1,3,3
(integer) Line dash number (corresponding to the dash menu) if points
are connected. Pass the position of the dash pattern in the dash popup
menu. The values between 1 and 8 always correspond to:

1 2 3 4

S 6 7

(integer) The colour of the lines connecting data points. Pass values
between O (dark) and 65535 (bright) . Omit to use the default color.
(string) Thetitle to be added to agraph if you create anew graph.

(string) The name labels to be used for the x- and y-axes if you create a
new graph.

(string) The text to be used in the legend. If this text starts with the string
'$hide$, the curve will not appear in the legend.

(string) The name of the style to be used.

graphName, legendName, groupName (string) The names to be given to the graph, legend and

plotType

group shapes.

(integer) The type of the plot. Use the constants scatterPlot,
verticalBarChart, horizontal BarChart, vertical Skyline, horizontal Skyline.
Default: scatterPlot.

fillRed, fillGreen, fillBlue (integer) Thefill color. Pass values between 0 (dark) and 65535 (bright)

fillAxisX, fillAxisY

. Omit to use the default color.
The axisto be used for filling. Omit or set to O to suppressfilling.

PlotFunction

procedure Pl ot Function(optional paranmeter list);
Plots afunction into a graph. Parameters:

function
xFirst, xLast
yFirst, yLast

autoY

from, to

xScaling, yScaling

XAXIs, YAXis

(string) The name of the function to plot. Default: current function.

(real) The start and end of the x-axis.

(real) The start and end of the y-axis. Specify these valuesif you set autoY
to false.

(boolean) True if the limits of the y-axis of the graph are to be selected
automatically to contain the whole plot, false if explicit limitsare givenin
parameters yFirst, yLast. Default isfalse.

(redl) The x-coordinates where the plot begins/ends.

Default: equal to xFirst, xLast.

(integer) The scaling of the x- and y-axes. Values can be | i nScal i ng,
| ogScal i ng, recScl ai ng (for 1/x-scaling) , pr obScal i ng (probability
scaing) . Omit this parameter(s) to use the current default scaling.
(integer) The axis to be used as x- and y-axis. Omit these parameters to
use the default axes.
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newWindow
newGraph
xStep
fittedParams

curveT hickness

(boolean) True if graph is to appear in a new window, false if it isto
appear in the current drawing window.

(boolean) Trueif plot isto appear in anew graph, falseif it isto appear in
the current graph.

(real) Step width for plotting. Set to O for using automatic step width
selection.

(boolean) Trueif last fitted parameters are to be used for the function, false
If the parametersin the Parameter window are to be used.

(real) Thickness of the curve. Omit for using default thickness.

dashPattern: (string) Defines the length of the individual dashes, separated by commas.
For example: '10,1,3,3
curveDash (integer) Line dash number (corresponding to the dash menu) of the
curve. Pass the position of the dash pattern in the dash popup menu. The
values between 1 and 8 aways correspond to:
1 . 2 3. _4_ _
——5__ _.&  _ _..1 .8 __
curveRed,
curveGreen,
curveBlue (integer) The colour of the curve. Pass values between O (dark) and 65535
(bright) . Omit to use the default color.
title (string) Thetitle to be added to agraph if you create a new graph.
xL abel, yL abel (string) The name labels to be used for the x- and y-axes if you create a
new graph.
legendText (string) The text to be used in the legend.
style (string) The name of the style to be used.
graphName, legendName, groupName (string) The names to be given to the graph, legend and
group shapes.
Pos
function Pos(pattern, s:string):integer;
Returns the position of the given pattern in string s. Returns O if the pattern is not found in string s.
Example:
Pos('hi', "hi there") returns 1
Pos('there', 'hi there') returns 4
Pos('glue', "hi there") returns O
PRandom
functi on PRandom ext ended;
External modules name. See Random
Print
procedure Print(optional paraneter |ist);
Shows the Print dialog box for a given window. Parameters:
window (integer or string) The name or window ID of the window. Default: Front

window
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See also: PageSetup

Random
functi on Randomreal ;
Returns arandom number evenly distributed between 0 and 1.
Re
function Re(z:conplex):real;
Returnsthe real part of the complex number z. To get the imaginary part, call function | m
ReduceData
procedur e ReduceDat a(optional paraneter |ist);
Reduces and/or smoothes the data in data window Parameters:
window (string or integer) The window, specified by name or window ID. Omit for
front window.
action (integer) keepSonme (= keep every n-th row) , r enoveSone (= remove

every n-th row) , aver age (= replace n consecutive rows by one single
row holding their average) , snoot h (= replace each row by the average of
the row and its n-1 neighbouring rows) , keepSel Rows (= remove al rows
except the ones that are selected) , r emoveSel Rows (= remove all rows that
are presently selected) . nis given by the parameter “points’

points (integer) additiona parameter if action is keepSome, removeSome, average
or smooth.
selectionOnly (boolean) Trueif only the currently selected cells are to be affected, fase if

al cells in the data window are to be affected. (Ignored if parameter
“action” isr enoveSel Rows OF keepSel Rows)

RelTimeStr ToNum
function Rel Ti meStr ToNun{s: string):real;

Convertsthe relative time string s into a number of seconds.

An example of ardative time string may look like: '4c 24y 9M 2w 5d 23h 52m 44s

with 'c’ for centuries, 'y' for years, 'M' for months, 'w' for weeks, 'd' for days, 'h' for hours, 'm' for minutes,
'S for seconds.

Use the pro Fit preferences to adjust the number of days per year and month for this conversion.

Roots
procedure Roots(optional paraneter |ist);

Finds the root(s) of afunction or finds the x-value of afunction where itsy-valueis equal to agiven
value. A given x-interva is searched. Parameters:

function (string) The function to be used. Omit for current function.

XMin (redl) The start of the x-interval.

xMax (real) The end of the x-interval.

subintervals (integer) The number of sub-intervals to be searched in the x-interval.

When the function’ s sign changes over a sub-interval, the sub-interval is
searched for aroot.

yValue (real) The desired y-value. Omit or set to O if finding the x-value where the
function becomes zero (roots) .
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printResults (boolean) Set to true for printing the results to the Results window. Omit
“printResults’ or set it to false for suppressing this.

To retrieve the results of a call to procedure Root s, call the function Get Resul t . Use one of the
following selectors:

rootsCount the number of rootsfound (< 100)
rootsXValue x-value of each root*
rootsy Value y-value of each root*

*pass an index (1..rootsCount) as second parameter to GetResult

The following example finds the roots of the current function between -1 and 1, then prints them:
pr ogr am Root Fi nder ;
var i, nrRoots:integer;
begi n
Roots(xMn -1, xMax 1, sublntervals 50);
nrRoots : = GetResult(rootsCount);
Witeln(nrRoots);
for i := 1 to nrRoots do
Witel n(' ', GetResult(rootsXvalue, i));
end;
Note: There's aso an obsolete version of Roots
function Root(name:string; min, max:real):real
which is supported for compatibility with older versions of pro Fit. Don't useit for new developments.

Round
functi on Round(x:real):real;
Rounds x to the closest integer and returnsits value.
RowSelected
functi on RowSel ect ed(rowNunber : i nt eger): bool ean;
Returnstrue if anything in the given row of the current data window is selected.
SaveDataAsT ext

procedure SaveDat aAsText (Wi ndow D:i nteger; fileNane:string);

Saves adatawindow as atext file.

wi ndow Disthewindow ID of the window, such asitise.g. returned by Get W ndowl D Or Fr ont W ndow.
fil eName isthe name of thefile. If fi | eNane contains asimple file name, thefileis placed in pro Fit's
folder. If fi | eNane contains afile path (e.g. ' HD: MyFol der: file'), thefileis placed in the folder
defined in thefile path. Pass' ?' for fi | eName to bring up a dialog box asking the user where to save the
file.

Use Set Text Fi | eFor mat if you want to specify how the text file must be formatted.

SaveDrawingAs

procedure SaveDrawi ngAs(wi ndow D: i nteger; fil eName: string;
format:integer);

Saves a drawing window as a pro Fit file (if f or mat = def aul t For mat ), a PICT file (if f or mat =
pi ct For mat ) or aEPSfile (if f or mat = epsFor mat ).
wi ndowt Disthewindow ID of the window, such asit isreturned by Get W ndowt D or Fr ont W ndow.
fil eName isthe name of thefile. If fi | eName containsasimple file name, the fileis placed in pro Fit's
folder. If fi | eName contains afile path (e.g.' HD: MyFol der: file'), thefile is placed in the folder
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defined in thefile path. Pass' ?' for fi | eName to bring up adialog box asking the user where to save the
file.
SaveDr awi ngAs(L, ' bla', defaul t) isequivalent to SaveW ndowAs(L, ' bl a').

SavePar ameter Set
procedure SavePar anet er Set (opti onal paraneter |ist);
Saves the the parameters that currently appear in the Parameter window. Parameters:
set (string) The name of the set. Omit to save all sets belonging to the given
function.
forAll (boolean)True if the parameter set isto be available for all functions, false
If the parameter set is only to be available for the current function.
Default: false
file (string) The file where the parameter set must be saved. Omit to save as

permanent sets.
See adls0: AddParameterSet, UseParameter Set, L oadParameterSet, Del eteParameter Set

Save

procedure Save(w ndow D:integer);

Equivalent to choosing Save from the File menu. Causes a run time error the window has never been
saved.

SaveWindow
procedure SaveW ndow optional paraneter |ist);
Saves awindow. Parameters:
window (integer or string) The name or window ID of the window. Default: Front
window
file (string) Thefile to save the window into. Use a ssimple name or afile path.
Default: thefile currently attributed to the window.
type (integer) The type of the file if non-default type (t ext Fil eType,

Pl CTType, EPSFType). Omit for default type. To control the format for
exporting data to a text file, call Dat aExport Opti ons before calling
SaveW ndow.

Optional parameters that are used for images only:

color Depth (integer) Color bit depth (1, 2, 4, 8, 16, 32). The maximum number of
different colorsin theimageis then 2** colorDepth.

bgColorRed (integer) The red part of the background color (0..65567).

bgColor Green (integer) The green part of the background color (0..65567).

bgColorBlue (integer) The blue part of the background color (0..65567).

interlaced (boolean) The image reconstruction will be stepwise. For GIF files only.

smooth (boolean) Anit-aliasing by 2x enlarged drawing and subsequent image
reduction.

drawSelection (integer) If only the selected shapes should be taken, set thisto 2, elseto 0.

resolution (integer) Image resolution in dpi. including 72, 144, 300, 360, and 600.

Standard screen resolution is 72 dpi.
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compression (integer) Select the compression quality: O=none, 1=low, 2=medium,
3=high, 4=maximum.

See aso GetFileDirectory, SetDefaultDirectory, OpenFile, SetOptions.
There is also an obsolete version of SaveW ndow supported for compatibility with earlier versions. Do
not use it in new programs:

SaveWindowAs
procedure SaveW ndowAs(w ndowl D: i nteger; fileNane:string);

Saves the contents of the given window into afile with the specified file name.

wi ndowl Disthewindow ID of the window, such asit ise.g. returned by Get W ndowi D or Fr ont W ndow.
fi | eName isthe name of thefile. If fi | eName containsasimple file name, the fileis placed in pro Fit's
folder. If fi 1 eNane contains afile path (e.g. ' HD: MyFol der: file'), thefileis placed in the folder
defined in the file path. Pass' ?' for fi | eName to bring up adialog box asking the user where to save the
file.

SelectAll
procedure Sel ectAll;

Equivalent to selecting “ SelectAll” from the “Edit” menu.

SelectBottom
function Sel ect Bottom i nteger;
Returns the row number of the bottom-most selected cells of the current data window or O if no cellsare

selected. Causes arun-time error if no data window is open.
External modules must use Get Sel ect i on.

SelectCell
procedure Sel ectCel |l (optional parameter |ist);
Selects one or more cellsin the current data window. Parameters:
row (integer) A row index if you want to select datain a single row. Omit if
you use fromRow, toRow.
fromRow, toRow (integer) The range of rows if you want to select datain severa rows. Omit
if you use the parameter “row”.
col (integer) A column index if you want to select data in a single column.
Omit if you use fromCal, toCal.
fromCaoal, toCol (integer) The range of columns if you want to select data in severa
columns . Omit if you use the parameter “col”.
options (integer) Controls what happens with the previous selection. Pass

addConti nuously (= addto present selection) , forgetd d (= forget
present selection, default)

SelectCells
procedure Sel ectCells(left,top,right,bottominteger);
Obsolete. Use Sel ect Cel | instead.

Removes the current selection from the current data window and selects all cells within the given
rectangle. Call with al arguments = 0 to deselect dl cdlls.

SelectColumn
procedure Sel ect Col um(optional paraneter |ist);

Selects a column or arange of columnsin the current data window. Parameters:
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col (integer) The column to select. Omit if you use fromCal, toCol.

fromCaoal, toCoal (integer) The range of columns to select if you want to select severa
columns. Omit if you use the parameter “col”.
options (integer) Controls what happens with the previous selection. Pass

addConti nuously  (=addtopreviousselection) orforgetdd (=
forget previous selection, default)

SelectDirectory
function SelectD rectory(s:string): bool ean;

Displays a directory selection dialog box and returns the path-name of the selected directory in the string
s. Thisfunction returnsf al se if the path-name had to be truncated.

SelectFunction
procedure Sel ect Function(' nyFunc');
Selects the given function in the “ Func” menu and makes it the current function. func is the name of the

function. A call to Sel ect Functi on(' myFunc') is quivalent to Set Opti ons(current Functi on
"nyFunc') .

SelectL eft
function Sel ectLeft:integer;
Returns the column number of the leftmost salected cells of the current data window or O if no cells are

selected. Causes arun-time error if no data window is open.
External modules must use Get Sel ect i on.

SelectRight
function Sel ectRi ght:integer;
Returns the column number of the rightmost selected cells of the current datawindow or O if no cellsare

selected. Causes arun-time error if no data window is open.
External modules must use Get Sel ect i on.

SelectRow
procedure Sel ect Rowm opti onal parameter |ist);
Selectsarow or arange of rowsin the current data window. Parameters:
row (integer) The row to select. Omit if you use fromRow, toRow.
fromRow, toRow (integer) The range of rowsto select if you want to select severa columns.
Omit if you use the parameter “row”.
options (integer) Controls what happens with the previous selection.

Passf or get A d (= forget present selection, default) , addCont i nuousl y
(= add to present selection, extending it continuously),
addDi sconti nuously (= add to present selection, extending it
discontinuoudly) , desel ect It (= deselect the specified rows)

SelectRows
procedure Sel ect Rows(top, bottominteger; sel ect:bool ean);
Obsolete. Use Sel ect Row instead.

Selects all rows between top and bottom if select = true, deselects them if select = false.
If there are selected rows outside top/bottom, they remain selected
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SelectTop
function Sel ect Top: i nt eger;
Returns the row number of the topmost selected cells of the current data window or O if no cells are

selected. Causes arun-time error if no data window is open.
External modules must use Get Sel ect i on.

SelectWindow
procedure Sel ect Wndow(w nd: string or integer);

Moves the specified window in front of all other windows. wind is the windowID or the name of the
window.

SetArrowStyle
procedure Set ArrowStyl e(location:integer; style:integer; size:real);

Specifies the default arrow style for lines and polygons.

| ocati on definesif you want to change the style of the arrow at the beginning of the line (I ocati on =
1), end (2) or both beginning and end (3).

Set styl e too if there should be no arrow at the specified location. Set styl e to 1. .. 12 to select the
arrow style corresponding to the entry in the arrow style popup menu. styl e values from 1 to 6
correspond to the 6 predefined styles:

1 > >
2 > S
> 6 >

styl e values from 7 to 12 correspond to the 6 custom styles which appear in the arrow style menu. Set
styl e to-1 for leaving it unchanged.
si ze: Thesizein points (1/72 inches). Set it to O for leaving it unchanged.
The following program draws a bent arrow as shown on the right.
program OneArr ow,
begi n
Set Li neStyl e(5, 1); {l'i ne thickness}
Set ArrowsStyle(1, 2, 20); {start arrow styl e}
Set ArrowStyle(2, 1, 20); {end arrow styl e}

OpenPol y(1, false); {draw a snmoot h pol ygon}
MoveTo( 100, 100); LineTo(150, 100); LineTo(150,50);
C osePol y;

end;

SetAxisAttributes
procedure Set Axi sAttributes(whichAxis:integer; flags:integer);

Sets various drawing options of an axisin the current graph.

whi chAxi s isequal to xAxi s or yAxi s and definesif you want to change the current x- or y-axis. (To set
the current axis, call Set Current Axi s.)

flagsis 0 or asum of the following constants:

equal ToMai n: axisisequal to the corresponding X1 or Y1 axis

dr awAxi sLi ne, drawTi cks, drawhajorTickLabels, drawM norTickLabel s: for drawing the
corresponding parts of the axis

pl usSi deTi cks: for drawing tick marks above or to the right of the axis

m nusSi deTi cks: for drawing tick marks below or to the left of the axis

pl usSi deLabel s: for drawing the labels above or to the right of the axisinstead of to the left or below it
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| abel sQut si deFr ame: for placing the labels outside the graph's frame
Example:
Set Axi sAttri but es(xAxi s, sanmeAsMai n+dr awAxi sLi ne+ti cksPl usSi de+dr awTi cks) ;

SetAxisPosition
procedure Set Axi sPosition(whi chAxis:integer; position:real);

Changes the position an axis in the current graph.

whi chAxi s isequal to xAxi s or yAxi s and definesif you want to change the current x- or y-axis. (To set
the current axis, call Set Current Axi s.)

posi ti on isthe position in the coordinates of the main axis perpendicular to the specified axis. If
posi ti on isoutside the range of thismain axis, it is set to its minimum/maximum.

SetBGDataPointStyle
procedure Set BGat aPoi nt Styl e(style:integer; size:real);

Sets the default background style of data points.

styl e, si ze have the same meaning as for the routine Set Dat aPoi nt St yl e.

If styl e designates a*“composite point”, only the background of this composite point is used.
Always call Set Dat aPoi nt St yl e before calling Set BGDat aPoi nt St yl e.

For more information see Set Dat aPoi nt Styl e .

SetBoxTitle
procedure SetBoxTitle(title:string);

Setsthe title of the dialog box invoked with the next call to the predefined function | nput (or I nput Box
for external modules).

SetCell
procedure SetCell (row, colum:integer; s:string);
Sets the string in the given cell of the current datawindow to's.

If the given cell isin anumeric column, Set Cel | attempts to convert s into a number. If this conversion
fals, the given cell is cleared.

SetColHandle
procedure Set Col Handl e(col : | ongi nt; col H Handl e) ;

External modules only. For advanced programming. Sets a given column to the datain col H.
The organization of the data in col H depends on the data type of the column. See also the entry for
CGet Col Handl e.
If the column is of typef | oat Col umm, col Hisahandle of type FI oat Col unnHandl e (handle to an array
of 4-byte floating point values), if it isdoubl eCol umm, col His of type Doubl eCol utmHandl e (handle to
an array of 8-byte floating point values), if itist ext Col umm, colH is of type Text Col unnHandl e (handle
to arecord of type stri ngDat a). (To get a column's type, call Get Col Type. You can find more
information in the files proFit_interface.p / proFit_interface.h)
Once you call Set Col Handl e, the handle becomes property of pro Fit — do not dispose it.
col Hcan either be:
» ahandlethat you alocated yoursdlf. In this case, the Handl€'s size must be:
4* (nr Rows+1) for columnsof typef | oat Col um
8* (nr Rows+1) for columnsof typedoubl eCol um
14 + gizeof dl stringsfor columns of typet ext Col unm
» ahandlethat you obtained from Get Col Handl e
e ni | if youwant to clear the given column
This routine should be used by experienced programmers only. Warning: Accessing text columnsin this
way isnot recommended. The definition of the data structures may change in the future.
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SetColName
procedure Set Col Nane(col :integer; nane:string);

Obsolete. Use SetColumnProperties instead.

Changes the name of a column in the current data window. col isthe number of the column, nane its
new name.

Set Col Name causes arun-time error if there is no data window open or if col is outside the bounds of
the data window.

SetColType
procedure Set Col Type(col umNunber:integer; theType:integer);

Obsolete. Use SetColumnProperties instead.

Changes the type of the column specified by col uimNunber tot heType. t heType can have the values
t ext Col urm (for text columns), f 1 oat Col unm (for numeric columns having arange of -1e30 ... 1e30, i.e.
4-byte floating point values) or doubl eCol urm (for numeric columns having arange of -1€300 ... 1300,
I.e. 8-byte floating point val ues)

SetColumnProperties
procedure Set Col umProperties(optional paranmeter |ist);

Sets the properties of one or more columns in the current data window. Omit any parameter for leaving it
unchanged. Parameters:

col (integer) The index of the column to change. Omit if passing values for a
column range in parameters “firstCol”, “lastCol”.

firstCol, lastCol (integer) The range of columnsto change. Omit if passing a single column
in parameter “col”.

name (string) Thetitle of the column(s).

nrDecimals (integer) The number of decimals for numeric columns.

format (integer) The format for numeric columns. sci enti fi cFor mat Or

f1 oat i ngFor mat, or the format for date columns: shor t Dat eFor mat ,
| ongDat eFor nat Or abbr evDat eFor nat .

width (integer) The width of the column(s) in pixels.

type (integer) The type of the column(s):
f1 oat Col umm (4 byte floating point with a range of -1e30 ... 1e30),
doubl eCol um (8 byte floating point with a range of -1e300 ... 1e300),
dat eCol um  (dates, asthe number of seconds since 1.1.1904),
ti meCol utm  (number of seconds),
t ext Col umm.

relTimeFormat (integer) Display format for relative time columns, by adding the following
flags. 1=seconds, 2=minutes, 4=hours, 8=days, 16=weeks, 32=months,
64=years, 128=centuries.

withTime (boolean) Set to true, if adate column should be displayed with time.
withSeconds (integer) Set to true, if a date column should be displayed with seconds.
datal oss (integer) Defines what to do if data would be lost when changing the

column's type. Use one of the following constants: st ayQui et (loose the
data, no error message), shower ror (display an error message and stop),
showwar ni ng (post awarning but do not stop), askCol umwi se (ask the
user for each column), askFor St op (ask the user once for al columns).
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SetColWidth
procedure Set Col Wdt h(col utmNunber:integer; wdth:integer);
Obsolete. Use SetColumnProperties instead.

Sets the width of the column specified in col ummNunber to the value (in pixels) passed inwi dt h. wi dt h
must be an even number between 14 and 510.

SetCurrentAxis
procedure Set Current Axi s(whi chAxi s:integer; axislD:integer);

Setsthe current (x- or y-) axis. The current axisis used for plotting as well asin various other calls, such
asS Set Axi sAttri butes.

whi chAxi s iseither xAxi s or yAxi s. axisID designates the number of the axis.

Example: Set Current Axi s(xAxi s, 2) makes X2 the current x-axis.

SetCurrentGraph
procedure Set Current G aph(graphl D:i nteger);

Sets the current graph to the graph identified by gr aphl D. To make no graph the current graph, set
graphl Dto 0.

SetCurrentWindow
procedure Set Current Wndow( wi ndow D: i nt eger) ;

This routine makes awindow the current window of its kind.

Thereis a“current data window”, a “current drawing window”, and a “current text window”. These
are the windows used by the output routinessuch asLi neTo, Set Data, and Wi tel n.

With the exception of text windows, where the default current window is always the Results Window,
when anew window is opened, it automatically becomes the current window of its kind.

wi ndowl Disthewindow ID of the window, such asit isreturned by Get W ndowl D Or Fr ont W ndow.
Calling Set Cur r ent W ndow( 0) resets the current text window to the results window.

SetCurvekFill
procedure Set CurveFil |l (whichAxis:integer; axislDinteger);

Setsthefill style of the next plotted curve. To fill the area between the curve and an x-axis or an y-axis,
set whi chAxi s tOxAxi s or yAxis, respectively.axislDspecifiestheindex of the axis. To disable
curvefilling, set axi sl Dt0 0.

A call to Set curveFi | | affects al subsequent callsto Opencur ve and QpenDat aSet calls.

SetData
procedur e Set Dat a(row, col um: | ongi nt ; ex: ext ended) ;

External modules only. Sets the value of the specified cell of the current data window to ex.

SetDataPointStyle
procedure Set DataPoi nt Styl e(style:integer; size:real; thickness:real);

Sets the default data point style. Thisstyleis used for all subsequent plotting of data points.
st yl e defines the “shape” of the data point:
0: pixel (the smallest point),

1-17: 0 1 2 3 4 5 6 7 8

¥+ XEH000¢

9 10 11 12 13 14 15 16 17

X WA AvADRORE=ap-=(

-1..-8: theeight custom pointsin the last row of the point style menu. sizeisthe sizein points
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si ze isthe size of the point in pixels.

t hi ckness is0, 0.25, or 0.5, or 1.0. Use O if you want to automatically use smaller lines for smaller
points.

Points can be simple or composite. A simple point consists of a single symbol, such as the styles 0 — 13
above. Composite points consist of two symbols (a foreground and a background one) plotted on top of
each other, such asthe styles 14 — 17 above.

Set Dat aPoi nt St yl e sets the foreground symbol or, if a composite point is used, both foreground and
background symbols. To set the background symbol separately, call Set BGDat aPoi nt Styl e.

SetDataSize
procedure SetDataSi ze( nunber & Rows, nunber O Col ums: i nt eger) ;

Obsolete. Use Set Dat awi ndowPr oper ti es instead.

Sets the number of columns and rows of the current data window. The number of rows and columns
must be between 1 and 30000.

Set nunber O Rows to 0 if you only want to change the number of columns. Set nurber Of Col uns to 0 if
you only want to change the number of rows.

To get the current size of a data window, use the functions Nr Rows and Nr Col s.

SetDataWindowPr operties
procedur e Set Dat aW ndowProperti es(optional paranmeter |ist);

Sets the properties of a datawindow. Parameters:

window (string or integer) The name or window! D of the window to be affected.

name (string) Thetitle of the window. Omit for leaving it unchanged.

boundsL eft,

boundsRight,

boundsT op,

boundsBottom (integer) The bounds of the window in global screen coordinates. Omit for
leaving them unchanged.

info (string) The info text attributed to the window. Omit for leaving it
unchanged.

fontName (string) The font to be used in the window. Omit for leaving it unchanged.

fontStyle (integer) The font style to be used in the window (pl ai n, bol d,

italic, underline, outline, extended, condensed or any sum of
these values) . Omit for leaving it unchanged.

fontSize (integer) The font size to be used in the window. Omit for leaving it
unchanged.
nrRows, nrCols (integer) The number of rows/columns. Omit for leaving this unchanged.
SetDefaultCols

procedure Set Def aul t Col s(xCol , yCol , xErrCol, yErrCol:integer);

Sets the “default columns” of the current data window. The default x- and y-columns are those columns
that are shown in the preview window. Default columns are marked with “x”, “y”, “Ax”, “Ay” in their
column header.

Y ou can set xEr r Col , yEr r Col to zero to “undefine” the column.

Set any of thexCol , yCol , xErr Col , yErr Col to-1 if you don't want to changeit.
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SetDefaultDirectory
procedure SetDefaultDirectory(path:string);
Sets the default directory for saving files to the one specified by the given path-name. Pass the empty

string (' ' ) as a paramter to re-set the default directory to its original setting, i.e. the directory where the
pro Fit application is found.

SetEBar Style
procedure Set EBar Styl e(capLength, capThick, |ineThick:real);

Sets the style of the error bars that will be generated by

OpenDat aSet / AddDat aPoi nt / Cl oseDat aSet . Error bars are generated

by AddDat aPoi nt when the error parameter of GpenDat aSet Says SO.

capLengt h: Thelength of the cap in pixels, -1 to make the caps as wide as

the data points, -2 to get abox (works only if x- and y-errors are given). _ barline

capThi ck, | i neThi ck: The thickness of the caps and of the bar linesin cap—
pixels (0.001 — 50)

SetError Analysis
procedure Set ErrorAnal ysi s(confidence:real; iterations:integer);

Sets the options for the error analysis to be used in the next call to Fi t . confi dence isthe confidence
interval probability in percent. i t er at i ons isthe number of simulated data setsto be analyzed.

SetFillColor
procedure SetFill Col or(red, green, bl ue:integer);

Sets the default RGB color used for filling shapes. Used for drawing or filling curves. r ed, gr een, bl ue
are integers between 0 and 65535.

SetFillPattern
procedure SetFill Pattern(pattern:integer);

Sets the default fill pattern used for filling drawing objects. Set pattern to O for making the shapes
trangparent. The following figure shows alist of al patterns and their pattern number:
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raren BN D O [ (T
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SetFitDefaults

procedure SetFitDefaults(algorithminteger;

yErrDi stribution,xErrD stribution:integer;

XErr Col um: i nteger; xErrValue:real; stopTine:real);
Sets advanced fitting options. It sets the x-error column and type, the algorithm and the stopping criteria
to be used in all subsequent callstoFit.
al gori t hm the algorithm to be used (1: Levenberg-Marquardt, 2: Montecarlo, 3: Robust, 4: linear
regression, 5: polynomia)
yErrDistribution, xErrDistribution: the distribution of the x- and y- errors. They can be
gaussDi str, doubl eExpDi str, lorentzDistr, andrewbDi str, OftukeyDi str
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xEr r Col umm tellsif x-errors should be used: set it to O if x-errors are unknown, to -1 if they are constant
(passthevaluein xEr r Val ue), to -2 if they are given in percent (pass the percentage in xEr r Val ue), or to
the number of an x-error column.

st opTi me tells when to stop Monte Carlo fitting: pass a value > 0 to give the maximum number of
iterations, a value < 0 to give a negative maximum time in seconds, 0 for continuing fitting until manual
Interruption.

SetFitParamRange
procedure Set FitParanRange(parani\r:integer; rangeMn:real;
rangeMax: r eal ; asPer cent : bool ean) ;
Sets the fitting range for parameter par ani\r asit is used for Monte-Carlo fits. If asPer cent istrue the

range values can be given as a percentage offset from the parameter value. The fitting ranges set by this
command stay valid until the next fit command has been executed.

SetFunctionParam
procedure SetFunctionParan{nane:string; i:integer; value:real);

Sets the default value of afunction parameter asit appearsin the parameters window. nane isthe name of
the function as it appears in the Func menu. Use an empty string (' ' ) to specify the function currently
selected in the Func menu. This parameter is case sengitive. i isthe parameter index, val ue its new value.
Example:

set Functi onParan(' Pol ynomi, 1, 6)
sets the degree (=a[ i ] ) of the built-in function “Polynom” to 6.

SetFunctionProperties
procedure Set FunctionProperties(optional paraneter list);

Sets the properties of afunction in the Func menu. Parameters:

function (string) The function (omit for currently selected function)

shown (boolean) Trueif the function is shown in the Preview window, false if not.
Omit to leave unchanged.

nrParams (integer) The number of parameters. Omit to leave unchanged. Do not
change the number of parameters while a function is being used, e.g. for
fitting.

SetGlobalData
procedure Set d obal Dat a(val ue: real ; index:integer);

Setsthe vaue under the given index in aglobal dataarray. Thisdataarray is shared between all functions
and programs. It can be used for communication between programs, functions, scripts and modules.

The index must between 0 and 99.

See also: GetGlobal Data

SetGraphAttributes
procedure Set G aphAttributes(flags:integer);

Sets various attributes of the current graph.
f1 ags is0 or asum of the following constants:

dr awFr ame: draw the frame
dr amvaj or Gri dX: grid lines at major x-ticks
drawM nor Gri dX: grid linesa minor x-ticks

dr awvaj or Gri dY: grid lines at major y-ticks
drawM nor Gri dY: grid lines at minor y-ticks
pl ot Behi ndAxes: first draw curves, then axes
gridinFront: firstdraw therest, then the grid
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gridinM ddl e: draw grid between axes and curves
The last two constants cannot be used at the sametime

SetGraphFrame
procedure Set G aphFrane(left,top,right,bottomreal);

Changes the position and size of the current graph to match the new values. (Use Set NewGr aphRect for
setting the default size of future graphs.) | eft, top, right, bottomarein pixels.

Setl abel
procedure SetLabel (whi chAxi s:integer; tickNuminteger;
| abel Nunber:real);

Setsthelabel of tick mark having number t i ckNumto correspond to the given value. Accesses the current
X- Or y-axis (use whi chAxi s=xAxi s OF whi chAxi s=yAxi s).

SetL abelsFormat
procedure SetLabel sFor mat (whi chAxi s:integer; format:integer;
deci mal s: i nteger);
Sets the number format of the labels of the current x- or y-axis. whi chAxi s iseither XAxis or yAXis.
f or mat : -1,0,1 for auto, decimal , and exponential, respectively.
A format parameter equal to any other number sets the labels format to fixed exponential and uses format
as the number in the exponent.

SetlL egendProperties
procedure SetLegendProperties(optional paranmeter |ist);

Setsthe vishility, position and size of the legend of the current function.

Parameters are:
visible (boolean) Show or hide the legend.
offsetx, offsety (real) Offset between topleft of legend and topright of graph.
width, height (real) Size of an entry in the legend (left part).

SetL abel Text
procedur e SetLabel Text (whi chAxi s:integer; tickNuminteger;
| abel Text: string);
Sets the label of the given tick mark to the to given string. Accesses the current x- or y-axis (use

whichAxis=xAXxis or whichAxis=yAXis).
Thisroutineis usually used after callsto AddTick.

SetLineColor
procedure SetLineCol or(red, green, bl ue:integer);

Sets the line default color to be used for any future drawing in the current drawing window. r ed, gr een,
bl ue are integers between 0 and 65535.

SetLineStyle
procedure SetLineStyle(thick:real; dash:integer);

Sets the default line style to be used for any future drawing in the current drawing window.

t hi ck isthelinethicknessin points (1/72 inches). Set it to O for leaving it unchanged.

dash isthe dash pattern, and its numerical value corresponds to the position of the dash pattern in the
dash popup menu. The values between 1 and 8 aways correspond to:
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Values between 9 and 12 correspond to the four last customizable entries in the dash styles menu. A
value of O leaves the dash style unchanged.

SetNewGraphRect
procedure Set NewG aphRect(left,top, right,bottomreal);

Sets the size and position of the next graph generated with Cr eat eNewGr aph, PlotData and
Pl ot Funct i on. Subsequent calls to Cr eat eNewGr aph, Pl ot Dat a and Pl ot Funct i on will use the
normal default position and size, i.e. the effect of Set NewGr aphRect only extends to the one graph
created next. (Use Set G aphFr ane for setting the size of the current graph.)

SetOptions

procedure Set Opti ons(optional paraneter list);
Sets some options of pro Fit. Parameters:

currentFunction (string) The current function. (Alternative call to Set Opti ons(
current Function 'myFunc') iSSel ect Function(‘nyFunc') ).
Omit for leaving the current function unchanged.
(real): The default type for columns (floatColumn, doubleColumn,
textColumn).

defaultColumnType

decimals (integer) The number of decimals to be used for writing numbers in the
results window. Pass a negative value for setting the total number of digits,
a positive value for setting the number of digits after the decimal point.
Omit for leaving the setting unchanged.

errorAlerts (boolean) true if error aerts are to be shown when running into errors

during the execution of programs or scripts. Omit for leaving this option
unchanged.

(boolean) Set to true if debug info is to be printed while running
AppleScripts. Omit for leaving this option unchanged.

scriptDebugging

clipboard (string) Moves the given string onto the clipboard.

recordGraphStyles (boolean): true if the default graph style is recorded each time agraph is
modified. false to disable automatic recording of graph styles. Reset to
true when finished with the execution of the program and of all other tasks,
including re-drawing of windows, etc.

creator DataTEXT (string): creator code for ASCI|I text files with data from a data window.
Note that the string must be exactly 4 characters long. It defines the
application that opens a file that is double-clicked in the Finder. If you
send 4 spaces as the creator, pro Fit resets the creator to a default value. All
thisistrue also for the following options.

creator Other TEXT (string): creator code for ASCI| text files not containing data.

creatorPICT (string): creator code for drawing files with the PICT format.

creator EPS (string): creator code for drawing files containing Encapsul ated PostScript.

creatorGIF (string): creator code for image filesin the GIF format.

creator JPEG (string): creator code for image filesin the JPEG format.

See also: Get Opt i on
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SetParamDefaults
procedure Set ParanDefaul ts(i:integer; value:real; node:integer;
name: string; mn, max:real);
Obsolete. Use Set Par anet er Properti es instead.
Sets the value, fitting mode, name and limits of a parameter of the currently running function. i isthe
parameter index, val ue its new value, node its new fitting mode (can be const ant , i nacti ve, Or
active), nane its new name, and ni n, max the lower and upper boundaries of the parameter.

SetParamDefaultValue
procedur e Set ParanDef aul t Val ue(i:integer; value:real);

Obsolete. Use Set Par anet er Propert i es instead.

Sets the default value of a parameter of the currently running function. The default value is the value that
appears in the parameters window. i is the parameter index, val ue the new value. This function is
generally used within the predefined function “Initialize”.

SetParameter Properties
procedure Set ParaneterProperties(optional paraneter |ist);

Sets some properties of a parameter of the current function. Parameters:

param (integer) Theindex (1 based) of the parameter to be changed.

name (string) The name of the parameter as it appears in the Parameter window.
Omit for leaving it unchanged.

value (real) The value of the parameter as it appears in the Parameter window.
Pass equal X for setting it “=x". Omit for leaving it unchanged.

min, max (real) The lower and upper limits of the parameter. Omit for leaving the
corresponding limit unchanged.

mode (integer) The mode of the parameter. Use par am nact i ve, par amAct i ve,

par anConst ant for making the parameter inactive, active or constant.
Omit for leaving the mode unchanged.
See als0: Get Par anet er Property

SetParamLimits
procedure SetParanmLimts(i:integer; mn, max:real);
Obsolete. Use Set Par anet er Propert i es instead.
Sets the limits of a parameter of the currently running function. Parameter limits define the range of

values that are admissible for a given parameter (for example during afit). i isthe parameter index, and
m n, max itslower and upper boundaries.

SetParamName
procedure Set ParanmName(i:integer; nane:string);
Obsolete. Use Set Par anet er Properti es instead.

Sets the name of a parameter of the currently running function. i isthe parameter index, nane its new
name.

SetProgramProperties
procedure Set ProgranProperties(optional paraneters);
Sets a property of the program. Parameters are:
program (string or integer) The name or the position in the Prog menu of the
program to access. Pass an empty string (' ' ) for the currently running
program.

284  Appendix A: Predefined functions, procedures and arrays



idleCallTime (integer) The next time the program will be called while pro Fitisidle. If
you set this property to a non-zero value, the program will be called
automatically as soon as the function TickCount returns a value that is
larger or equal to idleCallTime. Before calling the program, its tag
'msgWhy' is set to the string 'idle’. The program can read this tag to
determineif it has been called at idle time using the procedure Get Tag.

SetRange
procedure Set Range(whi chAxi s:integer; mn, max:real; scaling:integer);
Sets the range and scaling of the current x-axis (if whi chAxi s=xAxi s) or y-axis (if whi chAxi s=yAxi s).
m n, max iSthe new range of the axis. scal i ng isits new scaling and can take the values O (linear
scaling), 1 (logarithmic scaling), 2 (1/x-scaling), 3 (probability scaling), -1 (keep scaling unchanged).

SetShapeProperties
procedure Set ShapeProperties(optional paraneters);

Sets the properties of a shape in the current drawing window. Parameters:

shape (string) The name of the shape.

xPosition, yPosition (real) The shape's x- and y-positions as they appear in the "Coords"
window.

xSize, ySize (real) Rhe shape's size in x- and y-direction as it appears in the "Coords"
window.

text (string) The shape'stitle or text content (for control shapes and text shapes
only).

value (real) The shape's value (for control shapes only). For text edit fields, this

Is the numeric equivalent of the edit field or nan255 (invalid) if the edit
field does not contain a number.

active (boolean): Trueif acontrol shapeis active, falseif isdisabled (for control
shapes only).

rotAngle (redl) The rotation angle of a drawing shape in radiants.

arcStart (real) Applies only to the Oval-shape. The angle in radiants at which the
arc starts.

arcLength (real) Applies only to the Oval-shape. The length of the arc in radiants.

See also: Get ShapeProperty, NewShape, Del et eShape

SetTag
procedure Set Tag(optional paraneters);
Set the value of atag. Create thetag if it does not exist yet. Parameters:
tag (string) The name of the tag.
program (string) The name of the program if the tag belongs to a program. Pass an

empty string (' * ) for the currently running program. Omit if the tag does
not belong to a program.

window (string or integer) The name or id of the window the tag belongs to. Omit
if the tag does not belong to awindow.

value (real) The numeric value of the tag.

stringValue (string) The string value of the tag. Empty if the tag does not exist.
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per manent (boolean) Trueif the tag isto be saved together with the window/program

(or, if the tag is a global tag, if t he tag is to be saved in pro Fit's
preferences files so that it is available the next time pro Fit starts up).
Default: false

To set aglobal tag (i.e. atag that is attached to pro Fit itself), pass neither the program or window

parameter. To set atag of a program that is attached to a window, pass the program and the window

parameter.

Use either the value or the stringVaue parameter, not both.

See also: Get Tag, Del et eTag

SetTextFileFor mat
procedure Set TextFi |l eFormat (col Del i mter, endC Line: string;
wi t hCol Ti tl es, copyl nf o: bool ean;
noHeader Li nes, i nout : i nt eger) ;

Sets the default format for loading and saving text files with SaveDat aAsText and QpenDat a.

col Del i mi ter and endO Li ne define the strings to be inserted between columns and between rows.
Pass an empty string (' ) for col Del i mi t er tu use atabulator. Pass an empty string (" ") or'\r' for
endOf Li ne tu use a carriage return.

col Delinmiter and endO Li ne can be built by any string of characters. For col Del i ni t er, you can
use'\t' for atabulator. For endOf Li ne, youcanuse' \r' and'\n', for acarriage return and aline
feed, respectively. Any other character preceded by ' \ ' isignored.

Set wi t hCol Ti t | es=t r ue to save thetitles of the columns, f al se if you don’t want to save thettitles.
Passtruefor copyl nf o to save the “info field” of the datawindow at the beginning of the text file.
noHeader Li nes specifies the number of lines that must be skipped at the beginning of atext file when
loading it into pro Fit.

Set i nout =1 to modify the settings for importing text files, set i nout =0 to modify the settings for
exporting text files.

SetTextStyle
procedure Set Text Styl e(fontNane:string; size:real; style:integer);

Sets the default font, font size, and style for subsequent text drawing. Text color can set using the
Set Li neCol or routine.

SetWaitText
procedure SetWait Text(s1,s2,s3,s4,s5,s6:string);

Writesthe stringss1 ... s6 into proFit’s progress window, which is displayed during lengthy operations.
The strings are arranged in a two columns by three rows arrangement:

sl s2
s3 s4
s5 S6

Use an empty string (' ') if you don't want to changeit. Seealso Set Wit Tit | e.

SetWaitTitle
procedure SetWAitTitle(s:string);

Writes the string s as a title into proFit’s progress window, which is displayed during lengthy
operations. See also Set Wi t Text .

SetWindowlnfo
procedure Set Wndow nf o(wi ndow D: i nteger;info:string);

Obsolete. UseSetWindowProperties instead.
Setstheinfo field of awindow to the given string.
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(Theinfo field of awindow can be viewed by choosing the Get Info... command from the File menu. For
datawindows, it is the text that appears when you drag down the info hook.)
wi ndowl Disthewindow ID of the window, such asit isreturned by Get W ndowl D or Fr ont W ndow.

SetWindowlnfo
procedure Set Wndow nfo(w ndow D, | ength:longint; info:Ptr);

External Modules only. Setstheinfo field of awindow to the given text.

i nf o isapointer to the new info text and | engt h isitslength in bytes.

Call set W ndow( wi ndow D, 0, ni | ) to clear theinfo text.

wi ndowl Disthewindow ID of the window, such asit isreturned by Get W ndowt D or Fr ont W ndow.

SetWindowProperties
procedure Set WndowProperties(optional paranmeter |ist);

Sets the properties of awindow. Parameters:

window (string or integer) The name or windowlID of the window to be affected.

name (string) Thetitle of the window. Omit for leaving it unchanged.

boundsL eft,

boundsRight,

boundsT op,

boundsBottom (integer) The bounds of the window in global screen coordinates. Omit for
leaving them unchanged.

info (string) The info text attributed to the window. Omit for leaving it
unchanged.

fontName (string) The font to be used in the window. Omit for leaving it unchanged.

fontStyle (integer) The font style to be used in the window (pl ai n, bol d,

italic, underline, outline, extended, condensed or any sum of
these values) . Omit for leaving it unchanged.

fontSize (integer) The font size to be used in the window. Omit for leaving it
unchanged.

visible (boolean) Trueif awindow isvisible.

floating (boolean) Trueif the window is "floating”, false otherwise. This property
can only be modified for the Preview window.

modified (boolean) True if awindow contains changes that have not yet been saved
to disk.

isDialog (boolean, drawing windows only) True if a drawing window is to be
displayed in "dialog mode", false if not.

nextShapeName (string, drawing windows only) The name of the next shape to be created.

Set to blank to use a default name. Set this property before using calls
such asDr awRect Or Drawstri ng for setting the name of the next shape
to be generated. Ignored for non-drawing windows.

See also: GetWindowProperty

SetWindowTitle
procedure Set WndowTitl e(w ndow D: i nteger; nane:string);
Obsolete. UseSetWindowProperties instead.
Setsthetitle of the given window to the string nane.
wi ndowl Disthewindow ID of the window, such asit ise.g. returned by Get W ndowi D or Fr ont W ndow.
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Sin
function Sin(x:real):real;
Returns the sine of x.

Sinh
function Sinh(x:real):real;
Returns the hyperbolic sine of x. sinh is defined by
eX _ eX
sinh(x) =
(="
Sort
procedure Sort (optional paraneter |ist);
Sortsrows in adata window. Parameters:
window (string or integer) The window, specified by name or window ID. Omit for
front window.
referenceCol (integer) The column to be used for sorting.
order (integer) sor t Ascendi ng Or sor t Descendi ng, the sort order
selectionOnly (boolean) Trueif only the rows of the currently selected columns are to be

sorted, false (or omitted) if the rows of al columns are to be sorted

Speak String
procedure SpeakString(s:string);

Letsyour hardware read the text contained in the string s. If text-to-speech extensions are not installed on
your computer, this routine does nothing.

Sqr
function Sgr(x:real):real;
Returns the square of x. sar(x) = x2
Sort
function Sgrt(x:real):real;
Returns the square root of x. Causes arun-time error for a negative argument
Statistics
Statistics(optional paraneter list);
Performs statistical analysis on a data window. Parameters:
window (string or integer) The window’s name or window 1D of your data. Omit
for using the frontmost datawindow.
column (integer) The column to work on or O for all columns. Omit if
“selectionOnly” is true.
selRowsOnly (boolean) Trueif only the currently selected rows are to be analyzed. Only
used when parameter “selectionOnly” isfalse.
selectionOnly (boolean) Trueif the currently selected cells are to be analyzed. Falseif the
columns specified in parameter “column” are to be analyzed.
withBasic (boolean) False for suppressing calculation of the sum, mean, variance,
standard deviation and absol ute deviation. Default: true.
withSkew (boolean) False for suppressing calculation of skewness and kurtosis.
Defaullt: true.
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withM edian (boolean) False for suppressing calculation of mean median, maximum
and minimum. Default: true.
printResults (boolean) True for printing the results to the Results window. Omit
“printResults’ or set it to false for suppressing this.
To retrieve the results of this command, call GetResult with one of the following selectors:

st at Count : number of evaluated values
st at Sum sum

st at Mean. mean

st at Medi an: median

st at St dDevi ati on: standard deviation

st at MeanAbsDevi at i on: mean absolute deviation
stat M nununmni minimum value

st at Maxununmni maximum value

st at Vari ance: variance

statKurtosis: K urtosis

StopExecution
procedure St opExecution;

External modules only. Tells proFit to interrupt execution of the current module as soon as possible.

Str255T oNumber
function Str255ToNunber (s: Str255; var x:extended):integer;
External modules only. Converts the string s to a number x. s can be a numeric string or an expression.

Return values are 0 (conversion successful), 1 (x isinfinite), 2 (sis empty), 3 (x isan NAN (invalid
number), 4 (user aborted), or 5 (run time error).

StringToNumber

function StringToNunber(s:string; var x:real):integer;
Convertsthe string s to anumber x and returns aresult code as follows:

0: conversion successful

1: x isinfinite

2: s Isempty

3: x isan NAN (not a number)

4: user aborted calculation

5: run time error

Tabulate

procedure Tabul ate(opti onal paraneter |ist);
Tabulates afunction to a data window. Parameters:

function (string) The function to be tabulated, omit for current function.

from, to (real) Thefirst and lastvalue to be tabul ated.

stepValue (real) The step between tabulated points. Omit if you pass autoStep or

pointsStep for parameter “step”
step (integer) nuner i cSt ep (= tabulate for equally spaced points as defined in

stepValue) , aut oSt ep (= choose step width automatically, use a larger
number of points where the function varies quickly) , poi nt sSt ep
(tabulate for all values of the x column in the current data window) .
Default if omitted: numericStep
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parameter (integer) Omit or set to O if tabulating the function by varying its x-value.
Set to the number of a parameter for tabulating the function by varying this

parameter.

xValue (real) defines the function’s x-value if you pass a non-zero value for
“parameter”. Omit otherwise.

fittedParams (real) true for tabulating the function with the parameters obtained in the

last fit, false (default) if tabulating the function with the parameters
given in the Parameter window.

TabulateExtrema
procedure Tabul at eExtrena(opti onal paraneter list);

Finds the minima/maximaof afunction by varying its x-value in agiven interval. Calculates atable of the
extremafor different values of a parameter of the function. Parameters:

function (string) The function to be used. Omit for current function.

xMin, XM ax (real) The start and end of the x-interval.

parameter (integer) The parameter to be varied for tabulating. Pass -2 for varying
“xMin”, -1 for varying “xMax” (however, these two options do not
make much sense!)

from, to (real) The start and end value of the parameter to be varied.

stepValue (integer) The step for increasing the parameter.

subintervals (integer) The number of sub-intervals to be searched in the x-interval.

When the function’s derivative changes its sign over a sub-interval, the
sub-interval is searched for a minimum or maximum.
See dso: Extrema, Optimize

Tabulatelntegral
procedure Tabul atel ntegral (optional paraneter |ist);

Calculates the integral of a function over a given x-range. Creates a table of the integral for different
values of aparameter of the function or for different values of alimit of the x-range. Parameters:

function (string) The function to be used. Omit for current function.

xMin, XM ax (real) The start and end of the x-range to be integrated.

parameter (integer) The parameter to be varied. Pass -2 for varying “xMin”, -1 for
varying “xMax”

from, to (real) The start and end value of the parameter (or xMin, xMax) to be
varied.

stepValue (integer) The step for increasing the parameter (or xXMin, xMax) .

iterations (integer) The number of iterations (5 .. 15) . The more iterations you use,

the more accurate the result becomes.
See ds0: Integrate

TabulateRoots
procedure Tabul at eRoot s(opti onal paraneter |ist);
Finds the root(s) of afunction (or finds the x-value of a function where its y-value is equal to a given
value) within a given x-range. Varies a parameter and tabulates the roots for different values of this
parameter in a datawindow. Parameters:
function (string) The function to be used. Omit for current function.
xMin, XM ax (real) Start and end of the x-range.

290  Appendix A: Predefined functions, procedures and arrays



parameter (integer) The parameter to be varied. Pass -2 for varying “xMin”, -1 for
varying “xMax” (however, these two options hardly ever will make sense)

from (real) The start value of the parameter to be varied.

to (redl) The end value of the parameter to be varied.

stepValue (integer) The step for increasing the parameter.

subintervals (integer) The number of sub-intervals to be searched in the x-interval.

When the function’ s sign changes over a sub-interval, the sub-interval is
searched for aroot.

yValue (real) The desired y-value. Omit or set to O if finding the x-value where the
function becomes zero.

See dso: Roots
Tan
function Tan(x:real):real;
Returns the tangent of x. tan(x) = sin(x)/cos(x).
Tanh
function Tanh(x:real):real;
Returns the hyperbolic tangent of x. tanh is defined by
e’ -e* _ sinh(x
tanh(x) = —— = ().
e” +e" cosh(x)
TenTo
function TenTo(x:real):real;
Returns 10 to the power of x. tento(X) = 10%
TestData
function Test Dat a(row, col umm: | ongi nt) : bool ean;
External modules name. See Dat aCK.
TestStop

function Test St op: bool ean;

External modules only. Returnst r ue if the current operation should be interrupted (because of user wish
or proFitwish).

TickCount
function TickCount:real;
Returns the number of 1/60 seconds since your computer was started. It can be useful for timing your

programs or functions or for writing intermediate results or status information at regular time-intervalsto
the Results window.

TimeString
function TinmeString(secs: bool ean): string;
Returns a string with the current time. Set secs to true for appending seconds.
See also: DateString
Transpose

procedure Transpose(optional paraneter |ist);
Transposes a datawindow, i.e. exchanges its rows and columns. Parameters.
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window (string or integer) The window’s name or window ID. Omit for
transposing the front window.

Transp
function Transp(mmatrix): matrix;
Returns the transposed of the matrix m
true
const true = 1;
This constant stands for the logical value of true.
Undo
procedure Undo;
Equivalent to selecting “Undo” from the “Edit” menu.
Upper String
procedure UpperString(var s:string);
Converts al characters of sto upper case. See also Lower St ri ng
UsePar ameter Set

procedure UsePar anet er Set (opti onal paraneter list);
Moves a parameter set appearing in the parameter set menu to the parameter window. Parameters:

set (string) The name of the set.

for All (boolean) True if the parameter set is one available for al functions.
Default: fase

of Function (string) The function the parameter set belongs to. Omit for the current
function.

See als0: AddParameterSet, SaveParameterSet, LoadParameterSet, Del eteParameter Set

Vect2
function Vect2(vl, v2: conplex):vector[2];

A “construction function” for the vector[ 2] type. It takes 2 complex (or real) parameters, assignes them
to the elements of avector according to their order, and returns the vector..

Vect3
function Vect3(vl,v2,v3:conplex):vector][3];

A “construction function” for the vector| 3] type. It takes 3 complex (or real) parameters, assignes them
to the elements of a vector according to their order, and returns the vector..

Vect4
function Vect4(vl,v2,v3,v4:conpl ex):vector[4];

A “construction function” for the vector| 4] type. It takes 4 complex (or real) parameters, assignes them
to the elements of a vector according to their order, and returns the vector..

_ _ Write
procedure Wite(Stringor expressons);
This procedure can have any reasonable number of strings or expressions as parameters. They will be

written into the Results window.
Example:
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Wite('x value is: ', Xx);
Note: The format fields of standard Pascal (: x: y after numerical values or : x after all other values) are
not supported. The number of digits after the decimal point for thewri t e and wri t el n procedures can
be specified by choosing “Preferences” from the File menu. Use Set Opt i ons(decimals ...) for
setting it from a program or function.
You can redirect the ouput of W ite to a text file using the routines Cr eat eText Fi | e and
WiteToTextFile.

_ _ Writeln
procedure Witel n(String or expressons) ;

This procedure writes strings and numbers into the Results window. Then it moves the insertion mark to

anew line. It uses the same parameters as the procedure write.

Example:

Thefollowing writes the value of the top left data cell of the current data window into the results window:
Witeln('data cell (1,1) = ',data[1,1]);

You can redirect the ouput of Wi tel n to a text file using the routines Cr eat eText Fi | e and

WiteToTextFile.

WritelnString
procedure WitelnString(s: Str255);

External modules only. Writesthe string s to the results window and starts anew line.

WriteNumber
procedure WiteNunber (r: extended);
Externa modules only. Writes the number r to the results window.
Writelnt
procedure Witelnt(n:longint);
External modules only. Writes the integer number n to the results window.
WriteString

procedure WiteString(s: Str255);
External modules only. Writes the string s to the results window

WriteToTextFile
procedure WiteToTextFile(fileRef Numi nteger);

Re-directsthe output of Wite, Witel n, WiteNunber efc.toafile.

fi | eRef Numisthe number returned by Cr eat eText Fi | e or O if you want to direct output to the results
window.

Call d oseText Fi | e to close the file when you are through

XColumn
function XCol um: i nt eger;

Returns the column number of the x-column in the current data window. It returns zero if no x-column
was set and produces arun-time error if no datawindow is available.

XErrColumn
function XErrCol um: i nt eger;

Returns the column number of the Ax-column in the current data window. It returns zero if no Ax-column
was set and produces arun-time error if no datawindow is available.
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Y Column
function YCol um:i nt eger;

Returns the column number of the y-column in the current data window. It returns zero if no y-column
was set and produces a run-time error if no datawindow is available.

Y ErrColumn
function YErrCol um:i nt eger;

Returns the column number of the Ay-column in the current data window. It returns zero if no Ay-column
was set and produces a run-time error if no datawindow is available.
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Appendix B: About numbers

Floating point numbers

proFit uses three different formats for representing floating point numbers (or float):
 real (or float): This format has smallest accuracy but requires minimum size. It is used in data
windows if you set the range of a column to “—~1E30 ... 1E30".
 double: Thisformat has better accuracy but requires more size. It is used in data windows if you set
the range of a column to “—1E300 ... 1E300”.

« extended (or native double): Thisisthe format used for internal calculations. It has the same or better

accuracy as the double format.

The following list summarizes the features of each data type for the Power Macintosh and the 68k

version of pro Fit:

real double extended (native double)
Power Mac eaktt
minimum negative number —-3.4E38 —-1.8E308 —-1.8E308 —-1.1E4932
maximum negative number —-1.2E-38 | —2.2E-308 —2.2E-308 —1.7E-4932
minimum positive number 1.2E-38 2.2E308 2.2E308 1.7E-4932
maximum positive number 3.4E38 1.8E308 1.8E308 1.1E4932
decimal digits 7-8 15-16 15-16 19-20
size (bytes) 4 8 8 10/12%

T The FPU version uses 12 bytes, the non-FPU version 10.

tT 68k applies to pro Fit 5.1 or earlier — pro Fit 5.5 only supports PowerMac data.

Apart from the values in the list above, proFit knows four other numbers: 0, +INF (infinity), -INF (—
infinity), NAN. The first three of them will do what you expect them to do. E.g. 1/0 = +INF, INF/3 =
INF etc. NAN (Not A Number) isthe result of any computation that cannot be carried out, such as sqrt(-
1). The occurrence of NAN values in computations is reported as arun-time error.
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Date and Time data

pro Fit understands and works with time data, i.e. absoulte calendar dates and relative time.

The Mac OS stores dates as the number of seconds since January 1, 1904 (for the technically minded,
the date is stored as an integer number, 8 byte long).

pro Fit uses the same convention as the Mac OS to store dates, but uses “double” floating point values
instead of integers. With this number representation, pro Fit can store and recognize dates with second
precisions until up to 1015 (this corresponds more or less to a 6 byte long integer) seconds after January
1, 1904. .pro Fit can store dates with second-precision up to 31 million yearsin the future, and it can
store dates with day-of-the-week precision up to 3.1 billion years (3 x 109) in the future.

However, the date-time conversion routines currently available in Mac OS 9 only support dates up to
29'940 AD for date-to-string conversions, date-calculations, etc. Up to this limit, pro Fit can store dates
with a precision of milliseconds, while it can store dates in the present with a precision of approximately a
microsecond.
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Appendix C: File formats

This appendix describes the file formats used by proFit for transferring data or drawings to and from
other gpplications.

Data

The default text format

To exchange data between proFit and other applications, text files are used. Usualy, such files hold one
or more lines of text. Each line contains all values of a row separated by “tabs’ (- ). The lines are
separated by “carriage returns’ (). It is possible to use other characters instead of tabs and carriage
returns (see below).

There are two standard formats of datatext files produced by proFit:
The standard format with titlesis defined as follows:

19 line; namel — name2 — name3
2nd [ipe: 0123 - 1732 - 1122 9
3d|ine 2233 - 2125 - 2126

The standard format without titlesis very similar, but without the column titlesline.

Thereis an interesting exception for data text files to be loaded into pro Fit. If thefirst lineisasingle star
(*) pro Fit reads the second line as the column titles even if the file is loaded as being standard format
without titles.

Lines are separated by carriagereturns ((char ) (13) or\ r' for C programmers, chr ( 13) for Pascal
programmers).

Thefirst line with the column titlesis optional. These names are separated by tabs (character code 9, here
denotedas'—"' —(char) (9) or\'t ' for C programmers, chr (9) for Pascal programmers). If proFit
reads a file without column titles, it sets the columns names to “ Column 1”, “Column 2" etc.

A typical Pascal program for writing such afile would be:
var out:text;

rewite(text,'filenane');
witeln(text,'x',chr(9),'y");
witeln(text,'1.234',chr(9),"'2.341");
witeln(text,'-1.244" ,chr(9),"'3.412");

cl ose(text);

Some applications produce data text files using other formats, or read data text files only when they arein
special formats. proFit provides options to read and write text filesin other formats as well. The details
are given in the next section.
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Loading text files

For reading text files, choose Open... from the File menu, choose “Text Files” from the View pop-up
and select the file to be read. Y ou will be prompted for the following information:

Loading TEXT File Format

3 Function or program file
@ Data file Format | With Titles : ]

El [ Eancel] HL"TI]

If you select Function or program file, thefileis opened as a non-data text file and loaded into a new
function window.

If you select Data file, the file is opened as a data file and loaded into a data window. In this case you
can select either one of the standard formats or the custom format.

- If “Custom” format is not selected, proFit uses an intelligent trandlation agorithm, which recognizes
most data file formats automatically. By selecting the “With Titles” format pro Fit interprets the first
linein the text file as the column titles.

- If “Custom” format is selected, you can specify the file format yourself.

Loading TEXT File Format

3 Function or program file
@ Data file Format | Custom + |

] Contains header lines

Copy to 'Info’ field
S5kip

[+ Contains column titles

Column delimiter Line terminator
@ [Tab )| ®[crR D) | 2|
O [t | 3 e

| Show contents | 2] | cancel | |I_|md|

Y ou can import any file where the datais stored as lines of text, each line containing the values of arow.
Y ou can specify one or more characters (Column delimiter) that separate individual valuesin aline and
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the characters (Lineterminator) that separate the individual lines. For both, column delimiter and line
terminator, proFit gives you a selection of the most common combinations.

Furthermore, you can check
- Contains header linesfor skipping the first line(s) of thefile, or to copy them into theinfo field of
the datawindow, and
- Contains column titles if the file contains column titles in the first line following the optional
header lines.

Sometimes you do not exactly know how the text file is formatted. Therefore, you may want to have a
look at the starting lines of that file by clicking Show contents. Pro Fit will show you the following
dialog box:

TEXT File to be Loaded

Line offset: 0

*'l.lr'\-

first coltwery |ooooooooooonguery |oocooooooooonguery o
1.000000=+0%t 1. 0000002—5% tuary  texty 1220005
2.000000e+0%t 1. 000000=—9%tshor Ly

3. 000000e+0%% 3. 14 1592=+0% tar

4. 000000e+0% 1 0. 000000e+0% 1y

2. 224000=+3% Lt tabove is emptys

2

2

t

L] »

.342400e+44t 1. 234000e+3% Ly
L 424234a+B5 b EStart asdfasd Tkj Tkj LIk Tkj Thj Tkj Tkj k]

LR R R Rn=L AR LR AR AR AR AR AR ARARARARARARARARARARAR AR AN

Moo tabulator, hao line feed, o carriage return

Line breaks at: [JLF0nd [ CB ()

L] Wrap long lines

Note that special characters such as a tabulator, line feed or carriage return are written in a double
character form with abackdlash (\) asthe first character.

It is possible to display the text with different Line breaks. If Wrap long linesis checked, the lines will
not be cut at the right border but wrapped to the next line.

Saving text files

Y ou can also save datainto text filesin a custom format. To do this, choose Save as... from the File menu
for your data window and choose “ Text File” from the Format pop-up. In the dialog box that appears,
sdlect Custom format:
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Saving TEXT File Format

Format [ Custom 2 |

[+ Optimize Size

[+ Write header lines:
@ Copy text from "Info" field

3 Single line

[+ Write column titles

Column delimiter Line terminator
@ [ Tab %] @ | CR ($0D) %)
O [t | O [nr

12| | Eﬂncell |'javel

This dialog box is very similar to the one for loading text files. Again, you can select the Column
delimiter and the Line terminator.

If Write header lines is checked, you have the option to either write a single first line with the text
specified in the edit field to the right, or to copy the whole text contained in the info field of the data
window as the header of thefile.

If Write column titles is checked, the next line contains the column names separated by the column
delimiter.

Check Optimize size to write the numbers with as few characters as possible, without loosing precision.

The native data for mat

If you want to exchange binary data with pro Fit, you can use pro Fit's native file format. A description of
this format is given in the technical note “pro Fit binary data file format” that comes with the pro Fit
package.

Drawings

proFit drawings can either be saved in the native format of pro Fit (file type ‘ftGF’), or in one of the
following export formats: As PICT file (file type ‘PICT"), EPSfile (file type ‘EPSF'), JPEG file (file
type ‘JPEG’), or GIF file (file type ‘ GIFf’). These file formats can be used for export drawings (PICT
and EPS) or images (GIF and JPEG) to other applications. You can modify pro Fit's preferences
settings (using the “Preferences...” Item in the File menu) to decide which default application will be
used to open files exported by pro Fit.

C-300 Appendix C: File formats



PICT and JPEG files can aso be read by proFit.

To save adrawing in one of above file formats, bring the drawing window to the front and choose Save
as... from the File menu. In the dialog box that comes up, select the desired format type.

PICT files contain standard Macintosh PICT information and can be read by most drawing applications.
The exact format of the PICT files created by proFit depends on the current PICT settings. See Chapter
13, “Preferences’, for more information on the different PICT settings.

EPS files are Encapsulated PostScript Files. They are essentially text files containing a standard
PostScript representation of the drawing. This representation is used by other applications that
understand and work with PostScript. In addition to the PostScript text, a PICT representation of the
drawing isincluded. Thefile type of EPSfilesis‘EPSF . Hold down the option key while saving the file
to produce afiletype of ‘TEXT'.

JPEG files contain a (compressed) image with a format defined by the Joint Photographic Experts
Group. The exact format may be found on the Internet. Besides the files of type ‘JPEG’, also ‘JFIF
files are recognised and read by pro Fit (JFIF for JPEG File Interchange Format). JPEG files can be
interpreted by the standard internet browsers.

When saving JPEG files you may set various options like compression level, color depth, antialiasing,
background color, etc.

GIF files contain a (compressed) image with aformat defined by CompuServe. The exact format may be
found on the Internet. GIF files can be interpreted by the standard internet browsers.

When saving GIF files you may set various options like compression level, color depth, antialiasing,
background color, etc.

The Lempel-Ziv-Welch compression algorithm that is normally used within GIF files is owned by
UNISY S. Since we do not have alicence, we are not allowed to compress GIF files or to read GIF files.
However, it is still possible to save uncompressed GIF files directly with pro Fit and to open GIF files
with the help of 'File Exchange, atool generally available with Mac OS.
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Appendix D: Apple Script Cross Reference

The following table is a cross reference between the functions and procedures of pro Fit's built-in
programming language and equivaents available under Apple Script.

pro Fit programm ng | anguage Apple Script equivalent
- do script

- evaluate

- get data

- quit

- set data

AddPar anet er Set add parameter set

At t achPr ogram attach

Bi nDat a bin data

Cal | Program run program

Capture capture

Cl ear clear

Cl oseW ndow close

Conpi l e compile, do script

Copy copy

Cut cut

Dat aExport Opti ons data export options

Dat al nport Opti ons data import options

Dat aTr ansf orm transform

data[i,]] use the cell elements of the data window, e.g.

get value of cell 1 of column 2

Del et eFuncti on delete

Del et eFuncti on delete function

Del et ePar anet er Set delete parameter set
Del et ePr ogr am delete

Del et ePr ogr am delete program

Del et eShape delete shape

Del et eTag use delete tag
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Extrena

FFT

Fit

CGet Col ummPr operty

Get Dat aW ndowPr operty

Get Funct i onProperty

CGet d obal Dat a
CGet Opti on

Cet Par anet er Property

Cet Progr anPr operty

Cet Resul t

CGet ShapeProperty

Cet Tag
Get W ndowPr operty

Integrate

I nver seFFT
LoadPar anet er Set
NewDat aW ndow
NewDr awi ngW ndow
NewFunct i onW ndow
NewShape

OpenDat a

OpenFil e

OpenText

Optim ze

find extrema of

FFT

fit

use the properties of the column class, e.g.
get format of column

use the properties of the classes windowor table, e.qg.
get nrRows of window “MyData”

use the properties of the class function, e.g.
get nrParams of function “Sin”

use get global data

use the properties of the pro Fit application class, e.g.
get decimals

use the properties of the class parameter, e.g.
get name of parameter 1

use the properties of the class program, e.g.
get idleCallTime of program “Prog”

use the results property and the calculation results class,

e.g.
get chiSquared of results

use the properties of the class shape, e.g.
get value of shape “checkbox 1"

use get value of tag

use the properties of the classes window,drawingWindow
or table, e.g.
get name of front window

integrate

inverse FFT

load parameter set

make table

make drawingWindow

make textWindow

make shape

use open file “...” as data window
open

use open file “...” as text window

optimize
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PageSet up page setup

Past e paste

Pl ot Dat a plot data

Pl ot Functi on plot

Pri nt print

ReduceDat a reduce data

Root s find roots of

SavePar anet er Set save parameter set

SaveW ndow save

Sel ect Al l select all

Sel ect Cel | use select, e.g. select cell x of column 1
Sel ect Col umm use select, e.g. select column 3

Sel ect Functi on use select, e.g. select function “Sin”
Sel ect Row use select, e.g. select row 4

Sel ect W ndow use select, e.g. select window “Results”
Set Col umPr operties use the properties of the column class, e.g.

set name of column 3 to “data”

Set Dat aW ndowPr operti es use the properties of the classes windowor table, e.qg.
set nrCols of window “MyData” to 50

Set Fi t Par amRange set fit range of parameter

Set Functi onProperties use the properties of the class function, e.g.
set shown of function “Sin” to true

Set d obal Dat a use set global data
Set LegendPr operties set legend properties
Set Opti ons use the properties of the pro Fit application class, e.qg.

set default column type to real

Set Progr anProperties use the properties of the class program, e.g.
set idleCallTime of program “Prog” to 131203

Set ShapeProperties use the properties of the class shape, e.g.
set xSize of shape “rect” to 231

Set Tag use set value of tag
Set W ndowPr operti es use the properties of the classes window,drawingWindow
or table, e.g.

set font of window “Func” to “Helvetica”

Sor t sort
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Statistics

Tabul at e

Tabul at eExt rena
Tabul at el nt egr al
Tabul at eRoot s
Transpose

Undo

Wite

Witeln

calculate statistics -- use pro Fit's property “results” for
retrieving the results, e.qg.

get statMean of results
tabulate
tabulate extrema of
tabulate integral of
tabulate roots of
transpose
undo
write

write line
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Index

1/x axes 76

Abs 224

accuracy 189, 295

ActivateProFitWindows 224

active 129, 148

active data window 43

active parameters 110

add to menu 154

AddCommand 224

AddDataPoint 224

addition 208

AddParameterSet 224

AddTick 225

Adjoint 225

Alert 131, 225

AlertBox 225

align 63

analyze submenu 48

and 208

Andrew’s sine 102, 116

Apple Events 12, 177

Apple Script 12, 176
classes 180
methods 180

Apple Scripts 158

arccos 225

arcosh 225

arcsin 225

arctan 225

arguments 136

arrays 153, 155

arrow keys 31

arrows 66, 70, 275

arsinh 226

artanh 226

ASCII 230, 266

Ask 226

AskBox 226

attached programs 159

AttachProgram 226

auto 47

auto labels 87

auto-search 117

axes 84

axis scaling 76

backward 63

bad 148, 171

balloon help 132, 197

bar charts 80

base 10 logarithm 208

306 Index

baseline 65

batch processing 177, 178,
180

Beep 227

BinData 227

binning 40

bit-array 210

BitAnd 227

BitClr 227

bitmap 187

BitNot 227

BitOr 227

BitSet 228

BitShift 228

BitTst 228

bitwise operation 210

BitXOr 228

boolean 130, 144, 152, 155,
207

breakpoints 157

BringWindowToFront 228

Browse 132

Button 228

buttons 69, 161

CalcStat 228

CallFunction 228

Calling sequence 156

CallProgram 180, 229

CancelEvent 229

Capture 229

case statement 155

CellSelected 229

Char 153, 207

Check 147, 148, 151, 171

checkboxes 69, 161

checkPAnswer 172

chi-squared 103, 116

ChiSquared 229

Chr 230

circle 65

CleanUp 168

Clear 230

ClearData 139, 230

ClearLabels 230

ClearTicks 230

clipboard 74

CloseCurve 230

CloseDataSet 230

ClosePoly 230

CloseTextFile 230

CloseWindow 230

ColEmpty 231

color 70

Column Format 32

column width 32

columns 30
format 31

comma 191

comments 128

comparison 144

Compile 231

Compile & Add to menu 126,
130, 131

compiler 126, 154, 206

CompileText 231

Compl 231

Complex 152, 207

confidence intervals 104, 113,
114, 123

Confidencelnterval 231

Conj 231

const 135

Const menu 132

constant 129, 135, 148, 208

constant parameters 110

constants 135, 171

contextual menus 201

control shapes 69, 161

convergence 123

coordinate system 60

copy 72, 231
legends 82

CopyString 232

cos 232

cosh 232

covariance matrix 106, 107,
116, 232

CovarMatrix 232

create publisher 72, 74

CreateNewGraph 232

CreateTextFile 232

current axis 278

current data set 44, 53

current data window 43, 44,
48, 212

current drawing window 213

current function 53

current graph 215, 217, 278

current window 278

curvature matrix 106



curves 90
tabulating 91
custom ticks 87
cut 72, 233
dashes 70
data 233
data array 130
data import 34
data points 66, 90
data reduction 37
data set
current 44
data transform 35
data transformation 35
data window
current 212
data windows 30
column width 32
data transform 35
date 32
discontinuous selection 31
dragging columns 30
home field 30
info field 30
precision 31, 190
range 31, 190
resizing 30
selecting data 31
time 32
DataExportOptions 233
DatalmportOptions 233
Datalnfo 246
DatalnfoPtr 246
DataOK 130, 235
DataTransform 234
data[...] 233
date format 193
dates 32
DateString 235
DateTimeStrToNum 235
DeactivateProFitWindows 235
debugging window 155
default columns 44, 203, 279
default PICT style 188
default style 97
DefaultParaminfo 169, 173
DefaultParaminfoPtr 173
definition syntax 135
degrees of freedom 107
Delete 235
DeleteAxis 236
DeleteFunction 236
DeleteParameterSet 236

DeleteProgram 236

DeleteShape 236

DeleteTag 236

Derivative 237

derivatives 106, 112, 148,
151, 169, 170

description 128, 145

Determinant 237

deviation functions 102

dialog mode 98

digits 87, 189

DisableDrawingUpdates 237

discontinuous selection 31, 37,

55
Display As Dialog 99
Div 237
division 208
DoCloseWindow 237
DoMenu 237
DoNewWindow 238
DoScript 238
double 152, 295
double clicking 63
Drag and Drop 62
drag&drop 72
DrawArc 238
DrawDataPoint 238
DrawEllipse 238
drawing 61
objects 61
Drawing Info 61
drawing window 59
current 213
DrawLine 238
DrawNumber 238
DrawPICT 239
DrawRect 239
DrawText 239
DrawTextLine 239
dyda 149
edition container 74
ellipse 65
embedded PostScript 186
enlarged PICT 187
enter selection 201
EPS file 271
EPS files 72, 301
Erf 239
Erfc 239
error analysis 104, 112, 113,
114
error bars 91
error distributions 112, 116

error function 208

errors 101, 123

evaluation of simple
expressions 197

Even 239

EventRecord 251

Exit 142, 239

Exp 239

exponential distribution 102

exponential function 123, 208

exporting pictures 72

expression evaluation 197

extended 152, 295

extended accuracy 152

external code 155

external module 165

external modules 13, 157

ExtModulesParamBlock 173,
174

extrema 48, 50, 240

false 143, 152, 240

FFT 41, 242

file formats 297

file info 199

fill patterns 70

find 200, 201

find again 201

first 46, 149, 151, 170

Fit 240

FittedParams 242

fitting 58, 100

fitting algorithms 104

fitting mode 46

fitting multiple functions 118,
120

fitting ranges 116

fitting tool 56, 111

flip 63

float 295

floating point coordinates 60,
61

for loop 129, 140

formats 297

forward 63

Fourier transform 41

frame 93

FrontmostWindow 243

FrontWindow 243

FSSpec 174, 247

function 136, 145
definition 125, 144
fitting 100

function module 157



functions 45, 125
Gamma 243
gamma function 208
Gammal 243
Gammaln 243
GammaP 243
Gaussian distribution 102, 106
get info 199
GetAndSetStatus 243
GetBasics 243
GetCell 244
GetClickedCoord 244
GetColHandle 244
GetColName 244
GetColType 244
GetColumnProperty 245
GetCurrentAxis 245
GetCurrentGraph 245
GetCurrentWindow 245
GetData 245
GetDataWindowProperty 245
GetDateTime 245
GetDefaultData 245
GetFileDirectory 246
GetFrontWindow 246
GetFunctionName

string 246
GetFunctionParam 246
GetFunctionParamMode 246
GetFunctionParamName 246
GetFunctionProperty 247
GetGlobalData 247
GetGraphCoordinates 247
GetGraphFrame 247
GetMarkedCoord 247
GetMedian 247
GetModuleFile 247
GetNextGraph 248
GetNumFunctionParams 248
GetOption 248
GetParameterProperty 248
GetProgramProperty 248
GetSelection 248
GetSelectionBounds 249
GetShapeProperty 249
GetSkew 249
GetTag 249
GetWindowlID 250
GetWindowProperty 250
GetWindowTitle 250
GetWindowType 250
GIF

files 73
GIF files 301

global variables 174
good 171
graph 82

axes 84

curves 90

double-clicking 83

frame 93

grid 94

labels 87

lines 87

main dialog box 83

style 96
graph submenu 83
grid 94
GrLine 251
GrLineTo 251
GrMove 251
GrMoveTo 251
group 63
GroupBegin 251
GroupEnd 251
Halt 142, 251
HandleEvent 251
help 197

balloons 197
Help menu 132
high resolution PICT 187
highest 173
histograms 80
hyperbolic functions 208
if statement 128, 131
i 251
Im 251
importing pictures 75
inactive 129, 148
inactive parameters 110
INF 143, 251, 295
Initialize 148, 151
InitializeFunc 169
InitializeProg 169
input 212, 251
InputBox 253
inputRec 172, 253
InsertString 254
integer 152, 207
integer division 208
integer modulo 208
integral 48, 254
integrate 50, 254
interpolation 51
Invalid 255
invalidNum 255
inverse Fourier transform 41
InverseFFT 255

isFunction 172
isProgram 172
JPEG files 73, 301
justification 65
k urtosis 289
KeyPressed 256
kurtosis 40
labels 87
custom 87
Last 151
legend 82
Lens check box 61
Levenberg-Marquardt algorithm
104, 105, 114, 116
Line 256
line thickness 70
linear axes 76
lines 65, 202, 203
LineTo 256
linking 155, 165
Ln 256
Load Module 165
LoadParameterSet 256
local function 136, 145
local procedure 136, 145
Log 256
logarithmic axes 76, 86
logarithmic plot 124
logical and 208
logical not. 208
logical or 208
longint 152
loops 140
Lorentzian distribution 102
lower case 206
LowerString 256
lowest 173
macros 12, 125, 129, 176
main axes 76
main coordinate axes 76
MakeNewAXxis 256
MakeTicks 257
MarkedX 257
MarkedY 257
markers 56, 192
Matr2 257
Matr3 257
Matr4 257
matrix 207
Maximize 257
maximum 39, 48, 50, 257
maxNrinputValues 172
maxNrParams 172
maxParamNameLength 172



mean 39, 289

mean absolute deviation 39,
102, 289

mean square deviation 102,
103, 105, 229

median 39, 289

Minimize 258

minimum 39, 48, 50, 258

Mod 258

mode 148, 173

ModeType 172

module 165

modules 45, 157, 158
external 157

modules, loading automatically
158

Monte Carlo algorithm 105

Monte Carlo Fit 116

Monte-Carlo algorithm 104

Move 258

MoveTo 258

multi-preferences-file 158

multiple x-values 118

multiplication 208

name 173

NAN 295

natural logarithm 208

NewDataWindow 258

NewDrawingWindow 259

NewFunctionWindow 259

NewShape 259

NewWindow 260

NextWindow 260

nonlinear fit 116, 117, 118

normal distribution 102

normal PICT style 188

normal style 97

NrCols 261

nrRows 129, 261

number of digits 189

Numberinvalid 261

NumberToStr255 261

NumberToString 262

numerical accuracy 295

NumFitParams 262

NumToDateTimeStr 262

NumToRelTimeStr 263

Nyquist critical frequency 41

Odd 263

ok 148

OpenCurve 263

OpenData 263

OpenDataSet 263

OpenFile 264
OpenPoly 265
OpenText 265
operators 208
operators 143
optimize 48, 265
optional parameter lists 141
or 208
Ord 266
Outer 266
output 212
page setup 184
PageSetup 266
ParamArray 172
parameter defaults 146
parameter limits 46, 107,
110, 117
parameters 45, 110
defaults 129, 145
mode 129
poor definition 123
redundancy 123
parameters window 45, 144
ParamModeArray 172
ParamName 172
ParamNameArray 172
params -->> 115
ParamSD 266
partial derivatives 106, 112,
148, 149, 169, 170
Pascal 155
paste 75, 266
pb 168
Phase 266
pi 266
PICT 72, 186
files 72
options 72, 73, 186
PICT file 271
PICT files 301
PICT style 187
picture settings 187
pictures 72, 75, 186
PlaceWindow 267
plot
data 79
function 77
PlotData 267
PlotFunction 268
plotting 76
preferences 191
plug-ins 165
pNumber 148

pointers 155
points 48, 66, 90, 203
polygons 65, 202
polynomial 45
population 17
Pos 269
PostScript 185, 186
power 208
power of ten 208
power operator 130, 143
PRandom 269
precedence 143, 144
preferences 96, 189
Drawing 190
File export 195
General 189
Interface 193, 194
PICT Options 186
Plotting 191
Prefs file 196
Preview 192
printing 184
preferences file 158
loading and saving 196
preferences files 158
preview 53
drag tool 56
fitting tool 56
markers 56
preferences 192
zoom tool 56
preview window 53, 113, 115
Print 269
printing 184
at printer’s resolution 184
with postscript 184
pro Fit Modules 158
pro Fit preferences 189
probability axes 76
procedure 136, 145
Derivatives 148
First 149
Initialize 148
Last 151
program
attaching to windows 159
definition 125, 132, 135,
200
linking 165
program module 157
programs 12, 125, 129
progress window 113, 114
publisher options 75



QuickDraw GX 75

radio buttons 69, 161

Random 270

range of numbers 295

Re 270

real 152, 207

record macros 134

records 155

rectangle 65

redraw button 56

ReduceData 270

redundancy 123

RelTimeStrToNum 270

remove function or program
158

repeat loop 140

replace 200, 201

replace & find again 201

reshape 66

reshape mode 66

resizing drawing objects 62,
203

resolution 72, 185

RGB color 280

Robust algorithm 107, 114,
116, 117, 118

roots 48, 57, 270

rotate 62

Round 271

roundoff errors 60

rows 30

RowSelected 271

Run 169

run-time error 295

save module 157

SaveDataAsText 271

SaveDrawingAs 271

SaveParameterSet 272

SaveWindow 272

SaveWindowAs 273

scaling 76

scatter plots 80

script editor 177

scripting 176

scripts 125, 129, 158, 176

select all 31

SelectAll 273

SelectBottom 273

SelectCell 273

SelectCells 273

SelectColumn 273

SelectDirectory 274

SelectFunction 274

selecting drawing objects 61

selection 31, 37, 39, 55, 80
discontinuous 31
selection only 35
SelectLeft 274
SelectRight 274
SelectRow 274
SelectRows 274
SelectTop 275
SelectWindow 275
send 63
SetArrowStyle 275
SetAxisAttributes 275
SetAxisPosition 276
SetBGDataPointStyle 276
SetBoxTitle 276
SetCell 276
SetColHandle 276
SetColName 277
SetColType 277
SetColumnProperties 277
SetColWidth 278
SetCurrentAxis 278
SetCurrentGraph 278
SetCurrentWindow 278
SetCurveFill 278
SetData 278
SetDataPointStyle 278
SetDataSize 279
SetDataWindowProperties 279
SetDefaultCols 279
SetDefaultDirectory 280
SetEBarStyle 280
SetErrorAnalysis 280
SetFillColor 280
SetFillPattern 280
SetFitDefaults 280
SetFitParamRange 281
SetFunctionParam 281
SetFunctionProperties 281
SetGlobalData 281
SetGraphAttributes 281
SetGraphFrame 282
SetLabel 282
SetLabelsFormat 282
SetLabelText 282
SetLegendProperties 282
SetLineColor 282
SetLineStyle 282
SetNewGraphRect 283
SetOptions 283
SetParamDefaults 284
SetParamDefaultValue 284
SetParameterProperties 284
SetParamLimits 284

SetParamName 284
SetProgramProperties 284
SetRange 285
SetShapeProperties 285
SetTag 285
SetTextFileFormat 286
SetTextStyle 286
SetUp 168
SetWaitText 286
SetWaitTitle 286
SetWindowlInfo 286
SetWindowProperties 287
SetWindowTitle 287
Shape Settings 98, 164
shapes 213, 222, 249, 285
names 98
properties 98
Sin 288
sinc 146
singularity 123
Sinh 288
skewness 40
skyline plots 80
smooth 66
sort 38, 288
SpeakString 288
special procedures 151
Spline 44, 51
spreadsheet 12
Sqr 288
Sqrt 288
square 208
square root 208
stairway plots 80
standard deviation 39, 289
standard deviations 103, 106,
107, 123
Start Recording 134
starting parameters 123
statement 139
static variables 174
statistics 38, 288
Stop Recording 134
StopExecution 289
Str255ToNumber 289
String 153, 207
StringToNumber 289
styles 96
subscribe to 74, 75
subscript 64, 204
subtraction 208
sum 39, 289
superscript 204
syntax 132, 135



system requirements 11 version number 248

table of curves 91 versionNumber 172
table of extrema 50 while loop 139, 140
table of roots 49 window ID 221
Tabulate 289 windows
Tabulate Integral 51 debugging 155
TabulateExtrema 290 drawing 59
TabulateIlntegral 290 parameters 45, 110, 144
TabulateRoots 290 Write 292
tabulators 65 Writelnt 293
tags 221, 236, 249, 285 Writeln 293
Tan 291 WriteInString 293
Tanh 291 WriteNumber 293
TenTo 291 WriteString 293
TestData 291 WriteToTextFile 293
TestStop 291 x-column 44
text files 297, 298 x-errors 101, 103, 105, 106,
text objects 64 107, 108, 112, 280
tick marks 88 XColumn 293
TickCount 291 XErrColumn 293
ticks 88 y-column 44
custom 87 y-errors 101, 107, 112, 123,
time 32 280
time format 193 YColumn 294
toolbox routines 155 YErrColumn 294
tools palette 61, 64 zoom factors 59
Transp 292 zoom popup menu 60
transpose 38, 291 zooming 98
trigonometric functions 208 m 266
true 143, 152, 292 m (or pi) 143

Tuckey’s biweight 102, 116
type definitions 136
types 151, 155, 171
typographical minus 191
Undo 292
ungroup

legends 83
update 148, 171
upper case 206
UpperString 292
use QuickDraw for text 185
UseParameterSet 292
user programs 37
value 173
var 135
var parameters 137
variable 135
variables 136
variance 39, 289
Vect2 292
Vect3 292
Vect4d 292
vector 207
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